REINVENTING THE TATTOO
Second Edition
Table of Contents

Part I: Introduction
1.1) An History Of Change 1
1.2) Reinventing The Tattoo: An Overview 5

Part II: Design
2.1) Flow And Fit 9
2.2) Positive/ Negative Relationships 27
2.3) Contrast 37
2.4) Priority 51
2.5) Reserve 57
2.6) Lines & Edges 63
2.7) Depth 81
2.8) Lighting And Luminosity 93
Part II Review Questions 105

Part III: Working In A Second Medium
3.1) A Broader Perspective 107
3.2) Examples Of Other Mediums 111
3.3) Surface Preparation: Building Your Foundation 119
3.4) Acrylic Painting: A Brief Tutorial 125
3.5) Oil Painting: A Brief Tutorial 131
Part III Review Questions 139

Part IV: Working From A Reference
4.1) Seeing The Real Thing 141
4.2) Finding Or Creating Our References 145
4.3) Doing A Tattoo From A Model: Working From A Line Stencil 161
4.4) Doing A Tattoo From A Model: Working From A Crosshatch Stencil 164
4.5) Doing A Tattoo From A Model: Working From A Frehand Drawing 168
4.6) Extreme Modeling: A Larger Scale Project 173
Part IV Review Questions 180

Part V: The Digital Tattoo
5.1) Basic Computing For Tattooists 181
5.2) A Brief Adobe Photoshop Tutorial 187
5.3) Using Photoshop In The Design Process: Scanning And Coloring A Drawing 201
5.4) Using Photoshop In The Design Process: Making A Digital Simulation Of A Tattoo 207

Part VI: Tattooing Technique / Nuts And Bolts
5.5) Using Photoshop In The Design Process: Sizing A Drawing To A Tracing 209
5.6) Using Photoshop In The Design Process: Compositing Multiple Images Into One 213
Part V Review Questions 222

Part VII: Step-By-Step Processes
6.1) Technique: An Overview 223
6.2) Design Transfer: Stenciling And Frehanding 225
6.3) Needles 240
6.4) Tubes 250
6.5) Machine Tuning 257
6.6) Machine Setup 258
6.7) Machine 259
6.8) Machine Runs Rough 269
6.9) Machine Runs Intermittently 275
6.10) Machine Won’t Start 275
6.11) The Stretch 276
6.12) Tightening And Softening 277
6.13) Starting A Tattoo Magnum First 281
6.14) Comfort And Ergonomics 288
Part VI Review Questions 296

Part VIII: Conclusion
8.1) New Horizons 351
PART I

Introduction

1.1) An History Of Change

The art of tattooing took a long time to find its place in the world despite its powerful potential. Hidden away in geographically secluded subcultures, tattooing idled away quietly for millennia, unaware of the wealth of artistic richness awaiting just outside its cultural isolation. Its rather mystical allure beckoned to travelers and traders, yet its taboo qualities and slightly intimidating methods were enough to keep it hidden away from all but the most daring.

Eventually, globalization prevailed and tattooing took root in Western societies, where in the early Twentieth Century a few innovators found ways of using electricity to drive a needle fast enough that it could be used as a pen. Within mere decades they ironed out this process to an extent that images could be tattooed into the skin with great subtlety and accuracy.

Although there were precious few practitioners in the early Twentieth Century who had any kind of artistic background before becoming tattooists, those who did formulated the essential principles of placement on the body, flow of design, etc., that other tattooists soon adopted into the basic look of their work. The core of these design principles was largely borrowed from classic tattooing styles long in use in Japan and the Pacific Islands, but to the tattooists of the Western World, these were new ideas. It was the beginning of a long process of discovery.

Generations passed, and the craft was refined to the point where there were enough attractively tattooed people walking around in the world to support a number of publications which featured the latest styles in skin art. Inevitably, these magazines and books ended up in the hands of a more and more diverse assortment of artists, inspiring them and enabling many new styles of art to make their way onto skin. These innovators were able to meet and exchange ideas and techniques at tattoo conventions, which at that stage were becoming large and well-organized events.

Tattooing has evolved into a full-fledged artistic medium that is plugged into a global network and applied with an endless variety of sophisticated techniques. Nurtured in an environment of economic prosperity, combined with freedom of expression and the diverse influence of thriving subcultures worldwide, contemporary tattooing is arguably one of the fastest and most explosive renaissances ever known in the history of art. As we continue to mix and match our arts and technologies at a faster and faster pace, it is not difficult to envision even more exciting and innovative developments in the near future.

In 1900, less than 1% of the world’s population were tattooed. By 2000, that figure had come close to 10%.
Currently, the state of the art of tattooing is such that basically any image can be tattooed on skin with almost photographic realism. Although these techniques are used mostly for portraits and wildlife tattoos, they can be applied to other areas as well. This makes it difficult to keep the same level of artistry in tattooing as it was in earlier times. The few real limitations we’re facing now is in our understanding of what exactly makes a tattoo design successful, and what combination of elements will have the greatest visual impact while having the most flattering effect on the body that wears it.

With the wide variety of different styles being explored, it shouldn’t be hard to understand these limitations and use them to our advantage. Each style of tattooing has some particular artistic direction that it explores more closely than other styles. Japanese tattooing has always been about flow and placement on the body. Traditional American tattooing explores the language of the line, seeking ways to say the most with the least. Tribal tattooing is closest to the compositional equation and zero in negative relationships that balance between the tattoo and the skin in between. Biomechanical and Organic tattooing place heavy emphasis on the illusion of depth in the design and placement. Black and gray tattooing explores the subtleties of the whole range from dark to light.

With the tattoo profession being gradually taken over by experienced artists, we’re seeing many modern illustrative styles being tattooed, and these new styles are evolving from computer-generated designs. Classic styles, such as Van Gogh and Dali, are being painstakingly interpreted on skin alongside more modern masterpieces, such as Alex Grey and H.R. Giger. In less than a century, tattooing has evolved to encompass every conceivable style of art.

Much of this was made possible by the technical evolution of the tattooing process. Before electricity, the ink had to be literally hammered in, leaving little opportunity for precision or subtlety. With the invention of the electric tattoo machine, all of the things we see in skin today were made possible.

If you look through enough books of tattoos in the early part of the 20th Century, you’ll occasionally see a portrait done with fine lines and delicate shading. This wasn’t the typical way of doing things at the time, though, and most of the work you see from back then is somewhat rough. A lot of this can be blamed on the art form’s ghetto status, which scared away most of the promising artists who may have otherwise been attracted to it. This made it hard to get “real art” prices for tattoos, which meant that pure quantity was the only way to keep a tattoo shop running.

The new artistic ideal of slowing down and working more carefully has helped bring about all kinds of advances in machine designs, pigments, tubes and all sorts of other tattooing essentials. The modern electric tattoo machine, although basically unchanged for over 100 years, has been refined in many aspects and now can be tuned to puncture the skin in exactly the artist’s desired manner. In addition, tattooing methods have recently benefited from ergonomics, the science of making equipment that fits the user. Ergonomics have brought about developments in practical aspects of tattooing including machine weight, the shape of the tube grip, modern massage tables and adjustable chairs; these innovations have made both the artist and client more comfortable and allow for more productive sessions.

Pigments have also evolved in exciting ways. Almost every color in the spectrum is now available from many different suppliers using numerous different kinds of pigment, many of them tried-and-true in skin for decades, others brand-new on the market, promising but without these years of having been used and proven. Many of these new pigments are thinner and much easier to use than traditional flake powder pigments, which not only make the job easier but also allow for more color control over subtlety. Artists can use all these different pigments to mix their own custom colors, making their palette unique.

Now that we have a limitless range of styles and designs to choose from and sophisticated equipment and pigments to apply with, all we need is a better way of transferring our designs. In the old days we used acetate stencils, which made a very crude impression on the skin that could easily be wiped off prematurely. The Traditional American style of tattoo design evolved from these limitations, employing extremely simple line drawings to make it easier for non-artist tattooists to be able to follow the design and still make it readable and attractive.

However, the breakthrough to using hectograph stencils solved many of these problems, making possible more sophisticated designs including tattoos that take hours just for the outline, or methods where the design is applied shading first, without the outlining process as the beginning stage. Never before have we had so many choices. In the future we may see non-toxic, alcohol-soluble inkjet stencils in full color, allowing for an even broader tattoo vocabulary and easier, more intuitive ways of handling our favorite tattoo subjects.

Despite all of these exhilarating developments, tattooing is not yet out of the ghetto. Even with new TV programs giving tattooing a more positive spin, popular culture has been painting an ugly and simple-minded image of the craft for such a long time now that it’s become hard for the public to accept the idea of a new, improved tattoo trade. Unfortunately, this reputation is not totally undeserved, and the bad examples stand out much more than the good ones. If we want the reputation of tattooing to be cleared of this burden and see it truly embraced as a fine art, we need to accept the responsibility of not living down to these expectations, either artistically or ethically, and encouraging an environment of growth and change amongst ourselves and other artists.
However, many tattooists who have been established for a few years, especially those who own shops, are often somewhat closed to accepting new ways of doing things. These artists often feel that what they know was learned through years of struggle, and they feel justified in not taking change lightly. Tattooists in this position are likely to have apprentices who will succumb to their influence for better or worse. In many cases, these artists will impose a very rigid method upon their apprentices as one of the required conditions of their employment.

Generally, this style of apprenticeship will invoke rules that must be followed, or it’s the end of the world. Some of these rules may be helpful in keeping a new tattooist out of trouble for the first few weeks or months, but they can stop being useful as the apprentice gains more experience, and eventually these guiding rules become mandates that prevent professional development. Some ancient wisdom says, “Know the rules, so you can break them properly.” Anyone who really knows what they’re doing doesn’t strictly or blindly adhere to rules to guide them; they just follow their intuition, letting experience be their guide.

An example of this is the “liner” and “shading” misunderstanding. We are normally taught that our small round needle groups are for linework and our larger rounds and magnums are for shading and coloring. We are also shown a few basic movements of the hand which are the Official Approved Tattoo Hand Motions. Within this simple way of seeing it are the ingredients for clean outlines and shading, but nothing fancy or subtle. Often, this approved way of applying the tattoo is so rigid that even an artist experienced in other mediums, and quite good at them, can never quite get the hang of tattooing. Many times you’ll meet very talented individuals who do beautiful work in pastel or paint, yet their tattooing is merely average, showing none of the fire that they demonstrate in their other chosen medium. This is almost always the result of them allowing themselves to be bound by rules that are no longer necessary for tattooists of their skill level.

When painters are using a variety of different sized paintbrushes, they are unlikely to think of the small brushes as “liners” and the large ones as “shaders”. These names will only limit what the artist feels they can do with each tool. Instead, they are simply the small brushes and the large brushes, and are used interchangeably as the job requires. In the same manner, I encourage you to think of your needle groups as brushes, and refer to them by their description, not their traditional name. For instance, I often work with a 3, 5 round and a 7 magnum; I refer to them not as liners and shaders but simply as the 3, the 5 round and the 7 mag, and I’ll switch freely between them while I work, just as I would with brushes. Nice and easy, and I’m not subliminally convincing myself that I’m only allowed to make lines with the 3 or 5 round.

Another example of a tattoo technique myth is the notion that you must finish the black first, then work the darkest colors, moving your way through the medium and light colors, finally finishing with the yellow and white. Common wisdom says that you can stain a fresh area of light color by spilling or wiping a dark color over it, so by working from dark to light, there’s no risk of that happening. But does this need to be so ironclad?

My experience is that you can work the colors in whatever order you like, provided you’re conscious not to stain the lightest pigments. You do this by keeping the light colors protected with petroleum jelly and wiping the dark colors away from the light ones. Small amounts of dark pigment wiped over lighter ones don’t seem to make a difference; only by dry-wiping and really grinding it in will you have any risk of staining, which then would be likely to fall out in the healing process. Simply put, only the pigment particles that are rammed into an adequate depth during tattooing are destined to stay there. It’s easiest to move in a general dark-to-light direction while tattooing, but always give yourself the flexibility to work with whatever color you need to at any time. I often continue to work with black after many of the dark and medium colors have been put in. As long as we’re aware that staining can potentially happen and we do what we need to prevent it, we have no need for these ironclad rules.

Almost all visible “staining” from wiping dark colors over fresh light colors is superficial and will fall out when the tattoo peels.

Now that I’ve started debunking much of what you’ve been taught, I think it’s important for me to point out that nothing I have to say in this book is necessarily true, either. Just like all the stuff you’ve heard from other artists, these words are merely ideas to consider while doing your next tattoo. It’s up to you to find the truth out for yourself, and to always be flexible when it comes to what you believe can and can’t be done. Once you have the basic feel for the process, you need to begin questioning what you know and exploring what might be possible.

1.2) Reinventing The Tattoo: An Overview

Throughout this book will be numerous illustrations and photos. Although most pictures are right on the page where they’re discussed, occasionally you’ll be referred back to a previous photo or illustration. Each figure number will begin with the page number that it’s on, followed by a letter denoting alphabetically which image it is on that page going from left to right, from top to bottom. For example, Figure 79c refers to the third image on page 79.

You will also see a number of icons throughout the book, representing ideas that stand apart from the rest of the text in a particular way. These are as follows:

Fact: An essential design, technical or historical fact

Myth: Common misunderstandings that tattooists have

Important: Read these to avoid getting into problem situations

Helpful Hint: Tips that might make a big difference
Soapbox: As long as I’m writing this book, I may as well share my opinions, right?

Superstition: Although completely irrational, these ideas seem helpful in making a successful tattoo.

Try This: A project that would help you get a better grip on the topics being discussed, and might be enjoyable.

Definition: A quick descriptive definition of an important concept.

Exercise: At the end of each chapter are exercises related to that chapter. You can post your exercises for critique at www.hyperspacestudios.com/reinventing/exercises and compare your versions to the model drawings posted there.

Review Questions: At the end of each part are a series of questions about that part. You can find the answers at: www.hyperspacestudios.com/reinventing/answers

We’ll then discuss priority in a design, where we choose what parts of a design are the most important, and use graphic tricks to give them emphasis. We’ll talk about reserve, where we choose elements to withhold from the background so we can use them in the foreground, such as certain colors or white highlights. If every element is used in all parts of a design, it can be hard to read, but if some elements are reserved for just the foreground and others for only the background, the different layers of the design will be more visually distinct from each other.

Next, we’ll go on to talk a bit about the use of lines in a tattoo, and the distinction between a line and an edge. This includes a discussion of line weight and ways of building up lines; we’ll also cover the techniques of graining, bloodlining and lining in color. Just as important is when not to use lines, and how to execute a line-free tattoo, or a tattoo with line-free elements. We’ll also talk about the simulation of depth, texture and luminosity, which can give a tattoo extra dimension and life.

In Part III of the book we’ll discuss the idea of working in a second artistic medium, such as watercolors or oil paints, since having a second medium seems to keep the mind more limber and can give an artist more technical freedom as a tattooist. I’ll describe a number of mediums in some detail, compare them with the technical aspects of tattooing and follow through with brief tutorials in acrylic and oil painting.

Next, in Part IV we’ll talk about using reference photos, both with tattooing and with complementary artistic mediums, as a way of broadening your vocabulary and empowering your vision. We’ll go into how to find the appropriate reference and how to photograph it and prepare it for the tattoo or painting project. We’ll then move on to making your own reference models and using computer tools to aid in the creation of our designs.

In Part V, we go into much more detail about using the computer for design and archiving purposes. This begins with a description of the hardware and what it costs, and what software to use. A brief Adobe Photoshop tutorial is also presented, where we discuss in detail the step-by-step process of scanning, cleaning, balancing and resizing photos, along with strategies for building a better portfolio. We then use these same methods for more sophisticated design manipulation, including the use of the kinds of models we built in Part IV, and then outline some methods for making the right stencils for these unusual types of tattoo imagery.

In Part VI of the book we’ll talk more specifically about tattooing technique, beginning with a chapter on stenciling and freemarking, then moving on to the various needle groups and their pros and cons. After that we’ll talk about machine setup a bit, stuff like power, stroke and spring tension, and how these things influence the action of the machine and the way that it interacts with the skin. An ideal setup should allow for more airbrush-like layering with the magnum and more pencil-like freedom with round needle groups.

Next, we’ll talk about the stretch; how experienced tattooists may tend to neglect the stretch almost as badly as novices, and how you should feel the vibration of the needle striking the skin with your stretching hand. The more clearly you can feel it, the better your stretch is and the more ideal the penetration of the needle will be. Even though this is entry-level stuff that we pick up on the first day of our apprenticeships, it’s a thing that we always must remain conscious of, no matter how experienced we are, since it affects the outcome of a tattoo at least as much as the machines or the pigments do.

A favorite topic of mine is tightening, the act of going back into a piece with a small round needle group after finishing work with a larger group. This is a way of filling in corners, sharpening edges, adding detail, and cleaning up rough areas. Although this stage isn’t essential to being able to call a tattoo finished, I feel that it is not only an important step in giving your work a technical polish, but also one of the most fun parts of the job. We’ll also discuss...
switching between machines frequently in the same way a painter might switch between brushes, and some of the
new power units available that make this process easier.

In addition, we’ll talk about client ergonomics and why it’s advantageous to both you and your client that they
be comfortable. This is accomplished through body position, lighting, entertainment and atmosphere; also important
is your style of body contact and handling of them, how you wipe them clean, and the way you handle the psychological
aspects of their comfort. There are also a few topical numbing products available, which can make quite a difference to
the pain level if they are used carefully; so we’ll talk about these substances too, along with their potential pitfalls.

Part VII will show a number of tattoos in progress at various stages; this is where the design and technique from
the previous chapters all come together. We’ll talk about each stage and how it was accomplished, using which
materials and techniques. We’ll use this opportunity to show examples of the many ideas we’ve discussed in action,
such as contrast and positive/negative relationships, and how these things help make the designs work. Then in
Part VIII we’ll step back and take a look at everything we’ve gone over in the rest of the book, and talk a little about
where to go next with it.

PART II

Design

2.1) Flow and Fit

When approaching a new tattoo design, it’s normal for both the client and the artist to first consider the subject
matter as being of primary importance. After this is decided, the layout and color scheme are worked out alongside
the rest of the details. Although it may seem the obvious way to proceed, this approach tends to neglect the true
importance of the flow and fit of the design, which is why it’s not unusual to see a technically beautiful tattoo that
doesn’t flatter the body the way that it could.

The truth is, the flow and fit of a tattoo on the client’s body can be as important, if not more
important, than the actual subject matter of the piece.

No matter how simple or trivial an idea might be for a design, if it flatters the body, the client will most likely
grow old happily with it. On the other hand, tattoo collectors I’ve spoken to who have the most serious issues with
their tattoos—almost always complain about them being too stiff, too dark, too high up, or cutting across a body part
in a way that feels awkward or unnatural. Such complaints are rarely about the subject matter. When they are, it is
often a misunderstanding on behalf of the client who erroneously places responsibility for their dissatisfaction on the
subject matter instead of the true design problems.

In a real sense, the flow and fit are part of the subject matter, since they determine so much about how a tattoo
conveys its basic message. There are some styles of tattooing, most notably tribal and biomechanical, where the flow
and fit are the primary elements of that style’s design sensibility; in fact, these styles of tattoo design derive their basic
vocabulary directly from the shapes and forms of the body’s structure. A poorly designed tribal tattoo, no matter how
sharply it may be executed, will always look awkward; a good tribal design will look nice even if the points are dull
and the edges a little wiggly. If the fit and flow are striking enough, the tattoo’s strong design will prevail and these
technical weaknesses will scarcely be noticed.

In the tattooing context, flow and fit are two sides of the same coin. Flow refers to the
movement and overall from-a-distance graphic structure of a piece, such as how the larger
shapes in the piece move along the body’s musculature. Fit refers to the way that the piece
feels to the wearer and how it affects the body’s appearance, such as how high the collar line
is, or if the piece is bottom-heavy or top-heavy. Flow and fit work together to define the way that the tattoo
interacts with the body.
The light and dark areas were kept large enough that the flow of the design is clearly readable, even from a distance. For example, smaller details in the design were given less contrast than the larger shapes, as not to clutter the larger forms and distract from the overall flow. Likewise, a heavy black shadow has been placed under the large foreground shape, giving it depth and supporting the readability of its flow. This tattoo is one that has always brought a strong response from people flipping through my portfolio, despite its apparent lack of subject matter.

In Fig. 11a is a whole-arm design. A sleeve is always an exciting opportunity for a tattooist; it’s much less common to get such a request from a female client. I believe that the feminine form calls for a lighter overall look; to provide this light and open quality, plenty of open skin was left in the water to keep the tattoo from becoming too heavy. The water was used as a unifying element for flow, and cascades up and down the natural curves of the arm. It also serves as a unifying element to tie together the rest of the tattoo’s subject. The remaining elements in the design are brightly colored; if we had left areas of open skin in the hand and flanks along with all the open skin in the water, the piece would have appeared under-worked and insubstantial. Although the client already had a couple small tattoos on her forearm, we were able to incorporate them into the overall design in such a way that the entire arm still appears as one piece.

Fig. 10a & 10b is an example of a strongly contracting design with a smooth, simple flow shown next to a diagram describing the arm’s basic muscle structure and compositional flow. You can see how the important parts of the design are placed in such a way as to flatter the arm’s musculature.

Designs that have large amounts of untattooed skin in the background usually will be most successful if the foreground elements have little or no blank skin.

A unifying element is a continuous element such as fire, water or vines that appears in various places throughout a large tattoo such as a sleeve. When used the right way, unifying elements give complex designs better flow and visual continuity.

I believe that most tattoos done on women tend toward being too dark and dense. Women’s needs really are different from men’s needs; more open skin and a softer overall look are a good start. This depends on the client, of course. See page 24 for more on this subject.
A good rule of thumb to consider when designing fluid tattoos is the Golden S-Curve Rule, which basically acknowledges that the human body is made of curving, fluid forms that appear to follow an S-curving flow. The arms are not cylinders, for instance, a rigid symmetrical design placed on an arm will look awkward, its symmetry struggling for dominance with the natural asymmetry of the arm. A circular design placed on the deltoid will tend to look egg-shaped, while that same design placed in the center of the chest or back could potentially fit quite nicely.

In Fig. 12a is a tree design that follows the basic S-curve of the arm. It would have been easy to make the tree point straight up and down, as many real trees do, but this would have made the arm appear too rigid. Instead, the trunk is designed to emphasize the curve of the biceps and branches follow large, looping arcs that sit nicely on the deltoid. Straight branches are avoided entirely. The overall look not only follows the muscle structure of the arm but is designed to keep the viewer’s eyes in motion, giving the piece more energy. You’ll often see this method used in tattoos of tattoo machines; usually you’ll see them distorted intentionally not only to make them more interesting, but to make them flow better with the body.

Most body parts will look best if the tattoo on them appears slightly top-heavier, which is usually a more flattering fit on the human form. It can make an arm appear more toned or make a back appear slimmer at the waist. Conversely, a bottom-heavy tattoo will usually be unflattering to the body part. An existing tattoo that appears bottom-heavy can be visually “lifted” by adding an appropriate background element to the upper part of the design.

In Fig. 13a, several layers of curving elements are used to create a flowing sense of depth. The central coil is the thickest, cleanest and most prominent curve in the design. The fact that it’s clean and smooth makes it easier to get away without using a black outline. The fleshy pod enclosing it is made of a number of long flowing S-curves, all of which complement the flow of the inner coil. The zipper things follow another curve, and the points of the teeth describe yet another. The twisty organic stuff and the bottom of the pod are large and readable, sitting on parts of the arm that allow the design to take full advantage of the natural anatomy to strengthen its depth effect.

Part of the fun with this design’s flow are all the repetitions and gradations. The various teeth, spines and zipper flaps all follow the clean S-curves of the design, and they graduate as they repeat (i.e., each of the elements in a series gets larger or smaller than the last one in the same series). In the central coil, the spines get bigger and bigger until they culminate as the biggest, shiniest and brightest one at the coil’s tip. All of this rhythmic motion keeps the viewer’s eye zooming around the design, giving it life and energy.

A construction drawing is the early stage of drawing when simple lines that are not meant to be part of the finished drawing are laid out as a guide for the elements of the design. For example, perspective lines going to a vanishing point will guide how an architectural structure will be drawn, but will be erased when the drawing is done. The guidelines that you would use above and beneath lettering to keep it straight and a consistent height are another example of construction lines.

These kind of repeated patterns are created using a careful construction drawing. This method of drawing starts with long arcs and simple lines, just to make sure the design elements flow and interact in the right way. In this case, we started with a few basic arcs, making sure the flow and proportions of the major shapes were all balanced the right way (Fig. 13b) before laying out the repetitions and gradations, spacing the peaks and valleys of the teeth in a regular increasing and decreasing rhythm. The long arcs make the good skeleton on which to build these details, ensuring that the spacing and proportions of the details are consistent and smooth flowing (Fig. 13c).

When the basic layout looks good, the next step is to add detail and bring the drawing to completion, ready to stencil and tattoo (Fig. 13d). However, if you are laying out a large design and you start with detail before the structure of the design is finalized, it’s easy to put a lot of effort into parts of a drawing that end up being the wrong size in the wrong place. Detail can be fun to do, but it’s good to wait until the whole basic shape of a design is going in the direction you want before getting involved in detail.
A Tattooist’s Guide to the Major Muscle Groups

A basic familiarity of the body’s larger muscles can be helpful in laying out a design. If some of the larger curves or shapes in the tattoo design coincide with the form of the muscles, it will produce a naturally better fit and will animate better as the body part moves. I recommend that you invest in at least one good anatomy reference book, such as Jerry Barefield’s “Anatomy For The Artist” (Barefield & Noble, 1995). Although it is not necessary to memorize all the different muscles by name, having a general knowledge of their structure and natural movement can give you an advantage as a tattoo artist.

Part I: The Arm Muscles

1) Deltoid: The large triangular muscle at the top of the shoulder. A tattoo occupying this space is often referred to as a “shoulder cap.”

2) Biceps Brachii: The major muscle bulge on the front of the arm. Any half sleeve design needs to take the form of this muscle into account and take advantage of the curve in the front of the arm.

3) Brachialis: Another large frontal arm muscle, mostly covered by the biceps. This muscle is generally only visible on toned people.

4) Triceps: This large rear arm muscle extends from the armpit to the elbow and has a fairly prominent horseshoe-shaped bulge that can be used effectively in a tattoo design. From a side view, this bulge slants up and back diagonally toward the shoulder blade.

5) Brachioradialis: The largest upper forearm muscle that extends into the lower part of the upper arm. This muscle defines the top of the forearm part of a sleeve design, and continues in the upward-and-rear diagonal movement that the bulge in the triceps follows.

6) Extensor Digitorum: This muscle extends from the top of the forearm, then divides and connects to the four fingers. It forms a large part of the bulge of the outer forearm.

7) Anconeus: A continuation of the outer part of the triceps, this muscle, when visually combined with the extensor digitorum, follows the same diagonal movement as the brachioradialis.

8) Flexor Carpi Ulnaris: This long muscle extends from the elbow to the wrist and points straight toward the hand.

9) Palmaris Longus: This muscle and its neighbor, the flexor carpi radialis, run straight up the arm from the wrist and curve toward the inner elbow near the top of the forearm. These muscles form a V-shape that frames off the “ditch” of the inner elbow.

10) Abductor Pollicis Longus: This small muscle creates that distinct widening in the wrist just above the heel of the thumb.

Abstract tattoo subjects provide a chance to design the entire tattoo around the natural contours of the body part. In this sleeve design, the overall tattoo follows a basic S-curve pattern while parts of it address specific muscle features on the arm. Notice how a horn shape above the elbow makes use of the bulge and indentation at the top of the brachioradialis, while major features curve down the front of the bicep, angle up the back of the triceps and frame off the deltoid.
A Tattooist's Guide to the Major Muscle Groups
Part II: The Torso Muscles

11) Latissimus Dorsi: These large muscle groups extend all the way from the spine to the ribs under the arms that define the edges of the back. They give the back its characteristic V-shape.

12) Trapezius: Extending from the sides of the neck to the top of the tope of the deltoid muscles, then downward to the middle spine, the trapezius creates a smaller V inside the large V of the latissimus dorsi muscles. In a toned person, you can clearly see the division between these muscle groups.

13) Obliques Extrems Abdominis: These are the lower rib muscles, which begin over the kidney area and extend around the front and attach to the ribs, creating a diagonal movement upward toward the front center of the body.

14) Gluteus Maximus: These are the large buttock muscles, which are ideal for curved or spiraling shapes. This upper edge, which forms a shallow V in the center of the lower back, denotes a good lower boundary for a backpiece.

15) Gluteus Medius: This muscle defines where the hip ends and the rib area begins.

16) Tensor Fasciae Latae: The small soft ridge along the front of the hip region is formed by this muscle, which extends downward toward the side of the thigh.

17) Serratus Posterior Inferior: This group of muscles, which constitutes a deeper layer under the connecting tissue of the latissimus dorsi, forms the hinge in the lower middle back and is one of the major shapes worth considering when designing large back work.

18) Pectoralis Major: This is the main chest muscle, beginning above the ribs and extending up to the collar and the deltoid. A chest panel tattoo essentially covers the pectoral area.

19) Serratus Anterior: These upper rib muscles intertwine with the obliques externs abdominis muscles, creating the series of small bumps that you see on the ribs of a well-muscled person. Even on a less-toned body, these movements and shapes are important to acknowledge in any rib panel design.

20) Rectus Abdominis: Known popularly as a "6-pack," on toned individuals, these abdominal muscles form a series of horizontal ridges across the stomach.

Fig. 17a shows a rib and hip piece that was designed to emphasize the body's form. You can see in Fig. 16b how the rib muscles form a series of repeating curves, slanting diagonally forward and down. These form the basis for the large curving mechanical elements in that part of the tattoo. Big downward-pointing shapes are placed to take advantage of the latissimus dorsi muscle framing the back, and the points of the blades of the shoulder run horizontally, parallel to the abdominal muscles there. Another blade runs along the bottom curve of the pectoral muscle. A large red rotational element is placed on the point of the hip, with S-curving elements framing it off and bringing dimension to the hip area. The back edge of the whole tattoo is designed to make the piece appear widest at the shoulder blade height and narrowest at the waist.

Fig. 17b shows a much simpler rib design, more along the lines of what a street shop client may request. Although occupying a much smaller area than the piece shown in Fig. 17a, it is still drawn large enough that the curving legs can interact with the rib muscles. A design like this can be made to fit almost any body part, provided the legs and major elements are placed to make the most of the musculature. Almost every tattoo larger than a fifty dollar shamrock can be designed to make the most of the spot it sits on; it does not have to be a major piece of epic bodywork to deserve flow and fit considerations.

The backpiece in Fig. 17c is an abstract tattoo designed to make optimum use of the back. Because the client is a bony individual, his vertebrae were emphasized, not only in the glowing spine at the lower back but in the upper background as well. The large pointed foreground shapes follow the flow of the back's two largest muscle groups, the latissimus dorsi and the trapezius, ensuring that the tattoo will animate well when the client moves and twists. Because the design is made to work with the flow of the muscles, it will distort in a natural way with the body's movements, so no body posture will look awkward. Its major elements are pointing down and towards the center, creating a strong V-shape that is flattering and empowering to the body's form.
Fig. 18a demonstrates a totally different approach to using the back, showing an illustrative design instead of an abstract one. With illustrative pieces, there must be a balance between the readability of the design and its fit on the body. Unlike abstract design, where every element can be custom fit to the body, illustrative tattoo design needs to fulfill the requirements of the subject matter as well as flowing with the body. In this case, we chose to emphasize the powerful V shape of the wings, which sits perfectly on the lattissimus dorsi, and to keep the remainder of the eagle fairly classic, based on a design from the 1970's. We also included light rays radiating from behind the eagle and spreading out along the lower sides of the back and up the center of the trapezius at the top. Clouds circle around the design in the opposite direction of the rays, breaking up the straight lines of the rays and helping to establish the V shape along the sides of the tattoo. The bright yellow sun sits at the center of the back's widest part, concentrating visual energy there and giving the rays and eagle an appearance of outward expansion. The symmetrical flow of the sun, rays and wings helps to balance out the asymmetrical parts of the eagle and banner.

No matter what kind of design you plan on placing on a back, a centralized radiating element, such as the rays in Fig. 18a, will give it a strong graphic context on the back's symmetrical structure.

Fig. 18b shows another example of a smaller design on a larger body part, attempting to maximize the placement of the tattoo in such a way to work well with the muscles. The diagonal S-curved layout sits naturally on the arm and makes it easier to build upon later when the client wants larger work. If you think of every small piece as an opportunity to gain a new custom client, it's pretty much a given that we'll end up working around and adding on to our smaller work. It's always a good idea to consider the larger picture, even with small tattoos. The piece in Fig. 18c is an example of a moderately sized tattoo designed to fit the deltoid muscle. Thorns, vines, stripes, flames and rays all bring movement into the design, and the cloudy background at the top of the shoulder prevents the piece from being bottom heavy or looking like a sticker.

Some Negative Space Tricks

Sometimes a design can benefit from having extra flow and depth introduced through the use of flowing negative space streams, such as in Fig. 19b and 20a. In both cases, the subject matter of the design's not produce an obvious strong flow, risking a cluttered or awkward appearance. To avoid this, we added streams of unattached skin into both designs, bringing in better flow and helping to help break off both pieces harmoniously. Some tips for making the most of your negative space:

1) Rhythm and Variety: Let your streams of negative space flow along the same direction, but vary somewhat in width and movement to keep them from looking like stripes.
2) Soften your Edges: The more it looks like airbrush, the better. Try doing it entirely with a mallet, feathering the edges as you go and avoiding color lines or grayscale; this will give it the softest look.

3) Give it Depth: Try bringing some of these streams in front of your main subject, other streams behind. Make the streams overlap and intertwine, as long as this doesn’t make them read less clearly. Deepen the furthest back streams with some diluted color, which helps the closer ones jump out more.

4) Breaking Off: Instead of making streams that circle and enclose the design, use them to break up and dissolve its edges in the right places. This helps the overall tattoo flow much better into the surrounding skin.

5) Follow the Muscles: Use every opportunity you can to create movement that complements the natural curves of the musculature.

Fig. 20a shows a leg sleeve done by Pittsburgh tattooist Don McDonald and me in a collaborative project. If you refer to Fig. 20b you can see how we laid out the design to take full advantage of the natural musculature. The big yellow shape on the thigh sits on the diagonal bulge of the vastus lateralis and the rectus femoris. The round shape on the back of the calf sits squarely on the triceps surae, taking advantage of its natural bulge. The rest of the elements of the leg all flow with these main pieces and attempt to give the leg movement and flow. We avoided using any large still elements on areas that bend like the knees and ankles, instead using shapes and textures with wrinkles or rotational elements that would appear to move with the body. The leg is rendered in high contrast so that its flow is clearly visible from a distance.

21) Biceps Femoris: Running vertically from the back of the knee to the buttock, the biceps femoris defines the form of the back of the thigh. Its movement is more vertical than the scouring movement of the frontal thigh muscles.

22) Vastus Medialis: This muscle forms the distinct bulge above the inner knee.

23) Vastus Lateralis: This is the large bulging muscle on the side of the thigh, which creates a diagonal movement upward toward the buttocks.

24) Sartorius: The longest muscle in the body, the sartorius runs diagonally along the upper inner thigh, continuing the same diagonal movement as the vastus lateralis.

25) Rectus Femoris: This is the large frontal thigh muscle, fitted between the diagonal movements of the sartorius and the vastus lateralis. Together, these 3 muscles define the scouring form of the outer thigh.

26) Gastrocnemius: This muscle runs from the back of the calf to the heel of the foot, creating the bulge on the back of the calf.

27) Tibialis Anterior: Rather than being plain bone, the front of the shin has several muscles crossing it diagonally, including the tibialis anterior, which gives the top of the shin its slight bulge and events toward the outside of the calf.

28) Peroneus Longus: Continuing back from the shin we find this muscle, which together with the tibialis anterior form the large bulge on the outside of the calf.

29) Peroneus Brevis: This muscle forms the large bulge on the rear of the calf.

30) Achilles Tendon: Extending from the triceps surae to the heel of the foot, this large tendon creates a distinct vertical movement; together with the triceps surae it defines the more vertical, less diagonal movement of the back of the calf.
The illustration of the facing page clearly demonstrates the Golden S-Curve Rule. You can see how the S-curving layout moves freely over the body, obstructing nothing, while the rigid grid-like layout tends to clamp down on and confine the body, especially on the feminine form. For future reference, we'll refer to these different modes of design logic as flow and antiflow. This does not necessarily mean to eliminate all evidence of antiflow from your designs, however; it's simply a call to take it into account.

Flow and antiflow can be balanced as contrasting design elements in a manner similar to light and dark elements. There are styles of full-body tribal tattooing done in the South Pacific Islands (Fig. 23a) that make use of a grid-like layout on the body, although there are plenty of carefully placed curves in these designs to offset their rigidity. The resulting look is very striking, though definitely a masculine look.

These principles also can be used in more illustrative types of tattooing. Fig. 23b shows a design that called for a rigid architectural form to be placed at the top of a shoulder. If we had designed the temple larger and placed it in the center of the arm with nothing breaking through it, we would have had quite a stiff and awkward tattoo, which would distort in all kinds of strange ways when the client moved his arm.

To avoid this problem, we placed the architectural form in the background and put an S-curving tree in the foreground. The tree was made to stand out by giving it a strong outline and sharp contrast, while the temple was rendered with less contrast and no outline. The temple ended up small enough and broken in enough places by foreground elements that the overall look has none of the awkwardness that a purely antiflow design would have on this body part. However, the antiflow aspect of the temple visually defines it as being clearly more geometric than its surrounding organic elements, making it stand out from the background despite its softer rendering.

Another architectural element is presented in Fig. 23c, this time broken in the foreground by flowing water. Try picturing how the design would look if the architectural columns on either side continued onto the front of the arm instead of disappearing behind water. You might imagine how they could create a visual corset, restricting flow through the arm and making the piece appear rigid and confining. Just the right amount of the window structure has been used in the design to get its point across without taking over the arm with antiflow.
Masculine vs. Feminine: Do Women’s Tattoos Have Special Requirements?

In my opinion, they do, and this industry has some catching up to do in that department. Since tattooing began as a male enterprise, it’s not surprising that both men and women in the 1920’s had body suits with big chest eagles and portraits of George Washington. We’ve evolved beyond that, thankfully, but on the whole the industry is just starting to fully appreciate the plain fact of life that most men and women have naturally different aesthetic preferences. Here are a few basic considerations that can help create a more feminine look:

1) Graceful Flow: A more fluid, less aggressive overall approach to the design is a guaranteed way to make it more feminine.

2) Perfect Fit: Make the collar line and other edges of the tattoo fit exactly where the client wants them, experiment on paper or with marker on the client’s body to find what feels the most natural to them. Ask the client what kind of clothing they may want to wear to conceal it. In general, women can be far more sensitive to these particulars than men.

3) Less Black: This might just be my opinion, but men seem to wear heavy black shading better than women. Women designs can be successfully shaded with color, using black just in key places.

4) Less Lining: You will definitely get a softer look if you use finer lines on your main elements, and gray lines, color lines or no lines on your background elements.

5) More Open Skin: Working negative space through a tattoo to make a less dense seems to give it a more feminine appeal.

Ultimately, the overall feel of the piece is up to the client. However, you will find that the majority of women will react very positively to these considerations. There are middle grounds as well; for instance, you could create a design with aggressive movement, but softer color and shading plus more open skin.

It’s not unusual for clients to request window-type designs, especially temple windows, stained glass windows and the like. The window is a great metaphor that can describe an opening to an inner world, making for a potent element in the graphic language. Unfortunately, the typical window design is locked into the antiflow grid, risking an awkward appearance on the body.

In Fig. 2, I was asked to place a window at the top of the shoulder, which is a very natural place for someone to request such a thing. The window with straight sides would distort badly here, looking different from front and back, appearing asymmetric from a side view, and distorting even more with the natural movements of the arm. A good tattoo design should read well regardless of the position the body. Keep in mind that a trademark of an antiflow design is that the piece will look best when the client is standing in a stiff, military-like position, while not looking so hot when they are relaxed or in motion.

To accommodate this, we eliminated all straight lines from the design, replacing them instead with curving arcs. This way, the viewer is much less likely to notice any flaws in the tattoo’s symmetry. To further compensate and draw more attention away from the structure, we used an asymmetric design inside the window, and organic vines to both sides which weave back and forth in front of the window. The finished result is one that has enough visual cues in the window’s shape to be accepted by the viewer as symmetrical, while using several good tricks to distract from the fact that it isn’t really a true mirror image.

Break your geometric and symmetrical motifs with simple organic elements; this can save you a lot of technical struggle and make for a tattoo that reads more naturally, especially when the client is in a variety of natural positions. Remember that symmetrical designs are harder to tattoo, and that any flaws in them will be obvious unless the design is creatively broken in the right places.

Using these basic guidelines, it’s a simple matter to avoid the pitfalls of stiff or awkward designs. With a little consciousness applied to this idea, an artist’s vocabulary can be trained to automatically avoid stiff and awkward flow in their layouts. Ultimately, though, the fit of a piece is something to be determined by the client. It must feel natural to
them, especially when it comes to the neckline/wrist/ankle interface between the tattoo and the skin, the weight and
density of the piece and the use of un-tattooed skin in the design.

The comfort of the fit has the same kind of significance as the fit of an article of clothing; the person wearing it
will naturally feel whether it sits right on the body, if it cuts across a body part in a way that's visually uncomfortable,
whether it's bottom heavy, or if it's boxy where it needs to be curvy. All major projects should be approached in such
a way that these things are discussed at the very beginning before the design begins to take shape. If a client hasn't
talked much about these issues, suggest strongly that they do. Not only will this ultimately make for a better tattoo,
but your client will be impressed by how thoroughly you are taking their personal needs into account.

Clients' intuitive feelings on this matter should never come second to the tattooist's ideas
about what's right. Although we can make suggestions and offer feedback, only they can
truly know whether a design fits them or not.

Regardless of how perfect the subject matter or color scheme is, regardless of how many grueling hours spent
tweaking the details and refining edges, regardless of who we are and how far our client has traveled, to see us-the flow
and fit of a piece will ultimately determine whether our client is happy or not, and thus whether or not their tattoo is a
success.

Picture yourself in a tattoo shop situation with a male client who is requesting a large castle
design. He's giving you his whole upper left arm, to about 3" above the elbow. Try to design
it in such a way to give the piece good flow and to keep the architecture of the castle from
looking awkward on the arm. You can bring in other elements, including trees, mountains,
sky effects, negative space etc. Try to avoid making it too cluttered, busy or bottom-heavy, and focus on
the flow and fit. You can download the blank arm diagram and post your finished drawing at:
www.hyperspacestudios.com/reinventing/exercises

A woman is requesting a right 3/4 sleeve of a snake and flowers. She has specifically
requested that the soft and feminine, with a nice dissolve at the bottom and plenty of
un-tattooed skin in the piece. Any snake or flowers are okay as long as the overall look is
flowing, feminine and elegant. You can download the blank arm diagram and post your
finished drawing at: www.hyperspacestudios.com/reinventing/exercises

Download all of the blank body diagrams from the Exercises page, and print 10 or 20 of
each. Punch these pages and put them in a binder, a thin one that you can carry around like
a sketchbook. Make a habit of jotting down a design a day, even if it's only a 5 minute
drawing. Focus on your flow and overall fit more than details or color; quick drawings can
sometimes be as valuable in terms of learning experiences as detailed drawings can be. Knock out a
bunch of them and use them. Do some of them in pen so that you can't erase. Try a variety of subject matter.
Consider printing some of the blank body diagrams shrunk down to 4 per page so you can really step back and
focus just on the flow and balance of the design.

2.2) Positive / Negative Relationships

When we see a tattoo, especially from a distance or in low light, the first thing we notice is its silhouette.
The silhouette is essentially the relationship of the tattoo's dark areas against its lighter and un-tattooed areas, including
the surrounding un-tattooed skin. A strong silhouette will clearly reveal the flow and fit of the design; it will also
separate and give clarity to the various elements in the tattoo. In addition, it will give the piece strength not only from
a distance, but also through decades of aging and settling. A clear silhouette is at least as crucial to the success of a
tattoo as its flow and fit.

The silhouette is determined by the use of tattooed versus non-tattooed skin in the piece, the use of light versus
dark tones, and the incorporation of a clearly readable flow with large, open areas of dark and light. Not only should the
tattoo have a clear and pleasing relationship with the surrounding skin, but the elements within it should contrast
each other as well so that they don’t run together and create an un-readable mess. We can avoid this problem by paying
close attention to our positive/negative relationships.

We've already discussed negative space and its uses for introducing flow into a design that is otherwise not
very fluid. Negative un-tattooed areas in a piece can play a strong role in how that piece reads. We'll take this thinking
process a step further by describing all dark-colored shapes and areas as positive, and light-colored ones as negative.

A positive/negative relationship is a relative description involving two adjoining shapes, such as the snail and
background foliage depicted on this page. If the outer edges of the snail are
darker than the background directly behind it, we say that the figure has a
positive on negative relationship, or pos-on-neg (Fig. 27a). Likewise, if the
outer edges of the same snail are lighter than the adjoining background, we'll
say that it has a negative on positive relationship, or neg-on-pos (Fig. 27b).
However, if its adjoining edges are
shaded dark over a dark background we'll get a pos-on-pos relationship,
which makes for a dark, dense and less readable tattoo (Fig. 27c). Similarly, a
neg-on-neg relationship often will look weak and underdeveloped, detracting
from the clarity of the piece (Fig. 27d). Even when contrasting colors are used
in the foreground and background, it will be a denser tattoo if these colors are
of similar darkness to each other along the edges where they meet.
Curious to know how your color design’s silhouette will look on skin? Bring it into Adobe Photoshop (for a more detailed look at this image manipulation program, see Part V), go to Image → Mode → Grayscale, and see how its different elements contrast each other. If it looks dense but you don’t want to radically change the basic color scheme, try tightening the background color in the areas closest to the foreground shape while darkening the outer edges of the foreground areas. You can also take the opposite approach and deepen the background while lightening the foreground shapes. It matters a lot less what colors you use than how strong your positive/negative relationships are, since they are the foundation to the design’s structure.

Try bringing photos of some of your finished color work into Photoshop and converting it to grayscale (Image → Mode → Grayscale). How strong are your pos/neg relationships? We call this the Watson Test, after tattooist Watson Atkinson, who argues that any good tattoo should hold up to being photographed in black and white.

Fig. 29a shows a colorful adaptation of the traditional tribal approach. Strong black outlines and edges, heavy black shading and deep blue coloring, along with high-contrast large scale white highlights, make the foreground tribal shapes stand out boldly from the softer background. A 1/4” (6mm) yellow glow around the tribal shapes creates a light detail-free zone that helps separate the two layers of elements from each other; if any background details got too close to the foreground shapes, they would begin to compete for attention and would compromise clarity. The background is free from any black or dark outlines, and is printed on a warmer color scheme that uses dark concentrated colors or any shade of blue, ensuring that the background separates clearly from the tribal shapes. The background colors are key within a limited value scale, while the tribal shapes use the full range of value for maximum impact.

In Fig. 29b we have an example of a simple pos-on-neg relationship, where the entire design contained inside its outlines and no background is used. The bottom edge of the heart in particular is dark enough to strongly contrast the blank skin around it. The starburst above it is more delicate, but has most of its darker colors concentrated near its outer edges to give it strength and integrity despite its lack of strong outlines. The center part of the starburst was done in lighter colors, allowing the green flame to stand out in front of it with a strong pos-on-neg relationship of its own. The blossoms on both sides of the heart were colored with rich enough hues that give them pos-on-neg contrast with the blank skin around them, but the blossoms inside the heart were kept softer against the richer colors of the heart, giving them a clear neg-on-pos relationship with the heart. Notice how the coloring in the heart graduates to a deeper shade as it approaches the flowers, allowing for more clarity in the flowers’ neg-on-pos relationship. Any future work added around this piece would need to be kept soft near the heart, preferably fading into blank skin in the area closest to the existing tattoo.
In Fig. 30a we have a more complex pos-on-pos relationship, where the butterfly is done in darker tones, silhouetting it against the stained glass and light rays behind it. There is no color in the background immediately behind the butterfly, which would confuse the pos-on-pos relationship and make it hard to read; instead, we let the background colors get softer and drop out to skin and white around the edge of the butterfly. No dark colors or black are used in the window area, allowing those dark tones in the butterfly to leap out. To create further separation, we've added light rays shining from behind the butterfly, which creates a luminous layer between the bold contrasting foreground shape and the softer window area behind it. The limited contrast of the window keeps this complex design from becoming crowded and busy.

Negative on positive relationships are just as strong and clear as pos-on-pos ones, although with different effect and feeling. A neg-on-pos foreground shape will jump forward from its darker background in a way that is often more effective in creating an illusion of depth than a pos-on-pos relationship. Fig. 30b shows a simple example of the most basic kind of neg-on-pos relationship, where the foreground character is done entirely in soft colors, making it easy for it to pop forward from the deeper background. Dark and medium blues are used in the background to push the fish forward; enough color is used in the background to give it a feeling of depth, while enough skin is pulled through the background to give it some motion and avoid the dense “bruise effect.” Instead of lining the details inside the fish in black, which would have compromised the strong neg-on-pos relationship, these details were outlined with color, then reinforced using a liner and deeper color after most of the coloring was finished. Selective use of black in the eye and mouth makes these features pop out.

In Fig. 30c we have a clear and simple example of neg-on-pos, with heavy shadows pushing the hook forward and making it clearly readable. Details within this shape are kept simple and light in order to not compete with the strength of its neg-on-pos relationship. For added readability, a bold black outline ensures the clarity in any areas where the background isn't substantially darker than the foreground.

Fig. 31a shows a more complex, multi-layered use of neg-on-pos relationships. Often, this kind of relationship works extremely well for these kinds of abstract organic tattoos that aim to create a sense of depth. A darker background behind the lighter foreground shapes naturally pushes them forward, making it appear that they are casting shadows on the background. When we have different layers of elements weaving in and out of the foreground and background, a simple and foolproof strategy for keeping the design clear and giving it depth is to make the parts in the furthest foreground the lightest and the furthest back areas the darkest. If a foreground shape passes in front of a middleground shape, light and medium shading on the middleground shape helps push out the foreground. Whenever a foreground shape passes in front of the deep background, the even greater contrast between the light foreground shape and the dark background pushes it out that much more.

In Fig. 31b we have many examples of pos/neg relationships within one small tattoo. The flower, on a whole, has a clear neg-on-pos relationship with its background. Each petal, in turn, has a neg-on-pos relationship with the other petals that it overlaps, until you get to the smallest, innermost ring of petals, which create a pos-on-neg relationship with the glow around the central gemstone. The gemstone also has a clear pos-on-neg relationship with the glow behind it, making it stand out clearly. With the largest petals, readability is assisted by a strong outline. The second largest row of petals, which curve upward to form the volume of the flower, are shaded a cool lavender blue on the underside, which gives them curvature by making the undersides of these petals cooler and darker than their top parts, which are warm pinks. However, these blue areas are still significantly lighter than the shadows beneath them, giving it a neg-on-pos relationship with the bottom row of petals and preventing these layers from visually merging.
Sometimes a design will use different pos/neg strategies for different elements. For instance, in Fig. 32a, the snail has a neg-on-pos relationship with the foliage, while the leaves have a pos-on-NEG relationship with the far background. Handled this way, the leaves combine into a single dark shape, giving them a strong graphic look while still pushing the snail forward. Fig. 32b shows the opposite approach, where the snail is pos-on-NEG with the foliage, while the leaves are neg-on-pos with the background, making them the lightest overall shape.

**An Alternating Pos/Neg Relationship** is a situation where some elements in a design are clearly negative on positive, while the parts of the design between these elements are clearly positive on negative.

Fig. 32c shows an example of a large piece with alternating pos/neg relationships. The piece was designed to give the gears a sense of soft luminosity by using no black, dark colors or outlines anywhere in the background. The foreground shapes, on the other hand, use plenty of black, bold outlines and deep cool colors that contrast the warm background colors. The result makes the organic foreground stuff appear to be backlit, and allows for a design strategy that has strong flow and a good fit when viewed from a distance. The various planes and angles that make up the gears alternate between positive and negative, but at a lower contrast than the foreground organic stuff. By strategically incorporating both high and low contrast elements into a design, decisive pos/neg relationships can be used to keep a piece from losing its distinction.

**A Dynamic Pos/Neg Relationship** is one where a design will use both kinds of relationships within a single graphic element. For instance, the top half of a foreground shape is light on a medium background, while the bottom half is dark on a softer background. This kind of relationship can often be a more realistic way to shade a subject than a simpler pos/neg relationship.

To make this type of dynamic relationship possible, the background needs to take into account the requirements of the foreground. First, we finish the black and darker colors in the foreground shape and finish making all decisions about its shading. The background is then applied using mostly medium and light tones, as not to compete with the deeper foreground shapes. This color is pulled up against the outline of the highlighted upper parts of the foreground shape, establishing a strong neg-on-pos relationship, with the darkest tones closest to the outline. In other parts of the background, the color is applied lighter as it gets closer to the shaded underparts of the piece, leaving them a strong pos-on-NEG, usually with some blank skin behind the darkest part of each foreground shape. Throughout this process, the background is kept smooth and simple in such a way that doesn’t compete with the foreground.

In Fig. 32a is the same snail that we saw earlier, but this time we’re using a dynamic pos/neg relationship. The upper parts of the snail, which are lit by the sun above, look bright because of the deep tones right behind them. The undersides of each foreground shape are then brought to a deep shadow against the edge; wherever this happens, the background is made to drop out, allowing the deep tones in the snail to stand bold and clear. The light and dark areas of the background are made to merge smoothly together, drawing attention away from its fluctuations in value, leaving the snail focused and in the foreground.

In Fig. 33b is a piece where we opted for a dynamic pos/neg relationship, where the undersides of forms in the foreground were shaded dark, creating a pos-on-neg relationship, while their upper sides were highlighted in light colors and a medium background pulled behind them, giving these upper parts a clear neg-on-pos readability. Without the background, these highlight areas would have been neg-on-neg, making the piece look unfinished.
Fig. 3.4a shows an example of this kind of relationship. The background was done in medium colors, allowing some foreground areas to be lighter than the background while other areas are darker. To create a sense of light coming from the center of the background, the top and inner edges of the tree branches were illuminated, making them clearly negative against the positive colors. Light colors such as yellow ochre and white were used inside these upper and inner edges, then plenty of rich background colors were pulled up against the outside of these branches, which reinforces this relationship. On the bottoms of these branches, where they face away from the light source, the opposite is true. Black and deep colors in the branches were pulled right up against their lower inner edges, making them boldly contrast the soft and medium background hues. To emphasize this relationship, the background color does not go into negative space just under the black lower edge of each branch, leaving a 1/4" (6mm) fringe of blank skin to help enhance the tattoo's overall sense of depth.

Some subjects call for a more subtle use of pos/neg relationships to avoid a cartoonish appearance. Fig. 3.4b is a fanciful piece that we wanted to give some realism, which dynamic pos/neg relationships can be effective at achieving. Black shading and a moderately strong black outline make the figure pop forward from the much softer background. Most of the figure has a strong pos-on-neg relationship with the softer background, but some of the anatomy facing upward toward the light source has some light upper surfaces, with soft medium background colors pulled against their outer edges to create some areas of neg-on-pos relationships. The bottom arm has a deep black lower edge, but a light upper edge with a medium dark background. Throughout the figure, pos/neg relationships switch fluidly in a way that gives the piece realism without sacrificing too much readability. While the figure is saturated with muted colors with no blank skin left, the background is done with soft watered down colors, no white or yellow and plenty of negative space to help it fall back and clearly display the silhouette of the character.

In Salvador Dali's painting Atomic Leda (I'd show you, but I don't have the legal rights- if you don't already own a Dali book, you need one! In the meantime, you should be able to find this in a Google image search) is a masterful example of a dynamic pos/neg relationship. In the foreground is a nude figure floating in space lit with a strong, bright light source, giving her a warm, sunlit appearance and some areas of dark shadow. Behind the figure is a blue background rendered in mostly simple, flat tones as not to compete with the foreground. As this blue field gets closer to the brightly lit parts of the figure it gets darker; by the time it vanishes behind the figure it's about twice as dark as the surrounding ambient blue. Similarly, the blue areas that disappear behind the heavily shaded parts of the figure fade to a lighter blue, strengthening these areas' pos-on-neg relationship. The resulting appearance is not only clearer and easier to read, but gives the figure a kind of surreal optical shimmer that really adds to the painting's effect.

In reality, we actually see things this way, to a certain extent. If you hold your hand up against the bluish sky and look at its silhouette, you may notice a sharp line of color around it that's a shade lighter than the rest of the sky. This is a by-product of our seeing process and how the brain interprets strongly contrasting images.

Naturally, these ideas about pos/neg relationships need to be interpreted loosely, or it could be easy to get bogged down in formula and dogma. It's critical that we let our rules and guidelines muddle quietly in the background while our creative processes are allowed to explore the different possibilities unrestricted.

However, if you are working on a design and are wanting to give it a greater sense of impact, narrow your mental focus for a moment and consider the pos/neg relationships in the design. Most readability and clarity issues can be resolved this way. If you make a good habit of consciously considering these relationships throughout the drawing process, you'll find that eventually you'll be able to naturally draw more readable designs with less and less deliberate thought. Out of all the different factors that can be adjusted in a composition, its positive/negative relationships will have the greatest impact on whether or not it reads clearly from a distance or through the passage of time.

Sometimes it will take a little experimentation to find the optimal combination of pos/neg relationships in a design: that's why it's so important to do a shaded value study before doing the tattoo, where you won't have a second chance. Because this can take some trial and error, I recommend using graphite or some other erasable medium. More importantly, I suggest that you do your value studies small; you can work more quickly, try more options, and get a better overall sense of the piece that way without committing yourself to a larger shaded drawing that might not be going in the best possible direction.
For each of the line drawings below, try doing versions of all 3 major strategies: Pos-on-neg, neg-on-pos and a dynamic pos/neg relationship. After you finish you can compare your value studies to the finished versions posted there. Remember that there are countless correct solutions to this, but the important thing is to keep your silhouette clear. You can download the full-size drawings or post your finished versions for comment at: www.hyperspacestudios.com/reinventing/exercises

2.3) Contrast

Contrast is what makes different parts of a design stand out from each other. Whenever two elements are different from each other in any way, they will contrast each other visually. One of the goals of the artist is to make use of contrast in just the right way to make the statement they are after; sometimes bold contrast is just the right tool, making the message scream out in every way possible, where other times subtlety is the key.

To make this graphic statement, we have a variety of aspects of a design to contrast against each other. Dark versus light, warm versus cool, focus versus out-of-focus, smooth versus rough, and flow versus antiflow can be used as contrasting elements to establish a dynamic range and fine-tune a design's impact.

Dynamic Range is determined by both the color range and value range of an element in a design. If both black and white are used in that element it represents the full value range, or 100 points; an element using only black and medium grays occupies only half the value range, or 50 points. A design element that uses a pair of complementary colors in the same shape utilizes the full color range, or 100 points, while something that uses only blues and greens is using only a third of the color range, closer to 30 points. An element that uses both maximum value contrast and maximum color range within its borders has 200 points of dynamic range.

The most basic element of contrast is value, or the contrast of dark and light. The more dynamic range an individual design element has within it, the more it will jump forward, just as an element with less range will tend to fall into the background. For the purpose of this discussion, we'll refer to white as having a value of zero while black has a value of 100; all other colors and gray tones fall somewhere in the range in between.

For example, let's take a look at Fig. 37a, which features a close-up high contrast object and a lower contrast distant background. The droid, which needs to jump forward as much as possible without the assistance of too many bright colors, uses the full value range, all the way from the black outline and shading to the white highlights, giving it a total dynamic value range of 100. The landscape in the background, on the other hand, is rendered using no outline—gray wash instead of black and no colors darker than 60, compared to the 100 of the droid. This way they appear to be obviously way off in the distance, the same way that mountain ranges in real life appear to have less and less contrast as they get further away and are lightened by the atmosphere between them and their viewer.
We use similar contrast methods in Fig. 38a. The foreground shapes, which need to stand out, are given a bold outline and a value range of about 35. We can't do this the bold black outlines compensate.

Limiting the value range of the background works well for compositions with dark backgrounds as well. In Fig. 38b we have an abstract design that aims to create a sense of depth by lifting its light colored foreground objects out of the skin by using a dark background. The darkest parts of the background are mostly black and dark colors, with a few areas of medium color and no light color at all. This keeps the dynamic range of the background to around 50 or more, while the foreground objects use the full range, from their black outlines and bright highlights to their white highlights. To keep the design from getting too dense we avoid using much black shading in the foreground.

Don't Use Too Much Black!

There is a time-tested understanding that black outlines and shading are critical to the strength of a tattoo. Although this is partially true, many have misinterpreted this idea into thinking that each and every element in the design has to have strong black shading. The problem with thinking this way is that a tattoo with black shading in every element will look dark and dense, and will lose clarity with time and distance.

Colors have contrast, too. In art school lingo, we have "warm colors" and "cool colors." Warm colors consist of the yellows, oranges, and reds, which are normally associated with life and heat, plus the yellow-greens and red-purples. Cool colors consist of blues, blue-greens, and blue-purples, normally associated with water and ice. Warm and cool colors contrast each other naturally, and warm and cool contrasting relationships of neighboring design elements need to be considered in the same way that push/pull relationships should be.

Pictured below is a color wheel, which artists and teachers have used for many years to help themselves and their students understand color relationships better. Circling around the wheel is the full spectrum of colors in their natural order. When we draw a line straight through the center of the wheel, the two ends of the line will point to the two color opposites on each other.

When the two colors are exactly opposite on the color wheel, they are referred to as complementary colors. When two colors are complementary, they have the maximum contrast of color available on the color wheel, so that when these colors are used in neighboring design elements, they pop out from each other. These pairs of complementing colors include blue versus orange, purple versus yellow and red versus green.

The key to using your black shading selectively is to give your design its strength. A simple rule of thumb is that if your background has a lot of black shading, use very little in your foreground. Keep in mind that shading done with color will age just as well as the background. If you have a dark foreground object, keep the background light. If you have moderate amounts of black shading in both your foreground and background, you run the risk of losing clarity; your best bet is to choose either your foreground or your background to concentrate your darkest shading. This selective use of dark shading applies to deep concentrated colors as well as black.

Some Color Advice

While placing complementary colors next to each other will make them appear bright, mixing them together will accomplish the opposite and create a blend. Sometimes this blending is what we are looking for (I occasionally dip between orange and lime green to create warm blue colors), but usually we want to be careful to mix only compatible colors to keep the mix bright. If two colors are neighbors on the color wheel, you can mix them easily and get a pure color from them; for instance, blue and green will make turquoise. Two colors from further apart on the color wheel, though, such as purple and orange, will make a gray or brown.

If you are creating a color field that blends between two colors that are opposite of each other, you will need to use a transitional color. For instance, the sky around the temple back in Fig. 23 blends from orange into blue. To keep these two colors from blending into brown where they overlap, pink is used as a transition. Pink will mix with orange to make peach, and with blue to make lavender, so using it to bridge between the orange and blue is perfect for preventing brown in the sky.

Some transition colors:
- Pink bridges orange with blue or purple
- Blue bridges green and purple
- Yellow bridges orange and green

A quick glance at the color wheel will show you what color will best bridge between two other colors. If the two colors you need to blend are too far apart on the color wheel, you may need more than one color to bridge them. For instance, to bridge between red and green, you would need to blend from red to pink to blue to green.
In Fig. 40a we have a simple and effective use of complementary colors. The water is done in blue with tiny amounts of blue-green; the koi is colored in bright orange and yellow. The orange naturally jumps forward from the blue, making it distinct and 3-dimensional. These same yellows and oranges would be much less effective with plain skin tones behind them; the fact of blue being the complement of orange is what makes it appear so bright.

It seems that warm colors appear to jump forward from cool colors more so than the other way around; a blue foreground object with fire behind it may be less 3D than the warm-on-cool relationship of this koi design. In general, though, it’s safe to assume that warm colors tend to jump forward, while cool colors drop back. The stronger the color contrast, the greater the depth.

We can use complementary color relationships not only between a foreground object and its background, but between the upper side of an object and its lower side, or even the inside of an object and its outside edges. In Fig. 40b is a brightly colored lizard with an organic environment around it. The upper sides of the lizard are colored in oranges, yellows and reds, which are the warmest colors, and its undersides are colored in blues and purples, causing these areas to drop back and curve away, giving its overall form a sense of dimension. In a similar way, the organic background objects are colored green on the top and blue on the bottom, making them appear 3-dimensional, but no yellow and white are used, giving it less dynamic range than the lizard and keeping the different elements from competing.

Look closely at how the tail contrasts the background. The black outline and shading plus the white highlights in the tail give it a value range of 100; the primary blue versus the bright yellow and orange give it the full color range, also 100. So if we add up the color and value contrast in the tail, we’ve got a dynamic range of 200. However, the elements behind the tail neither rise to the zero of white nor sink to the depths of black: their value range is around 60. The green and blue are warm and cool compared to each other, but still have no more color contrast than about 40 (if a trip halfway around the color wheel is 100, a trip a quarter of the way away is 50, and so on). This gives the background a total dynamic range of 100, or about half that of the tail.

If you glance back to Fig. 40a, you can see how warm and cool colors are used to give the koi extra volume. Although pink is a warmer color than the blue water surrounding the fish, it is a cooler color than the oranges and yellows in the center of the koi. By using it around the edges of the body, it causes those edges to drop back, giving the whole form a sense of curvature and dimension. If we had used blue for this part of the job, it would have given the koi an even more dramatic sense of volume, but also would have caused the edges of the fish to merge with the background and rob it of some of its clarity; the medium warmth of pink makes it perfect for the job. Pink is also used around the edges of the lizard’s eye in Fig. 40b to produce a similar curvilinear effect.

One nice by-product of using contrasting colors is that not only will the different elements remain distinct from each other and show an illusion of dimension, but the overall piece ends up being more visually striking as a result. When other artists ask me what brand of colors I use, the information they really should be asking for is what color combinations I use, because the way that colors are combined and placed next to each other has such a significant impact on how bright they will appear.

Back in Chapter 2.1, the tree in Fig. 12a uses a similar warm-on-top, cool-on-bottom logic to these brightly colored pieces, but with more subtlety. The design is meant to have a naturalistic feel to its color scheme, so we avoid using bright yellow or primary blue. Instead, a range of browns and earth tones is used with lavenders, blues and cooler browns on the undersides of the shapes to make them drop back. Although the separation between the dynamic range of the tree piece is less than in the lizard, it still is more than enough: The full value contrast plus subtle warm/cold scheme of the tree gives it a total range of about 165, while the background is around half that.

Honestly, I don’t go through my tattoos rating their dynamic range point-by-point; this rating system is really just a tool for discussing and understanding the use of color and value contrast, a way of illustrating how these things can add up. We have a wide variety of graphic tools at our disposal, including countless examples that I haven’t listed here; one of the great pleasures of tattoo design is in finding ways of combining these tools for different effects. The dynamic range is a way of measuring in our minds the kind of effect we’re achieving, whether it be powerful or subtle.

What Brand Of Colors Do You Use?

You may be surprised to hear that this is the most common question I get asked. The answer changes from time to time, and usually includes several brands. My experience tells me that most brands of pigment are workable, with very few being total garbage; there are many good brands to choose from that can give you the results you want (if you want to know what I’m using today, come to the Reinventing Forum and explore the Pigments discussions).

So what’s the magic ingredient to make your work the brightest? There isn’t just one; making your work appear bright is a combination of good materials and equipment with good design skills. Most importantly, keep your neighboring elements different values so they don’t blend together, then use contrasting colors next to each other, such as blue and orange, in neighboring objects. A combination of strong value and color contrast will give you the brightest look; the best pigments in the world won’t help you if you don’t use them in the most dynamic combinations.
Focus works the best when we have out-of-focus elements to contrast the sharply focused ones. In Fig. 42a and Fig. 42b we have two similar shots of the same subject, with one of the image all in focus, the other focusing only on the foreground element, allowing the background objects in the picture to blur. The one that’s all in focus produces a sense of busyness, as every part of the shot has an equal amount of detail, competing with the central object. The other shot, although compositionally similar, is much more clearly readable, with the less important elements being allowed to drop out of focus. In addition, the background in the second shot is also both cooler and darker than it was in the first image, widening the difference in dynamic range even further between the foreground and background.

We can create focus and out-of-focus effects by using sharp edges versus fuzzy edges, high contrast versus low contrast and sharp detail versus no detail. I’ve been practicing focus tricks as much as possible in my paintings. Fig. 42c is a composition with only parts of it in sharp focus. I achieved this by first photographing the object, then duplicating the image on canvas using the photo as a guide. I used a projector to trace the photo onto the canvas with colored pencil, then kept the photo taped up to the easel so I could refer to it continuously while painting.

One thing that seems to help this kind of effect dramatically is to use different sized brushes for different areas. In the focused areas the smallest brushes are best, since they will naturally create the tightest detail. Moving outward into less focused areas, the larger brushes are better for the job. In these kinds of blurry areas it’s important to refrain from using any small brushes at all, because that could easily spoil the effect by canceling out the softness.

Let’s look at a close-up shot of the tree piece we discussed earlier in Fig. 12a and zoom in closely on the branches, where you’ll see an example of the use of focus (Fig. 43a). The smallest twigs of the branches, instead of getting thinner and thinner like hair (and creating a cluttered look), were rendered with a 5 magnum using smooth looping brushstrokes to create soft edges. A 5 round was then used to unite the soft twigs with their more focused branches. In a few places, out-of-focus twigs were made to pass behind the focused branches in front of them, creating more depth. This combination of effects creates a distinct sense of depth, while still keeping the upper part of the design light and minimal, as per the client’s request.

Fig. 43b shows a different use of focus, this time with a crisp edge on the foreground shape jumping out from a darker, cooler and less focused background. Getting this look was actually pretty simple. The foreground leaf was outlined and its edge sharpened with a tight 3, with the lower edge of each shape lined darker than its upper edge. After coloring, its white highlights were pulled out to its edge with the three as well, maximizing its sharpness. The background was done using the magnum only, with loose oval strokes of the machine: This way, the edges of the shapes were deliberately blunter a bit. The background area is also cooler than the foreground leaf, with no yellow and more blues, and contains no white to compete with the foreground highlights.

A good way to bring your foreground element into focus is to handle its white highlights using a 3 or 5 round instead of a magnum. Magnums tend to create a more diffuse appearance in the way they apply pigment to the skin. The tight concentrated quality of a small round will make your highlights appear sharp and give you a more dramatic focus effect with less effort. Be sure your 5 round isn’t too tight or it will be less effective at packing in white pigment.
In Fig. 44a we have another example of the use of focus. The edges of the important features are given sharp definition and strong value contrast, while the simple areas of the face and most of the background have less contrast and softer edges. A 7 mug is used for most of these background areas and much of the face using light, looping movements to keep the edges soft. Then a 5 round comes into play, sharpening the edges of the rays and adding detail and definition to the facial features, giving the most value range to the eyes, nose, and mouth, creating the sharpest focus there and making the features stand out from the rest of the design.

There are also many examples of atmospheric effects in this book which are kept out of focus with blurry edges to help emphasize the main subject of the piece. The wind on the fruit- and-vegetable-sleeve in Chap. 2.1.1 (Fig. 19a) is an example of an unfocused element passing in front of focused ones; the atmosphere behind the trees in both Fig. 12a and Fig. 22b shows the focused element in front of the blurry background. Both strategies have their time and place.

Textures are also good tools to express contrast; objects with different textures will stand out from each other as surely as if they were different colors. A smooth, shiny object will stand out from a bumpy and rougher environment. Similarly, a rough bumpy object can leap forward from a smooth, simple background. Smooth and rough elements can also be balanced equally, as in Fig. 44b. Other textures besides smooth and bumpy exist well, such as the repeated patterns in biomechanical designs or the veiny patterns in the red cabbage on that fruit- and-vegetable-sleeve. With a little imagination, we can concoct a whole spectrum of different textures to play against each other.

If we want textures to really contrast each other, each need to have a different basic silhouette—when we blur our eyes and look at them, their differences should be clearly visible. Smooth textures are more open and have less detail; they will contrast a bumpy, more detailed texture in a similar sense that an out-of-focus area will contrast a focused object. Although bumpy organic textures and biomechanical textures may have similar amounts of detail to each other, the detail is organized so differently in these two subjects that their silhouettes are distinctly different from each other; the one being fluid and random, the other being more rigid and repetitive. That veiny pattern on the cabbage has yet another distinctly different silhouette. Overall, though, the difference in contrast between textures is always greatest if one of them is smooth and open, the other tight and detailed.

Detailed textures can be very effective at bringing attention to a foreground element. However, if you plan on using a dark background, it is in your best interest to limit the darkness of your foreground detail, or it might close up the foreground shape against the darker background. When in doubt, shade and color the background first, then add detail in the foreground. Start these foreground details at a lighter value and then add more value as necessary to strike the right balance; the goal is to give the detail enough distinction while not making it too dark for any nearby background areas.

The range of contrast between different textures will be largely determined by the difference in the amount of detail between one texture and the other. If we were to make a texture wheel similar to our color wheel, the most densely detailed textures would be opposite the smoothest textures, with a whole range of density details in between (Fig. 45a).

Comparing the top to the bottom are the opposites of detail density, with it being smooth and open at the bottom and tightly detailed at the top. Comparing the left side with the right are the opposites in detail organization; the left side being more regular, the right side being more random.

The piece in Fig. 45b is a simple tattoo with a single foreground object and a background texture. The shell in the foreground is smooth and shiny, so it contrasts the bumpy texture in the background. It was made to appear slick and shiny by giving it a sharp, clean curving black outline and a long, smooth white highlight down the center. In real life, smooth shiny objects will often show long "streaks" highlights like these. The shell was given a polka-dot pattern to make it more interesting, but the edges of the spots were kept soft and out of focus, as not to lose the smoothness of the shell.

Making the polka-dots disappear behind the long white highlight strengthens the smooth shiny effect. Smaller, sharper white highlights were put in the bumpy ridge spiraling around the crown of the shell to give it a hint of texture and make it appear glossier. For added color contrast, small yellow highlights were run along the upper edge of the shell to contrast the cool blue background.
The tattoo in Fig. 46a is another example of smooth versus bumpy. In this case, there are several holes in the smooth foreground skull that reveal areas of bumpy patterned through them. This bumpy texture was given an overall radiating flow that continues from one hole to the next, giving the background a sense of continuity. We used green in the background texture and orange in the skull to separate their color schemes from each other. The small details in the background versus the smooth simplicity of the crystal facets, in addition to making these two elements visually different, gives an interesting impression of something very large inside something very small.

In Fig. 46b we have several different textures. The petals of the lye are smooth and soft, with warm colors on their upper areas and coolness underneath to give them form and volume. The gemstone in the center is sharp and faceted, made up of straight lines and angular corners; these features contrast the smooth gradations and flowing areas of the petals. A glow around the tip of the gemstone brings the point forward, while the directional movement of the rays brings more attention to it. The leaves in the background are made of long, narrow veins that flow nicely with the shoulders. The pattern inside them is made of repeated arrows filled with small and random textures, complementing the simplicity of the outline of the leaves and contrasting the textures of the flower petals and the gemstone.

In Fig. 46c is a piece with two distinctly contrasting textures, smooth and rough. I tried to give these different elements 50–50 priority, letting them share the hand equally. The smooth stuff is given clean, sharp black outlines and long, clear highlights which stand out resolutely in front of the chaotic texture in the green stuff. Both textures use the warm above/cold below logic, but the blue-green cool on the textured shapes are much cooler than the lavender cool on the undersides of the smooth stuff, keeping the shapes distinct from each other. The smooth shapes cast shadows as they pass over the bumpy background, spelling out for the viewer exactly what simulated distance there is between them. The knuckles are rendered in such a way that the parts that will naturally heal light are intended to be light in the first place.

The backpiece in Fig. 47a is everything with texture from top to bottom. We’re able to get away with this because of our use of large areas of dark, where the textured bumps are all in shadow with no colors lighter than 50, and large areas of light, where the bumps are of all light colors, with the shading going no darker than 50. Despite all the texture, the overall structure still reigns supreme, giving the resulting piece a clearly readable overall silhouette. Waves crash in from the sides following strong flowing movements, clearly visible with their clean neg-on-pos relationship, giving the piece some large movement.

The texture in the face are contrasted by the smooth and shiny crown, which is otherwise essentially the same color scheme, appearing as if the natural elements have tarnished them equally through the years. The clean movement of the edge of the crown helps to make it distinct from the stone texture of the face. The eyes, on the other hand, are given an entirely different texture in a completely different and much brighter color scheme to give them as much life as possible in contrast to the stone face. The tiny spots in the eyes bring focus to them, while the big clear white highlights make them appear smooth and wet.

I’ve only scratched the surface of the world of textures here; we also have leafy textures and viney textures, fleshy textures and hairy textures, scaly and finny textures, bony and warty textures, just for starters. Each have their own attributes, their own distinct silhouettes, and their own complementary opposites. All of them can add visual excitement to a tattoo.
As we talked earlier, flow and antiflow can be used as contrasting design elements as well. Since the viewer will notice the flow of a structure at a glance the same way that they will notice colors, contrasting flow is a powerful way of separating elements. Fig. 23b is one good example of this; despite the subdued color scheme through the piece, the rigidity of the architecture jumps out from the organic surrounding environment and gets noticed.

Fig. 23c is another good example of this; most of the arm is made of flowing elements such as water, so the architecture of the stained glass window stands out distinctly in comparison. As you move around her arm you will see many contrasting elements. However, even a brief glimpse of the grid-like architecture between the crashing waves jumps out and demands a closer look. Using a flowing element in conjunction with a rigid one has other benefits too; in this case, it allows the window part of the design to end at a convenient place on the arm. If it went any further its columns would continue around the outside of the arm, giving it a rigid corrected look. However, the water allows it to end in a way that shows just enough structure to make its point without taking over the arm with rigid lines.

You don't need to combine all of these contrast strategies in every piece to get good clarity. The good news is that we have so many choices of ways to give our designs contrast that there are almost infinite combinations. Fig. 48a shows a simple line drawing, which could be completed in countless different ways. Fig. 48b shows it shaded with a simple neg-on-pos relationship to keep the foreground and background elements from merging. Fig. 48f goes one step further by giving the foreground object maximum value range and keeping the range of the background minimal; Fig. 48d goes half the way with a parallel color strategy that gives the foreground even more dynamic range while keeping the background more subdued. Fig. 48e brings texture and detail into the foreground while keeping the background elements smooth and simple, then Fig. 48f takes the contrast of the foreground versus background even further by blurring the background and leaving the foreground sharp.

This is a maximal approach, which uses all of the contrast tricks together, while it really only requires a couple of these strategies to make the design strong and contrasting enough to work as a tattoo.

Use this line drawing as a basis for trying different contrast strategies. You'll need a strong neg-on-pos relationship first. Try giving the foreground elements maximum dynamic range while limiting the background. Try some different textures as well, and see what you can do with them. Don't be afraid to try a few different versions to see what you like the most. You can download this line drawing at: www.hyperfarsstudios.com/reinventing/exercises; after you've done you can compare your drawings to the finished versions posted there. Remember that, even following the basic rules of contrast, there are as many unique approaches to this as there are artists.
The turtle exercise is designed to encourage experimentation with texture. The 3 reference photos with it are meant to serve as starting points for creating realistic texture effects in the turtle's back, although you can use anything that suits the purpose. Try making the head and legs notably different textures from the shell. You can download this line drawing and larger versions of the photos at: www.hyperspacestudion.com/reinventing/exercises.

2.4) Priority

When creating a complex tattoo design, such as a scene, we have the added challenge of keeping the tattoo from becoming chaotic and hard to read. No matter how large the area of skin is, too many competing elements can spell disaster for a composition. Narrowing down the number of elements sometimes can help, but this isn't always appropriate for telling the graphic story the right way; sometimes a certain amount of complexity is unavoidable.

The trick is to have all of the design's elements working in harmony, not in competition. To accomplish this, we must first ask ourselves which elements are the most important in the composition, then the order of importance of the remaining elements. By doing this, we are assigning priority to each element, which will help us make decisions about how to approach each part. The top-priority elements should be made to stand out the most, while other elements should command less attention and drop back.

There are many ways of expressing priority. Perhaps the oldest and most commonly used of these is line weight. The thickness of the line is a simple and effective way of assigning priority, where the object with the boldest line will stand out the most. Less important elements get a thinner line, and background detail has no black line at all. Bold lines need to be used carefully; if too many elements have fat lines, line weight will stop being an effective way of assigning priority, and the piece can end up with a cluttered look.

Similarly, a lot of small details with black lines can get pretty dense and messy, clogging up the design and threatening to cease up with age. With just the right balance of fat, medium and thin lines, a tattoo should begin reading cleanly before any shading or color is even applied. There will be a more detailed discussion on lining and rendering details without lines in Chapter 2.6.

The techniques we talked about in the chapter on contrast are all effective ways of assigning priority; the most important elements get the greatest use of dynamic range, while the background is more subdued. The piece pictured in Fig. 51a uses many of these tricks. The features in the face have the greatest range of contrast, with sharp details of black and white right next to each other. The rest of the body has less value contrast, the background even less. The eyes are very contrasting, with sharp white highlights interacting with the black pupils. The white highlights in the face and body are softer-edged and contrast their surrounding colors less, commanding less attention than the eyes.

The cool green of the eyes contrasts the surrounding orange by 100 points, giving it the maximum color contrast on top of having the maximum value contrast. Color also brings the cat forward from the background, a strong warm-on-cool complement. A pink edge on the undersides of the legs, body and cheeks makes these areas curve back from the warmer orange on the upper sides of these shapes, creating volume. Blue and green alternating rays give the background energy, while still keeping its colors cool and simple enough to not compete with the cat's colors. Red-orange stars leap out from the unfocused blues and greens.
Directional design elements, such as light rays, also direct the attention of the viewer’s eye, giving priority to whatever shape these elements point toward. The background around the cat has radiating rays of blue and green pointing in towards it; rays were also used for this purpose in Fig. 30a and Fig. 46b. Other elements direct attention, too: the whiskers and the stripes on the forehead bring attention to the center of the face. Another radiating shape, the starburst medallion, balances out the face and adds character to the cat, while still having less range of color than the face; it stands out without taking over.

The outline around the prophecy of the cat is the thickest, making it clean and readable against all the active movement of the background. This outline is made shaper, like a fur coat, by overaggregating 3 or 5 round needle group back and forth in a scribbling rhythm while moving along the stencil (Fig. 52a). Lines around the medallion, eyes and mouth are almost as thick, giving these features priority. No black lines are used in the background or the stripes, since this would clutter the design.

A directional element is any part of a design that aims to point the attention of the viewer in a particular direction. Light rays are the most common type of directional element, although any part of a design that radiates from or toward a common point will have a similar effect.

The piece in Fig. 53a called for a whole crowd of characters that could easily become chaotic. We have a whole scene going on with many elements. The main figure, the cave environment, the shackles, the gate, the archway and its contents, the fire, and dozens of little figures in armor waving weapons around. Consideration of priority in this piece is super important.

The main character is obviously the most important element in the design, so it was made as large as possible without crowding the details above and below. It was given some of the fattest outlines in the whole tattoo, plus long flowing black hair, which reads in a similar graphic way to the boldness of the outline. It was also given the full value range, using large flowing areas of white against heavily contrasting areas of dark color and black shading which can be clearly read, even with blurred eyes. This strong, clear and contrasting readability is a great way to give this element top visual priority.

A row of light rays streaks between the figure and the background, lifting the figure even more to the foreground. The rays are simple and open, mostly untattooed skin. A fringe of more untattooed skin traces much of the way around the outside of the figure as well. Remember: Untattooed skin reflects light differently than tattooed skin. Thus, it is an important element to use when defining the silhouette of a design; this fringe of skin around the figure adds to its readability. Because of the skin’s reflective quality, the rays and the outline of the figure are clearly readable from a distance, giving the design a clear direction despite all its detail.

The rays converge in the top of an archway. Since the rays are such a dominant directional element in the design, they bring a lot of attention to this archway, giving it second priority. The arch is of secondary importance, since it is where the figure is going. The details inside the arch are kept under 60% contrast so that they drop back.

while bright oranges and yellows are used inside the arch to contrast the stone and make the arch appear to glow.

On the back of the hand is a pair of shackles. The fact that the figure is leaving them behind is clear in the figure’s body language, but the largest ray of light lands on them, bringing attention to them. Between the use of the ray and their prominent placement on the hand, the shackles have a high priority that demonstrates their relationship with the large figure.

The small figures are an important part of the story, but a big risk of clutter. We addressed this by making them swim in several diagonal movements across the arm. By overlapping the individual figures in these simple movements and coloring them all the same, we merged them into a few directional shapes, controlling the chaos. Bright yellow and orange flames are used between these movements to contrast them and give them a little overall clarity. The flames were done with no outline, to keep them from closing up and to prevent them from competing with the other elements.
Sometimes it is hard to define the different elements in order of priority; in some cases different parts need to stand out in different ways. Fig. 54a is a relatively simple design with two main elements: the glowing pods and the organic environment. Because the pods are contained within the environment, it's important for parts of the organic stuff to come clearly into the foreground. To achieve this we used strong black outlines and shading, bright highlights and full color contrast, giving the foreground organic ribs close to 200 points of dynamic range. The organic stuff that defines the far background has less than half of this dynamic range, using no outlines and low contrast of both color and value.

The glowing pods living through this environment need to stand out without coming all the way into the foreground. This was accomplished partly by making them as bright as possible, giving them fairly strong edges without using actual outlines, and incorporating directional rays to bring attention to them. Contrasting pink and green within these pods adds to their color range and makes them pop out. Glossy highlights in these pods, used in a similar way to the glossy highlights in the eyes of Fig. 51a, give them still more brightness and focus. This gives the overall tattoo three levels of priority: The foreground, which uses strong outlines and contrast to come clearly forward, the pods, which use bright color contrast, directional rays and sharp defined edges to stand out from the deep background without overshadowing the foreground, then the deep background which is outline-free with low contrast and simple color.

Fig. 55a shows a different kind of relationship, with only two basic elements comprising the whole design. Despite the limited number of elements, the tattoo is fairly complex, with the water and mechanical elements weaving in and out of the foreground and background. For the sake of clarity, the simplest way to separate these elements was to give the mechanical parts strong outlines while limiting the use of line in the water.

You will notice that the mechanical elements use outlines only on their outer edges, not on inner detail, which was instead handled with color lines and grays. Strong lines are always the most effective if they are not overused; a good rule of thumb is to use them around the outer edges of shapes that you want to separate from a background, but not on inner detail within those shapes. Using bold lines in this way gives them the most power to give clarity to a complex design.

The water in this tattoo was first brushed in with a magnum, then given sharp edges with a 5 round. I prefer to tattoo flowing elements this way, instead of outlining them first and then adding shading and color.

Not only does this make the project go quicker, but it makes it much easier to avoid any unwanted lines; the whole process just flows more naturally. After roughing the waves in with the magnum, various shades of blue and select bits of black were built carefully up to the edges of the waves, giving them clarity without making them compete with the bold outlines of the mechanical elements.

More priority was given to the mechanical stuff by making it more colorful than the water and using white highlights, which were not used in the water at all. Vivid red was used in the parts that needed to jump out the most, which contrasts the blue/turquoise of the water. Bright yellow in the foreground mechanics would have separated the elements further, but the client wanted a more subdued appearance, so we used duller yellows and ochres instead, knowing that there would still be more than enough color contrast. The various tricks used to separate the elements include color, line, unainted skin and white highlights. This effect was pushed further by using black shading in any parts of the background that have foreground elements nearby, but avoiding any true black shading in any of the foreground shapes.
Almost any design with more than one element needs to have the priority of its elements considered; it's a simple step which can mean the difference between a strong tattoo or a piece that looks well-rendered up close, but like a third-degree burn from a distance.

This line drawing is for a complex design that runs the risk of looking too cluttered. Your job is to reinterpret the line weight in the drawing to give the piece clarity. Try giving the most important elements the boldest line, the secondary elements thinner lines, and the furthest background fine or gray lines. The design should read clearly even with only the line weight established. Once the priority has been established using line weight, consider ways of using value and color to push the effect further. Download the full-sized drawing at: www.hyperspacestudios.com/reinventing/exercises

2.5) Reserve

When defining priority, we use our graphic tools in each design element to a greater or lesser degree, depending on the importance of that element. We can also hold back a few tricks, using some for only the background, and setting aside other tricks for just the foreground. Each element has something that the others don't have, all parts of the design will be more distinct from each other; if we reserve the brightest colors and most eye-popping textures for the most important object, it will have top priority. In effect, priority and reserve are two sides of the same coin; that is, reserve is used to establish priority.

Let's consider a hypothetical tattoo both with and without the use of reserve. We've all seen this hypothetical tattoo; dozens of artists have done and published something along these lines. I'm talking about your basic koi-and-water design, with all the design elements where they should be: Good flow of the koi, good color contrast from the warming in the fish to the cools in the water, nice crashing finger waves in a good layout for the body part, maybe a couple of cherry blossoms in a different color than the fish. Now what will make or break this design is the use of white.

Big shiny white highlights look great in a koi tattoo; if used in the right places, they will make the fish look glossy and 3-dimensional. Unfortunately, many artists don't stop there, and continue to put white highlights in the water as well. Considering the waves individually, it might make sense to do this, since it helps to establish the depth of the waves by using the whole value range. However, too much of this ends up canceling out the white in the koi, reducing its priority by doing it blend more with the water. White highlights contribute the most to a design when they are used selectively instead of all over. The same goes for color, texture, or any other design tool.

This is the essential idea behind reserve, which is that too much of a good thing can flatten out a tattoo by causing its foreground and background elements to appear visually the same. Using our favorite graphic effects selectively will ultimately give them more power.

Remember that reserve is a relative thing. If you use white highlights in your foreground, that doesn't mean that you can't use any at all in the background; it just means that the majority of your white highlights should be concentrated in the foreground. You can go a step further by making your foreground highlights sharp and bright using a 5 round, while keeping the few in the background soft and indistinct, using a magnum.

Fig. 58a on the following page shows an example of a design with three different elements. Although all three elements are of similar importance in the design, each needs to stand out from the others in a way that the whole tattoo separates visually. The water, although covering the most area, aims to give the piece flow and feeling without being its top priority element, so its colors are kept simple. As with most water I do, it was handled with the magnum and color first, then given defined edges with a 5 round. Some black shading was used in the water, but softly in a way that blends seamlessly with the blues. Tiny hints of warm color and small select white highlights make the foreground waves stand out from the background water without competing too much with the warmth and brightness of the crystal.

Next, the rocks need to stand out from the water without outshining the crystal. They were given a strong black outline, making them appear solid and giving them long-term graphic strength. Heavy shading and a complex pitted texture also makes them pop out from the much smoother water. Some cream yellows and whites finish out the rocks, giving them still more priority from the water without making them brighter than the crystal.
Finally, the crystal itself was made as bright as possible with reds, oranges and yellows that strongly contrast the blues and turquoises of the water. Sharply organized white highlights boost this effect. The crisp rhythmic angular patterns of the crystal also help it pop forward from the water, which is much softer and simpler. Directional rays take it even further and help separate it from the background. A strong outline was avoided on the crystal; instead, its edges were made as sharp and high contrast as possible without a line, using a tight 3 round to develop the edges. Pink was used as the transitional glow color around the crystal, fading the warm colors of the crystal smoothly into the water.

This piece shows a number of examples of reserve, such as:

- Water has vibrant cool colors, minimal white and warm colors, moderate black shading, smooth texture, no outline, large amounts of blank skin
- Rocks have muted warms and cools but no bright colors, strong outline and black shading, tight pitted texture, textured white highlights, minimal blank skin
- Crystal has no outline, clean and sharp edges, bright warm colors with smooth white highlights, no rough texture, no cool colors, no blank skin at all

The tattoo pictured in Fig. 59a is an abstract 3-dimensional design which has two different basic elements, an organic environment and a crystal centerpiece, which weave around and between each other. With all of these different movements going on, it's important to keep the elements separate and readable.

Since the two elements are of essentially equal priority, the goal was to separate them by making them as different from each other as possible, rather than making one more important than the other. For starters, we reserved all black shading bold outlines, for the organic stuff; the crystal structure has none and no visible outlines. All green and blues were used in the organic environment, with none of either in the crystal. Similarly, all reds, oranges and pinks are found only in the crystal.

The far background is purple, which is the only color that isn't strongly represented elsewhere in the tattoo. This purple contrasts the orange and yellow coil strongly, pushing it forward. It also contrasts the lime greens in the organic structure. By reserving the black for the organic foreground only, we avoided merging the foreground with the background, which would make for a denser and less readable piece. Negative space streams break away from the wrist, allowing for an attractive swirling dissolve into the blank skin of the hand; this also helps to keep the piece from looking too dense, and avoids a straight amputation-style cutoff at the wrist.

Although there are some small off-white highlights layered on top of the organic stuff to sharpen the texture, all true white is in the crystal; these highlights were rendered in sharp clear areas, as opposed to the bumpy and minimal way the white is used in the green. Last but not least, the angular shiny crystal facets contrast the bumpiness of the organic stuff, just blur your eyes and you'll see a difference in the silhouettes of these two textures.

Some examples of reserve used in this piece:

- Organic environment has the only black shading in the piece, along with some purple concentrate layered over the black, the only green in the piece, tight organic textures, no true white highlights, no blank skin
- Crystal structure has the design's only reds, oranges or true yellow, sharp white highlights, smooth angular details, no cool colors, no green, no blank skin, no black
- Background has the only true purples of the piece but no purple concentrate, no black, no white, and no sharp detail
In order to make white highlights appear strong, you need to make space for them and support them. White pigment that is layered over color, even a light color like yellow, will not hold up as a true white; for that, you need to leave a blank space for it when you are doing your color. The richer the color is immediately next to the white, the brighter and glossier that highlight will appear.

Fig. 60a has a few major design elements which need to interact constructively. This client had requested a lava lamp, which was given a flowing S-curve structure instead of the straight, rigid structure that lava lamps really have. The curve of this shape follows the natural curve of the arm and was reinforced by giving it a strong, clean black outline and bringing heavy black shading and dark color behind it, giving it a strong neg-on-pos relationship. For this glass, shape we reserved primary yellow and bright orange; although you'll find hints of these colors layered elsewhere in the design, only the lava lamp has any strong concentrations of it. We also gave it the biggest, cleanest white highlights, which jump forward from the smaller and softer highlights in the rest of the tattoo.

To make it appear as if behind glass, we used no outline on the globular lava, which would make it compete with the lamp itself. Instead, the lava was given strong primary red free. The fleshly area to the right of the lava lamp have magentas and violets but little or no primary red, which is a stronger pigment than magenta. We avoided bringing the background orange right up to the lava, since that would decrease their pos-on-neg strength; instead, a fringe of bright yellow was left around the lava wherever possible. The lava jumps out from the orange and yellow areas behind it partly because of the bright blue on the underside of each globe, which contrasts the bright warm colors and gives each globe more dimension. The long white highlights on the surface of the lamp were pulled in front of the globs in a few places to strengthen the impression that they are behind glass.

Contrast between warm and cool colors was used to create depth throughout the design. The edges of the lava lamp are colored pink, which is cooler than yellow and orange, causing the edges to curve back. The fleshly stuff is lit up by the lava lamp, so all of the fleshy details pointing towards the lamp are bright warms, while the areas pointing away are in blues and purples. The ribs on the right side of the piece are also illuminated by the lava lamp using this same warm/cool logic.

For the ribs we have reserved brown and ochre, which are not as bright as the orange in the lamp but are unique in the design, making them stand out. The flow of the ribs is considered carefully as not to become chaotic; the ridges and details on each rib are repeated in the others, unifying them as a continuous field of simple, readable movement.

Examples of reserve used in this tattoo include:

- Lava has the only true oranges and yellows but no black; has the biggest clearest white highlights, also has the strongest and simplest black lines and contrasted edges in the whole piece.
- Lava is done in a strong primary red with primary blue underneath; has very white point highlights, no outline or black shading.
- Ribs have a black line and black shading, the only browns and ochres in the piece, some muted yellow but no true yellow.
- Flesh background has black shading but no strong outline, displays a muted warm / cool spectrum without true reds, oranges or primary blues; has layered whites but no strong, sharp white highlights.

There are many graphic tools to potentially hold in reserve, but it seems as if the most important are: Black outline, Black shading, which have the deepest value available; colors, particularly the brightest primarics; white highlights, especially large, sharp, clear ones; untattooed skin, which balances out the rendered areas; texture or fine detail, which are used in the top priority object but much less everywhere else. The strengths and benefits of each of these tools are most effective when careful reserve is used, giving each tool a chance to be noticed in the overall scheme of the tattoo.

Selective Shading Will Help to Separate Your Elements!

If there's one mistake I see more tattooists guilty of than anything else, that's using too much shading in too many elements in a design. I can recognize this problem, being occasionally guilty of myself. It's completely natural to start with black and gray shading and work all the way through the tattoo, making sure the design is shaded enough to read clearly before starting with the color. In fact, this is an idea based on common wisdom that's been passed down through generations of tattooists. So why question it?

The point I'm making is not that a tattoo doesn't need shading, but nice gradations can be done with color as well as with black. It will age the same way, so why use black or graywash in areas that should be done in pure color? More importantly, do the shadows in the foreground shapes really need the same amount of black as the shading in the background? This is the easiest way to make a tattoo overly dark and dense. Even worse, tattoos with too much black shading will soon start to turn into a black blob, like those old sailor tattoos, while a tattoo shaded selectively doesn't ever need to become a blob of any kind.

Bottom line: There's such a thing as too much of a good thing.
2.6) Lines and Edges

When you look at a photograph or the world around you, you’ll see that in real life there are no outlines. An outline is a graphic tool that was created to make the shape it describes stand out more than it would in real life. In tattoo design, this kind of exaggeration can be very helpful for the sake of clarity and readability, so we often use outlines to strengthen our designs.

In real life, the edge of a shape has no thickness at all; the shape ends at its edge, and the background begins. An outline differs from this because it has a thickness, like a thin black tribal shape; it has two edges with a thin area of black between them. Outlines are usually made crisp and smooth, so it’s like having a thin tribal tattoo reinforcing a design’s composition.

Fig. 63a shows two different versions of the same image, one with an outline, the other without. The image with the outline immediately has more impact and boldness, while the other one has more subtlety and realism. In both cases we are avoiding pos/neg and neg/pos relationships with the background. However, in the image without the line, more attention must be paid to keeping these pos/neg relationships as readable as possible. In the upper parts of the head it is a neg-on-pos relationship; the deep tones of the background are pulled up against the edge of the face, taking care to develop the edge into a clean and readable one. On the diagonal parts of the chin, which are in shadow, the opposite happens. The fur is shaded in deep tones and pulled out to the edge, switching to a pos-on-neg relationship. When using an outline, we can be looser about developing our edges without having to work quite so hard to maintain readability.

In the most basic kind of tattooing, all outlines are created equal. Lining is done in a single pass with a standard "lining" needle group, using black. Tattoos done this way are often cluttered and busy yet at the same time not strong enough. When using only one type of line quality, a design needs to be very simple and economical to avoid these pitfalls. With more complex designs, different line qualities are important to keep the complexity from becoming chaotic.
In most of the more complex designs in this book, you'll see a number of different weights of line used alongside with details that have no lines. If you go back to Fig. 40a you'll see how the koi has a simple, clean, fat black outline all the way around its outside, including the fins and whiskers. This is called a peripheral outline, since it defines the periphery of the shape, giving it clarity. The use of bold lines was avoided in any of the details inside the koi, which would have competed with the peripheral outline and canceled out its effectiveness. The smaller details, such as gills and the spines inside the fins, were given a thin black outline while the scales and eye bulges were done with a graywash line.

The water was given no line at all, making the koi appear to be more in focus by comparison. To do this, we first finished the black and gray lines in the koi and then skipped the lining stage in the water, going right into this part of the stencil with a 7 magnum. After getting the blues roughed in, we switched back to a 5 round and sharpened the edges of the waves in key places while leaving them softer in others. This is an example of using focus to assign priority; line and edge quality are the keys to creating these focal effects.

Fig. 64a shows a simple tattoo using some elements with black outlines and others without. The black lines around the petals were kept to a fairly light weight. They are slightly thicker on the larger petals and finoer around the smaller ones. The jewel in the center has no lines, but instead starts in deep red at its outer edges and fades inward into orange, yellow and white. By fading the red inward from the edge, the dark red line that defines the edge seamlessly becomes part of a gradation that makes the shape strong and clear but avoids the graphic limitations of a line. Just outside the red edge is a white line that gives the jewel an extra degree of graphic impact by widening the dynamic range of its edge. Details inside the jewel are made of smaller gradations, keeping the whole jewel line-free.

"Of course everything needs a black line. We're carbon-based organisms, so every shape in a tattoo needs a wall of carbon fencing it in, or else..."

The truth is, all quality tattoo pigments will blur and shift at about the same rate. Black lines are so successful because they give a shape such an added degree of strength and clarity for such a minimal amount of work. However, any well-executed tattoo with strong edges and well defined pow/seg areas, whether using black or only color, should stand the test of time. If it can read well from a distance, it should age well.

In Fig. 65a is a complex multi-layered design that uses both lines and edges to define its shapes. The big hooks in the foreground, along with a few other small foreground elements, have strong black outlines that give them strength and clarity. Other elements, such as the wrinkles near the ankle and knee, have clear edges but no black lines. This gives the wrinkle elements a smooth, creamy appearance and a far more lifelike quality than black lines would allow for.

The petals have strong black areas and their undersides that fade right into their textures; the bold alternation of pow/seg relationships is one of the tattoo's defining characteristics, giving the overall piece a stronger silhouette and more distinct rhythm. None of the interior details within the hooks have black lines or sharp edges except for the rows of spines, which were intended to float above the surface of the hook.

For any parts of a design where you plan on using no outline and no black shading to support the edge, expect those edges to fade about 10-15% more than any black outlines in the design while the piece heals and settles. For tattoos that use no black at all, remember that dark concentrate colors fade a lot more in the healing process than black does—there is no other pigment that heals as dark as black pigment. For black-free tattoos, the major design elements an extra degree of reinforcement with rich color in key places, and make sure the edges of the important shapes are well saturated. Using a small round to define the darkest color edges will give you sharper healed results than you'll get by using only a magnum. A second pass after healing is usually a good idea for tattoos that don't use any black lines or edges.
There are many ways of tattooing lines of different weight, some ways being better than others. The first thing that might occur to an artist would be to use thicker needle groups such as 11 or 14 rounds for the fat lines, and smaller needle groups for thinner lines. One of the drawbacks to this is that a different needle group is needed for each line weight, making it harder to explore the whole range of thicknesses in any given piece. The other major problem with this is that heavy lines done in a single pass usually aren’t very high-quality lines.

The quality of a line is determined by:

- The sharpness of its edges
- The consistency of its thickness
- The depth and evenness of its black

When a line is put in with a single pass of a large needle group, it’s kind of like using spray paint; pigment will be concentrated in the center of the line, since more needles pass through the center than the edges, while the edges end up being softer. Moreover, a single-pass line of any weight will tend to have blow-outs and drop-outs as a normal by-product of the way it is applied. The best remedy for this is to use a smaller needle group and build up the line.

In Fig. 66a and Fig. 66b are examples of lines done both ways. The one on the left is a tattoo on my own leg that was done around twelve years ago by a skilled tattooist, using a single-pass line technique. The other one I did almost thirteen years ago, using the types of line building methods described here. The difference in quality between these lines is pronounced; the built-up lines are clearer, more consistent and have notably sharper edges. In fact, this difference was visible long before all these lines had passed. It seems that the line building process provides better insurance against the passage of time.

The simplest way to do this is to make a first quick pass over the stencil with a medium round needle group, usually a 5 round (Fig. 67a). After the whole stencil is committed to skin comes a second pass, this time moving in small overlapping ovals to bulk out the line and establish its edges (Fig. 67b). Finally, a quick third pass is done, working in short straight zips through the skin, skating along the edge to smooth it out and make it crisp along both edges, anywhere that the looping ovals haven’t already accomplished that (Fig. 67c). See Video Clip 1: Basic Line Building on the enclosed DVD for a short film of this process.

Part of the beauty of this method is that while a single-pass line is almost always going to be flawed, the line can be adjusted and perfected in the second and third passes. Fig. 67d shows a purple stencil for a clean arc with a black line showing where the first pass with the 5 round actually ended up. Even with lots of experience, this margin for error is relatively normal and usually attempted in a single-pass line. Shown next is the second pass where the opportunity is used to build the line outward in one places and inward in other places, bringing the line closer to the desired clean arc. The final step is to skate along the edges in short straight strokes, sharpening them and refining our arc to a point where it looks clean and smooth.
It's a common assumption that the best needle groups are the tightest ones. However, this isn't necessarily true. After much experimentation, I slowly acquired the habit of using loose 5 rounds for building my lines, such as in Fig. 68a. After years of working with loose rounds, I began using needles made by someone new, whose idea of a "loose 5" was really much tighter than even my definition of a tight one (Fig. 68b). I noticed immediately how much harder it was to build lines with these tighter rounds; they took much longer to build up, and didn't look as dark as they should have. Worse still, my clients started coming back with poorly healed linework.

After switching back to a much looser 5, things returned to normal and building lines stopped being a struggle. There are a few reasons for this. First, a looser 5 will cover more ground in less time, allowing us to work more efficiently. Second, since the holes it pokes are farther apart, the skin takes less of a beating and the line can be developed more with less trauma. Finally, a good separation between needles means better capillary function, delivering more ink down into the holes they poke and actually making the line darker.

Part of the reason the skin gets more traumatized with the tight 5 is that the group is tight enough that it stops being a group of 5 needles and becomes one big nasty one. With such a big and rugged point, the machine is less able to punch it through the skin, so it spends much of its effort bouncing around near the surface, tearing as it goes. You'll notice with a too-tight needle group, you will need to stretch harder and bear down more on the skin; this is a sure sign that you need more space between your needles to reduce any unnecessary resistance. If you prefer a tight 5, then make sure it's tightened with moderation (Fig. 68c).

It can be nice to have both loose and tight round groups in your kit. Not all projects are created equal; a backpiece will go quicker if you use a looser group, while a more delicate armpiece might require a tighter group. You can work faster with more power if your groups are looser, since they offer slightly less resistance against the skin than a tight group. With smaller work, speed is less of an issue and a tighter group will offer more precision, which can be useful in a smaller tattoo.

If a built-up line is desired and a loose 5 is just too big, there's the option of switching to a loose 3. This group can be used to make lines of any thickness, although it takes longer to make really fat lines and can cause raised, slightly scarred lines if it is used too fast in order to make up for its small size. I usually use a 3 to build up lines in smaller details, such as the hydras in the droit's legs shown back in Fig. 37a. For bigger lines, a 5 round is a good all-purpose tool. For gigantic quarter-inch lines, there's no reason not to put them in with a 5 or 7 magnum and then sharpen the edges and corners with a 3, 4 or 5 round as necessary. I've found that bold lines put in this way are less likely to trench, and tend to heal more easily than fat lines built entirely with a round.

The one method of building lines that I would not recommend is to use a small group to outline both edges, then switch to a larger group to fill in the gap (Fig. 69a). There are a few problems with this. First of all, the outlines that are initially put in for those edges will have all the normal wiggles and imperfections that single-pass lines have; there is very little opportunity for refining those lines, as discussed earlier, in many. Second, it's hard to make these lines truly parallel, so even with a steady hand it's easy to end up with inconsistent line weight, leading to a need for either slightly sculpting along the edge to make its weight uniform. A third problem is the normal pitfall we run into when filling in all space with a large needle group; it's hard to get the black in right up to the line without accidentally going over it, so lines done this way usually don't look that great.

A good way to practice technique for building lines is to use black colored pencil on illustration board. Make a first pass with the black colored pencil, just as you would with a tattoo to commit its stencil to skin. Then, go back and use the hand movements we discussed earlier to build up the lines, aiming for smooth consistent line weight with sharp, clear edges, making the edges of the lines as parallel to each other as you can. While doing this, try other hand movements and find what feels the most natural; you'll probably find that you work best with a wide variety of hand movements, rather than sticking to a formula. Freedom is the key, the goal here is to find the way that comes the most naturally and intuitively to you.

If you're planning on coloring any drawings that will have black colored pencil lines, put the color in first and do the outline last, since it's easy to disrupt a carefully built-up line while coloring with colored pencils, and black can easily get smeared into your light colors kind of like the tattooing staining problem, but in reverse.

When translating these hand movements back to your tattooing technique, the trick is to get your equipment to work like a colored pencil, which can be accomplished by doing a few simple things. First, you want a longer stroke on your machine than you would normally have on a fast single-pass liner, with a gap of about the thickness of a nickel between your point and your spring (also referred to as your point gap). That will slow the machine down, allowing you to develop the line more evenly without chopping up the skin. Second, give your spring the bare minimum tension you can get away with; when the machine is at rest the spring should just barely be in contact with the point. This will cause it to run more softly, allowing you to work with the line more without making a trench in the skin and giving you more control over the lining process in general (see Part VI for a more detailed machine tuning discussion).
In the past I have preferred using machines for driving my 3 rounds which had even less spring tension than this. Actually had to give it a little flick of the wrist to get it to start; I eventually incorporated this “flick” movement into my work habits. This seemed to give me the maximum freedom to mess around with my lines, but can be a difficult balance to maintain in a machine and is only really useful for very small, delicate work. If you like to tinker with machines, I recommend you experiment with variations of this setup.

Finally, you’ll want to work with as little power as you can get away with. When starting a tattoo or switching machines at any point in the tattoo, start with the power turned too low, and slowly turn it up until it feels right. If you need to add a little more power while you’re tattooing, feel free at any time, especially while working together skin areas. But always be prepared to shave a little power off, especially in areas of softer skin like the inner arm. After a bit of experience, you’ll habitually use the right amount of power, but in the meantime, it’s better to start with too little than too much.

If you use a power unit with presets for two or three machines, it is still vital to check how hard it is hitting before touching the machine to the skin. Even with presets tuned exactly to each of your machines, particular circumstances may require slightly less power. Always be conscious of how tough or soft a given spot on a client’s skin is, and how hard you can hit it.

Keep in mind that you’ll want plenty of needle hanging out of the end of the tube. I was originally taught to only have as much needle hanging out as I plan on burying in the skin, and to use the tip of the tube as a kind of “depth guide”. This is a crude and inaccurate way of lining. After observing and collaborating with other artists, I began using more and more needle; eventually, I reached the point where I use so much needle that it doesn’t even retract all the way in the tube, despite the long stroke.

It is even artist’s job to find a comfortable balance between having enough needle visible to control the tattoo process while still getting it to retract enough into the tube for it to load up with ink. You can lengthen your point gap to make the needles retract further, but that will also slow the machine down and affect its performance in other ways. Both good and bad. You may need to experiment a bit to find the exact balance of needle point visibility versus ink flow that works best for you.

At first I was afraid of burying the needle and damaging someone, but I quickly outgrew that fear. I found that as long as I kept my powder fairly low and was conscious of my stretch, it seemed that the needle would automatically puncture the skin to exactly the right depth before retracting. This is a result of a perfect balance between force and resistance, produced by a long, low-tension stroke striking skin that’s stretched to a good tightness. Finding this balance is one of the keys to having precise control while tattooing.

The main advantage of the long exposed needle is visibility. When the needle points are visible they can be controlled better, especially while building areas or handling other precise operations. Having a lot of needle hanging out is one way to improve visibility, another important way is to have a good bevel on the tube. In Fig. 71a is the side view of a tube tip for a 5 round, which is beveled at a 45 degree angle. This improves visibility dramatically without noticeably effecting ink flow.

Most commercially available round tubes don’t come pre-beveled, you’ll need to do that yourself. Get a fine tooth metal file, something around 8” (20cm) long and 3/4” (2cm) wide, and a small round needle file, which are usually about a 1/4” (6mm) wide at the handle and taper to a point; make sure you find one with a point small enough to fit into your round tubes. If you have trouble finding needle files, try Sears.

Next, clamp the larger file onto a workbench and hold the tube as shown (Fig. 71b). Bring the point down onto the file and pull it toward you in slow, measured strokes (Fig. 71c). After every three or four strokes, check your bevel and make sure you’re not going further than necessary.

When you’re happy with the bevel, round down the point of it with a couple of light passes over the file, so that it won’t be dangerously sharp (Fig. 71d). Finally, insert the needle file and twist it back and forth a few times to clean out any burrs inside the tube (Fig. 71e). Rinse with a fast-running faucet to ensure there are no steel filings hiding in the tube, waiting to be driven into someone’s skin. Check out Video Clip 2: Beveling A Tube for more detail on this procedure.

Between the spring tension and stroke, the low power level and the long visible needle, you should be able to work with your small round needle groups freely and intuitively, the way you would use a pencil. Building clean lines and edges is a relatively easy job with a pencil, and can be with a tattoo machine as well.
Tuning our machines to work like pencils is especially helpful when working with design elements that don’t have any lines. If a black line isn’t wanted in a design element, we need to ask ourselves what is appropriate: a bloodline, a grayline, a color line, or to go right into the stencil with the magana and shade or color an area without any lines at all.

Bloodlines are made by tattooing with nothing but clean water in the tube. Lines done this way will commit the stencil to skin for the duration of a session, but will heal out and disappear when they’re no longer needed. Bloodlines are great for things like smoke and wind, any element that is meant to have soft edges. They are meant to be done quickly and should cause very little trauma. When first put in they may not be clearly visible, especially if the stencil is dark. By keeping track of which ones have been done by working systematically from one end of the tattoo to the other, we can avoiddoing any of them twice. Eventually, as the bloodlines reddened and the stencil fades, they will become clearly readable for a few hours.

Bloodlines are very versatile; we can color or shade right up to them, then sharpen their edges with the same hand movements that would be used to sharpen the edge of a bold black line (Fig. 73a). One potential drawback is that the holes poked in the skin during the bloodlining stage will make it harder to create a Truly sharp edge; there, the extra trauma along the edge caused by the bloodline can limit how sharp it will look after healing. Another potential issue with bloodlines is that some pigment can accidentally be introduced during the bloodlining process, or possibly afterwards, by wiping dark pigments over them. To avoid these problems, it’s best to use bloodlines only for design elements with soft edges. For sharp-edged details try using black lines, gray lines or color lines.

Graylining is a way of making a permanent line light enough that it can be made to disappear as the piece is shaded and colored, turning it into an edge instead of a line. A grayline is done with graywash, so the wash can be made as light or as dark as desired, depending on what is needed. For instance, a light grayline would be used when doing a large, multiple-session tattoo that incorporates a soft smoke effect; where a bloodline might be used if it were a single-session piece, instead a very light graywash would be used. The line will still be there when it heals, but will be light enough to be hidden underneath the soft shading and color that will be put around the smoke in later sessions.

Other features in a design might be graylined in more medium tones that will sharpen the edges of those shapes more than a bloodline would. In Fig. 73b, a healed first session, where a 3 round was used to grayline the faceted background and other details, then a 5 round to line the central figure with black and to build up those lines. Switching back to the 3, we continued with development in the character’s detailed ornamentation and fine-tuned the bold lines around his hands and other detailed areas.

In the next session the facets were shaded with a 7 mag (Fig. 73c), working with very diluted washes and using quick oval movements, then dipping into slightly stronger washes and using smaller ovals closer to each facet’s edge. The edges were then sharpened with short overlapping strokes of the 5 round (Fig. 73c), dipping into a much stronger wash when working along edges of large shapes to make the edge crisper. Healed, the gray lost about 40% of its darkness, which is normal, along with all of the redness (Fig. 73d). Once healed and settled, this soft gray foundation was perfectly prepared for the coloring stage.
This process was then continued with the medium colors (Fig. 7.4a), starting with deep oranges and reds, then greens, taking care not to overlap the two colors too much, which would make brown.

Most of the tightening was handled with the 5 round, which saves time and helps create a smooth appearance; then the 3 round was used to sharpen the edges and corners a final degree (Fig. 7.4b), placing small amounts of dark purple in key spots for emphasis. Finally, in Fig. 7.4c the light orange and yellow were packed in with the magnum, then tightened with a 3 and 5 round, maximizing both the saturation and sharpness of the highlights.

In the finished piece you can see how the edges of the facets healed nicely and sharp, yet quite a bit softer than the black peripheral outline of the figure (Fig. 7.4d). By avoiding black lines and keeping the value below 60%, the background can be tightly rendered and fully realized while still not competing for importance with the figure. The grayline made it possible to keep the background soft, but the tight rendering of the shading and color are largely responsible for the sharpness and clarity of the faceted surface.

Going back to the temple in Fig. 23b, you'll see a healed photo showing some areas that were lined with straight black, others that were graylign. It's easy to see how the different uses of line and edge make the design read more clearly and give the tattoo more visual variety. If the same tattoo were all lined in black with the same weight of line throughout, it would lose most of the effect of distance and atmosphere.

Some designs call for an element with sharp colored edges, without black or gray muddying the color. This can be accomplished by lining with color. That way, the color of the shape can be brought right up to the color line, making it disappear and become the edge instead of a line. The jewel shown earlier in Fig. 6.4a is an example of this.

However, there are some limitations to color lining, since colored pigments are a different consistency than black ink, they don't go into the skin quite as smoothly as black pigment. Some modern colors are a thinner consistency than the traditional flake-powder pigments, making them better for tattooing lines. Many tattooists are using liquid dispersion colors such as Starbrite to supplement their palettes (come to the Reinventing Forum and take a look at the pigment discussions if you want to know more about the popular brands on the market today). These colors are almost as easy to line with as black. In general, though, color is less reliable to line with and seems more susceptible to dropout and biowouts than black ink. This is partly a problem if the line is going to be incorporated into an edge, but color lines that are meant to stand on their own will probably need careful development by gently walking them over to fine tune their weight and sharpness in order to make them heal consistently and hold up over time.

In Fig. 7.5a, the stencil for the central crystal shape was committed to skin with medium pink, which is easy to line with and light enough to allow for some adjustment later. The rays radiating from it were GL7Lined, making it easy to keep their edges soft. Heavy black lines were used around the cave features to give them the most graphic strength and to make the crystal look light in comparison.
With curvy organic fat black lines, the first stage of making a quick pass over the stencil before building up the line can often be skipped; instead it can be built during its first pass, working in small overlapping ovals (Fig. 76a). The final refinement of the edges is done with the quick-skating motions, still leaving many of the bumps and wigglers as part of the finished look (Fig. 76b). It's important not to let this method be an excuse for working too quickly, which can cause the line to heal too light or fuzzy around the edges. In addition, this method of building black lines is not recommended for clean areas and precise edges because it's harder to control than building along a first-pass line. But for organic outlines, it can save a little time and possibly give the line more character. Check out Video Clip 3: Building an Organic Line for a film of this process.

After finishing all the lining, shading and cool colors, pink and lavender were pulled up against the pink outline of the geometric shape, first using the magnum and then tightening it with the 5 round. The orange gradations inside this shape were handled in the same way, roughing them in with the magnum and then refining them with the 5 round. Before switching to yellow and white, a final tightening pass was made with the 3, selectively adding dark orange and red. By moving in light skating motions along the edges, then pulling the color away from the edges and into the shapes with inward-moving strokes (Fig. 76c), it's possible to make the color line disappear altogether. Finally, yellow accents and white highlights were added, first using the 5 round and then switching to the 3, which was particularly useful for keeping the white edges precise. Take a look at Video Clip 4: Turning a Line Into a Clean Edge to see this process in action.

Committing the entire stencil to skin using a 3 or 5 round seems a natural enough way to begin a tattoo. Nearly all of us begin our careers being taught the basic assumption that we have to outline a design first before we can get on with the more exciting parts, and many tattooists simply never question that assumption.

Many tattooists are now challenging this basic idea, instead laying the stencil and then going straight in with a magnum. Some are finding that this works not only for soft and out-of-focus effects, but for precise detail as well. A few tattooists are known for doing realistic portraits without anything except for a magnum. Working this way, a tattoo can be approached in terms of forms and edges, rather than lines (remember, in photos of real life, there are no outlines!) Using this one needle: group, sharp and soft edges can be applied almost simultaneously.

Although the magnum is an extremely versatile tool, there are some things that are better done with a small round, such as sharp lines. Fine-tuning of areas and details can be tricky to do with a magnum, which can seem big and cumbersome at times. In addition, there is a limit to how sharp a line or edge can be made with a magnum; a small round group is more controllable and its points are closer together, making it more ideal for honing precise edges. Typically, edges sharpened with a small round will heal cleaner and richer than those done with a magnum alone.

**Starting a Tattoo With a Magnum First**

Beginning a tattoo with a magnum instead of with an outline may seem like a strange approach to a traditionally trained tattooist. However, this idea should make sense to anyone who has ever done oil or acrylic paintings. Think of the magnum as a large pastel stick that you can use to initially lay in the larger gradations and color fields that define the piece. To follow through with a "smaller brush" (such as a 5 round) to tighten it and add detail. This method can be more effective when combined with normal outlining, and switching between machines for each (see Chapter 6.9 for more on this technique).

**Parts of a tattoo best started…**

**With a magnum:** Large simple forms, color fields or gradations that define the major dark/light areas of a design, soft-edged elements such as smoke and clouds, some thicker outlines and any other shapes in the design that are simple enough to be easily sketched in with the magnum.

**With a round:** Delicate or precise line lines, lettering, small facial features, tight geometric patterns or structures.

With most projects I like to work interchangeably between the magnum and the small rounds. These days, I commit my stencil to skin partly with a magnum, partly with a 3 or 5 round, switching back and forth between machines as many as five or six times before finishing the first pass over the stencil, depending on the needs of each part of the piece. By the end of the first pass the soft edges are soft, the sharp edges are sharp, the lines are crisp and bold and important small details are in place. Take a look at Video Clip 5: Starting a Tattoo With a Magnum for some examples of this type of tattoo application.

Working this way can be easier using stencils that are different from the standard linear stencil by showing not only lines, but positive and negative areas as well (Fig. 77a). These shaded areas are included in a stencil mainly in places where the intention is to begin magnum first. Crosshatch shading works well for
stencils because it transfers to the skin nicely without becoming a big purple blur (Fig. 78a) and holds up clearly while tattooing.

The extra step of crosshatching shading a stencil is completely unnecessary if the entire tattoo is going to be outlined first. To make the most of this kind of stencil, it’s best to lay down your gradients and positive/negative relationships as you are making the first pass through the tattooing process. Start at the bottom and work each area at least to the point where the basic lines, gradations and positive/negative relationships are established before moving upward to the next part of the stencil. This can be done fairly rough, just enough to show the basic light and dark areas of the piece along with any important details (Fig. 78b), and then crosshatched later (Fig. 78c). Use all different needle groups to refine edges, darken small shapes, enhance contrast and smooth out small gradients and color fields. For tattoos larger than this hand piece, there is always the option of refining or even completing each area before moving on, which can sometimes be easier for the client to endure because it involves less skipping around in the tattoo.

I have done a fair amount of work where I have laid out most of the tattoo with a 5 mag (Fig. 79a) before tightening it with a 3 or 5 round (Fig. 79b) and then finishing the color and highlights with a 7 mag and the 5 round (Fig. 79c). The 5 mag seems like a great tool for laying out large pieces, especially those that have line-free edges throughout them. With their low needle count and wide spacing, 5 mags offer very little resistance against the skin, so it is easy to fly quickly with them, covering a lot of ground and establishing small and medium gradients quickly and easily. They are also small enough to maneuver around tighter detail and can be used for lining as well, although I find that lines done with mags almost always seem to need some tightening and edge development with a round group later in the process.

Whatever methods you use, incorporating elements in your tattooing with both lines and line-free edges gives the work more depth, character and subtlety than work that uses lines uniformly around every detail. Switching more freely between needle groups while tattooing can make it easier to line or edge shapes selectively, giving you more freedom and control. Finding a balance between lines and edges in your tattooing opens up all kinds of new possibilities for dimension, lighting and other dynamic graphic effects. Given all these potentials, don’t just settle for a single line weight in your work.
2.7) Depth

A strong illusion of depth can have a powerful impact. If it’s done convincingly enough, this illusion can help move the viewer into seeing beyond the skin and into the vision of the design. I’ve noticed when people are paging through my portfolio at conventions, that their strongest reactions are often to the pieces that convey the most depth; those tattoos just seem to have a little extra grab.

Depth is an important tool for keeping complex tattoo designs clear and readable. Maintaining clear relationships between the foreground, middleground and background elements will prevent these interacting parts from getting cluttered. Instead of cramming the different design elements into the tattoo side-by-side, we can overlap them, with top priority elements in the foreground and most other elements passing behind them.

The neck tattoo in Fig. 81a uses a variety of depth tricks to give it dimension and make it pop out from the skin. The swirls of negative space are there to give the design movement and to keep the tattoo from looking like a sticker by bringing some blank skin through it. By having some swirls in front of the pumpkin and others behind it, the design is given 3 distinct overlapping layers of elements.

The dark shading behind the pumpkin contrasts the orange, popping it forward. Vertical seams on the pumpkin’s face in such a way that produces a sense of volume; the curved grid on the peanut gives it form in a similar way. Shading and highlighting on both objects accent their forms even more. To bring the whole thing to life, a dark shadow underneath the peanut lifts the design up and out from the neck, while the small gap of skin between the shadow and the peanut helps show how much space is between the object and the ground.

This is a lot of different depth tricks in one small design. Shading and highlighting, overlapping elements, contour lines and cast shadows. Brought together in the right way, these tricks bring a lot of added life to an otherwise simple tattoo.

The tattoo pictured in Fig. 82a is a good example of a more complex illustrative design with major and minor foreground objects as well as two levels of background elements. To successfully convey the story the client had in mind, we needed the well, complete with crank and bucket; the candle holder, pitcher and cups; two pillows next to each other with complex Persian designs on them; the background architecture, palm trees and the whole sunset sky, including full moon and flying cranes... not to mention the butterflies, which are a good element for adding mood and atmosphere to the design, but also a potential clutterer.
I normally avoid incorporating so many different things in a tattoo, but in this case I liked the kind of atmosphere that these elements invoked and felt that they could work well together if balanced carefully enough. Since the well is the most important element, it was made as tall as possible without going into the armpit, which would distort it. The well was given the full value range, using large areas of black and plenty of white highlights. The wooden parts of the well have a clean black outline and a large, clearly readable dark area at the top that steps out from the light colors below. White highlights were used to create two textures, wood and stone, which help bring the well into focus.

Most of the other elements have less contrast, especially in the background. Where the shaded parts of the stone in the well threaten to create a pos-on-pos relationship, the background drops out to a lighter value, making the true black in the well jump forward. This is a similar strategy to Fig. 23b, where less value range was used in the background to create an illusion of distance.

The use of perspective is another strategy that can be used to convey depth, and the structure of the well gives us an opportunity to use this important graphic tool. The design has four circles in it, viewed at an angled perspective, so they appear as ovals (Fig. 83a). You'll notice how the ovals appear flatter when they're closer to eye level and more circular the further down they are. In Fig. 83b you can see how the ovals become more circular higher above eye level as well. This characteristic of circles and perspective is evident in real life; to see this effect, just pick up a drinking glass and move it up and down, paying attention to how the ovals change. Similarly, Fig. 83c shows an image of a castle that incorporates a number of foreshortened circles at different altitudes; the perspective of these circles is crucial in showing the dimension of the structure.

The low circular wall in Fig. 82a is another example of circles in perspective, and was designed in such a way to come both in front of and behind the well, adding to the sense of depth already established by the well's perspective. A candle holder was used as a bright light source to play over the texture of the stones and cast a shadow on the wall, which helps to establish the wall and the well's relative positions in space.
Although the sunset in Fig. 82a is complex, which conveys a sense of vastness (as opposed to a simpler sunset, which may have made the sky look smaller), its value range is kept to around 60, with even less contrast in the areas closest to the well. There is no true white in the sky because it would have competed with the well; instead, the white is reserved for the moon and the crane to give them added emphasis. The crane has no outline, keeping it in the distance, while crisp black lines around the butterflies pop them forward.

The overall sense of depth and space in this piece is a result of many depth-related language elements being used together. Here is a brief summary:

- The main shape (the well) has a strong outline, secondary elements have less outline, background has no outline.
- Full contrast is used in the foreground, with diminished contrast in the background layers (a good strategy for scenic tattoo subjects).
- Detail is concentrated in the foreground in the main design elements such as the well and pillows, while the background temples and trees are simple silhouettes with just a hint of detail.
- Shapes overlap in a way that describes the depth of the scene. The round wall comes in front and goes behind the well to describe the space around it, and the bowl of the well and the moon to describe the sky.

Objects on the ground in front of the well are placed to show their relationships in space:

- Perspective is used to show the 3D forms of the main elements. The fore-shortened circles in the well, bucket and cups are done to show their orientation in space, and the closer wood pole appears taller than the more distant one, as it would in real life.
- Black is used selectively, with true blacks used only in the foreground elements (in other types of projects, the opposite strategy, where strong black is used in the background but very little is used in the foreground, may be more appropriate).
- Lighting effects are also used to describe shapes, such as on the well and the cups; light and shadow are very effective ways to show the form and volume of objects.

As you can see, depth is not a singular effect that you can apply to a design. Instead, it is a combination of many graphic tricks put together the right way to create an effective illusion.

I feel that complex scenic tattoos like “The Well Scene” work better on some body parts than others. For instance, I would be reluctant to put this same design on the outer arm, where a more strongly flowing tattoo is more desirable. This is because the outer arm will be viewed often from a distance, while inner arms are generally seen only from up close.

Cast shadows are a fantastic depth tool, as demonstrated earlier in Fig. 10b, 46c and 65a. This kind of shadow really shows the viewer the apparent distance between the object casting the shadow and the surface where the shadow has landed. Fig. 85a shows another example of the use of cast shadows; you can see how the shadows cast by the ribs follow the curvature of the bumps that they are cast on, which helps to show the form and volume of those bumps as well as the amount of space between the bumps and the ribs. You can see how in Fig. 85b the shadows have been moved in Photoshop closer to the ribs casting them; this diminishes the sense of space between these bumps and the ribs that are casting the shadows. Fig. 85c shows the same tattoo but with the shadows flat instead of following the curving surface they are on. This causes the design to lose part of its volume. For the maximum effect of depth, try doing both of the following: keep the shadow some distance from its source, and make it follow the curvature of the landscape’s form. These are both important factors in making your cast shadows effective.
I've noticed that when I look at many heavily tattooed people's sleeves, the top of the forearm is usually the densest and least readable part of the design. Often this is because the spot gets tattooed with a cheesy skull or something when the person is sixteen, then covered up when they are twenty-one, then fixed again five years later. But even when the area is tattooed for the first time, it seems that it is more prone to looking dense than most other parts of the arm. I think this is largely because this part of the arm is the hairiest, darkest and most leathery part, which sees the most sun exposure. That adds up to a lot of factors working against any tattoo that is being designed for that part of the arm.

I usually try to make up for this by designing outer forearm work to be more open and clear than the rest of the sleeve, making sure to use some long, smooth areas and light colors along with some larger, high-contrast shapes. This helps compensate for the inherent lack of contrast that this part of the arm often tends to have.

Fig. 86a uses many depth tricks. For starters, the way the piece is laid out on the arm takes advantage of the natural bulges and dips in the arm, with the two fullest shapes sitting on the rosiest part of the deltoid and filling out the front of the bicep. These large forms were given a clear warm on top/cold below color logic, which supplies them with a greater sense of volume. Next, each of these shapes was given a clear neg-on-pos relationship with the surrounding background, which can be very effective in bringing shapes to the foreground.

The smooth orange shapes fused to these organic parts also help to describe the depth of the design. Because these shapes appear in a predictable series, their structures can be used to show depth. For instance, the row of spines embedded along the top and front of the coil on the deltoid help to show how thick that coil is; the way the organic stuff is rendered around these spines shows how they're embedded into the coil. You can get an idea of how to construct these kinds of shapes in Fig. 87a.

Although a much different kind of design than in the well scene, this piece uses many of the same depth tricks. A brief summary:

- Foreground shapes have strong black peripheral lines, while background shapes and textures rely on shading alone.
- True black is concentrated in the background areas, with shading in the foreground done mainly with color (the opposite strategy of Fig. 82a).
- Shapes pass in front of and behind each other, with openings in the design showing background movement.
- Warm and cool lighting is used on the tops and bottoms of the main forms to help establish their volume.
- Cast shadows are used throughout the piece to show the lighting direction and separate the different layers of the design.

Fig. 87b is a similar composition in terms of the layout strategy of the largest forms. This time the whole foreground area is shiny and non-textured, making it jump out from the darker and rougher background. A strong clear peripheral outline helps it to stand out more.

The fine lines inside the main body of the coil help describe the depth of the form the same way the spines do in Fig. 86a. These lines help define the coil's thickness while showing which parts are concave and which are convex. When lines are placed on a shape in such a way as to describe its form, they are called contour lines. In this particular tattoo, contour lines are one of the most critical design elements in establishing its depth. Every part of this design clearly shows its angle and position in space, using contour lines. Even without any shading or color, the linework alone is enough to show the design's essential form and structure.

Contour lines can show the depth and form of an object without a background being necessary.
Almost all the tattoos in this book rely heavily on contour lines to help describe their form. In Fig. 88a we have two very similar shapes; one relies on shading alone to convey its depth, and the other uses contour lines to a much greater effect. Notice how the contour lines are disguised as normal detail in the design so that they appear as a natural part of it. This can be done with stripes on a shirt, the brim of a hat, the structure of scales wrapping around a snake-like body... Almost any design with any surface detail presents an opportunity for using contour lines to create more of a depth illusion.

One of my favorite tricks for creating depth is the 3-Dimensional Figure 8, or 3DF8. This happens when a design starts with a simple S-curve and then follows all the way through to its starting point in one continuous movement (Fig. 88b). This type of flow fits very appropriately over most large body parts, such as sleeves (Fig. 88d). In Fig. 88c is an abstract design using this type of layout; pictured next to it is a more traditional dragon design that expresses depth this way. In both of these designs, the top priority element flows through the foreground, curves up over the top and then passes behind the foreground object, flowing in the opposite direction. The foreground and background will stand out from each other more distinctly when they flow in opposite directions in this way; when combined with other depth elements such as cast shadows, selective shading and strategic use of outlines, a 3DF8 will add another degree of depth.

Fig. 89a is a good example of this strategy; the basic 3DF8 is plain to see. The part of the Figure 8 that passes behind the foreground objects is darker than the foreground parts, reinforcing its sense of depth. In addition, the foreground detail is in tight focus while the background detail was kept simple and blurry; the sharp white highlights used throughout the foreground are not used at all in the background areas, enhancing the priority of the foreground. The entire design consists of shapes that swirl in front of and behind each other, creating both depth and movement at the same time.

Back in Chapter 2.1, the tattoo pictured in Fig. 10e makes strong use of this layout principle; so does the dragon in Fig. 89b. In both cases, the foreground elements follow the arm’s natural S-curve, then flow through into the 3DF8. This movement logic is not necessarily followed all the way through in every part of the tattoo; the important thing is that the foreground elements flow along the arm’s dominant S-curves and the elements passing behind them flow in the opposite direction.
Fig. 90a shows a complex abstract design that follows the basic 3DF8 plan that we illustrated in Fig. 88c. In this example, the flow/counterflow elements are used in various places throughout the design, such as the shoulder cap and near the elbow. Floral elements occupy some of the spaces that these flowing elements create. Although the Figure 8 elements are not continuous through the tattoo, they are present enough to suggest the volume of the space to the viewer. To make the layout flow as smoothly as possible and still contain all the desired elements, a number of small sketches were done first (Fig. 90b). In this case, it required a few drawings to find the best flow for this piece; that is why it is a good idea to begin with small sketches before moving up to larger drawings.

This 3DF8 thing may be another one of my superstitions, but I'll bring it up again anyway when we discuss certain designs later in the book. I believe it is a universal design principle. Even if we don't think about it consciously, in the act of using the S-curve and flowing the background elements in the opposite direction from the foreground, we'll automatically end up working with a 3DF8.

Whatever your strategy, creating an attractive illusion of depth can give most designs an extra degree of visual punch. There are many tools available for achieving this, which can be mixed and matched in countless different ways to create any desired effect. If the maximum possible visual impact is desired, these tricks can be stacked up all at once into a very powerful illusion of depth. These tools include:

- Making a dynamic range in foreground objects
- Making a dynamic range in background objects
- The use of bold priority lines in foreground objects
- Thin lines or no lines in background
- The use of strong black shading in either the foreground or the background, but not both
- Sharp edges and high-contrast detail in foreground objects
- Soft edges and blurry detail in background
- Strategic overlap or interweaving of foreground, middle and background shapes (3DF8 is an example of this)
- The use of perspective to show an object's position in space
- The use of light and shadow to show the volume and form of objects
- Contour lines for describing the surface volume of shapes
- Cast shadows to lift objects up from surfaces
- Use of the body's natural form to give the design's largest shapes more volume

The way that objects in a design overlap and interact tells the viewer a lot about the depth of the design. In Fig. 91a, notice how the clouds use the space around the dragon but do not overlap in front of or behind it. This is a common problem when a smaller design is added onto, but in these cases at the very least a background can be brought behind the older tattoo to include it in the new larger layout. Fig. 91b is a variation where the dragon and clouds were designed at the same time, allowing them to be drawn in a way that interacts and overlaps more. This makes for a more dynamic interaction of its elements in addition to giving the design more depth.
2.8) Lighting and Luminosity

Like depth, lighting is a great effect that has a strong visual impact that can bring life to the tattoo. Lighting effects can be used to simulate convincing texture, create a realistic illusion of dimension, or simply bring attention to an important element. It can be used as language, as well: A holy light coming from above, a sinister light coming from below, or a transcendental light coming from within. Good lighting effects will add readability to a piece and help balance its light and dark areas, keeping the design from getting too dense or too wishy-washy.

There are a variety of tools available for simulating luminosity. For starters is the use of both color and value contrast, whereby the lightest colors and white are reserved for the light source, while the darkest tones are saved for the shadows. We also have the surfaces and objects within the composition, and how the light plays over them, including cast shadows and other shading effects. Objects can be placed within a design in just such a way that they describe the lighting situation in a way that's the easiest to read.

The Light Defines The Form; The Form Defines The Light

Light and form are two sides of the same coin when it comes to using light to define the dimension of an object. On the one hand, the light playing over the surface of an object will create areas of highlighting and shadow on that object that define its mass and character. On the other hand, the way the light hits the objects in a design shows the viewer where the light is coming from, along with the color and quality of the light. So when you are shading an object, you are doing two things: you are describing both the object and its light source.

Another important luminosity tool is light rays, such as the big open ones in Fig. 53a and the smaller ones in Fig. 46b. Light rays are not only effective in suggesting the strength and direction of a light source, but when used just right they invoke a sense of beauty and awe. For example, when we're outdoors and we see light rays breaking through the clouds, it can be a breathtaking experience. Rays can also be used to separate layers of a design, making the depth of the piece more readable. Last but not least, light rays are a great directional element that can be used to focus the viewer's attention, which can add visible energy and graphic structure to a tattoo.

The light rays in this design do many things: they silhouette the main figure, making it stronger; they pass through elements in the design, demonstrating depth and clarifying relationships; most importantly, they tie together all the different elements in the design and give it an overall compositional flow. Notice how the light rays are a variety of different widths to keep them from looking stiff and unnatural.
If you're ever unsure about the way light should play over an object, try to simulate it in real life and then translate what you see into the tattoo design. In a case of a design like Fig. 95a, you could stand in front of a mirror with a small lamp and hold your hands around it to see what the lighting on them looks like, moving them around to see what changes different angles of lighting make. You can even snap a couple of photos of your hands in these lighting conditions, and refer to those photos while drawing the design. Have a friend pose for a photo shoot if it will give you better references to work from; most figurative designs will benefit a great deal from this.

The tattoo in Fig. 95a uses a wide variety of tools to convey luminosity. The background and the parts of the figure facing away from the light source are in deep, cool colors which strongly contrast the bright yellows and whites of the light source; the deep cool colors in the figure and in the background are separated by layers of flowing negative space. Next, the character's skin is textured, creating opportunities to light and shade the texture so that all the surfaces facing the light source are lit the brightest, with black and green shading on surfaces facing away from the light source, along with some areas of strong black on the larger body parts. These textural lighting effects are especially effective with the character's face, which is lit clearly from below. The hands are placed in such a way that only a thin edge facing the light is illuminated, while the rest of each hand is silhouetted in shadow.

Light rays were also used in this design, which adds to the glow effect and helps create a relationship with the objects around the rays. You'll notice how the rays pass in front of the legs and behind the hands, helping to establish their relative positions in space. These rays are kept short and feathery, aiding the sense of luminosity without blocking important structural parts of the design.

The glowing shape in the center has a light pos-on-neg relationship with the glow around it, kind of like the gem pictured back in Fig. 46b. This gives the shape strong clarity, especially with the use of a white outline around its outside. Other tattoos in this chapter use a neg-on-pos relationship for their glowing shapes. Both approaches work, provided the colors in the light source aren't too dark.

Neg-on-pos light sources generally will be more realistic, as light sources in real life are all neg-on-pos. However, pos-on-neg light sources can be a graphic necessity in some cases, such as any objects with bright coronas of light surrounding them. Either way, be sure the light source is bright enough and the surrounding environment is shaded in a way to make the identity of the light source obvious.

Secondary Lighting is a second light source, usually much dimmer and in a contrasting color to the main light source, which helps keep the shadow areas in the design from becoming too dark or hard to read. Most of the pieces described in this chapter have warm main light sources and cool secondary lighting.

Proper light and shading effects are automatically recognized by the brain. Because of this, lighting illusions are far less effective when the use of light is highly stylized and less realistic than if the lighting bears some resemblance to reality.
Fig. 96a is a relatively simple example of a neg-on-pos light source. True white is reserved for the glowing object, along with oranges and reds, which leap forward from the green and tan background. Apart from being the lightest object in the design, it is also established as the light source by the shading and highlighting on the surrounding organic textures. By making the surfaces on the far side of the object light and the ones on its near-side silhouettes, the orange shape is defined clearly as the composition’s light source. To make the effect even stronger, the silhouetted areas incorporate cool blue secondary lighting to contrast the warm illumination while edges of yellow and white face inward toward the light source. Textures throughout the design are lit and shaded to help strengthen the lighting effect.

Fig. 96b is a more complex example of a neg-on-pos glowing shape. Like Fig. 95a, this light source employs rays as a graphic element. But this time, instead of taking the yellow and white of the rays all the way in to the light source, which would make a pos-on-neg light source necessary, the rays fade to a medium pink as they come up against the outer edge of the glowing shape, kind of like the rays back in Fig. 75a. Then the light is played over the surrounding surfaces, which are structured and faceted as opposed to the organic environment in Fig. 96a. The chrome petals are facing away from the light source, so they are mostly reflecting the blue secondary lighting; we see yellow highlights only along their uppermost edges. The petals visible on the far side of the flower are catching the light full-force, so they’re colored mostly yellow.

To help make the light source and its surrounding illuminated surfaces appear bright, plenty of deep and medium cool colors were used in the background. To avoid making the tattoo too dark or dense, negative space streams were brought through the foreground, giving the piece some S-curving flow and suggesting that the lotus in the design is spinning. In addition, other streams are flowing behind the flower, giving the tattoo more depth.

Whether your light source is visible in the tattoo or not, it’s critical that your light rays all appear to converge on one point. The easiest way to be sure of this is to choose a point somewhere that will be your light source (this can be inside your composition or at the far end of your drawing table) and then use a ruler to make sure every ray follows through in that direction. Rays that aim in random directions will look dopy and unrealistic. (The one exception: Underwater scenes, since water can reflect light in unpredictable ways.)

The direction and color of a light source can do a lot to establish the mood and psychological space of a piece, and lighting from below has a particularly potent effect to it. Our eyesight evolved in a natural situation where almost all light came from above. Because of this, light from below can produce a mood that is morbid or otherworldly, and this can be a very potent graphic tool.

On-Camera vs. Off-Camera Light Sources
In this chapter, most of the light sources are visible as glowing objects in the composition; these can be referred to as on-camera light sources. Others tattoos, such as the one on the following page, Fig. 98a, show the effect of the light without showing the actual light source; these can be referred to as off-camera light sources. In both cases, the original and effect of the light must be considered while shading the piece, but an on-camera light source can bring an added sense of illumination to a design (along with additional design challenges). Typically, light sources are kept off-camera in most tattoo designs; only in particular cases is the light source desired as a visible compositional element.
Fig. 98a is an example of the classic ripping-through-the-skin demon tattoo design. To bring this piece to life, strong texture and convincing lighting are used to give the form as much reality as possible. In this case, lighting the design from below is meant to suggest a fiery underwater, with red and orange light striking the face and horns from a hidden light source below. Textures and other details in the design catch the light and help show the form of the face. Eyebrow spines cast shadows upward, and strong shading along the tops of the horns help define their form and give the piece power. For extra dynamic range, small amounts of cool secondary lighting are used in the edges of the head and horns facing away from the light.

The tattoo in Fig. 98b shows a dark interior space. The green light implies a sense of discovery or enlightenment, where a red light would have seemed lurid or sinister. Rays from the glowing orb help separate it from the background and establish it as the light source in the composition. Light and shadow play over the surfaces of the skull and bones, including a strong cast shadow being thrown upward from the head onto the chin (cast shadows are always on the opposite side from their light sources). Purple shading contrasts the yellows and greens. Areas of negative space stretch across the design, adding to its movement and helping give the piece a lighter look, which was the client's preference.

Negative Space or Solid Color: Which Is Best? Many of the tattoos I do are handled like paintings, where every square inch of the skin is used in order to make the most of the lighting and shadows. This is fine as long as the piece has plenty of contrast and movement, selective use of black, large dark and light areas and all the other tools used to make a design strong. But some tattoos call for use of negative space, either because of a client's preference or due to a graphic requirement of the design. Either way is legitimate, as long as the strength and clarity of the design are considered first and foremost.

The alien character in Fig. 99a is lit from below, but invokes a completely different feeling than either Fig. 99b or 99c. In this case, it is a cool outer-space light being emitted from the planet Earth. Although the continents and oceans are visible, all detail fades to light color and then white near the planet's top edge, making it light enough in value to appear as the light source in the composition. The alien is lit from below, as suggested by both the shading and highlighting on the head and hands. Textures on its big round head contribute to the sense of directional lighting; notice how each bump is lit from below and shaded from above. An edge of medium blue outside the black shading on the head gives it more roundness and a better sense of mass and volume, by reserving the black for the alien only, the remaining elements in the design remain soft and vibrant.

The electrical discharge around the head is kept in plain skin, since white or yellow would have been too much contrast with the lighting effects in this design and could have made the piece appear more dense.

You can learn a lot about how light and form interact by observing real objects with real light falling on them. The better your light references, the more convincing your lighting effects will be. Even just a few small drawing or painting projects incorporating real lighting effects from reference can help to broaden your drawing vocabulary and make your library of effects more versatile. For more on working with references, see Part IV.

Sometimes a design will call for a 3D geometric shape of some sort such as a jewel or a nautical star. To give these kinds of elements the strongest visual effect possible, it's good to light and shade them in a realistic way.

Let's start with a basic cube, with only 3 sides visible at any given time (Fig. 99b). If the light is coming from the upper right of the cube, it's easy to figure out that its top side will have the most light hitting it, the right side the second most and the left side the least (Fig. 99c). If the same light source is moved down and to the right to a point where more light is hitting the right side than the top, the relationship of the shaded planes reverses (Fig. 99d). At one point in its journey from upper right to lower right the light will strike the top and right sides equally, creating a thin highlight along the edge between the 2 planes (Fig. 99e). In order to make the relationships between the adjoining...
facets visually clear, subtle gradations are used within each facet that help clarify the pos/neg relationships of each edge. The only pos-on-pos or neg-on-pos relationships will happen in the case of light hitting 2 adjoining facets equally, as in Fig. 99c, or 2 facets facing away equally from a light source, as in Fig. 99f.

When a computer is used to create solid objects in virtual space, the light and shadow on the object are simulated using a process called ray tracing, where a light source is mathematically generated and aimed at the object, producing a convincing illusion of light and shadow. We can use this same process in our own minds to envision light and shadow on simple objects. This is especially true in the case of faceted objects, which are made of simple planes arranged in clearly understandable relationships to each other.

Now let's consider a more complex faceted object. The gemstone in Fig. 100a has 3 distinct levels: (1) a flat central face, (2) an intermediate angled level, and (3) a third level, which is angled furthest away from the flat face (see cross section in Fig. 100b). To figure out the lighting effect on each facet in each level, we must consider both the angle (Fig. 101a) and the pitch (Fig. 101b) of the light source. It's not quite enough to know if the light is angled from the upper right; for instance, it's also crucial to know if the light's pitch is closer or farther away from the observer. Having an awareness of both these factors is important when creating dimensional lighting effects.

When the light source is striking the edge of the gemstone (Fig. 100c) the most brightly lit facet will be in the third level (Fig. 100d). With the pitch closer to the viewer's point of view, the second level ends up having the brightest facet (Fig. 100e, 100f). If the pitch and the angle are brought straight to the center, so that the viewer's point of view is the light source (like a camera with a flash), the flat face becomes the brightest facet and the remaining facets are shaded equally and symmetrically, with their value determined by how far they are angled away from the center face (Fig. 100g). In all cases where there is one facet catching the most light, that facet will have pos-on-pos relationships with all of its neighboring facets.

If the pitch of the light is brought back to the edge of the shape like in Fig. 100c and its angle adjusted so that it strikes two facets equally, we get that white line between them like we did with the cube in Fig. 99c, with soft gradations in the two adjoining facets that support that white line without making those facets too dark (Fig. 101c). If the pitch and angle are adjusted so that the light strikes a number of facets equally, we end up with a few white lines converging on a white point (Fig. 101d).

Another variable in a potential lighting scheme is the sharpness of the light source. If the light source is soft and ambient there will be more light striking all of the facets, which results in less shadow (Fig. 101e). Alternatively, if the light source is made sharper and more concentrated, there will be fewer brightly lit facets and more shadow (Fig. 101f).

With these 3 variables to play with, visualize this simple gemstone in your mind's eye with the pitch, angle and sharpness of the light source moving through all different combinations of these variables. Watch the show behind your closed eyelids as the light source moves around, changes color and intensity, first soft and then gradually sharpening. Rotate the object in the virtual space of your imagination as you would rotate a real object in your hands. Watch the patterns of light and dark change on the object's surface, occasionally glinting as a facet momentarily catches the light source head-on. Your brain has the computing capacity of a billion iPhones;
Any artist who works hard at getting lighting effects right will eventually be able to create good lighting without so much conscious and systematic thought. The way objects interact with light sources is something that can eventually become second nature. But in the beginning, following lighting guidelines or working from good reference material will go a long way toward making it easier to get an intuitive grasp on how lighting works.

In tattooing, the way light plays over surfaces is just one way of creating a luminosity effect. Here's a brief summary of the lighting tools discussed in this chapter:

- Making an on-camera light source the lightest and brightest object in the composition, and reserving most true white for the light source.
- Using light rays around the light source to establish the light direction and to focus attention.
- Shading and highlighting the objects in the environment the right way to support the lighting effect, whether those objects are organic or geometric.
- Bringing objects in front of the light source in place, and silhouetting those objects.
- Using bright highlights along the edges of objects facing the light source.
- Fading black outlines to color lines as objects pass in front of light sources.
- Using secondary lighting, much dimmer and in an opposite color to the main light source, on surfaces facing away from the main light source.

These tools can be used together with the depth tools in the previous chapter to create deep, vibrant and dynamic tattoo designs that jump off the skin. These depth and lighting effects can be combined with a good flow and fit, clearly realize the pos/neg relationships, strong use of priority and good contrast. No matter what your style or your graphic sensibilities, when you make use of these tools your work can’t help but stand out and be noticed.
Part II Review Questions

1) Why are flow and fit important?

2) How can the flow and fit of a design be a significant aspect of its subject matter?

3) What kind of movement fits the most naturally on the body?

4) Where are the best parts of the body for symmetrical designs?

5) What is a good method for taking a tracing of a client’s body part?

6) What is the purpose of a construction drawing?

7) If dark is the opposite of light, what is the opposite of flow?

8) What is tattoo’s silhouette, and what factors affect it?

9) Does “Pos-on-Neg” refer to a light shape on a dark background, or a dark shape on a light background?

10) Are positive and negative relationships determined by the relationship along the edges of a shape, the average overall weight of the design elements, or both?

11) What kind of pos/neg relationships are likely to be the least readable?

12) What is a dynamic pos/neg relationship?

13) What does it mean to use the full value range?

14) Is more dynamic range preferable in the foreground or in the background?

15) What two factors are responsible for dynamic range?

16) What kind of colors have the most contrast with each other?

17) What’s a good way to use warm and cool colors to give a rounded object a sense of volume?
PART III

Working in a Second Medium

3.1) A Broader Perspective

These days, many of the artists attracted to becoming tattooists already have some kind of art background. Some were comic artists, others commercial artists. Some were art school graduates, others art school dropouts—and many, like myself, had no formal training but had always done art to some capacity, such as punk rock fliers, custom leather jacket decoration or album cover art. There are also tattooists who had little or no real experience in any artistic medium before apprenticing, but were sufficiently interested in the craft to really put in the hours and do the homework, and go on to do a good deal of experience in a short time. Once established in the tattoo profession, though, the one thing that the vast majority of tattooists have in common is that skin art is just about the only kind of art they do.

It’s easy enough to understand how a beginning tattooist needs to wear blindsers and shut out pretty much everything else while they focus on tattooing’s steep learning curve. There are just so many things to learn and only 24 hours in a day, so remember walking home from work during those first few weeks in a state of shock. It’s extremely rare to find tattooists working in any other medium during their first two years, and we can hardly fault them for it. But there does come that time when we’re comfortable enough with the basic tattoo process that we may have room in our brains for a little more. At that point it’s time to broaden our horizons by working in a second artistic medium.

There are many reasons for this. For starters, we have a freedom in drawing or painting that we don’t have in tattooing; we can work with whatever subject we want, at whatever size, in whatever color scheme, without someone else’s requirements to limit us. While working on our personal projects, we have no one else’s expectations to live up to and can focus on exactly what we’re trying to accomplish without each stroke of the pencil or brush being burdened with duty or obligation. We even have the freedom to leave a project forever unfinished if necessary, and move on to something more promising—let alone doing this to our tattoo clients is, of course, out of the question.

Another big advantage to working in a second medium is that a project can take as many consecutive hours for as many days or weeks as necessary without the client running out of money or going into shock. This is an opportunity to really “get into” our subject, and I believe that one of the greatest experiences an artist can have is to become fully immersed in a project. Artists actually can only immerse themselves in a tattoo project for so long before the client has to go home.

Personal art projects are a chance to get familiar with an unfamiliar subject matter, or even just to broaden our perspective on a familiar one. These projects facilitate free experimentation without any risk, allowing us to expand our vocabularies with our successes without burdening anyone else with our failures.

Although it’s great to get proficient in a second medium for its own sake, a greater goal is to nurture a relationship between two mediums where they complement each other. Tattooing has many benefits that are not to be...
Sometimes a carefully planned design that was created only for the purpose of being painted will also end up becoming a tattoo project, often as a result of a regular client seeing the painting and requesting it on their skin. However, it’s not uncommon for a project to begin as a tattoo design, usually with some of the client’s request as a major influence in the design, and later become a painting, like the project shown on the facing page.

When working in a second medium, artists bring with them all the things they’ve learned about design layout and fluid composition, all of the precision and steady-handedness, and the whole vocabulary of design ideas that tattooing has offered them. From their second medium they bring back to tattooing their new-found freedoms, their fine-tuned experimental successes, and the surprises that their personal artistic spirit introduces when left to run unchained, exploring what it pleases.

Each medium has its own unique approaches and methods, some of them similar to tattooing technique and others that are quite different. Drawing with ink and/or colored pencil is closely related to tattooing in its hand movements, from making lines to rendering gradations. Painting is very similar to tattooing in that they both have palettes of wet colors laid out that the artist can dip into and mix on their brush or tube. I have found that painting has allowed me to have greater freedom with my color use when I tattoo. Sculpting can give artists a better understanding of the 3-dimensional form, both of the body itself and of dimensional effects that they create in the skin.

Regardless of what we choose, working in a second medium is sure to open our eyes to new possibilities, reach our hands a new variety of movements, broaden our graphic vocabulary in unexpected ways, and give us more artistic freedom in general.

Advantages of a tattooist working in a second artistic medium:

- You can experiment with things that might not work well on skin
- You can work on a project at any convenient time without budget restrictions
- Tattoo clients bring in fresh ideas that you may never have thought of, which can translate into work done in your second medium
- Working in an alternate medium can widen your perspective, bringing fresh insights and approaches into your tattooing
- The freedoms of your second medium will help you find new ways to handle your tattooing technique, giving your work a more unique and personalized look
3.2) Examples of Other Mediums

There are countless different artistic mediums available to us, each with its own unique strengths and weaknesses, both visually and in terms of user-friendliness. All of them are satisfying in their own ways, but for the purpose of this book we'll try to stick to those which have a close enough relationship to tattooing for them to be of some specific benefit to our tattoo technique.

Colored pencils are already a part of most tattooists’ lives, and those of us that have worked with them have likely noticed how similar working with them is to tattooing. When sharp, they are like a tight 3; after working with a sharp pencil for a minute or two, its point becomes more like a loose 5, and can be used for both detail and larger gradations. As it gets duller, it becomes similar to a magnum; you can even purchase 1/4” (6mm) colored pencil sticks for laying down large areas. Colored pencils are great for flash, T-shirt designs and any other work that requires a tight, refined look, but can also be used for looser, more abstract art.

One major difference between colored pencils and tattooing is that, while we work from dark to light to avoid staining while tattooing, it is the other way around with colored pencils. If we have an area of dark purple or black pencil already laid in and bring yellow right up into it, some of that dark pigment can be picked up at the point of the pencil and smeared into the field of yellow—and unlike tattooing, these stains won’t heal out. Color smears can be avoided by working in a general light-to-dark direction, although sometimes this kind of smearing can be used as a desirable blending effect.

If you’re serious about colored pencils, I recommend Prismacolors, both in pencil and in stick form; they are softer and lay down more with less effort than harder pencils. They are easy to blend by layering over each other, and with a little practice they can be made to achieve smooth gradations (Fig. 111a-111c).

For the most labor-intensive colored pencil drawings I recommend using illustration board instead of paper, which gets crumpled and dog-eared. It’s good to use a board larger than the actual drawing so there’s an area to get tape marks and thumbprints all over. Try out a few kinds of illustration board to find the one you like the best. You’ll want something slightly rough, too smooth and it won’t accept the color well, too rough and there will be deep pits in the paper that can’t be filled with color, leaving countless tiny white marks in your otherwise smooth gradations.

There are significant differences in the quality and receptiveness of the different illustration boards available. It is definitely worth your while to experiment with different boards—your local art supply store may have samples on display that you can doodle on.

Some projects involve making the final drawing on tracing paper, since most tattoo drawings typically involve several layers of tracing paper getting taped down over each other as the drawing gets developed. When planning a fully rendered colored pencil drawing as the final layer, using a heavy vellum instead of regular tracing paper makes
the drawing was more durable and less likely to crinkle or tear, while still offering most of the transparency that tracing paper allows. You'll want to make the final rough layer of your drawing dark, clear, and as readable as possible before the vellum gets taped down.

Colored pencils can be hard on the hands, since it's usually necessary to bear down on the board to get good color saturation. I actually find that working with pencils of any kind is far rougher on my poor little hands than using tattoo equipment, so if wear-and-tear of the hands and wrists is a factor in your life, you may want to consider a different medium.

Since colored pencils offer unique qualities not found in other mediums, I still find them useful for finishing color tattoo design renderings. To minimize wear and tear on the hands, I have adopted the habit of doing most of the coloring in the computer using Adobe Photoshop, then printing the drawing on high quality matte inkjet paper and finishing it with the colored pencils. In addition to making it easier on the hands, this method can save a lot of time as well (see Chapter 5.3 for more on this method).

When working with soft colored pencils, there is an option to use an oil painting medium called Liquin and a paintbrush to blend the colors (try this on a small experimental piece first, not something you've labored on!) For the first few seconds after applying the Liquin with a soft brush, only the loose crumbs of color on the paper's surface will respond to the brush. Then the Liquin works its way into the deeper layers of color and makes the pigment more workable as well. After 15 or 20 seconds it will have softened the color all the way to the paper, making it possible to lift the color off the paper but also making it harder to blend. With this short of a time window available, it's best to only wet down a small area of the drawing at a time.

When working with soft colored pencils, there is an option to use an oil painting medium called Liquin and a paintbrush to blend the colors (try this on a small experimental piece first, not something you've labored on!) For the first few seconds after applying the Liquin with a soft brush, only the loose crumbs of color on the paper's surface will respond to the brush. Then the Liquin works its way into the deeper layers of color and makes the pigment more workable as well. After 15 or 20 seconds it will have softened the color all the way to the paper, making it possible to lift the color off the paper but also making it harder to blend. With this short of a time window available, it's best to only wet down a small area of the drawing at a time.

Bold Lines in Your Colored Pencil Drawings: Some Suggestions

Often colored pencil drawing will call for black lines, possibly thick, dark colored lines. Since colored pencils are partially opaque, light pencil that accidentally gets on top of black lines is quite visible and can make the drawing look less clean. This is especially true if you draw the lines on with black ink before adding the coloring. However, you can add ink lines after the colored pencil is in place, since the waxy pencil finish will repel the ink.

The simplest solution is to make a final pass over the lines with black colored pencil when you're done coloring. This even have the option of doing the lines entirely with black colored pencil and saving yourself the step of inking them in the first place.

There are a wide variety of stick-type mediums, such as pastels, charcoal and Conte crayons. These mediums can be satisfying for anyone feeling the need to work large, especially after all the tiny precision of tattooing. They are great for filling large areas and creating long, smooth gradations. Although they have fewer parallels to tattooing than colored pencils do, they allow for a lot of freedom and can give our intuition a chance to loosen up.

Pastels are similar to colored pencils, but are bigger and softer. They can be layered more than colored pencil and allow for light-colored highlights to be placed on top of darker colors. Pastels are usually oil-based and can be blended with fingers, paper towels, Q-tips or blending stumps, but are hard to lift up or erase. Because they're big and soft, it's more difficult to create sharp edges or precise detail with them. However, there are now some companies marketing thin pastels that look sort of like fat colored pencils, with a core of pastel stuff inside a wooden pencil.

Charcoal is a good classic medium for doing large drawings. We can lay down heavy blacks with charcoal, then use a variety of tools, including our fingers, to create long, smooth blends and gradations. Charcoal sticks can be sharpened more easily than pastels and can be used for fairly precise detail. It can be erased and lifted, making it possible to create subtle or sharp highlighting effects after most of the charcoal has already been laid down. Art supply stores carry electric erasers, which can be used to draw precise white highlights in a charcoal drawing.

Conte crayons are a bit like charcoal but slightly waxier and richer. They are available in a variety of colors, but most artists are familiar with the rich reddish earth tones they are commonly used in. Conte crayons are great for portraits, lending the work a classic-looking sepia tone. They don't lift as readily as charcoal, and can be sharpened almost as much as a colored pencil. Since the sticks they come in have a square cross-section, the square corners can be used as sharp points without having to use a pencil sharpener.
Since stick mediums can be worked with quickly, they are ideal for figure drawing from a live model. Live figure drawing has been a staple in classical art education through the ages and is always a healthy education for any artist, regardless of what style they choose to specialize in. Working in a live drawing situation can help artists develop a more intuitive and accurate sense of proportion and a clearer ability to identify and accurately express 3-dimensional objects in their respective positions in space. In a nutshell, live figure drawing is practically guaranteed to make you a better artist on all levels. See page 110 for more on this subject.

Ink wash and watercolor are two other mediums that have classically been used by tattooists through the ages. Most old flash was done this way, in a technique known as “ spit shading”, although these mediums are appropriate for anything from landscapes to portraits.

Watercolors can be very bright and luminous. More than most other mediums, watercolors rely on reflectivity of the white paper to provide this luminosity. To do this, these colors must be very translucent, basically just staining the paper, they can only be layered to a limited extent without getting a muddy look or shedding the paper.

The key to using watercolors is to wet the paper before adding the color. To have the most control over the color, it’s best to only wet the paper in the area that’s about to be worked. Let’s say that you’re painting a landscape and you’re ready to paint a rock in the scene. Start by using a clean brush to fill the rock in with clear water in a thin, even coat (Fig. 114a). Next, drop a small amount of color into the part of the rock that’s going to be the darkest. The drop of color will spread quickly through the thin pool of water, but will stop dead at the dry paper, creating a clean edge (Fig. 114b). Then, while it’s wet, blot the brush dry and use it to move the color around in that pool, taking advantage of the amazing amount of subtle control the wet paper provides (Fig. 114c, 114d). As long as the area is wet, you can keep dropping in color and moving it around, provided you’re conscious to not shred the paper.

Ink wash is basically like watercolors, but without the color (Fig. 115a). It is a good medium that allows for deep blacks and smooth gradations, providing easy access to the whole value range. With a little practice, these effects can be done quickly and almost effortlessly, using techniques very similar to watercolor painting but also potentially incorporating the use of quill pens and other ink drawing tools. It can be an ideal technique for graphic art designs such as flyers and T-shirts, and is an attractive way to shade black and gray flash.

Quill pens have many good qualities but also can be unpredictable, drying out at inappropriate times or suddenly dropping a blob of ink while rendering line detail. There is also the option of rapidograph pens, which are easier to control but can blur and require maintenance. Quill pens allow for easy variation in line weight, which is sometimes desired. However, when a consistent line weight is what’s needed, rapidograph pens are the right tool for the job. Each type of pen has its pros and cons.

Fig. 115a

Fig. 115b

Quill pens come in many sizes and are a classic method of doing lines and details in ink. Thin brushes are good too, but require more control and give a less consistent line (which can be desirable too, depending on the circumstances). These pens can be used for the black inks, or for many vibrant colored inks available. For colored inks I recommend Dr. Martens (not to be confused with a popular line of boots!).

Once an ink and watercolor piece is finished, there is also the option of working over it with colored pencil, either for select finishing touches or for a whole extra layer of detail (Fig. 115b). Since watercolor is so great for filling large areas, we can spare our hands the stress and do the big chunks of color this way, then switch to colored pencils to add detail and character.

Nowadays many artists, including tattooists, have begun using computers as an artistic outlet. There is some debate over the legitimacy of digital art, but many artists feel that any tool that allows them to accomplish more with their productive time is legitimate. In my own experience, the computer has been an important and valuable tool that gets almost daily use in my life as an artist.

Using a computer, images can be developed from scratch, either in a painting program, like Adobe Illustrator or a 3-D modeling program like Bryce 3D. Alternatively, existing images from photos or drawings can be imported and then customized in Adobe Photoshop, which is one of the most important image manipulation tools ever invented.

Computers are great for cleaning up our portfolios and making our presentation slicker in general. In addition, they can be used for tattoo design and stencil preparation, as we’ll discuss in Part V. There are countless things we can do with them, once we get past that steep learning curve.

When looking at an instruction manual for a new program, our eyes glaze over and our thoughts drift to simpler, nicer things. It can be like sitting in a classroom under buzzing fluorescent lights, looking at a textbook on Classic Latin 101. The people who write these manuals have a bad habit of assuming you’re in on their lingo, and it’s
easy to get discouraged when we don't comprehend everything we're reading.

My recommendation is to go into learning a computer program with a specific goal in mind, some type of program that the project is appropriate for. While you read the manual's introduction and its first few chapters, take organized notes, keeping track of which tools and menus seem pertinent to your project. Then, refer to the manual's index to look up answers for specific questions as you attempt to work with the program. Most programs also have a Help feature where you can type in basic questions and find short discussions on many topics. Usually, between using the manual, referring to the help features and taking careful notes, you'll figure it out surprisingly easily. If not, there's always Tech Support, or late-night frantic phone calls to computer-savy friends of yours.

The more familiar you are with the various menus in your program, the easier it will be to understand the things described in the manual. Often you can figure out answers to many of your questions simply by exploring the menus and looking for potential options that could accomplish what you are attempting to do. The more familiar you are with the menus, preferences and tools, the less you'll need to rely on help of any kind.

By having a modest project as a goal, you can get functional in the program without memorizing the whole 300-page manual. Soon you'll be able to find your way around in that program well enough to try more advanced things, keeping the manual at your side for those tricky parts. Eventually you can lose the manual altogether, and I would have to say from experience that the more programs you learn, the easier it gets to pick up other new programs.

Using a computer is very different from tattooing in terms of the technical side; in a few clicks of the mouse you can transform a mundane image into a dazzling kaleidoscope of color and texture, while a tattoo must be done slowly, one tiny piece at a time. Digital art won't necessarily teach us new hand motions or ways of blending colors, like the more hands-on artistic mediums. Nonetheless, it has so much to offer to our graphic vocabulary that it's a hard medium to ignore. We'll go into this subject in a fair amount of detail later in Part V.

Scratch Art: Tattooing's Inverted Half-Sister

Some of you may remember back in grade school, making scratchboards by covering paper with crayon, then India ink, to make a surface that could be "drawn" on by scratching with a stylus. Most artists don't realize that scratchboards are now available in art supply stores that are a highly refined, responsive and versatile graphic art medium. They can be drawn on with almost anything: A sharp stylus, a wire brush, steel wool... and yes, even with tattoo needles, which create interesting effects.

In 2007, hundreds of tattooists participated in a group show featuring scratchboard art. Apparently the medium is one that tattoo artists seem to work with quite naturally... Is one-shot nature and the fact that the surface is sharp and impurities make for many parallels between it and the tattoo medium. If you are a tattoo apprentice, I recommend trying scratchboards to strengthen your precision and planning skills.

(Pictured, clockwise from upper left: Peter Udvari, Sabine Gaffron, Shane O'Neill, Aaron Cain)

Underpainting is the act of putting down a simplified foundation for your painting, often in acrylic and usually in a limited color scheme, before starting the oil painting process. This preparatory step can result in the need for fewer layers of oil paint, which will make painting less likely to yellow or crack with the passage of time.

Acrylic Paints Are Easier To Use Than Oils... Or Are They?

It seems that most artists who choose to start painting for the first time assume that they should begin with acrylics, since they are supposedly easier to work with. In reality, it can be tricky to get good blends and subtle effects with acrylics without a fair amount of experience. Their quick drying time limits their workability, and you cannot blend new color with color that's been on the canvas for more than a few minutes. Without a few good pointers on how to paint successfully in acrylics, the experience can be discouraging for someone first learning to paint.

Oil, however, has different strengths and weaknesses than acrylics. Their prolonged drying time is both a blessing and a curse: the paint remains nicely workable potentially for hours, allowing for far more control over its blending, but sometimes this same slow drying time can get in the way of progress and can make for a muddy appearance. Again, experience will show artists how to make the most of the medium's properties.

There is one thing about acrylic painting that's a little easier... and that's the clean-up, which is a simple soap and water procedure.

Of all the artistic mediums available outside of tattooing, painting is perhaps my favorite and has taught me the most. Working with paintbrushes is similar to using tattoo equipment, but with a whole extra degree of flexibility and intuitiveness. Use the paint, artists can lay down color in great quantities or in minute amounts; they can work quickly over a large area, or labor for months on something tiny. Unlike many other mediums, paint allows for light colors to be placed easily over dark colors, a freedom that tattooing definitely doesn't have.

The two major types of painting we'll discuss here are oil painting and acrylic painting. Both are common mediums, and are readily available almost anywhere that sells art supplies. Oils and acrylics have similar texture, opacity and transparencies, and use similar pigments. The major difference between them is in their workability and drying time.

Since acrylic paints are water-based, they dry quickly, especially when applied in thin enough layers. This can be very advantageous for layering color, but makes it harder to blend different colors together and get smooth gradations. It can be great for very precise or detailed work, as artists can rest their hands directly on the canvas and get right into it. Many famous artists, such as Todd Schorr, use acrylics and get beautiful, detailed, vibrant results.

For a long time I had a clear preference for oil paint. I like the workability of a medium that stays wet longer, since it's so much easier to get good blends. But after doing enough serious painting in acrylic, I eventually found ways of achieving similar effects. I like the rich glossy finish the oils dry to, but this can also be obtained in an acrylic painting using acrylic gloss medium. I assumed that the pigments themselves in oil paints were richer, purer and more vibrant than in acrylics, which tend to look more plasticly. But with enough experimentation it has become clear that very equivalent effects can be achieved in both mediums. The main difference is in the process, not the end result.
Oils have been around much longer than acrylics and have a rich history of centuries worth of trial-and-error. There are many secret formulas and recipes for the ultimate oil painting medium, but I usually try to keep my procedure as simple as possible so I can concentrate on putting down the paint. However, since acrylics have their own strengths, I sometimes take advantage of these by doing an acrylic underpainting before applying the oils. This can make it a little easier and faster for me to render the first pass on complex geometric shapes or other things that require a lot of precision. When I do this, I try to keep the acrylic paint as thin and waxy as possible, as not to create a thick plastic layer on which the oils might be reluctant to bind.

At any rate, it can be helpful for a painter to be fluent in both acrylic and oil painting, since each medium has its own strengths and weaknesses. Having comfortable control over acrylics also makes it possible to do sophisticated underpainting work for your oil paintings. With this in mind, what follows in Chapters 3.3 through 3.5 should help familiarize novice painters with a few simple techniques to help get started. Before beginning, though, I recommend that you read through to the end of Part III, where you’ll find some helpful hints for preparing your space and getting started.

You Can’t Use Acrylic And Oil In The Same Painting, Because Oil And Water Don’t Mix!

It’s true that oil and water don’t mix, but that’s not what’s happening when working with oil over an acrylic underpainting. Once the acrylic has dried thoroughly, there is no water to be found. All that is left is a plastic resin that, unless applied with gloss medium, will readily accept oil paint. A thinly applied yet thorough underpainting can in fact save a few layers of oil paint, which can crack and cause other problems when applied too thickly in multiple layers.

If you have any doubts, remember that the gesso used to prime most canvases is none other than white pigment in an acrylic medium—also known as white acrylic paint.

Oil paints can be applied over well-dried acrylics, as long as the acrylics paints aren’t mixed with gloss medium. However, under no circumstances is it a good idea to apply acrylics over oil paint—the compatibility does not work both ways.

3.3) Surface Preparation: Building Your Foundation

One of the first temptations when picking up oil or acrylic painting is to go large. Why not, when it’s so easy to cover a whole big canvas in a single session? From this perspective, “small” might be a 24x36” (60x90cm) canvas. Let’s redefine “small” as tattoo-sized, 8x10” (20x24cm) or even smaller, like 3x4” (7.5x10cm). From the tattoo-sized perspective, 24x36” is quite large, back-piece sized.

The fact is, artists can learn just as much from a small painting as they can from a large one, but without the big-time commitment. If a series of paintings needs to be done in order to work through a particular problem, such as getting the lighting right in a certain texture, a whole series can be done in just a few weeks if the paintings are small; however, the same series could take two years with larger pieces. It’s hard to try a few different ways of doing something in the same painting without the overall piece looking inconsistent; so a lot of variations on a theme need to be explored, small paintings are the way to go.

I have seen this many times: Novice painters getting most of the way through a big canvas and then giving up. A common reason for this is that their technique is evolving rapidly, enough so that the canvas is covered, the earliest parts don’t match the most recent parts. Because this kind of progress and technical evolution is common in the learning stages of painting, working small is the best way to avoid the discouragement that comes from looking at a mostly-finished larger painting and realizing that the whole thing needs to be gone over again to make it look consistent. Plus, small paintings can be fun to do and most as important, affordable for your tattoo clients and their friends.

When an artist has done enough small paintings of a given subject matter to feel comfortable with it, they can then move up to medium and large pieces of that same subject. Since they’ve worked through all the major questions in a smaller format, they’ve earned the right to cruise through the big one without any major technical struggle. This is an ecstatic creative space, where the familiar process that was fine-tuned in the smaller paintings allows the artist to stop asking questions and start using their intuition, becoming one with the unfolding of the vision.

Whether working in oil or acrylic, we have the choice of a number of different kinds of painting surfaces. Stretched canvas has always been popular for a variety of reasons—it’s a lightweight flat presentation for your painting, with a lightly textured, slightly resilient surface that readily grabs paint off the passing brush. These days it’s easy to buy pre-stretched canvases at any art supply or hobby shop that are of decent enough quality. I am generally perfectly happy with your basic commercial stretched canvases, at least as far as the small ones are concerned.

On the other hand, I have been gravely disappointed by larger commercial stretched canvases, which tend to go out of whack after a while so that they won’t sit flat against a wall. Often they end up with areas near the corners where the canvas is loose, sagging inward. It’s disheartening to put hard work into a painting to see this happen. The problem comes from the fact that the canvas is stretched after the gesso has been applied, which limits how tight the canvas can be made. In addition, those cheap commercial stretcher bars aren’t thick enough to hold their shape through the years.

Gesso is the white primer used on artists’ canvases and most other painting surfaces, and is used almost universally in preparation for all types of paint. Traditionally, gesso was made with powdered marble, but most gesso today is usually white powdered pigment in an acrylic base.
If you stretch your canvas when it is raw and then apply the gesso, the drying process will help tighten the canvas to an extra degree. It is much harder to stretch a canvas tightly if it comes pre-gessoed on the roll.

So, as a general rule, anything larger than 24 x 36” (60 x 90 cm) should be hand-stretched. You can get heavier duty stretcher bars from some of the larger art supply shops, or online. There is also the option of building your own from 1 x 2” (2 x 3 cm) lumber, using crossbraces on lengths greater than 18” (45 cm) or so (Fig. 120a). This requires some basic carpentry skills; if you don’t have the space for power tools, you can get quite decent results with a small hand saw and avice box (look for the type with the movable pegs, which are a versatile and clever way of restraining any size piece of wood as you cut).

There are other options for painting surfaces besides stretched canvas. Canvas panels are a popular alternative to stretched canvas, partially because they take up much less space and are less expensive. Their working qualities are slightly different from stretched canvas, since the surface does not give way under the pressure of the brush because of the panel’s firm backing. Some artists prefer this kind of workability, though. The one major disadvantage of canvas panels is that they are prone to warping. Usually it is not very noticeable, but it can build up over the years; larger panels are more susceptible to this, which is why you’ll seldom see canvas panels over 1 x 4’ (28 x 34 cm) or so.

Some artists like to paint on gessoed paper, which has a different kind of workability from canvas. If you start with a heavy enough paper, the gesso won’t wrinkle it and the resulting surface can be fairly nice for painting. The obvious advantage of this is the price, which makes it financially feasible to whip out lots of paintings if you happen to be in a phase that calls for that kind of quantity. Gessoed illustration board is a much heavier paper alternative, less likely to warp or wrinkle, and can be a very nice surface.

Wood, Masonite and Clayboard can also make for good painting surfaces. In these cases, the surface is smooth, slightly porous, with almost no tooth. High quality plywood, if sanded and gessoed, will produce a surface almost identical to clayboard. Personally, I haven’t found these surfaces to be too smooth for the kind of painting I do, but I could easily imagine varieties of much more refined work that would call for a fine texture as a surface. The disadvantage of using any kind of wood is that it can crack along its grain after the painting is done, sometimes years later.

You can prevent some cracking when painting on wood, but an artist can only have so much control over how the wood will react as it dries. The best thing you can do is let the wood dry out for a while (a year or more isn’t a bad idea) in a space that gets light and airflow, like near a window in your garage. Next, coat it, both front and back, with a shellac-based primer-sealer like Kilz (you can buy this stuff in the gallon and apply like normal paint with a roller or brush). After letting it dry thoroughly, apply two coats of gesso to your painting surface, and you’re ready to go. If the wood is mostly dry to begin with and you seal it against interacting with the moisture/dryness cycles the air in your home goes through every year, it is much less likely to crack and may last decades without any change.

Painting Surfaces: The Roughness Factor

Not all painting surfaces are created equal. Artists choose different surfaces for a variety of reasons; rough and smooth surfaces suit different styles and temperaments. Burlap has the most tooth of all common painting fabrics and produces a coarse brushstroke, but is sometimes used for its unique responsiveness to the brush. Smooth surfaces like wood won’t saturate with color as easily as the rougher materials, but allow for greater detail and refinement. You can imagine these materials as being on a scale from 1 to 5:

1) Clayboard, Masonite, sanded wood
2) Fine cotton linen, gessoed paper
3) Standard artists’ canvas
4) Coarse cotton duck
5) Burlap

Regardless of your surface material, the layer of gesso applied to it will have a noticeable impact on the quality of the surface. With small commercial canvases, the layer of gesso already in place is usually more than adequate. So, for these smaller paintings, the gesso is not even worth worrying about; these canvases are ready to use straight from their wrappers.

For larger canvases, I usually use a roller to apply the gesso, which makes for the smoothest application. A roller can be used to lay the gesso on thin or thick, so it can be perfect for the needs of almost any artist. For most kinds
of painting, I recommend using a thin-nap roller, such as a 1/4" (6mm) nap, which will apply the gesso with the least amount of texture.

Roller Stipple is the pattern left on the wall (or your canvas) by the nap on the roller. On a wall, the stipple is a desirable texture, and most wall paints are formulated to dry thick enough to preserve this pattern. When gesso dries, most of its volume is water, which evaporates away, causing it to flatten. If applied thin to begin with, the gesso will show almost no signs of roller stipple when dry, and what remains can be easily sanded out.

Paint roller sleeves will release small pieces of fluff into your gesso, creating lumps in the dried finish. You can avoid this by attaching one end of a strip of 2" (5cm) painters' tape to a pole or ladder, pulling the other end of the tape about an arm's length toward you, then running the nap of the roller back and forth on the sticky side of the tape. The adhesive on the tape will remove most loose lint from the roller.

For any painting surfaces wider than a roller, it's important that all gesso is smoothed out by the roller in the same direction. When moving a roller up and down it produces two slightly different stipple patterns, known as an up stipple and a down stipple. Even if you are applying the gesso in very thin coats, you want the stipple to be the same all the way across. With thicker coats, it's even more important.

For a smoother finish, you can get small 9" (22cm) roller sleeves that fit on special small handles. These sleeves have a much finer nap than standard paint roller sleeves, and are perfect for gesso finishes where you want no roller stipple to be visible.

Some artists, including myself, enjoy some visible roller stipple on our painting surfaces, so we apply the gesso thicker and in more coats. This can be done to the extent where the grid-like texture of the canvas is completely buried under a new organic texture created by the roller. These kinds of surfaces can require a fair amount of sanding to make them smooth enough to show fine detail, but can be extremely nice surfaces on which to paint.

The cotton weave pattern on standard artists' canvases, with two thin sanded coats of gesso, can be nice to work on as well; the majority of painters through the ages have been more than content with the basic canvas grid and haven't found all the extra gesso to be necessary.

For most of the kinds of painting that I do, I prefer to tint the canvas before I start laying out the design. This tinting normally consists of a thin coat of acrylic paint, sometimes 40-50 on the value scale, applied before the design is drawn on with colored pencil, which is how I begin the majority of the paintings that I do.

Normally this tinting is done with a color that is fairly neutral, either a warm or cool gray, easy to build up later in either a warm or cool direction. If the painting is going to be predominantly blue, the tinting will be mostly blue; a painting with a pastel color scheme would be tinted in a lighter warm gray, maybe a 25% or 30% gray. It is a larger painting that incorporates a major light source within the picture, that area is often tinted lighter than the rest of the canvas (Fig. 123a).

One reason I like to tint my canvases is because I enjoy building up light colors up from a medium background before starting with the mid-value and darker colors. With oil painting in particular, this is a good strategy for avoiding muddy paint mixes while working. It also allows me to get the canvas covered much more efficiently than if working over blank gessoed canvases, which clearly shows all of its unwanted white gaps until they are all covered with paint.

Another reason for my preference is that I like to draw my compositions onto the canvas using white colored pencil before shading with other colors. I find that this makes it easy to represent the dimension and lighting of the form with a minimum amount of drawing; we'll go much deeper into this aspect of laying out paintings in the next two chapters.

This sort of preparation is appropriate for both oil and acrylic painting, and in both cases gives the painter a good starting point from which to launch into a project.

Both oil and acrylic paints are translucent when applied in thin layers, allowing the colors of whatever is underneath to show partially through. If you are tinting a canvas for a painting where some elements require a very bright, pure color, make sure those areas are tinted in such a way that it won't be a struggle later in the painting process to get the colors you want.
3.4) Acrylic Painting: A Brief Tutorial

The small painting demonstrated in this chapter (4x5", 10x12cm) is an example of the kind of small compositions I do when exploring the abstract dimensional stuff that’s one of the mainstays of my tattoo vocabulary. First, I mix enough tint for two canvases, since I have another project to do when I’m done with this one. I mix the paint with my gloved finger, then spread it with a folded heavy-duty paper towel (Video Clip 6: Tinting A Canvas). Elsewhere nearby, the other canvas gets tinted with the same paper towel. A wide brush can be used as well, but it can sometimes be a challenge to avoid thick brushstrokes. This tinted canvas, dried, is around 45 on the value scale and is just a little bit warmer than neutral gray (Fig. 125a).

For more elaborate layouts, I will use a digital projector, and project a scanned version of my drawing onto the canvas. For this painting, though, I am simply looking at my sketches and drawing freehand onto the canvas, starting with white colored pencil (Video Clip 7: Sketching With White Pencil). Whether tracing or drawing freehand, my objective is not to put down a line drawing, but to fill in light areas with light pencil in order to establish all of the composition’s pos/neg relationships, along with the direction and intensity of all of its major gradients. The goal is to capture some sense of the volume and form of the objects in the design before the darker pencil is even used. In Fig. 125b all the white colored pencil is in place, and the image is beginning to take on solid form as the first strokes of dark colored pencil are added.

For shadows in the colored pencil layout of a painting, I normally use purple-black pencil, which is nice and dark like pure black but contains a cool purple element, making it ideal for shading (Video Clip 8: Finishing With Dark Pencil). Instead of adding lines with this pencil, shadows and gradients are sketched into place instead, continuing to build what was started with the white pencil. This is done using a light hand with a dull point on the softer shadows, while going back to a sharp point for the detail (Fig. 125c).

The finished drawing is more than just a stencil to start the painting; it has enough pigment on the canvas that it is a beginning stage of the painting itself, containing a faint preview of what the finished piece will look like. All it needs now is some paint to bring it to life.
Projectors: Where Do I Begin?

It depends on how much you plan on using your projector. The cheapest ones are the Artograph opaque projectors, which you can get at most hobby stores. These use an internal light source to illuminate a drawing or print image that you place in the projector and magnify onto your canvas. They are workable in a bare-bones budget situation, but you will quickly run into limitations in terms of how large or how detailed you can get with your projectors. You have to work in almost total darkness to be able to use these low-budget projectors. Artograph (and other brands as well) also make higher budget models of opaque projectors with brighter lamps and better projector clarity.

If you happen to have a working slide projector, it may be worth investigating. Slide projectors are much brighter than Artograph projectors, and allow for impressive amounts of detail; most can focus small and close or big and far away, which allows you to easily lay out all kinds of paintings. They have their drawbacks though: as an obsolete technology, it is becoming harder to find places that will develop slide film. You can overcome this by making a negative of your image in Photoshop (Image > Adjustments > Invert), printing it, photographing the print with regular film and then mounting the negative from this photo into a slide frame (a reversed negative makes something that closely resembles a slide of the original image). You also have the option of sending a digital file to a service bureau to have it output as a slide. However, slide projectors are fussy. Sometimes the slides shift in their trays as they heat up, bulbs burn out and are hard to replace… that kind of thing.

The 21st Century solution is known as a multimedia projector. This is an electronic device that plugs into your computer (or DVD player, or camera, or anything with a video output jack) and then projects the image, like a slide projector. Multimedia projectors (also known as digital projectors) are the most versatile out of all of your options, allowing for an image of image to be-animated, processed, tweaked and then projected. They are also much brighter than slide projectors or opaque projectors, and usually offer a wide range of projection size (from quite small to very large). Most are bright enough to project large and still be able to work with the room lights on. Projected very large, you may find that the pixelation is too coarse, so for very large detailed projects, you may find a slide projector handy. Personally, I’ve only run into this pixelation problem with one project, and it was a project involving an almost unreasonable amount of fine detail.

If you are shopping for a digital projector, look for one with a bare minimum resolution of 1024 x 768 pixels, at least 1000 lumens in brightness. As an added bonus, you can then use your projector as a home theater component when you’re taking a break from your art.

For a small canvas like this, it can sometimes be more comfortable to use a table or drawing board instead of an easel, since it gives you an easy place to rest your hand and quick access to all of your supplies (Fig 127a). I usually like to tape the canvas in place to keep it from shifting around. Within easy reach is a piece of paper towel, tape, securely down for easy brush wiping. Also at hand are a cup of clean water, brushes, a plastic plate and the tubes of paint. Apart from changing the paper towel once or twice, that’s everything that will be needed for the session.

Working with acrylic, it doesn’t make sense to pour a palette with all the colors you’re going to work with. Since most of them will dry up completely before you get a chance to use them. It’s easier to work within a single family of colors at any given time. Working on a tinted canvas, the most dramatic results come from working light to dark, so this painting is started in a mix of white and yellow ochre. After pouring moderate amounts of both colors onto the palette close together, I mix small amounts into the palette spectrums of ochre and white (Video Clip 9: Mixing White And Ochre). A small amount of water is then poured into the edge of the palette to use for diluting the paints (Video Clip 10: Adding Water To Palette).

Brushes: Using The Right Tool For The Job

Paintbrushes come not only in different sizes but also different shapes, kind of like tattoo needle groups. The similarity between the two mediums is easy to see in the comparison of brushes and needle groups.

Round brushes can range in size from a tiny point to a fat bullet shape as thick as your forearm. They compare closely to round needle groups in both appearance and use. Although there is no brush designed specifically for lining, the smallest round brushes are ideal for fine-tuning precise edges and lines.
Square brushes are great for blocking in areas of color. I like magnums and flats, they can be used to lay down smooth gradations with a light touch and smooth movements of the brush.

Filberts are my personal favorite, and are basically square brushes with rounded corners. They allow for a wide variety of brush stroke shapes and can be used to block in areas or, with a lighter touch, lay down fine detail. Many tattooists are using magnums with their corner needles pulled back to create a filbert-style profile, which can provide much of the same versatility as a filbert brush.

Other more specialized brushes are available as well, such as fan brushes. Bristle type is also a big factor; stiff bristle brushes will move paint differently from soft brushes. Personally, I prefer synthetic badger hair brushes, which are a good compromise between stiffness and softness. Windsor-Newton Monarch is a good brand.

The process of layering paint is fairly simple from this point. By diluting the acrylic paint and applying it with a relatively stiff brush, the painter ends up having a high level of control over a small amount of pigment (Video Clip 11: Beginning Stages Of Acrylic Painting). For these earlier stages, I work with a medium-sized filbert brush to apply the paint, sometimes working with the brush wet with paint, other times blotting it dry on the towel to use for blending. As it dries, more diluted paint is added in layers. In some cases, more concentrated paint is used. At first, though, the contrast of the piece is kept fairly moderate, without any focused detail (Fig. 129a).

**Scumbling** is the act of using a short stiff brush to work small amounts of paint into the canvas using scumbling motions, creating a very thin film of pigment with a fine soft texture. Scumbling is a good way to generate soft gradations with fast-drying paints such as acrylic, and is sometimes best done with old, worn brushes.

The pigments used in your colored pencils are similar in many ways to the pigments in your oil and acrylic paints, and are compatible with both mediums. What that means is that while you paint, pigment from the colored pencil drawing will lift up on your brush and mix with the paints that you are blending. I personally have no problem working with this, and in fact use it to my advantage; but if you find that this is an obstacle in your painting process, you can first spray the canvas down with two or three thin coats of acrylic matte medium, which will fix the pencil pigments in place but still leave you with a nice paintable surface.

From this, the color scheme is built up gradually with more translucent layers of diluted paint; first some shading in purples-black (Fig. 129a), then a mossy green tint (Fig. 129b), then some turquoise secondary lighting (Fig. 129c), finally rounding off the lighting effect with more deep purple-black shading (Fig. 129d), still doing everything with that medium filbert brush. Paint that is added in more distant elements is diluted, while foreground elements make use of richer pigments. By the end of this stage of the piece, the rough overall form of the vision is already coming to life (Video Clip 11: Middle Stages Of Acrylic Painting).

Next, a small round brush comes into use, and the purple-black detail is sharpened, darkened and built up (Fig. 129e, 129f), using diluted paint to work on low-contrast background detail (Video Clip 13: Purple-Black Detail). This is a stage where any shape or detail that needs more definition can be refined and elaborated on; a few minutes spent refining the detail in a small painting like this one are crucial in giving the finished piece its visual interest and appeal.

In the final stage of the painting, the same small round brush is used to apply white and ochre-white highlights.
through the painting, giving extra dimension and reality to its textures and details (Fig. 130a, 130b). This is always my favorite stage of the process, since all the work is done and the selective highlights placed through this painting are small things that make a big difference (Video Clip 14: White Detail).

Once finished, the painting can be signed, and when it's good and dry, sprayed with two or three coats of acrylic gloss varnish. This final gloss coat not only protects the paint from damage, but its glossy transparent resin gives the paint an added depth and vibrancy that you normally only see in oil paintings.

---

**Note:** Although it is possible to brush additional layers of paint over a gloss varnish finish, it will repel paint that is diluted beyond a thick creamy consistency. If you want to spray acrylic medium between your layers of paint while you work, use matte medium, which will accept diluted paint far more readily. A gloss finish can then be added when the piece is complete.

If artists can produce an oil paint finish by using acrylic paints, then why should they bother with oils at all? The answer lies in their different styles of workability. Acrylic paints are blended by layering them over each other in thin coats; oil paints can be blended on the palette, on the canvas and many other ways—in terms of blending, oils have many more options than acrylic paints. I use both kinds of paint for similar kinds of projects... but despite their parallels, they are worlds apart.

---

3.5) Oil Painting: A Brief Tutorial

Although much different in subject matter from the acrylic project, this oil painting is started using essentially the same technique; the canvas is tinted, then placed near the thumbnail sketches so it's easy to pick up the thought process where it had been left during the sketching stage (Fig. 131a). As with the acrylic project, white colored pencil is laid down before the darker pencil is added to make the white work most effectively (Video Clip 15: Sketching White In Flower). Because this image calls for more subtlety than the acrylic painting, a medium purple pencil is applied next (Video Clip 16: Sketching Purple In Flower) in order to build the drawing's contrast gradually before finishing with small amounts of purple-black pencil (Video Clip 17: Sketching Dark Pencil In Flower). Like with the acrylic painting, the finished colored pencil layout is not a line drawing, but instead is a complete low-contrast preview of the finished painting (Fig. 131b).
Different Oil Painting Mediums

Under most circumstances, oil paints must be diluted with some appropriate oil-compatible medium to be workable enough for painting. There are many mediums available, each with its own properties:

- **Turpentine** or its less toxic cousin **Turpenoid** are to oil paint what water is to acrylic; this type of solvent is about the same consistency as water and readily dissolves any wet paints. These solvents are also used for cleaning brushes. **1-3 days drying time**

- **Linseed oil** is the medium used in formulating most oil paints in the tube, and therefore is the medium most native to the paint's chemistry. It is crucial that you use artist's grade refined linseed oil, which has a fine consistency like olive oil. **5-15 days drying time**

- **Many artists, myself included, prefer a mix of Turpenoid and linseed oil, as in this chapter. This mix dries faster than pure oil and can have better adherence to pervious layers of paint. 3-7 days drying time**

- **A classic oil medium is a 3-way mix of Turpenoid, linseed oil and Damar varnish**, which is a crystal resin varnish that is used as a protective final coat by some painters. I work without the varnish in my painting medium because of its stickiness and the way it crystallizes in my sinus passages. **3-7 days drying time**

- **Stand linseed oil** is a thicker, heavier alternative to plain linseed oil, and is preferred by painters who like more impasto buildup. It has a different workability from regular linseed oil, and can be mixed with Turpenoid, although not as easily. **5-15 days drying time**

- **Liquin**, mentioned earlier on Page 112, is a brand of alkyd, a quick-drying alternative to linseed based mediums. It dries in a hard resin like linseed, but can be dry enough to pack and ship within oil hours. It has a shorter period of workability than oil, and a stickier consistency. **1 day drying time**

- **Other brands of alkyls are available as well, each with its own unique properties**

Drying time can be speed up by adding cobalt drying accelerators, which have the potential drawback of cracking the paints as they cure. The best way to speed the drying time of a painting is to blow on it with a fan, or in humid climates, a dehumidifier (the dryer air is better at carrying away the oil vapors). In any case, try to work with good ventilation while using these mediums—all of them are at least slightly toxic.

When applying the oil to the canvas, there are a number of alternatives. One is to use a wide soft-bristled brush to apply the medium, or a disposable foam brush. Another is to use a folded heavy-duty paper towel (as shown in Video Clip 11: Spreading On The Oil Medium). Either way, care must be taken not to smear the colored pencil foundation more than necessary. I usually aim to do it in a single first pass and a couple of light smoothing passes, all of them as gentle as possible. Scrubbing back and forth can seriously disrupt the pencil drawing. Even when done carefully, there may be small amounts of bleeding of the colored pencil pigments; this effect will disappear quickly as paint is applied.

If you want to fix the colored pencil so it doesn’t run, spray it down with 2-3 thin coats of acrylic matte medium spray, then let it dry for 2 hours or so before oil painting. Definitely don’t use gloss medium, though, or you may have adhesion problems.

It’s important not to apply too much medium, or it may begin running or dripping while you work. To avoid this, block off any excess oil with a clean paper towel, then look at the surface of the canvas at an angle so you can see the glare from your lamp reflected on the canvas; in this glare you should be able to see any overly wet or dry areas. You can correct these by blotting off excess oil or by adding where needed with a brush or oil rag. It doesn’t take much practice to be able to get an even coat.

Once applied, you have 5-6 hours of good workability, depending on how thick the oil is. Areas that you don’t touch with very much paint may still be wet and workable the next day. For larger paintings, I recommend only putting medium on an area I think you can get a good pass on in one session; in a large detailed painting I usually oil down sections not much larger than a dinner plate per session unless they are much simpler areas.

If you are painting and find that drips of oil are running through some of your brushstrokes, that means you have an area on the canvas with too much oil. In some cases you can carefully blot those areas to minimize the dripping. Beyond that, the best way to stop dripping once it has started is to apply as much paint to that area as you can to soak up the oil. If the painting is smaller (and you have no cats present), laying it flat is another option.

This basic oil painting setup is similar to an acrylic setup, with the canvas fixed in place, a paper towel taped down for wiping on, a palette handy and a selection of brushes available (Fig. 133a). Once the canvas has been oiled down, no other oil mediums will be needed. And unlike acrylic painting, this palette can be poured all at once without worrying about it drying too fast. In Video Clip 19: Mixing Dark Colors With White, I am preparing a range of values with two of the colors that I am planning on using in the flower.
At the end of a painting session, if there is a lot of good paint still on the palette, you can keep it usable by covering it with plastic wrap for the night. Be sure to press the plastic down so it sticks to the surface of each paint blob. It will pick up some of the surface paint when removed later, but most remaining paint will be good as new.

Like with the acrylic project, I am using a small round and a medium filbert brush for this. For oil paintings, I prefer brushes that are a bit softer and usually a little newer than the brushes I use for acrylic. Also, like the acrylic painting, the first stages of the process will be done with the larger brush, and the small one will be reserved for later.

As brushes are used through the months and years, even if cleaned properly, resins build up at the base of the bristles, making the brushes stiff. At the same time, continuous wear on the tips of the bristles causes them to get slowly shorter, so a long, soft brush will, with enough use, become a short stiff brush. I find paintbrushes to be useful for something or another at all stages of their lives.

To minimize the possibility of contaminating the colors and getting muddiness in the painting, the strategy is to finish the pinks and magentas in the flower before starting the green elements in the painting. White and pink-white are the first colors to go down, also for the purpose of avoiding muddiness (Fig. 134a). The paintings add easily to the oil canvas and their easy workability makes it a simple matter to start blending the paint even at this earliest stage (video Clip 2b. Starting An Oil Painting).

Next, the small round brush comes into play for a few minutes and is used to lay in the fine edges around the stamen of the flower and to refine some details around the edges of the petals (Fig. 134b). With these details in place, the filbert is picked up again and used to lay down a coat of reds and pinks that is rich enough to overwhelm most of the gray underpaint (Fig. 134c).

Still working with the filbert, some warmer pinks are brought in, this time incorporating a touch of orange to give the pink a warm peach tone (Fig. 135a). These colors are all blended as they are laid down, so that there won't be unwanted rough edges to deal with later in the painting process. Next, a cooler, deeper magenta is brought into the deepest parts of the flower to give it more fullness and depth (Fig. 135b).

Blending Your Edges
A good way to make your painting appear smooth and well-executed is to blend the edges of your brushstrokes. This is done to avoid leaving edges unnaturally sharp, or any choppy brushwork in areas that are meant to be smooth. Generally, I like to smooth out my brushwork as I go, laying down no more than a small handful of rough brushstrokes before giving the brush a quick wipe and then coming back to smooth the brushstrokes. This doesn't necessarily involve removing all character from your brushwork (otherwise, you might as well use an airbrush) but at some point you need to decide for yourself what sort of "roughness factor" you want to incorporate into your work, and then refine your brushwork accordingly. For an experienced painter, this blending is a step that happens automatically as part of the painting process.
To add the next layer of white to the flower the smaller round brush is used, since at this stage its greater precision is helpful in giving the delicate folds of the petals their subtle highlights and detail (Fig. 136a). Still working with the small round, deep alizarin crimson is brought carefully through the deepest folds of the petals, selectively maximizing the volume of the blossom, especially toward its center (Fig. 136b). Next, the stamen is colored yellow and highlighted with white again, popping it out from the deep crimson folds of the flower (Fig. 136c). Finally, orange details are added to the stamen as well, along with additional white finishing details throughout the flower, giving the white highlights additional sparkle (Fig. 136d).

This completes the flower part of the painting, unless any final detailing seems necessary after the leaves and background are completed. There are a few advantages to finishing one element at a time in an oil painting, one of them being the ability to concentrate more on each object. But the main reason I chose this strategy in this case was to avoid working back and forth between pink and green, which are opposite one another on the color wheel and would have increased the chances of muddying the paints.

For the remaining area of the painting, the deep background is the obvious next step. I chose a medium blue, allowing for a variety of pos/neg relationships through the painting. This is laid down quickly with the filbert, with some variation in the color field to keep it from looking flat (Fig. 137a). Next, still with the filbert, light green is blocked into the highlight areas of the leaves (Fig. 137b). Knowing this green will be gone over and refined with a smaller brush, I do this loose and quick, but still take care not to contaminate the blue background or the pink flower.

Next, dark greens are applied through the areas of foliage that are in shadow, including the blurry background foliage at the bottom (Fig. 137c). Because the background is still wet, it is easy to blend the blurry edges of the background foliage with the ambient background. The last step before switching to the small round brush is to add some simple highlights and blue secondary lighting in the foliage (Fig. 137d).

Now, with the small round brush, dark edges and detailing are added to the foliage, including contour lines that show the curvature of the leaves (Fig. 137e). After smoothing and refining these features, white detail is added through the leaves, along with highlights to the blue secondary lighting in the foliage. With the leaves and background basically finished, the whole painting is evaluated, and final highlights, details and refinements are made carefully throughout the whole piece, including the flower (Fig. 137f).

At this point, the painting could be called finished. There’s not much more that could be done to it while wet that wouldn’t risk overworking or muddying the piece. Once dried, though, there is the option of adding another layer of oil, probably a thinner layer this time, and adding small glazes and refinements. The painting could potentially be given more of a soft glow that way. But for the purpose of this demonstration, we can call this piece finished.

Someone in one of those old art history books said, “There are no finished paintings, only abandoned ones.”
This is an interesting remark. On the one hand, it’s not strictly true: I can, in my mind, imagine a completely finished painting. On the other hand, I don’t know if I’ve ever actually accomplished one. Instead of worrying about this, though, artists simply decide when each piece has run its course, then move on to the next.

Taking on a second medium is not a small commitment, and normally means giving up something else in your life. Most folks aren’t eager to make big changes, especially in their social lives, where there’s pressure from others to “hang out with the guys” at the strip club or whatever, sometimes several nights a week. Excessive network TV programming, casual web-surfing, and video games are also big time-suckers.

If you are juggling art life and family life, this commitment can be harder to make, and will sometimes involve having to find creative ways to make art time for yourself. But I have known many artists who have successfully found this balance.

The thing is, if you’ve got an artistic pursuit that’s keeping you inspired, you won’t find yourself missing those nights in front of your PlayStation. You may even experience that weird turning point some artists go through when you are sitting with friends watching a movie, but thinking about how you can’t wait to get back to your easel. Artistic involvement can have that kind of power in a person’s life.

As a gesture to yourself, you need a dedicated art space in your home, a place where you can shut the door on the world if necessary. You want your art supplies organized and readily available, which might mean installing some cabinets and shelving. Then you can deck out the walls with posters and magazine clippings of images that inspire you, including your own latest stuff. Music can also be a good thing, provided it’s a good soundtrack for the art you’re trying to do- if they’re at battle with each other, it can work against you.

No artist is immune to the struggles of getting from the beginning to the end of a project. Even with small projects, but especially with large ones, you will likely experience a “hump” somewhere around two-thirds of the way to completion. You may find at this stage that the piece isn’t looking the way you had envisioned, or that it had been looking pretty good for a while there, then you did something that might have taken away from it. Feeling this way, it’s easy to get discouraged and think about abandoning the project.

If this feeling sets in, you have to remind yourself that this is a normal stage for any worthwhile project; doubt will arise, and the only antidote is to have faith. You may have to remind yourself why you’re doing the project- for the experience, not to get the piece in an art museum. Especially keep in mind that with just a little push, you’ll soon be past that point and coasting toward completion, all the hard parts behind you. This last phase of a project can be the most fun, but must be earned by pushing through the hard parts.

You might be starting small, with little experience in any medium. I’d like to assure you that this means nothing; it doesn’t have to take you decades to begin tasting a piece of what you’re hoping to accomplish. Because if you appreciate art, you’ll have subject matters that interest you. If a subject interests you, you’ll explore it, eventually uncovering all kinds of surprises. Before long, without trying, you’ll find yourself on a unique personal path, and you’ll feel your momentum building as you move along it. You’ll begin to be able to design projects for yourself that you know will apply all of your current strengths to your most interesting subjects.

With your strengths empowered this way and directed into a piece of art, you will create a thing of beauty.
PART IV
Working From a Reference

4.1) Seeing the Real Thing

Regardless of what medium we’re working in, we’re limited by our own experience. When choosing a subject matter of interest, our first attempts to conquer it artistically may tend to be a bit cartoonish and minimalist. One way to avoid these limitations is to find a similar subject that another artist has already done, and copy it. This is fine if the goal is to make art that looks like another artist’s work, but that’s not very satisfying after a while. In art school, students are often instructed to set up an easel at the local art museum and copy some of the works of the old masters; normally they will study a variety of different artist’s styles this way. This can be a very helpful exercise, but ultimately students will need to move on to create their own style.

When working with a new subject that we need to know more about, one key step to gaining the necessary understanding of that subject is to work from a reference. Our references can consist of practically anything, except for perhaps someone else’s tattoos (for reasons of originality). There are a number of books available meant specifically for the purpose of subject reference. These books illustrate various subjects such as posed figures, flowers, animals, and just about any subject we can imagine; some of these books were published specifically for the tattoo industry. In addition, millions of copyright-free images of everything from fire rocks to flamingos are available on the internet. For most subjects, good reference material is not that hard to find.

A found reference is an image or a graphic element that is taken from an already existing source such as a book, magazine or web page. Although much of this material is copyright-free, almost any found imagery can be used as inspiration as long as it’s changed and presented in an original way.

In a case where a good reference can’t be found for a particular subject, we can make our own. For instance, objects can be set up on a table and observed while drawing or painting, as with the classic still life paintings. A human model can be put in a pose of our choice in such a way to get a good interaction of light and shadow, then either drawn from life or photographed for reference purposes. Objects can also be set up in a careful arrangement of light, shadow and composition, then photographed. If the subject isn’t one that can be obtained from found objects, sometimes it can be made from scratch using clay or other materials.

A created reference is an image or graphic element that was made and/or photographed by you. Using created references avoids all copyright issues and also makes for a more personalized piece of art.
Working from reference has many great benefits. For starters, it offers us a chance to increase the accuracy within our subjects, such as animals and human figures, which can be tricky to do without either good reference material or a lot of specialized experience. In addition, when sorting through reference material choices, you may be able to imagine unexpected variations on the theme that you wouldn’t have considered without doing a little research first. I have found that sometimes doing an online search of a subject will not only provide good graphic starter material but also interesting factual information on the subject. For instance, I recently started a sleeve featuring a Geisha girl. In the course of doing online research I found that parts of a Geisha outfit could be varied in many ways, while other aspects, such as the hairstyles, follow a fairly strict set of guidelines. Knowing these things made it easier for a Westerner like me to approach this subject without being completely ignorant of its finer points.

Even though simplified from its photo reference in many ways, this painting has a believable quality that is hard to attain without having something real to look at. After doing many painting projects of this kind, which typically take a day or two each, I’ve found it much easier to create good lighting and texture without always needing to consult reference.

Although this type of exercise does involve a bit of mindless duplication and repetition, it does serve the same kind of purpose as practicing a musical instrument or doing physical exercise: the end result is that your fluency with the subject matters, and other subjects like it, will become more automatic and give you better results with less deliberate effort.

Another Level of Realism

I did this piece on artist Aaron Cain using a model that he and I built together. There is definitely a different quality to this piece than if it was just drawn out of my head. Because the model provides all of the areas of light and shading in their right places, the lifelike dimension of the piece is uncompromised, creating a strong illusion. This realism is contrasted by the use of a few bold lines around some of the foreground shapes, along with some thinner black lines where they are needed on certain hoses and wires, offsetting the realism with a sense of graphic style.

Another type of realism that references can help with is not just in getting the structural proportions and factual details of our subject right, but also mastering the light and shadow effects that can give an art piece life and dimension. Any subject where there is light playing over a textured surface and a potential for dynamic shadow effects, it’s helpful to use a reference where we’ve set up our subject in a controlled lighting situation and photographed it. This kind of personalized reference photo can help not only with proportions, light and shading, but also with focus and atmospheric effects. In an ideal situation, a good reference can contribute to greater artistic control over a piece’s dynamic range.

Last but not least, reference material can expand our vocabularies by familiarizing us with new subjects, and by offering us new and unexpected insights into familiar ones. Even with an established stylized way of drawing a subject, looking at a reference every now and then is likely to improve our mastery of that subject while introducing us to new language elements.

The more an artist knows, the more versatile they become. Using reference material while making art allows us to absorb truths from these references, providing deeper understanding of our subjects. By beginning with a core of truth and then developing a stylized look from there, your style will have more substance—ideally, you want your viewers to see your work and believe that it’s drawn that way because you chose to, not because you weren’t capable of something more realistic.
4.2) Finding or Creating Our References

For the purpose of your average-sized tattoo or a small painting, a found reference can do just the trick. There are countless ready-made images available, such as we discussed in the previous chapter, many are free, and some are available for a small price. Even publications that aren’t marketed specifically as artists’ references, such as a wildlife encyclopedia or a bodybuilding magazine, can be a great source. It’s legal to use these images in a tattoo design, as long as you don’t publish these found images as T-shirts, flash or that kind of thing.

However, a found reference can also be changed or manipulated, either by using a computer or during the drawing process. Different foregrounds and backgrounds from various found references can be mixed, matched and combined. During this process we need to remember not to be ruled by our reference, though, and refer to our own intuitive judgment about what looks good and what’s appropriate in a design and a given body placement.

References can be manipulated in many different ways, but this can almost always be done the most easily with a computer using Adobe Photoshop or some equivalent image manipulation program. We’ll be covering that in detail in Part V, but for those artists who are not ready for that technological step, I completely sympathize. Fortunately, references can be manipulated many other ways besides computers, so there’s no need to keep up with the modern digital rat race just to create nicely composed custom reference material for tattooing. The most basic way is to make multiple photocopies of your reference material in a variety of sizes and then trace and redraw as necessary, using good old reliable pens, scissors, tape and pencil.

Found reference can be combined with hand-drawn elements or other design features added in Photoshop.

This finished composite reference combines a found photographic image with surrounding hand-drawn elements and rays that were plotted in Photoshop. The finished composite may look slightly raw at this stage, but the act of tattooing it makes all the different elements come together cohesively on the skin.

For this painting project I did with Pittsburgh tattooist Don McDonald, we combined soft clay with moped parts, hoses and plumbing components from a local hardware store, junk from the darkest corners of the garage and broken parts of a futuristic plastic ray gun.
Ideally, the goal is to create an original piece of art that has a sense of realism, not necessarily an exact copy. Unless doing a portrait or something along those lines, the purpose of the reference is to gain more freedom—and when enough aspects of a subject are portrayed accurately, there is greater opportunity to interpret the rest of it much more freely while allowing the subject to retain its realism and identity.

Some subjects just aren’t going to be easily available in existing material. In addition, there comes that time when it no longer feels satisfying to use found references; we want the whole piece of art to be from our own hand. By creating references from scratch, artists give their work more of their own energy. This allows for more control of the way a piece looks on skin and gives the client the pleasure of knowing that even the reference that they are working from is an original, created just for them.

The key to creating custom references is to have a good camera and a rudimentary ability to use it. A big part of this is being able to get good results without using the camera’s flash; in most cases the flash will light the subject too evenly, making it look flat. Even with colored lights aimed from various angles at the subject to make it look dynamic and exciting through the lens, using the flash will cancel out all of this. So for starters, it’s necessary to find a camera that can be operated without the flash that will meter its exposure automatically for the lighting situation.

I have been asked many times for advice on digital cameras. However, this is a rapidly changing field and any recommendations I make today may be obsolete tomorrow. Therefore, instead I offer a comparison between the two major types of digital cameras: Point-and-shoot cameras and 35mm Single Lens Reflex (SLR) cameras. Both camera types can be useful for tattooists, but each have their own strengths and weaknesses.

Generally, I recommend Canon products because of my long history using them with usually very favorable results. I have both a Canon point-and-shoot and a Canon SLR, and use them for different purposes. However, don’t take my word for it; you can find reviews for the latest cameras in magazines such as Popular Photography or websites such as www.epinions.com.

Point-and-shoot cameras are generally small and made as uncomplicated as possible; in most cases, all you need to do is point, zoom, and snap the picture. All of them have autofocus features that can provide the optimum sharpness and depth of field. The main limitation of this type of camera is the lens; because it is usually a small retractable lens it will not have the high optical quality of a larger lens and will be limited in terms of how far it can zoom or how close it can focus. These small lenses are the single biggest factor limiting the image quality of point-and-shoot cameras.

Resolution most of these cameras is easily high enough for publishing or portfolios, although you will have less control over your results than you would with a good SLR. Price is the biggest advantage; the best point-and-shoot cameras are around half the price of the most accessible SLR cameras. Having your camera handy when you need it is essential, so portability is also a big plus; a good point-and-shoot like the Canon Elph will easily fit in a pocket. I have dropped mine on concrete multiple times and it still works fine.

SLR cameras are at the other end of the spectrum in terms of professional features. Most of them are more complicated to use than point-and-shoot cameras, and in many cases you will actually have to read the manual. The cheapest of this family of cameras will run around $800 or so. The main advantage of using an SLR camera is the ability to change lenses; a digital SLR will usually take most lenses from older film cameras of the same make. This provides access to many lens types, such as macro lenses, wide-angle lenses and other specialized options that aren’t usually available in point-and-shoot cameras. Most of them have a variety of settings, from totally automatic to totally manual, giving you a wide range of control over your results.
The best type of lens for a project depends on its subject matter. For most subjects, a standard lens is more than adequate. Sometimes, though, it's better to use a macro lens, which provides a much closer view and produces rich variation in focal effects. Most of the tattoo reference photos in this book were shot with a standard lens. Many of the paintings, however, were done from reference photos shot with a macro lens, such as the painting on Page 142.

Macro lenses are great for gathering reference imagery. However, the same dramatic depth-of-field effects that make them ideal for taking dynamic reference photos also make these lenses far less appropriate for documenting tattoos, where the macro lens is likely to give you unwanted blurry areas in your pictures.

Wide-angle lenses are at the far end of the spectrum from macro lenses. Rather than zooming in on one small object or surface, wide-angle lenses can capture a whole scene. Generally, photos taken with this family of lenses will contain more information than you would need for a tattoo design, and for the most part you can get by without the need for this kind of lens. However, if you find yourself in situations where you want to step back to capture more of a scene but can't because the room is too small, then a wide-angle lens might be worth the investment. They are also capable of focusing on close objects, but cause some distortion as you get closer, also known as a "squeezing" effect; this effect can sometimes be desirable but, in the case of human subjects, can be comically unflattering.

There are many other specialty lenses available, including some expensive and exotic ones. However, if you get yourself a standard all-purpose lens and a moderately priced macro lens, possibly supplemented by a wide-angle lens, you will be able to compose almost any reference photo you could possibly need for the purpose of tattooing.

Popular Photography Magazine is a great up-to-date, user-friendly resource for information on the newest cameras and lenses available as well as the current trends in software and techniques for image manipulation.

The lighting used when shooting a reference photo is instrumental in describing a subject's 3-dimensional form, revealing its essential details and establishing the mood and style of the piece of art that will be made of it. Light and shadow are some of the basic keys to a design. Because lighting is so important, we'll spend a little time talking about it.

We'll be using a deer skull for the reference object in this hypothetical tattoo project. In a consultation with the client, we've worked out the general tattoo idea and have figured out its size, placement on the body, the composition and all of its pos/neg relationships, along with a quick sketch (Fig. 148a). We've also taken a tracing of the client's body part, with them standing in a neutral "Bus Stop" position (Fig. 149a, 149b). The next step will be to set up the skull with the right position and lighting to try to capture the basic essence of the sketch with our actual props.

When aiming for a naturalistic look, shooting outside in natural sunlight is often the best way to handle the lighting. With outdoor lighting there is a choice of ambient light (as with an overcast or hazy day) or direct filtered sunlight (which creates stronger shadows and has different qualities at different times of the day). Most cameras deal really well with sunlight, and in many cases a tripod will be unnecessary; simply compose the subject, focus and shoot. I recommend shooting a variety of pictures from slightly different angles, using the autofocus for some and focusing others manually. Try moving the subject around to get different lighting effects and variations on foreground/background relationships. It's not unreasonable to shoot dozens of pictures to get the subject just right. It's normal to have new insights about the subject after the first 30 or 40 photos; sometimes it's necessary to work through a variety of combinations of light and position to get the vision right.

When shooting objects on a bright sunny day, often their shadows are so dark that those areas appear black in your photos, sometimes hiding important detail. To create a soft underlining, try placing the object on a towel, either white or a light color like pink or robin's egg blue, which will reflect some soft light onto the undersides of the object. By using a colored towel instead of a white towel, the object may be more readable and have a greater apparent sense of volume. Using a white towel with a few layers of colored plastic wrap over it will create a similar effect.
The last hour of day light is often used by photographers to give their subject a warm glow. The low angle of the lighting at that time of day can be effective for creating a very particular mood. Since the evening sunlight is a much warmer color than during the rest of the day, the light on the object strongly contrasts the soft blue light reflected from the sky unto other parts of the object. This produces a natural warm/cool lighting combination. Because of the rapidly changing nature of the light in the last half hour before sunset, it is important to plan ahead and have the subject and camera situated before the low angle sunlight comes and goes.

Sometimes a project calls for a more dramatic lighting scheme than natural sunlight can generate, such as multiple light sources. In order to attain the most control over the lighting in a composition it needs to be photographed in a controlled situation, either at night or in a windowless room. It’s important to have a good stable working surface, about countertop height, and easy access to electricity. A minimum of 5 or 6 feet (1.5-2 m) of space in front of the table or counter is necessary for maneuvering the tripod (Fig. 150a).

A good tripod with a sturdy, fully adjustable head is necessary for having any kind of control over your photos. Even with bright outdoor lighting, you will often get a sharper photo with better detail if the camera is immobilized on a tripod. I recommend tripods from the Bogen/Manfrotto line.

There are numerous lighting options available, depending on the desired look of the piece. Brighter lights mean shorter exposures, but with a good tripod that shouldn’t matter. I’ve used regular incandescent bulbs, including cheap colored party bulbs. A digital projector can also be used to generate any colored light desired by filling the screen with a large colored rectangle and projecting that on the subject. By leaving the projector out of focus, any pixilation effects from the projection will be eliminated, producing a smooth colored light.

For our hypothetical deer skull, we’ve opted for a simple blue/ yellow combination. Since these colors are so different from each other, their opposition as light sources helps describe the shape with dramatic clarity. Once the photos have been shot in these basic colors, their color schemes can be easily altered or enhanced in Photoshop.

The blue lighting for this project is produced by a basic six-dollar 18” (46cm) fluorescent tube light wrapped in colored plastic wrap. This is a simple and effective way of making a variety of colored light that doesn’t get inconveniently hot and is cheap enough that a whole spectrum of colored lights can easily be kept handy. For yellow light I am using a color balanced fluorescent floor lamp with a flexible neck, similar to what I use for tattooing except that there is a yellow plastic bag over the lamp to tint its light (Fig. 151a). Because the lamp is fluorescent, it’s unlikely to get hot enough that this could be dangerous.

There is a very simple featureless background in your reference photo that makes it easier to copy and trace, and can make it easier to work with the subject in Photoshop.

Free hazard! Always use caution whenever creating lighting effects. Under NO CIRCUMSTANCE should any kind of improvised lighting he left unattended while plugged in. If using multiple lights, plug them all into a power strip so that the whole lighting setup can be controlled from the one switch on the power strip. Be sure any hot lamp is not in contact with potentially flammable surfaces before stepping away.

The next step is to place the skull on a table, crate or some kind of riser that will raise it up and to make it easier to adjust your subject without having to touch it (be sure to cover the riser with a piece of fabric that matches the background). Next, lock the camera onto the tripod and aim it at the skull (Fig. 151b). While looking through the lens, move the skull around until it’s composed in the camera the same way as it is in the sketch. With that accomplished, start moving the lights around and shooting photos, looking for the most dynamic combination (Fig. 152a-152c, next page).

Sometimes it’s helpful to have an assistant for this part, since it’s not always possible to get the lamps precisely where they need to be just by leaning or propping them. Having a person hold them and move them around makes it possible to explore the greatest variety of illumination options. This is the time to start shooting pictures like mud: The more lighting variations, the better.
Depth of field can be controlled by adjusting the camera’s f-stop. On some cameras, this is a control on the lens itself, usually in the form of a rotating ring with numbers on it. Many newer cameras have a control wheel on the camera body that will adjust the f-stop, often displaying its number in a small window on top of the camera. Each camera is different, but the numbers are usually from 4-32 or thereabouts. Most SLR cameras have an aperture priority mode that allows for the adjustment of the f-stop, but automatically meters the length of the exposure. By using the lowest number, the picture will get the shortest exposure, but the narrowest depth of field—that is, the fewest number of elements will actually be in sharp focus (Fig. 153a). Using the highest f-stop, much more of the photo will be in focus but it will require a longer exposure. For these higher-numbered f-stops, you’ll almost always want to use a tripod, even in good lighting.

After enough pictures have been shot to feel confident that the subject has been properly captured, it’s time to download the photos and choose the best one for the tattoo. Using Photoshop, the tracing of the client’s arm can be scanned at full size, making it easy to resize the sketch to the right dimensions. Sizing it in a copy machine can also accomplish the same task. For the purpose of this design I have used the Transform tool in Photoshop (more on this subject in Part V) to make the antlers shorter, allowing the skull to be larger in proportion. After sizing it to the tracing, other Photoshop tools were used to add the negative space effects from the original sketch (Fig. 153b).

This project is a good example of a tattoo that could benefit from being done with a crosshatched stencil, a method that is ideal for showing the differentiation of two colored light sources in a stencil and is good for handling negative space effects. Since the tattoo is on a curving body part, copy paper would be too stiff for a good transfer. Instead, it gets traced in pencil onto lightweight tracing paper (Fig. 153c) and then run through a stencil machine. The crosshatched drawing is handled in a way that clearly shows the blue and yellow areas by shading the blue areas with crosshatching while leaving the yellow and white areas open. Printed on the skin, this stencil will contain enough information that the tattoo can easily be done without needing to constantly refer to the photo.

When using two different colored light sources, it’s nice to have a distinct area of shadow between the two colors to keep them clearly separate, rather than allowing them to mix. This not only makes for a more graphically striking color scheme in the piece, but also makes it easier to tattoo by providing strong and readable areas of shadow that can strengthen the image’s structure. This shadow core can be clearly represented in the stencil or frehand drawing.

Depth of field describes how much of a photo is in sharp focus. If an image is sharp overall, including the objects in the near foreground all the way to the mountains in the deep background, then it has infinite depth of field. On a macro photo, when parts of an object are in focus but areas of the same object that are closer or further away are blurry, then that image has a narrow depth of field.
Often a single light source is more than enough to capture a subject the right way. In the case of these orchids, a simple white lamp on an adjustable neck is perfect for the job. This time a white background is used instead of a black one (Fig. 155a) because the tattoo this reference is for is meant to be much lighter and softer than the deer skull. For the purpose of this piece, only one large flower and a few buds are needed, so the camera is brought close and is carefully adjusted to focus tight on these flowers.

This tattoo will feature white flowers over pale skin, so a good pattern of shadows is needed to give the design some strength. To accomplish this, the lamp is moved into various positions to get different combinations of light and shadow. The objective is to get enough dark shadowing to show the form of the flower without making it appear dark, it should still remain a white flower.

If you tattoo flowers regularly and want reliable subjects, consider buying a variety of fake flowers. These are made very well these days and can be very cooperative and long-lasting photo subjects. Even though they won’t appear completely realistic in the photos, the act of tattooing them will cancel out that problem.

The photo in Fig. 155a is probably too washed out to make for a good reference. This is caused by the light angle being too close to the camera angle, like using a flash but not quite as intense. There are some good shadows but the overall effect looks overexposed. In Fig. 155b, there is plenty of shadow and lots of good volume, especially in the big top petal, but the overall flower is too dark and getting mostly swallowed up by shadows. Fig. 155c shows a happy medium, having plenty of shadow to help define the form and curvature of the petals, while still leaving enough of the white flower unsheathed to allow for a soft tattoo.

The image in Fig. 155d is improved a further step. Since Fig. 155c was the closest match to what we were looking for, most of it is being used. However, the shadow in the lowest petal is too large and cuts that petal in half; the easiest solution is to use Photoshop to composite the lowest petal from Fig. 155a onto Fig. 155c. This helps optimize the distribution of light and shade in the design, making it a strong tattoo despite the lack of bold black outlines.

After sizing and printing the design, it’s time to make a crosshatch stencil. The stencil can be made directly on an inkjet print or photocopy (provided it’s on regular copy paper instead of any kind of heavy paper) because it’s going on a hard surface and traced it with a ballpoint pen, scribbling in crosshatch shading throughout the process to establish the basic areas of light and dark along with the important gradients and pos/neg relationships in the design (Fig. 155e). You can see on the front side of the stencil (Fig. 155f) how the detail of the flower was carefully translated into lines and crosshatched areas that can accurately convey the realism of the flower when printed on skin.
If you have a stencil machine, your other option is to lay tracing paper over the print, trace and crosshatch the image, then run the drawing through the stencil maker, as with the deer skull project. This may produce a longer lasting stencil but allows for less control over how dark or light its lines are.

Stencils made on thin, flexible paper will cooperate better than those done on stiffer paper. Copy paper is the stiffest paper that can be used for stencils, and is best for either small tattoos or flat areas like chest panels. Lightweight tracing paper is good for stenciling anywhere on the body. However, because of its flexibility, the paper from a stencil sheet is the most ideal paper for laying over curly body parts.

For some types of images, we'll never find what we're looking for at any store, in the woods, or even in a junkyard. At times like these, we can build our subject from scratch in the form of a model and then take photos of it. The model can be made of any malleable material, but my own experience is in using plasticine, which is a type of clay that stays wet indefinitely.

There are many types of plasticine available, each with its own characteristics. I prefer Venus clay for its smooth, cream-like texture and workability. It comes in a greenish-gray color, and is by far the smoothest and easiest to manipulate. However, for photo reference purposes it's nice to use a white plasticine because of how well it responds to lighting. Most hobby stores carry it in white or a light cream color. Plasticine is often referred to as modeling clay and is marketed in various forms for children, hobbyists and professional sculptors. Almost all brands are suitable for the purposes described in this chapter, but the professional grade clay is, of course, the nicest working material.

Before building anything it's important to have a clear idea of what basic form the model will take; even a relatively simple sketch can be enough for guidance (Fig. 156a). It will help prevent the need to make major decisions on the fly, which is much trickier in the 3-D world than it is on paper. If this model is for a tattoo design, it's helpful to have a good tracing before starting the sketching process.

For a model of this simplicity, the skeleton is nothing more than a length of copper hose screwed into place on a wooden base (Fig. 157a). A power drill was used to drive in the screws at an angle that holds the hose down on the base (Video Clip 21: Anchoring Copper Hose to a Base). To accommodate the points of the screws, a piece of thick lumber was used (Fig. 156b) with thinner wood, the exposed points could be a safety hazard. For larger models, two layers of plywood can work just as well.

With the basic skeleton completed, the next step is to add crumpled aluminum foil to give the model its form and bulk (Fig. 157b). The foil should be packed together fairly tightly so that it keeps its shape later when the clay is being pressed into place, and should also be wrinkled enough to give the clay something on which to grab. Wrinkling it by hand before attaching it to the model helps make the foil more agreeable, allowing it to stick to the model better (Video Clip 22: Preparing and Attaching Foil).

During the whole process, the model will remain flexible and can be positioned or adjusted as needed. That's part of the advantage of using copper hose as a skeleton and plasticine as a surface; at any point the model can be flexed or reshaped as necessary. If this tentacle had been a larger model than this, 2 or 3 pieces of hose would have been bundled together using wire or electrical tape to make a much stiffer skeleton to prevent the model from sagging under its own weight. In a couple extreme cases, I have needed to use fishing line to hang parts of a model from a frame to stop them from drooping.

Once the foil has given sufficient form to the model, it's time to spread a simple skin of clay over the surface (Fig. 157c). This will go faster if some of the clay is first cut and flattened into pancakes that can easily be stuck onto the model (Video Clip 23: Preparing a Plasticine Skin). These slabs of clay are pressed into place on the model, then their edges are smudged down onto the wrinkled foil surface or the neighboring slabs of clay already in place, working it all together to create a smooth continuous surface. For larger models, it's nice to have an assistant for this stage.

You may find the consistency of some white modeling clay to be stringy and hard to work with at first. To overcome this, massage the clay into 1/4" (6mm) thick medium-sized workable pieces. The process of working the clay with your fingers will help mix it to yield a smoother consistency.
The next step is the fun part: With the skin in place, it’s time to add detail. There is no limit to what you can do here: Pinch and poke the clay into shape, stick on balls and rolled up cylinders and donut shapes to give it new features, Try using the back end of various sized of paintbrushes to carve or poke detail into it. Invent your own moves here (Fig. 158a, 158b). Once the basic skin is on, the rest will be more of a game than an exercise (Video Clip 24: Detailing A Plasticine Model). The finished model has a variety of detailed areas, smooth areas and small and large shapes, along with plenty of good twists and turns (Fig. 159a).

The model’s flat white finish makes it easy to photograph. This process is handled the same way as the deer skull photo shoot, using a black background and two different colored lights. The final photo has a careful balance of the two colors, along with clear distribution of shadows separating the colored areas (Fig. 159b). Next, the image is made grayscale in Photoshop, then run through a filter called Photocopy to clarify its detail and make it easier to trace (more on this in Part V). Then this processed image is printed at full size and the waves from the original sketch are drawn on in pencil (Fig. 159c).

Due to the tattoo’s placement on a shoulder cap, the stencil needs to be done on paper more flexible than copy paper; the easiest choice is to trace the photo with the crosshatch shading onto tracing paper (Fig. 158d), and then run the drawing through a stencil machine. Although the image run through the Photocopy filter is easier to trace than a full color image would be, a color print is kept at the drawing board for reference while the crosshatch shading is being done. This allows for the most faithful representation of detail in the stencil.

By creating this degree of information in your stencil and keeping your reference photo available while tattooing the piece, it should be easy to achieve a bold, bright and realistic look in your tattoo work.
Here are two examples of moderately sized tattoo projects involving clay models. In the snail project, the objective is to give the shell as much volume and dimension as possible, fitting it on the top of the shoulder facing into the collarbone area. Try making a foundation out of aluminum foil taped securely to a flat wooden base. This is a structurally simple project that should allow for some fun development of surface detail; after photographing the model, try combining it with some leaves or other elements for a sense of context. The second project, for the outside left calf, would require making a skeleton out of copper hose screwed to a wooden base. Multiple strands bundled together with tape would provide both stiffness and branching possibilities; narrower branches might be supported sufficiently with pipe cleaners. Look for references for the moon and a raven silhouette on the internet. For both projects, try making a final drawing from your reference photo in pencil. You can post your projects and compare them to others at: www.hyperspacestudios.com/reinventing/exercises.

4.3) Doing a Tattoo From a Model: Working From a Line Stencil

Working with models not only can expand our vocabularies and give our work greater realism, but also will present us with new challenges to overcome. How exactly does an artist use such a thing for a tattoo design? Many of us have made portraits from photos, which is helpful practice for this kind of project, whether on paper or on skin. The traditional method of preparing and stenciling a portrait is to translate the reference photo into a simple line drawing that contains the basic essence of the portrait, then to tattoo very carefully from that stencil while observing the photo to see what each line in the stencil is supposed to represent.

Line stencils have been the standard in the tattoo profession for as long as stencils have been used, largely because of the technical limitations of acetate stencils. However, the use of hectograph ink in modern stencils has made it possible to produce much more complex stencils. For most hectograph stencils I prefer the crosshatch stencil method that I’ve been describing in this chapter and in Chapter 2.6. But I do understand that not every artist will be comfortable using this different thought process for transferring designs onto skin. Therefore, this chapter provides an example of a task done from a model that was transferred using a traditional line stencil.

One of the keys to success when tattooing from models is to work with familiar subject matter. This way, even if part of the photo is hard to read or you can’t make heads or tails of part of your stencil, you can still “wing it” through these areas by drawing from what you already know of the subject. Once you’ve found a sure-fire method for stenciling and working from the stencil, you can move on to less familiar subjects.

When photographing a subject using a light source that’s visible on-camera within the composition, that light source will not only illuminate the subject but also wash out the photo. This is called lens flare, which happens when light is aimed into a lens. To prevent this, it is necessary to block the bulb from being visible from the camera’s viewpoint without blocking the light that is playing over the subject. The simplest and most flexible way to do this is to make a loop at the end of a stiff wire, stretch tape across the loop to make a light shield, and affix the other end of the wire handle to the base of the model. Then, while viewing through the camera, maneuver the loop into position between the lens and the bulb so that in the final photo, the bulb is obscured but the rest of the subject is visible. I recommend making a light shield no larger than the bulb itself.
The finished tattoo has an unusual sense of realism not found in most of my hand-drawn organic work (Fig. 163c). Although the tattoo retains most of the detail and many of the effects in the model, the finished piece has been adapted in a number of ways from the reference photo to make it a better tattoo. The contrast of the large dark and light areas was exaggerated, and some detail was given more emphasis while other detail was eliminated to keep the piece from becoming too busy.

Black was concentrated heavily in some areas, while being avoided almost completely in others, giving the piece a clear overall silhouette. White was reserved for the foreground textures, where it was used sparingly. In the background, the few white highlights used are not true whites and are mixed with yellow and green. The concentrations of detail bring focus to the bones, while the background was made softer and simpler, with almost no small detail.

Although a line stencil like the one used in this project is a perfectly adequate way to transfer a design onto skin, for a subject like this I believe it is a more difficult way to accomplish the job. Attempting to convey large amounts of realistic texture with lines can make for a very busy stencil, which can really bog down the shading process because of all the searching that needs to be done through the reference photo to check what each line represents. Because a crosshatch stencil shows where the dark and light areas go, the piece can be done more quickly and intuitively without having to constantly look at the reference photo. But for any artists who are not comfortable trying unconventional stencils, you can still explore subjects like this by using a line stencil.

I began this piece the obvious way, by mixing a light graywash and lining all the detail with it; black was only used on the peripheral lines of the ribs and horns (Fig. 163a). Even though the stencil was clear, the grayine had to be done with the photo in plain sight so it was possible to understand what each of the lines was meant to represent in the design. Once half shaded, the texture of the model begins to take form (Fig. 163b), but this stage of the process goes very slowly because of the complexity of the stencil and the difficulty in reading it.

The life-sized model was made of white clay with a foil interior (Fig. 162a). No skeleton was needed for this model because it had no unsupported elements that could potentially sag. The pitted rock texture was done mostly with the back ends of different sized paintbrushes. The central element that will sit in the middle of the Food Shape was later drawn in by hand when the photo was retracted.

Two blue lights and a regular small incandescent bulb were used to create the lighting effect in this model (Fig. 162b). The incandescent bulb was held in place with a stiffwire, then a wire loop with tape stretched across it was positioned in such a way to block the direct glare of this bulb from washing out the photo, while still allowing it to shine freely over the model.

The stencil for this was made the old fashioned way. The life-sized photo of the model was printed, taped to a light table and then traced. During this process all the bumps, pits and wrinkles in the photo were translated into simple lines. The finished stencil is clear and readable (Fig. 162c), but will only be of any use during the tattoo process if the reference photo is observed very closely.
4.4) Doing a Tattoo From a Model: Working From a Crosshatch Stencil

Working from a customized photo reference only makes sense if there is a practical way of translating its realism into a tattoo. A sense of photographic realism is a result of many different things coming together in just the right way, and lighting is one of the most crucial elements; this is why I go to such lengths in describing how to optimize lighting for each object. When tattooing from this sort of reference photo, one of the key ways of translating the realism from a photograph to a tattoo is to make sure all the major dark and light areas are in the right places in the stencil, and that all the gradients in the photo are represented correctly. With multiple light sources, this equation can become much more complex.

Once a final reference photo of a subject has been chosen and all necessary manipulations and modifications have been done, the stencil becomes the final step that can make or break the finished piece. With a line stencil, the dark and light areas are represented by outlines that can easily be interpreted the wrong way while tattooing, unless consistent attention is paid to the reference image throughout much of the execution. However, by using crosshatching in the stencil to represent the dark and light areas and most major gradients of the reference photo, it is much easier to correctly interpret the shading in the design while doing the tattoo.

Part of what makes the crosshatching method work so well is that it represents dark and light areas with lines, which are required by the photorecording stencil making. Actual smooth gradations will not stencil clearly, usually producing an unreadable smear when run through a stencil machine. Crosshatch shading can produce very clean and readable gradations that don’t smear or fade any more quickly than a normal line stencil.

This project is a neck tattoo I did on Massachusetts tattooist Cory Kruger. As with the Aaron Cain chest project, this model was a collaborative effort. We first built an appropriate skeleton for the piece; we needed thin, bendable leaves to build clay onto so we used pieces of 4” (10cm) aluminum accordion dryer hose, cut with lightweight sheet metal shears, then bent and secured to a sturdy cardboard box with tape. Aluminum foil was then added to finish roughing in the basic form. We then covered it with a thin plasticene skin (Fig. 164a), refined its shape and added detail, taking care to balance rough areas with smooth zones (Fig. 164b).

For a light source we used a simple “pigtail” socket light with a stiff wire handle and a wire loop light shield to hide the bulb (Fig. 165a). Several dozen variations of this shot were taken, with minor changes in the position of the bulb in each shot however, because the incandescent light was much brighter than the blue lights, the cool areas of the model ended up all and lacking contrast. To make up for this, we also took some shots with only the blue lights on (Fig. 165b). All shots were taken from the exact same angle using a tripod, making the process of digitally composing the photos much easier (more on this coming up in Part VI).

If you are shooting multiple photos with different lighting and intending to combine them in the computer, keep the camera angle and position identical in all photos. This makes the composing process far easier.

The finished reference consisted of parts of both photos, along with an eyeball that Cory and I designed in a 3D program called DAZ Bryce. This gave us a glassy element that had the same level of realism as the model parts; however, the digital glass model was much easier to work with than real glass. The finished reference image (Fig. 165c) combined these two elements and includes a drop-shadow effect that was used in the tattoo. To check for placement ahead of time, we did a Photoshop simulation of the reference image on a photo of his neck (Fig. 165d).
The stencil for this tattoo was done on copy paper (Fig. 166a-166b), using both lines and cross-hatching to convey the dark and light areas of the design. Although the rock is a curved canvas, the way this tattoo sits on the neck and collar area allowed the sheet of paper to lay fairly easily, so the stiffness of the copy paper was not an issue. I often make my photo reference stencils on copy paper if the body part allows for it; using tracing paper can make it hard to see subtle aspects of the design during the tracing process.

Consider these options when making crosshatch stencils:

1) Tracing an inkjet print or photocopy with a ballpoint pen with a sheet of stencil paper underneath it
   - Advantages: Requires only one tracing, allows for a high level of accuracy
   - Disadvantages: Paper is still doesn’t work well for all body parts

2) Taping tracing paper over a print or photocopy, tracing it in pencil, running it through a stencil machine
   - Advantages: Requires only one tracing, allows for multiple stencils to be made, paper is very flexible
   - Disadvantages: Tracing process is more difficult because of impaired visibility, even using a light table; stencils are limited in size to 8.5x11” (21x35cm)

3) Taping tracing paper underneath an inkjet print or photocopy, then tracing the copy with a ballpoint pen and a sheet of stencil paper underneath both layers
   - Advantages: Requires only one tracing, allows for high level of accuracy; makes stencil on tracing paper, which is preferable to copy paper for most body parts and has fewer size limitations
   - Disadvantages: Requires very firm pressure while tracing to get a good stencil, which can hamper the tracing process and compromise the realism

- Taping tracing paper over an inkjet print or photocopy, tracing it in pencil, removing photocopy and then re-tracing the pencil drawing in ballpoint pen with a sheet of stencil paper underneath it
   - Advantages: Produces a high quality stencil that is strong, flexible and will make a good print on the skin; retracing process allows for additional review of the design before tattooing it
   - Disadvantages: Requires two tracings, which is a lot of work and can increase the risk of mistranslation

Notice how the stencil for this piece makes use of both lines and gradients. The outer edges of the important shapes are plotted out clearly this way and the precise arcs in the eye are easy to read. After that, crosshatch shading is used to establish the light and shadow in the piece, to create the dropshadows that lift it up from the skin and to give the forms in the design their curvature. Pos/neg relationships and gradients are all in place in the stencil; pits, bumps and other small detail have been carefully added to the stencil as well.

To capture the important pos/neg relationships and gradients before the stencil disappeared, I sketched in the edges of the shapes carefully with a 3 round and then worked inward, sketching in the small detail along with small and medium shaded areas by using the 3 round as if it were a pencil. On several occasions I switched to a 5 magnum to work some of the larger gradients, but much of the piece was laid out with the 3. However, this tattoo was not outlined in the normal sense; instead, its edges were built up with careful overlapping strokes. The normal strategy of going through the whole stencil with a single-pass line would have seriously disrupted the stencil and limited the opportunity to create a realistic look.

Working with a crosshatched stencil does require a different thought process from a simple line stencil, and this can take a little getting used to. I recommend trying this method with a small and relatively simple design on a familiar client when you use a crosshatched stencil from a photo reference for the first time.

Once you are accustomed to working this way, you may find crosshatch stencils to be more suitable for creating a sense of realism or dimension in your work. By thinking in terms of edges as opposed to lines and approaching the execution of a tattoo as if it were a drawing or painting, you can successfully translate much of the realism of the photo onto the skin. Having the light and dark areas in their correct places makes this realistic look possible; a good crosshatched stencil can make this easier to achieve.
4.5) Doing a Tattoo From a Model: Working From a Frehand Drawing

Another method I’ve used for transferring photos of models onto skin is to draw the design directly on with markers, also known as frehanding. This is probably an inappropriate term considering how time-consuming this process can be. But when it comes to sleeve designs, frehanding is very often the best way to get a good fit on the arm.

The frehand drawing process will usually go the most smoothly when there is a well-resolved sketch or reference image from which to work. Drawing on the skin with nothing to go by is an easy way to end up in trouble; there are simply too many considerations to keep in mind when designing a large tattoo to just spit it out like that. As a general rule, I will only draw directly on the skin if, at bare minimum, I have a finished sketch that has all the major shapes interacting the way they will be in the completed tattoo, and all the pos/neg relationships and major gradients are defined in the drawing.

Frehanding from a photo brings in some additional challenges. Working from a sketch, you are simply translating your own drawing language from one surface to another. With a photo, however, there is the extra mental step of seeing the photo, interpreting it in your mind and then translating it into your drawing language.

The following sleeve design began as a life-sized plasticine model. The model started as a heavy wood base with a thin wooden skeleton mounted upright on the base. This was given form with aluminum foil, then covered and detailed with plasticine. Including carpentry and wiring, the finished model represents about two days’ work (Fig. 168a).

For the purpose of this tattoo, the lighting on each part of the model was very important in showing the form and texture of the design. Setting up the lighting to shoot a single reference photo of the model would not have provided the kind of specialized lighting on each detail that the project called for. Instead, multiple shots were taken of close-up areas of the model (Fig. 168b, 168c), making sure to capture every surface of the model, taking each shot with carefully optimized lighting to give its shapes as much dynamic detail as possible.

This sleeve was handled in seven sessions. In each of the first four sessions, the design was divided into 4 major sections and drawn on; during these appointments, frehand drawing time was a substantial part of the sitting, close to equal with actual tattooing time (Fig. 169a). The marker drawing was handled in a light-to-dark manner, which allowed the design to come together gradually without having to do a lot of erasing. During the process, the reference photos were kept nearby and consulted regularly. Starting with a yellow Sharpie, the basic flow, fit and layout of the shapes were marked in place. Using a highlighter like yellow or lime green allows for a sort of scribbling in the early stages of the drawing without causing madness problems later in the process.

The drawing was then continued in orange, refining what was started in yellow. During this step the proportions and layout are still being worked out, so it’s good to avoid getting involved in detail, however inviting that may be. When the area was composed in a way that worked well on the arm, some detail was then added. Finally, a purple pen was used to finalize anything that seemed to need it. It’s a simple matter to switch back and forth between markers throughout the drawing process and make use of their whole range of value (Fig. 169b).

While working with the markers you will notice that they can be blended together; in particular, a lighter marker can be used to blend colors that were drawn with a darker marker. This makes it quick and easy to brush in the design’s basic pos/neg relationships and major gradients, along with the lines, edges and other detail that a normal line drawing would include. This technique provides many of the same advantages as a crosshatch stencil in terms of giving the tattooist as much information as possible.
Freehand drawing with marker has advantages and disadvantages. Its major advantage is the flexibility it provides, which makes it possible to optimize the flow and fit of a large design far more easily than can be done with a stencil. Its major disadvantage is the fact that it wipes off more easily than stencil ink, and in some cases, has to be partially re-drawn partway through the tattoo process. In addition, a large freehand drawing can also take up several hours worth of a tattoo session, an issue that using a stencil can circumvent.

Although the majority of this design was drawn on, notice how part of it had been stenciled. Some types of images require more geometric precision than a freehand drawing can provide; these kinds of elements just aren’t meant to be drawn on freehand. Stenciling and marker drawing can be combined in countless ways to provide the freedom and fluidity of freehanding plus the accuracy and reliability of a stencil.

Drawn-on tattoo designs will wipe off more readily than hectograph stencils. This means that the vital aspects of the design need to be committed to skin before the marker has faded too much. As with the neck piece in the previous chapter, simply going through the freehand drawing with a single-pass outline would weaken the strength of the marker drawing and might lead to a misinterpretation of the way the drawing is meant to represent the tattoo.

Because this piece relies on areas of dark and light instead of lines for its strength, a sensible approach is to work magnum first. Using a 5 magnum to lay out this kind of design provides the best of both worlds: it is a small enough needle group to define edges and rough in lines but wide enough to make simple gradations and establish basic posi-negative relationships. For most of this tattoo I worked with a magnum first and then followed up with a 3 round. A 3 round was used to gray in the transparent areas at the top and to add a few select concentrations of fine detail elsewhere in the tattoo. By the end of the first session, there was enough of the image tattooed in place to provide a good starting point for the next session (Fig. 170A).

Because of the desire to give this tattoo a realistic appearance, very few bold lines were used; only the rib shapes in the foreground of the wrist area called for the kind of graphic dimensional separation that bold lines can provide. To ensure that the tattoo has enough structural strength to hold up from across the street, care was taken to make sure that the dark and light areas in the piece were large and clearly defined from each other. By the end of the first pass, the flow of the piece was bold and readable from a distance, even in its unfinished state.

A second pass provided a chance to flesh out the light colors and layer the deeper ones. The reference photos were checked throughout the process to try and keep as much real as possible. Many of the large light areas have no true black at all; by keeping the black shading concentrated in shadow areas, the strength of the tattoo is maintained. Dark and light colors were then distributed in such a way to give the arm a clear silhouette from a distance. Individual detail was given less value range than the larger shapes, as not to clutter the overall flow (Fig. 171A).

Down at the wrist are three rib shapes with strong peripheral lines to pop them forward. Because of the conservative use of lines in the rest of the piece, these ribs have an extra degree of boldness. They curve in a counterflow to the elements passing behind them, creating a simple 3D effect. The background elements between the ribs were given less focus by using only the magnum and avoiding bright colors or highlights. The ribs, on the contrary,
have sharp details and white highlights, done with a 3 round. Hints of yellow at the points of the ribs also help bring them forward from the blues in the background.

By the completion of the tattoo, the look of the photos had been altered in numerous ways, placing more importance on the flow and readability of the tattoo than on how accurately the photos were copied. Acknowledging the S-curve flow of the arm and placing more priority on that than on individual details ensured an attractive clarity, while the realistic details offer additional reward for the viewer’s eye. The method of drawing the design on freehand made it easier to find an ideal balance between flow, accuracy, realism and style.

Don’t underestimate the challenge of freehand tattooing. It has become fashionable for artists to put the word “freehand” on their business cards, but in many cases what is actually happening is bad hot-dog tattooing, done with overconfidence and not enough care. When exploring freehand tattooing for the first time, start small and take your time. There is nothing to prove here!

A client has approached you about a half sleeve. They have presented you with an interesting looking rock they want as a background, and some brightly colored flowers for the foreground. Your job is to draw the rock onto the arm freehand, adjusting its parts for an optimum fit, adding the flowers in the right places for an ideal accent. Flowing negative space may also work in this composition. Drawing freehand in a blank arm image makes it easier to draw the same project directly onto a real arm. Compare your drawing to an example at: www.hyperspacestudios.com/reinventing/exercises

4.6) Extreme Modeling: A Larger Scale Project

On rare occasion a project will come up that calls for using every trick in an artist’s toolbox. I have taken part in a few projects that involved much larger, more elaborate models than the ones described up to this point. These kinds of projects are not necessarily more difficult than simpler ones, but definitely call for more hours of work. The end result is worth the extreme effort because the resulting piece can be so striking and unusual in ways that are next to impossible to achieve without having a detailed custom reference.

The model discussed in this chapter was a collaborative piece created with Pittsburgh tattooist Don McDonald; the finished reference was designed for a tattoo spanning from his knee to his collarbone. The large size of the piece presented an opportunity to build a visually elaborate model to translate into a tattoo.

If you have never collaborated with another artist, working in clay is a good way to start. All of the different collaborative model building efforts I have been involved with have gone very smoothly and quickly, and been quite enjoyable experiences. When sharing a project with another artist, there is a greater chance of someone making a mistake; however, the real-world, hands-on 3D aspect of clay model building seems to make it easier for both participants to understand each other’s intentions, preventing that problem from happening as much.

Our starting point for this project was to take a tracing of Don’s chest, rib panel and thigh. Beginning with a series of thumbnail sketches, the rough idea was sketched onto the tracing at full size (Fig. 173a), placing each element of the design in the best position for each body part. One-inch ruler markings were drawn along the sides of the tracing to provide points of reference while constructing the model.

Next, we went to the garage and built a box to house the life-sized model. This box serves as support and protection for the model, making it self-contained and portable. Rulers were then marked on both sides of the box to correspond to the rulers on the full-size sketch.

For something of this scale, the clay needs to be well supported to keep it from sagging. The model’s skeleton (also known as its armature) can be made from virtually any material, but the most useful ones are flexible materials that can be bent and adjusted during the modeling process. For smaller and more lightweight models, florists’ wire or pipe cleaners can sometimes do the job. However, for larger ones I prefer to use soft copper refrigeration hose, which comes in a variety of different gauges, each with its own degree of stiffness. This kind of hose can be found in most hardware stores, usually in the plumbing department.
Our model’s skeleton was made of 1/4” (6mm) hose that was screwed into the wooden frame in several places (Fig. 174a). The anchor points where the hose was fixed to the frame were chosen carefully to make the model fairly stiff but still allow enough flexibility to be able to make minor adjustments further into the building process. The ruler markings on both the frame and the tubing were consulted regularly during this procedure to ensure that the model was correctly proportioned; with this established, aluminum foil was then put on to give the model its basic form.

The first layer of skin was then added, much like with the tentacle projects in Chapter 4.2. The slices of clay were worked into consistently smooth slabs, then laid over the foil and smeared together to make a continuous skin. By starting at the base and working upward, the clay had a solid foundation to grab onto until the skin was complete enough to hold together on its own. By the time the first layer of skin was finished, the model was quite sturdy.

You’ll notice that the skin of our model was made of several different colors of plasticene (Fig. 174b). Because of the model’s large size, we wanted to save our supply of clean white clay for the surface details, so for the first layer of skin we used clay recycled from older models. I’ve saved a few of the models I’ve done, but I’d run out of room if I kept them all. In most cases the clay ends up getting reprocessed into the next model. Some of the clay in this piece has seen 4 or 5 different projects.

Because of the model’s complexity, its fabrication had to be handled in overlapping stages. The skin in the back of the box was finished before the foil was wrapped onto the skeleton in order to prevent the hassle of having to squeeze clay into tight corners later in the process. Additional materials such as hoses and engine parts were brought into the mix after most of the foreground objects were covered in clay (Fig. 174c).
We then shot a few dozen pictures, each with a slightly different lighting angle (Fig. 176a, 176b). In some, a blue light was positioned above the model to help define some of the detail in the upper areas; in others, blue lights were placed in a variety of other positions. All photos were shot with the camera in a fixed position on a tripod, making it much simpler to composite these different parts of the photo in Photoshop, as we'll discuss in Part V.

In addition to using photos of the elaborate plasticene model, the finished Photoshop composite also incorporates a detailed central shape for its light source that was generated in Bryce (Fig. 177a), like the glass eyeball in the Cory Kruger neck project. We made this shape fairly simple in order to keep it tattooable.

The finished reference brings together all the best part of these photos and other elements (Fig. 177b). Although not perfect, its rough edges were smoothed out as it was translated first into a tattoo and then a painting. For the tattoo, we used full-sized inkjet prints of the reference image in order to allow for the most uncompromised detail and accuracy when tracing the stencil. I spent a few long hours hand-tracing it, carefully working out my strategy for getting the image accurately committed to skin.

The model was then lit and photographed, using several blue-wrapped fluorescent lights and an incandescent bulb that was installed in the model. However, we found that the position of the yellow bulb did not provide the flexibility we needed. It became obvious that the nature of the model would require several photos taken with minor variations in the lighting in order to capture the piece in the most dynamic way. So I removed the lamp and then held it with my hand; the yellow 25-watt bulb was not too hot to hold for a few short minutes.
The finished tattoo was done without outlines, following the reference as closely as possible (Fig. 178a). Some things about the design have been changed; most notably the addition of negative space streams to break off the piece, accentuate its overall flow, and keep the background from becoming too heavy.

Once finished, we decided the model was successful enough that we also collaborated on a painting of the design (Fig. 178b). On canvas, we had the opportunity to translate the reference faithfully into a painting, unlike the tattoo project where a certain amount of interpretation was necessary to make it work well on skin. Doing both projects from the reference allowed the subject to be explored from two distinct directions.

Most projects won’t call for anything this elaborate. Indeed, the majority of tattooists seldom get the chance to work even with small and simple custom references. But I’ve included the topic in this book because it shows that there are no limits to how far you can go to make a design original, powerful and memorable. I encourage all artists to go beyond what is readily available or easily achievable, because it is the effort that extends outside the norm that will result in the most surprising discoveries and accomplishments.
PART V

The Digital Tattoo

5.1 Basic Computing for Tattooists

These days, the added capabilities of the computer are available for creating custom references and designs that are much more to our liking. In addition, they can be used to clean up our presentations and help us to look more professional in general. When my wife and I bought our first computer we expected it to be useful for making our portfolios nicer and archiving our images for printing and internet use. However, we had no idea how much it would empower us artistically and broaden our horizons in general.

Now that we're well into the 21st century we're beginning to see a division between those who embrace computers and those who don't. This is a completely understandable thing; computers are not only expensive but fiendishly complicated. To someone who has never worked with one, the learning curve concerning working with a computer may seem insurmountable. This chapter is presented in an effort to dispel some of the sense of intimidation by giving you inside look not only at what is possible with a computer but by showing you, step-by-step, how to get from knowing nothing to being able to handle most of the basics without help.

A program (also known as an application) is a piece of software designed to make your computer do a particular thing. For instance, Safari is an internet browser program, while Photoshop is an image manipulation program. Without programs, your computer is just an expensive plastic box.

Because learning to use a computer involves becoming familiar with several programs, each with its own instruction manual, I recommend keeping a notebook by your computer and taking notes as you figure things out. Try to distill your discoveries into simple step-by-step instructions that you can follow later. By keeping track of what you learn and making yourself a simple "cheat sheet", you won't have to keep re-inventing the wheel.

A complete digital outfit for a tattooist should consist of the basic computer (Central Processing Unit, or CPU; keyboard, monitor, mouse), a scanner, a printer, and good peripheral controls such as a trackball or graphics tablet. There are cheap entry-level machines available from brands like Dell or Gateway where you can pick up most parts of this outfit for around a grand. If it's really all you can afford, that's fine; it will do the job. But if you're a working tattooist you can probably afford something more powerful, and getting a cheap computer is kind of like using cheap tattoo machines—it can mean more work or expense later. Especially in the case of an artist wanting to do a fair amount of image manipulation, the wrong computer can cost many extra hours in the long run.

For answers to these questions, go to: www.hyperspacestudios.com/reinventing/answers
A hard drive is a recording device in your computer that stores the various programs and files that you have. When you open a graphic file it is read from the hard drive by the computer, when you are finished manipulating that file and save it, it will be written back onto the hard drive. This is also known as your computer’s storage, and serves as its long-term memory. You want your computer to have plenty of storage space.

Random Access Memory (RAM) is the part of the computer that is responsible for the execution of a job by acting as the processing core’s short-term memory. Generally, a computer’s RAM will be around 1/10th the size of its hard drive. More RAM means that jobs requiring a lot of calculations will be performed faster. This is also known as your computer’s memory, and is used only for short-term jobs.

Many artists in all different mediums, myself included, seem to prefer Macs over computers for their artistic flexibility and powerful processing. The lowest-end Mac is the Mac, which will run you around right to eighteen hundred dollars, depending on how fast and well-equipped that particular model might be. Higher-end Macs can run up to around $3500 or more; these models don’t come with their own monitors like iMacs and usually require a bit more setup, but are more potent workhorses with fewer limitations. The recent iMacs, though, are powerful space-saving machines with many great features; it’s worth doing your research before making the purchase.

For a sense of scale, picture this: An image posted on the Internet has to load quickly, so its file size is kept to a minimum; using JPEG compression, a web picture will generally be somewhere between 50-100 KB. For printing purposes, though, that would be too crude. At full 300dpi photo resolution, an 8 x 10” picture without compression will be 20.6 MB, hundreds of times the file size of that web image.

I just bought a new computer with 1.5 TB of hard drive and 2 GB of RAM. By 2008 standards that hard drive will hold a lot, but if we were editing a lot of video or music, I could easily use it up in a year unless I had good habits about backing up and storing files that were not being used often.

A CD will hold around 600-700 MB of data. A CD of uncompressed music will usually give you about 7-8 minutes of listening at full resolution. Compressed into MP3s, though, that same CD will hold hundreds of songs. So the size of a file will be affected in a big way by the file type, and whether or not it uses compression.

Bytes, Megabytes and Gigabytes

Digital files come in all different sizes, like books. But instead of measuring their size in pages, they are measured in bytes. Like the Metric system, digital file sizes are measured in increments of 10, 100 and 1000:

- 1 kilobyte (KB) = 1000 bytes
- 1 megabyte (MB) = 1000 KB, or 1 million bytes
- 1 gigabyte (GB) = 1000 MB, or 1 billion bytes
- 1 terabyte (TB) = 1000 GB, or 1 trillion bytes

For a sense of scale, picture this: An image posted on the Internet has to load quickly, so its file size is kept to a minimum; using JPEG compression, a web picture will generally be somewhere between 50-100 KB. For printing purposes, though, that would be too crude. At full 300dpi photo resolution, an 8 x 10” picture without compression will be 20.6 MB, hundreds of times the file size of that web image.

I just bought a new computer with 1.5 TB of hard drive and 2 GB of RAM. By 2008 standards that hard drive will hold a lot, but if we were editing a lot of video or music, I could easily use it up in a year unless I had good habits about backing up and storing files that were not being used often.

A CD will hold around 600-700 MB of data. A CD of uncompressed music will usually give you about 7-8 minutes of listening at full resolution. Compressed into MP3s, though, that same CD will hold hundreds of songs. So the size of a file will be affected in a big way by the file type, and whether or not it uses compression.
Expect to spend up to twice as much for the pro model. The iMac comes with its own monitor but the faster Macs don’t: a good monitor can start at several hundred, and an oversized one (very helpful for artists!) might begin at around $700 and go up to $2500 or so for the premium Mac cinema display.

You’ll also need a scanner and printer, which start at about a hundred each and go up from there. A decent-quality standard size scanner runs around $200; a good Epson printer will run you about the same. Larger scanners start in the thousands, and an oversized Epson printer can run around $6,700 or more, but if you do a high volume of large print work, it can be worth it.

For a controller, I generally don’t recommend a standard mouse, which can be hard on the hands and wrists and doesn’t offer enough control for fine artistic work. I’ve had good luck with a trackball, which allows tasks to be done with the fingertips, not the whole arm. Kensington makes a few good trackballs—the best ones are those with the biggest, heaviest ball and multiple buttons. These buttons can be programmed so that one is for clicking, one is for double-clicking, one for dragging, and one for slow cursor, which provides a much greater degree of control. Since I need to let my right hand rest as often as possible, I taught myself to use the trackball with my left hand and found that it was remarkably easy. At first I still handed the ball over to my right hand for the more precise operations, but with only a few weeks’ practice I actually found myself preferring the left hand for most computer-related tasks.

Another good type of controller for artists is a graphics tablet, which works kind of like a big version of one of those electronic signature-taker things for processing credit cards. The smallest tablets start at around $100 and provide a 5x7” (12x18cm) work area. I prefer the small tablets because the cursor can be easily moved from one corner of the screen to the other with just a flick of the wrist. A larger tablet provides more precision but can be expensive. The newest line of Wacom tablets incorporate several buttons on the tablet that can be programmed to mirror the functions of keys on the keyboard including Shift, Control and Option. This allows artists to sit back comfortably from their computers and work with the tablet freely, without having to lean forward to use the keyboard very often. Some types of work, such as Photoshop airbrushing or cloning, are ideally suited for tablet work because the pressure-sensitive pen is so similar to using a normal pen or pencil. In addition to these tasks, I have found the tablet to be a good all-around navigation tool that can save strain on the wrist and hands.

Most new Macs come with a SuperDrive, which will read and write both CDs and DVDs. If you are using an older or lower-end computer without a CD or DVD burner, you will need to get an external one. The ability to make CDs and DVDs allows you to send files to places like print shops and magazine publishers, and gives you a medium for archival backup of your data. Any files that you are not actively using can be burned onto CD or DVD and kept in a CD storage box for handy access. I recommend keeping detailed notes of each disk’s contents either on the disk itself or on a card that is kept with the disk in the same slot in the book. Having to load each disk into your computer to see what’s on it will quickly become an annoying burden once you’ve started accumulating a lot of disks, which is inevitable.

You’ll most likely get the best deal on your computer through catalogs such as Club Mac, Mac Warehouse or MacConnection. If you get catalogs from several places, you can compare prices—usually they are pretty competitive with each other. You can also compare prices on the internet if you have access. If not, you can begin by calling 1-800-555-1212 and ask for the 800 numbers for each of these resellers. If you have internet access, you can go straight to www.apple.com and customize your computer at their online store. However, you may find that the customer service and response time of the major catalogs is preferable.

New computer owners are often frustrated by the setup process. It’s easy to become intimidated or confused by the newness and complexity. Just remember that there are 11 years old all over the world that could do it for you in about an hour (not that this fact will necessarily make you any less frustrated!). The setup process is actually pretty simple, especially if you’ve got a friend or family member who’s done it before. You can also find forums online, often connected with the manufacturer’s website, that will usually have answers to the most common questions. Keep in mind that this confusion is a short phase that all new users go through, and you’ll quickly work your way past the hurdles toward being fully functional. Before you know it, you’ll be answering questions for friends of yours who just bought their own computer; more importantly, you’ll be able to figure out how to answer your own questions.

Although I am a Mac user and recommend them to others, ultimately there are few major differences between the functionality of a Mac versus a Windows-based system. These days, both types of computer are using the same processors; in many ways, the hardware is virtually identical. The main difference between the two basic computer types is in their operating systems.

An operating system (OS) of a computer is the program that gives the user control over the machine. It has a controller driver that allows you to use a mouse or tablet, provides settings for system preferences (such as screen brightness, sound volume, etc.) and includes system for storing and navigating files and folders. For Macintosh computers, it is known as Mac OS, and most are using OS X or newer. It is the Mac OS that makes the Macintosh such a prized machine for artists to use. For most other computers, Windows is the popular operating system.

Many of the commands you’ll need to know for working with programs are similar or identical for both Mac and Windows users. I am aiming to make this book useful for users of both types of OS by providing the commands in two colors, blue for Mac and red for Windows. Please forgive me if some of the Mac-enabled options I discuss here are not available for Windows users.

There are countless graphic application programs available, each with its own unique advantages; a single person could never learn them all in a lifetime. For our purpose as tattooists, probably the most important program we can learn is Adobe Photoshop. Photoshop can be used like a paint program, where we start with a blank canvas and add colors and shapes using the many tools available. But its real strength lies in its ability to import existing images and manipulate them, which is what we'll explore here.

Photoshop is not a cheap program; a full-blown package of the newest version will run you around $600. I assure you that this investment is worth it. However, many scanners will come with a free stripped-down version of Photoshop called Photoshop Elements. This has many of the basic features of the full version, but lacks most of its bells and whistles and a number of its more fundamental abilities. A decade ago, I got by just fine with this version for my first eight months or so of owning a computer. You'll find it adequate for getting familiar with the basic workings of Photoshop, and if you never plan to do anything beyond simple portfolio maintenance and website management, Photoshop Elements may be all you ever need. Once you get more experience with these tools, though, you're likely to want the greater versatility offered by the full version. If you need to manipulate imagery for your business, the purchase price makes a good legitimate write-off during tax season.
Making a Program Active

It’s normal to have more than one program running at the same time; for example, you may be running iTunes to play music while you are working in Photoshop. However, only one of them can be actively interfaced at a time. In a Mac, you can switch between programs just by clicking in that program’s window. In the case where you are working with both Photoshop and iTunes, if you click in any Photoshop window, the menu bar at the top of the screen will become the Photoshop menu bar, and the rest of the Photoshop tools will appear.

Then, if you click in the iTunes window, the menu bar becomes the iTunes menu bar and the Photoshop tools will become invisible, even though it’s still running. For the purpose of discussion in this book, we’ll refer to whichever program is in the foreground as the active program.

Any program window you click in becomes active; when that happens, the title in the top bar of its window will turn black, and the titles of the other windows will turn gray.

Once upon a time, it was easy to get a program simply by asking a friend to borrow their software CD or by downloading it from some hacker site. I won’t bore you with an ethics lecture about making art; the folks who did the hard work get paid for it, or anything like that. But the new reality is that most software companies have found pretty effective ways of discouraging pirating of their software, and for the most part it is a waste of time to try circumventing these measures. Adobe products in particular are very well protected. My advice: Just spend the money, it’s worth it. Any measures needed to make a pirated program work will inevitably lead to decreased functionality and other frustrations. Think of it as karma, or something like that.

Software installation is the act of requesting your computer to make a copy of a program from a CD or the internet onto its own hard drive, and to interface that program with all related programs. For instance, Photoshop must interface with your scanner program and with your operating system in order to function.

Windows-based computers use a different mouse from Mac computers, which includes a “right-click” button. Mac controllers don’t incorporate the right-click, and instead use a Control+click combination. If you are a Windows user, any time I refer to a Control+click, think of it as a right-click.

Installing programs in your computer is usually a simple matter of inserting the software CD and double-clicking on the disk icon that appears on the screen. A folder will open with several things in it, one of them called an installer. If you double-click this icon, you will be led through a simple set of instructions, and in some cases you’ll be required to restart your computer. Once you have Photoshop and your scanner driver installed, you are ready to begin working with your photos.

5.2) A Brief Adobe Photoshop Tutorial

Adobe Photoshop has been around for a long time and has entrenched itself in the world of digital media as the gold standard in computer-based image manipulation. Manipulation of an image can take countless different forms, from slight changes in color or contrast to the complete reworking of a composition. Because of its versatility and the vast amounts of feedback that Adobe’s programmers get from their users, Photoshop is without peer when it comes to almost any kind of manipulation to existing imagery.

I’ll try to be quick here. Photoshop has countless tools and menus, so we’ll only discuss the ones that can be used the most readily in tattoo design preparation or portfolio presentation. This chapter will be the most helpful if you already have your computer, have Photoshop installed, and are able to experiment with the features we discuss right there on the screen as we talk about them. If you don’t have a computer yet, this section will probably be utterly mind-bending, and I don’t blame you if you want to proceed to Part VI until you are properly outfitted with a computer and ready to explore its capabilities.

I have found that the best way to learn a program is to have a project that you need to do with that software, and learn how to do it. Starting by knowing nothing and then reading the whole massive instruction manual is not going to make you productive; what you need is some simple tasks to perform, an instruction manual and a little spare time. Once you have done a few small jobs and are familiar with the basic workings of the program, you can begin taking on more complex things until you reach the point where you are able to use the program freely without any guidance. Many programs are like this; you can become functional with only a basic knowledge of the software, but with deeper exploration you will continue discovering ways to expand your capabilities.

Importing Photos From Your Camera Into Photosho

In order to work with a photo, you need to bring it into Photoshop first. There are a number of ways to do this. First, you’ll need to download your photos. This should simply involve plugging the camera into the computer and turning it on (some cameras have a choice of either Camera Mode or View Mode; it will need to be on View Mode to download). This should cause a photo archiving program like iPhoto to open, which will prompt you to click a button to begin downloading. Once finished, you can turn off your camera and unplug it.

From there, you have several options. I prefer to make a separate folder on the desktop and copy the pictures I plan to use into that folder, which makes it easier to find them later when I need them. This is done by first clicking on the background of the screen so that iPhoto becomes gray and the Finder, which is the navigation feature of Mac OS, becomes the active program. Then go to File > New Folder, which will make a new empty folder on your desktop that you can name whatever you want. Next, drag and drop your chosen photos from iPhoto into that folder; doing this will make copies of them but still leave the original files in iPhoto. This will make the pictures easier to find when you need them.

Photoshop has good image browsing features, so finding your pictures in your iPhoto database from the Photoshop File > Open menu is fairly easy. However, once your iPhoto library gets large enough, you may find it a good idea to copy your most important images into their own folders where they can be more easily found.
When you open Photoshop for the first time, you'll see a variety of small windows around the screen containing various tools, menus and options. These small windows are known as the Photoshop world as palettes. To your right will be a group of palettes that each have tabs along their top; these tabs will select between different functions within each palette. Each of these little windows is in fact completely encrusted with controls and functions, to the extent that they can seem intimidating; you will quickly overcome this as you familiarize yourself with the controls.

Most Photoshop users are only familiar with a small percentage of its tools and features, yet are still able to do impressive work with it. Photoshop is like that; no two users work with it the same way. An artist can find many useful things to do in Photoshop even with a limited knowledge of its tools and functions, so don't let its awesome complexity be a turn-off.

For our first demonstration project we'll lay out a portfolio page with two photos on it. To make this a more useful demonstration let's assume that one of the photos is a digital picture that you've already downloaded from your camera and saved in its own folder, and the other is a photographic print that will need to be scanned. Make sure your scanner is plugged in and turned on, and that the scanner driver for it is installed.

A driver is a program that comes with a hardware item such as a scanner or printer, which allows the computer to control that device. On its own, your computer could never know the specifics of operating every compatible piece of equipment on the market; driver programs give your operating system the specific information it needs about that equipment. If you are using an older device on a newer computer and there appears to be a compatibility problem, you can often fix that by going to the website of the device's manufacturer and downloading a new driver that is compatible with your current OS.

The first step is to create a new Photoshop file for the page you are making. Assuming the printer is borderless, the file should be 8.5x11" (21x28cm) at 300dpi. You can do this by going to File > New (Apple: N / Ctrl: N), then filling in the information for the size and resolution of the new file you want to make.

Keyboard shortcuts are key commands that can save a lot of work. For example, to make a new document, you would normally go to the File menu, click New and then click OK in the New File dialog box. By using the keyboard shortcuts, you would instead hold down the Apple key and hit N, then the Return key instead of clicking OK. When you navigate through the menus in the menu bar, you will see that the commands which allow for keyboard shortcuts have them listed on the right side of the menu. You can write the most commonly used ones on an index card and keep it by your monitor to help you get familiar with them; even better, you can buy a "skin" that lays over your keyboard that have keyboard shortcuts for various programs printed on each key.

The next step is to import the images that will be placed on the page. The digital picture has already been downloaded from the camera, so bringing it into Photoshop is a simple matter of going to the File > Open menu, then finding and selecting the picture you want. If you've already copied that file into its own folder, this process is easier.

Once the image has been opened, see if it needs to be cropped to remove unwanted excess background from the picture. The Photoshop Crop Tool is a simple and handy way to crop your photos, even if they are crooked. Select the Crop Tool from the toolbar, then click on your photo near one of the corners and drag diagonally across to the opposite corner. The position of the Crop box can be approximate at first. You will notice two squares in the Options bar at the top with a check mark in one and a circle/slash symbol in the other; the crop will not be finalized until that check box is clicked. Until then, you can adjust and angle the box to fit your photo the way you want. By clicking and dragging on any of the small squares around the box, it can be resized and made taller or wider. When you move the angle just outside the box, it will turn into a curved arrow, which allows you to rotate the box to compensate if the photo is crooked (Fig. 189a). When the box is at the angle you like and frames the part of the photo you want to keep, click the check mark in the Options bar to finalize the crop.

In most file navigation modules such as the Finder or the Photoshop File > Open menu, there are several options for displaying your files. The button on the left is icons, which will show a grid of folders and thumbnail images. If you need to see image thumbnails to find your file more easily, this feature can be helpful. The second option is a single row file list, which lists the contents of the selected folder, and the third is a multiple row file list, showing folders within folders. This third option may appear complex at first, but once you are accustomed to it, you will find it very useful for staying familiar with the complex tree of files and folders that will accumulate in your computer. Also useful is the desktop shortcut (Apple > D) which navigates straight to the desktop in these menus.
The Toolbar

Many of Photoshop’s most important tools are contained in small vertical window known as the toolbar. There are 22 squares containing tools, and most of these squares have their own small drop-down menus (which appear when you click and hold on them) that have additional variations on each tool. This list gives you a brief rundown of these tools and their functions.

1) Marquee Tool
For selecting rectangular, oval or linear areas of a file; can be hard-edged or feathered

2) Move Tool
For selecting and moving objects or layers; can be set either to move the selected layer only, or to select the layer of whatever object this tool is clicked on (check “auto select layer” for this second option)

3) Lasso Tool / Polygonal Lasso Tool
For selecting irregular or polygonal areas of a file; can be hard-edged or feathered

4) Magic Wand
For selecting areas of an image that are of similar color

5) Crop Tool
For cropping and realigning images

6) Slice Tool
For breaking an image apart into smaller pieces for web purposes

7) Healing Brush
For repairing small flaws in an image

8) Paintbrush
For drawing, painting or airbrushing; brush can be made in various sizes, hardnesses and textures, and can be set to various opacities and other properties

9) Clone Stamp
For copying small areas from one part of an image to repair or change other areas; works the same as the Paintbrush

10) History Brush
This is used for returning parts of an image to an earlier historical state. For example, if you open an image of a portrait and then change the levels but liked the nose better before that change, go over the nose with the History Brush and any areas you touch will return to the image’s levels as they were before the change.

11) Eraser
For erasing parts of the selected layer; works the same as the Paintbrush

12) Gradient Tool
For generating gradients of a number of different types; useful for many things but especially for simple backgrounds

13) Blur Tool / Sharpen Tool
For blurring or sharpening; works the same as the Paintbrush

14) Dodge / Burn Tool
This is similar in principle to the dodging and burning that photographers do in the darkroom. The Dodge Tool is the black lollipop thing, and is used for lightening areas of an image. It can be set to lighten the highlights, midtones or shadows. The hand-shaped thing in the drop-down menu is the Burn Tool, used for darkening the shadows, midtones or highlights. With practice, these tools can be very helpful in getting rid of some of the glare in your tattoo photos. Works the same as the Paintbrush

15) Path Selection Tool
For selecting and working with paths

16) Type Tool
For creating text of all sorts; works the same as a word processor but with more graphic options

17) Pen Tool
For laying down work paths; allows for precise control over areas and curves

18) Rectangle Tool
For making rectangular work paths

19) Notes
An alternate version of the small adhesive Post-It notes. Probably most helpful in multi-user projects

20) Eyedropper
For choosing colors from anywhere on the screen; you can temporarily turn the Paintbrush into the Eyedropper by holding down the Option key

21) Hand Tool
For easily navigating around inside an image that is blown up much larger than the screen

22) Zoom Tool
For zooming in and out from an image; it is capable of zooming inward to the point where the pixels start getting large

The toolbar has some additional features as well:

23) Foreground / Background Color
The paintbrush uses the foreground color, and if anything is erased on the background layer or the canvas is enlarged, the background color will be exposed. The arrow to the upper right of these squares will reverse the two colors if clicked, and the button to their lower left will return them to default.

24) Standard Mask / Quick Mask
Allows for easy masking and selection options

25) Standard View / Full View With Menu / Full View
Provides three viewing options for your file

26) Edit in ImageReady
This provides a quick solution for web-optimizing images; of particular use to web designers

Most tools can be customized using the Options bar, which runs horizontally along the top of the screen and contains menus and options that pertain to whichever tool is selected in the toolbar at that time. For example, if you have the Paintbrush Tool selected, the Options bar allows you to customize the size, feather and opacity of the brush, among other things. Take the time to familiarize yourself with the tool options available.
Next, the image needs to be brought into the 8.5x11' page that was made earlier. This is done easily using the Move tool, which is capable of moving layers or parts of images from one file to another, as long as they are open at the same time. Simply select the Move tool, then click on the file you want to move and drag it into the other file (at first it may appear that the source file is getting randomly misaligned, but when your cursor exits that file, it will realign itself as you drag the image into the other file). Most likely, it will land there semi-randomly (Fig. 192a).

In all likelihood it will not be the right size. It may be smaller than desired, but it's also possible the image will be larger than the page and will end up running outside its borders. Don't panic— the whole image is still there, but it needs to be sized down. The simplest way to do this is with the Transform Tool, which you access by going to Edit > Transform (Apple> T / Ctrl+T). This tool provides a resizeable box like the Crop Tool that can be sized, angled and distorted in a variety of ways. By clicking and dragging inside the Transform box, you can also move the image anywhere you want. So, if your image is larger than the page, you can size it down by clicking on the corner box and holding the Shift key (which prevents distortion of the image by keeping its proportions true while you resize it). Then you can click inside the part still visible and drag the rest of the image onto the page.

One of the most important tools a computer offers is the ability to step backwards if a mistake is made, known as undo. On a Mac, it's simple: Hold down the Apple key and hit Z (Ctrl+Z). Hit Z (Ctrl+Z) a second time to redo the action. Sometimes it can be helpful to go back and forth between two minor variations in a document to see which looks better; hold down the Apple / Ctrl key and keep hitting Z until you decide which one you want.

Photoshop offers the ability to step back more than one action by using its History palette. This palette shows a list of all your recent actions; scroll back and click on different ones until you have backtracked to the point you want.

For a page with two images, both photos need to be either horizontal or vertical in order for them to fit on the same page. You may be satisfied with the results you get by simply eyeballing the size and placement of the images on the page, which can look good in some cases if done with an artistic eye. But if you want precise results, you need to use guides. Guides are straight horizontal or vertical lines that can be dragged into place anywhere in your file and then used to align different elements on the page. In the case of a two-image page like the one being discussed in this chapter, imagine the page having two horizontal photos with a 1/4" (6mm) space between them and a 1/2" (12mm) border all the way around.

To make guides, the rulers need to be active. If you don’t see them above and to the left of the window, go to View > Rulers (Apple > R / Ctrl > R) to activate them. You can click inside either ruler and drag guides out into the page, placing them where you want. You can zoom very close into the page to align them precisely to specific numbers on the rulers. If you release a guide and want to move it some more, hold down the Apple / Ctrl key and position the cursor over the guide; this will give you a handle for dragging it. To get rid of a guide, drag it back into one of the rulers.

Once you have your guides where you want them (Fig. 193a), you can use the Transform Tool to resize the images to fit the spaces shown by the guides. Instead of cropping the photo before bringing it into the page, you can use the Transform Tool to compose the image using the guides as a boundary (Fig. 193b), then trim off any excess that extends beyond the guides.

To get rid of these unwanted extra areas of photo outside the guides, the area needs to be selected with a rectangular marquee. First, go to View and see if Snap has a check next to it. If not, turn it on by selecting it from the menu. Next, select the Rectangular Marquee Tool, check the Options bar to make sure the Feather is set to 0, and then click on one of the corners defined by guides and drag diagonally across to the opposite corner of that photo. By having Snap enabled, the marquee should align itself precisely on the guides. If not, you can try again or you can go to Select > Transform Selection, then drag the square handles until they snap into place, aligning the selection with the guides (while using the Transform Selection tool, you may have more luck getting the selection edges to snap to the guides if you use the side handles as opposed to the corner ones).

When the marquee is where it belongs, the next step is to go to Select > Inverse. Check the Layers palette to make sure the layer with that photo is selected, then hit the Delete key. That will crop everything outside the selection in that layer. Afterward, deselect the marquee (Apple > D / Ctrl > D).
The Layers Palette

One of the features that makes Photoshop so powerful is its ability to develop images in multiple layers. The Layers palette displays the layers in your document and allows you to click on them to select which layer you want to work. You can also click on the Eye icon to the left of each layer to make it visible or invisible. When you create a new document it will consist of a single layer with the default name “Background”. Whenever you paste an image onto the file, it will appear as its own layer, with the default name “Layer 1”. You can change the name of the layer by going to Layer >Layer Properties, which opens a box that allows you to rename a layer, among other things.

This demonstration shows a few different ways of working with layers. First, a new file is created and an image of a girl with a basic white background is pasted in place and sized to fit, creating a simple two-layer file. Next, to clear out the white background, the top layer (the one with the girl) is chosen, then the Magic Wand is selected from the toolbar and clicked on the white background. If you select the white background, the tolerance needs to be set higher in the Options bar. If it selects more than just the background, the tolerance needs to be lower (sometimes it is necessary to set the tolerance lower than you want, then use multiple clicks with the Shift key held down to make the desired selection). When the selection includes only the background (Fig. 195a), your results can be made to look more natural by going to Select > Feather, and using the Feather for two or three pixels. Next, hit the (Delete/Backspace) key to remove the background. Then Deselect (Apple - D/Ctrl - D) to get rid of the selection edges.

Lettering needs to be added to the image, which is done with the Type Tool (Fig. 195b). When a new type is created, it automatically appears as its own layer, and this layer will appear on top of whatever layer was selected in the palette before the type was generated. To put the type in the background behind the girl, simply click on that layer in the palette and drag it to a position below the layer with the photo. This will cause the lettering in the image to appear behind the girl’s head (Fig. 195c).

To add a new background, open another file with the background image you want, select and copy the image (Apple - A. Apple - C/Ctrl - A/Ctrl - C), then click back to the file with the girl, select the background layer, and paste (Apple - V/Ctrl - V). In many cases, this same action can be performed by using the Move tool to drag the image from one open file to another. If it needs to be resized, use the Transform tool. Because the background layer was selected before pasting, the new background image appears as a layer above the old background but behind the girl and the lettering (Fig. 195d).

Since the old background is no longer of any use, the new one can be merged onto it to make one layer. To do this, select the new background, then go to Layers > Merge Down (Apple - E/Ctrl - E). Different transparent layers can be merged together this way as well. To produce a gradient in the background, create a new blank layer by going to Layer > New Layer, and name the layer “Gradient” (naming your layers is not necessary but can be helpful). After choosing a color in the foreground color box in the toolbar, click on the Gradient Tool, choose the type of gradient you want in the Options bar, then click and drag the tool across the document to produce the gradient (Fig. 195e). If the gradient is too bright for the image, it can be made transparent by going to the Opacity option at the top of the Layers palette and sliding it back and forth to choose how transparent you want it. Additional glow effects can then be used to clarify the different elements in the image (Fig. 195f).

This is just the tip of the iceberg in terms of what can be done with layers, but should be enough to get you started.
Sometimes computers crash, or in some cases we'll make a mistake and really screw up the file we're working on; that's why it's so important to regularly save everything. Every few minutes as you work, pause for a moment to save what you are doing. That's actually really simple: Hold down the (Apple / Ctrl) key and hit S. If you're about to do something major to a file and want the ability to go back to your older version if the new one doesn't work out, save the new one under a different name.

Bringing the photographic print into your portfolio page involves a few more steps than working with a digital photo. Make sure the scanner bed and the photo are clean and dust-free, then place the photo in the bed and close the lid.

From Photoshop, go to File > Import; from there another menu should drop down with a list of import options. One of these should be the name of your scanner; select that one. This will open a window for the scanner driver and cause the scanner to warm up. Sometimes scan programs can take a few moments to open, so be patient.

The driver window will consist of a tool area and a view of the scanner bed (Fig. 196a). To see what is currently in the scanner bed, look for a button that says Preview or Preview (1) and click that. The scanner will then make a quick pass over the scanner bed and display its contents in the window. There will be a rectangular marquee (2) in the window somewhere that you can then move and adjust to frame off the photo as you want.

It's possible that the image will appear too dark or too light in the window; if this is the case, it's important to adjust the levels before scanning. Somewhere will be a button showing a little black mountain shape (3) that will allow you to make this adjustment. The window this button opens shows a larger black mountain shape, representing the distribution of color, dark and light in the image; this is known as a histogram (Fig. 196b). As a general rule, the sliders at the left and right should not clip off much (if any) of the histogram's curve, or there will be blown-out highlights or shadows in the image. Ideally, they should be slid up to the point where the curve starts at either end, but not much further (Fig. 197a). When the image's levels look good, click OK to return to the main scan window.

There will be a slide bar or drop-down menu for choosing the resolution of the final scan (4); for the purposes of making your page, 600dpi will work okay using a high resolution for a scan, the image can be sized up substantially on the page without losing fuzzy. With the resolution chosen, the levels checked and the image framed in the marquee, it's time to click on the Scan button (5) to import the image into Photoshop. The actual scanning process may take a minute or so.

When scanning multiple images, it's best to fill the scanner bed with photos that are of similar exposure and brightness levels. When multiple photos are similar in this respect, they can be adjusted and scanned as a whole batch. This can save time, but if some photos are darker or more washed out than the others, they will need to be adjusted and individually scanned. Even a low-quality photo can begin to show hope with its levels adjusted optimally.

When the scan is complete, the image will appear in Photoshop as its own file. To bring it into the portfolio page, follow the same steps as with the digital photo: Select all (Apple-A / Ctrl-A), copy (Apple-C / Ctrl-C), and click back into the main page and paste (Apple-V / Ctrl-V), or just use the Move tool to drag it in. After that, the procedure is the same as with the digital photo. Transform its size and angle to your liking, position it where it belongs, then use the Marquee Tool to select the image's area on the page, select the inverse, and clear it with the Delete key.

While doing editing work on images, especially smaller scale retouching, it's essential to be able to zoom in and out from the image. You can do this either by using the Zoom Tool (click it on your image to magnify; click while holding Option to demagnify) or by holding down the (Apple / Ctrl) key and hitting either the + or - key.
With scanned photos, there is always a high probability of having dust, scratches or fingerprints on your images. This is especially apparent once you’ve zoomed in close. The Cloning Stamp is ideal for making invisible repairs to this type of damage. Let’s take an example of a photo where white dust is visible in a dark area of the picture. The way to remove the dust is to first select a brush size for the stamp that is a bit larger than the dust specks but not too much larger, with its hardness set at 0%. Move over the stamp to an area near a dust speck that is the right color and texture for the repair. Hold down the Option key and click on that spot (Fig. 198a); then, release the Option key, position the stamp over the dust speck and click again (Fig. 198b). The speck will vanish, covered by pixels copied from a nearby area. Properly done, Cloning Stamp retouching can be almost impossible to detect.

With both images in place and trimmed, the page is essentially done. There is still the option of selecting the background and filling it with the color of your choice, or adding gradients and other effects to the page as described earlier in the Layers palette description. The images can be dragged back and forth with the Move Tool to see if they look better above or below each other. If either image is too light or too dark, its levels can be adjusted in a similar manner as with the scanner driver by going to Image > Adjustments > Levels (Apple > L / Ctrl > L). When the background looks right, the photos are where they belong, and their levels are adjusted so they look appropriate on the same page with each other, the page is complete (Fig. 199a).

The final step is to go to Layer > Flatten Image. This makes the whole image into one layer, which takes up way less storage space. You don’t want to do this until you’re sure because once a file is saved that way, the original background is no longer continuous underneath the pictures; it’s all just one image.

All that remains is to make another 50 portfolio pages or so. By the time you’re finished, you’ll be pretty smooth with a lot of fundamental Photoshop operation.
5.3) Using Photoshop in the Design Process: Scanning and Coloring a Drawing

Some projects call for having a finished color rendering of the design before starting the tattoo. Generally, any tattoo that is using new color strategies which you aren’t really familiar with will be better in the long run if you start with a color rendering. This will not only provide a reference to consult while tattooing, but will also give you a chance to experiment with color variations in your design before committing it to skin.

In the early part of my career I did colored pencil renderings of nearly all the tattoos I did, and some drawings of tattoos I wanted to do (Fig. 201a, 201b). However, colored pencil rendering can be a laborious process, and in some cases I ended up putting almost as much work into the drawing as the tattoo. These days, my hand tires quickly if I use colored pencils for too long, so I began experimenting with Photoshop as a way of making the coloring process faster and easier.

Photoshop can provide ways to mix digital and analog media. This image was first created as a pencil drawing in my sketchbook; after scanning and doing some rough coloring and other adjustments in Photoshop, I then printed the image on heavy paper and finished it with colored pencil.
This project has some elements that are symmetrical and others that are not. It is the kind of project where a little composing, or the combination of different pieces into one picture, can save some time and effort. Fig. 202a shows a whole sketchbook page, with a thumbnail sketch of the client's lower back in the lower left corner. The spiral filigree shape, which will be almost identical on both halves of the design, only needed to be drawn once. Then a variety of roses and rosebuds were also included in the sketchbook page, along with some foliage. These various bits and pieces can all be copied and pasted together in Photoshop. The advantage of finalizing the design digitally instead of drawing it all at once on paper is the flexibility that Photoshop offers; by being free to rotate and resize each rose as it is positioned in the design, it's possible for the relationships between the shapes to be adjusted with a new level of versatility.

To do this, first the Polynomial Lasso Tool is used to select the filigree element (Fig. 202a). It is then copied (Apple-C / Ctrl-C), given a new file (Apple-N / Ctrl-N), Return (Ctrl-V/Ctrl-N), and pasted (Apple-V / Ctrl-V). Next, the layer is duplicated and flipped (Layer > Duplicate Layer; Edit > Transform > Flip Horizontal). The canvas is doubled in size by going to Image > Canvas size, changing units to Percent, changing the width to 200% and clicking the left middle square on the tic-tac-toe board. After that, the Move Tool is used to position the flipped duplicate layer where it belongs (Fig. 203a). Finally, the canvas is made a little larger to provide some breathing space by going to Image > Canvas Size and setting both width and height at 120% or so.

Not all scanners get good results from pencil drawings. For cleaner results, sometimes it helps to push the levels, either in the scanner driver or in the Photoshop Levels module, in such a way that the blacks are exaggerated slightly and the whites are pushed to the point where the general sense of smudginess on the page vanishes. This will not necessarily give a good representation of the nuances of a soft pencil drawing. However, if you plan on coloring the drawing, this will give you a clean foundation of dark and light values.
Next, the Polygonal Lasso is used to select and copy the roses from the sketchbook page and paste them on the master file. The Transform Tool is then used to resize, angle and position the roses (Fig. 204d). Any extra white around the roses can then be removed with the Eraser Tool (Fig. 204b). Next, the Zoom Tool is used to get in close and the Paintbrush is set to a small diameter at about 50% opacity and used to sketch in the thorns, using black for the lines and white for cleaning up (Fig. 204e). At this point the drawing looks essentially like it was drawn whole in a large sketchbook instead of being composited from smaller parts. Now would be a good time to save the file, if you haven’t already been saving it regularly.

Once the composite is finished it’s time to see if the levels on the drawing need to be adjusted, or if there are any specks or smudges that need to be cloned out or overpainted. With that done, a new layer is added by going to Layer > New Layer, and naming the layer “Shadows”. In this case, the coloring begins with black, dark purple and lavender shadow colors. To make this go quickly and smoothly, it’s good to begin with a large brush with its hardness set to 0% and its opacity around 25%. Its diameter should be larger than necessary, causing some overspray onto the foreground elements (Fig. 204d).

With most of the basic shadows roughed into place, the next step is to clean up the overspray. This is done most easily with the Eraser Tool, which should be set to about half the diameter of the Paintbrush with its hardness at about 95% and its opacity at 100%. Using this, it takes only a few minutes to clean up the shadow edges (Fig. 204c).

To add the next family of colors, it’s a good idea to begin with a new layer; this time it will be named “Filigree”. Again, most of the coloring is done quickly with a wide Paintbrush, not worrying about overspray (Fig. 205a), then cleaned up with the Eraser Tool (Fig. 205b). By this point, the outlines of the drawing are fairly faint under all that airbrushing, but that can be fixed later with colored pencil.

At this stage a smaller brush can be used to add more detailed coloring to the design. During this process it’s important to make sure the airbrushing is happening on the top layer where it’s visible; often with multi-layered Photoshop files it can be easy to accidentally work on the wrong layer and wonder why the results aren’t visible.

When all the basic color is in place, some drawings call for an additional layer to be made for highlights (Fig. 205c). This is done with white using a small airbrush (Fig. 205d). It is easier to make white highlights at this stage in Photoshop than later with colored pencil.

Eventually the drawing reaches a point where it makes no sense to continue in Photoshop, since small detail and lines can be done more easily with colored pencil. The drawing in this chapter is simple enough that a normaletter-sized print is more than enough. However, for a complex drawing it might be helpful to resize it to 11x17” (28x42cm). In any case, it is best to print on a heavy matte paper for the purpose of colored pencil retouching.

The colored pencil stage is relatively short but makes a big difference to the finished drawing (Fig. 205e). Pencils easily handle jobs that the digital Paintbrush doesn’t do well, such as outlines and small sketch detail that can help give the whole drawing a more finished and refined look. The overall process, including digital time, requires about half as much effort as a complete colored pencil rendering, yet produces a drawing of comparable quality.
5.4) Using Photoshop in the Design Process: Making a Digital Simulation of a Tattoo

Sometimes it’s nice to be able to visualize how a tattoo will fit on a person before actually laying the stencil or freemaking it onto them. Being able to experiment by placing the design in a photograph of the body part can be an impressive thing for the client to see, but more importantly, it gives the artist the opportunity to work with the more subtle aspects of the tattoo’s fit. You could have a finished drawing that looks great on paper, but when placed on the body has a few awkward or ill-fitting details. Auditioning the design on a photo of the client can help weed out these kinds of issues before the appointment.

We discussed this in Chapter 4.4 with a digital simulation of a design on Cory Kruger’s neck that looked good but also showed some empty space on the collarbone area. The simulation helped us to anticipate the need for small changes in that part of the design allowing us to have the new stencil ready the night before instead of losing an hour or more of time on the appointment day.

Making a digital simulation of a tattoo is a fairly simple procedure, depending on how fancy the simulation might be. In most cases it’s just a matter of importing and sizing the photo of the client, then copying and pasting the design onto the photo, resizing it to fit, and erasing any excess design that doesn’t work in the simulation. Let me give you some step-by-step instructions.

First, let’s assume that you and your client are in email contact, and the client has sent a decent photo of their body part (Fig. 206a). In some cases, you may need to help instruct them on how to do this; for that purpose, I’ve written up a quick step-by-step form letter on this subject that I can send to my new clients. The next step is to size the image to a big enough scale to do the composition; 8x10” (20x25cm) at 300dpi is more than adequate. This can be done by opening the file with the photo of their body part, then going to Image > Image size and setting the size and resolution. Be sure the Constrain Proportions box is checked to avoid distorting the image. At this stage you may also want to crop the photo and get rid of unwanted distracting background.

For layout of high-resolution graphics, sizing a low-resolution emailed photo up to a large size will generally produce a blurry and indistinct image that won’t print very well. However, for the purpose of quick Photoshop simulations like this, that isn’t enough of an issue to worry about.

With the body part image sized and cropped, it’s time to bring in the tattoo design. Start by opening the design file, then using the Move Tool to drag it into the body part file. Most likely, it will be too big or too small for the body part and will need to be resized.

Under ideal circumstances, it’s good to have the body part photo available when you’re doing your initial thumbnail sketches. That way you’ll be able to see the specifics of the area and know roughly the proportions of the canvas you’ll have for working. Sketching directly onto prints of the body part photo can be even more helpful, allowing you to think about the tattoo’s fit from the very beginning of the design process.
Often it can be difficult to see if a layer is the right size while you are transforming it because as you are changing its size, it is temporarily covering details that it needs to interact with in a certain way. This problem can be worked around by changing the layer’s transparency; just go to the Layers palette, make sure the layer with the tattoo design is selected, and set its opacity to about 50% (Fig. 209a). You’ll want to play around with different opacities until you can read both layers clearly at the same time.

With that done, go to Apple→T / Cmd-T (2) to transform the tattoo design to the right size and angle for the body part. Once the design is sized, use a combination of the Magic Wand and Eraser tools to remove any blank white from around the design before setting its opacity back to 100%.

If you want to email it to your client, it needs to be resized and compressed for the Web. The simplest way is to go to Image→Image Size and set the resolution to 72dpi (computer monitor resolution) and change the size to something reasonable, somewhere between 7-10 inches (18-25cm) tall. Next, go to File→Save As, name it what you want, and use the drop-down menu to select JPEG as the file type. When you click OK, a new window will open with the slider for setting compression; set the slider anywhere from 1-12 to determine the quality of the image. As you move the slider, at the lower left corner of the window will be a number telling you the approximate size the file would be at that compression rating. Generally, 100kb or so is a good emailable resolution.

With a finished simulation, you are that much better prepared for the tattoo. It can also help clients to visualize their projects, especially if they need a chance to compare two or more different options. For the purpose of merely impressing the client, creating a digital simulation might amount to unnecessary extra work. I personally don’t do these simulations very often. But for the elaborate projects that call for it, especially those involving an exact fit or the incorporation of pre-existing tattoo work, a simulation will make both artist and client that much better prepared.

5.5) Using Photoshop in the Design Process: Sizing a Drawing to a Tracing

While making digital simulations may not be necessary for most projects, sizing a tattoo drawing to exact specifications for the purpose of making a stencil is something that needs to be done much more regularly. This is a job that can be done by making multiple photocopied on a copy machine at various sizes, choosing the one that comes the closest to fitting perfectly, and then making the stencil from that. However, this sizing process is easier when done in Photoshop, and allows for a much more exact fit.

The precision of a stencil’s fit to its body part is largely determined by the accuracy of the tracing. Tracing body parts is important for all tattooists who do custom work from stencils, and is a surprisingly delicate operation, especially if the tracing involves a body part that isn’t flat. When I do this I normally make cuts into the tracing paper in various places to help the paper conform to the body part better; I also find it helpful to have my excess paper around the area being traced. Using a few tabs of tape to secure the paper to the skin will help make it a more accurate tracing. You will need to ask your client to not move once the paper has been taped down in order to prevent a distorted tracing.

Making your design fit the tracing is a matter of scanning them both, keeping the tracing at its actual size, then sizing the drawing to fit the tracing. This is a procedure similar to creating a digital simulation, but is different enough to make it worth a quick review of the steps.

First, the tracing needs to be scanned at full size; I recommend a minimum of 200dpi. The tracing’s resolution won’t affect the size of the stencil print as long as your finished document is in this same resolution.

If the tracing is any larger than the scanner bed and needs to be scanned in more than one section, I recommend putting numbered markings throughout the tracing to make it easier to line up the different parts after they have been scanned (Fig. 209a).
In this example, the tracing was scanned in two sections. To add the right section to the left section, first the canvas of the left section has to be made large enough to hold both parts. To do this, click on the Background Color box (in the bottom of the toolbar) and set it to white. Next, go to Image>Canvas size. Since the canvas needs to be roughly double in width, the simplest way is to set the units to Percent (as opposed to inches or pixels) and type in 200% for the width. Before you OK it, go to the tic-tac-toe board at the bottom of the window and click the center left box (Fig. 210a); this will keep the existing image tight against the left side of the canvas and add all the new length to its right side.

Next, click over to the file with the right side of the stencil, click on it with the Move tool and then drag it back into the body part file. Since the two halves were scanned at the same size, the right half will not need to be resized, however; it’s very likely it will need to be rotated slightly. First, make sure the top layer is selected in the Layers palette, set the opacity of that layer to around 50%, then activate the Transform tool (Apple-T/Ctrrt-T). With the top layer at 50% it should be easy to rotate and move that layer until the numbered markings match up (Fig. 210b, 210c). When you are satisfied with the match, click the check box in the Options bar to OK it, then set the opacity back up to 100%. If you want to merge the two halves into one layer, you can do this by going to Layer> Merge Down (Apple-E/Ctrrt-E). This would be a good time to save your work (File> Save As), then give it a name; if you’ve already named and saved it at least once, you can save again with (Apple>S/Ctrrt-S).

At this stage, you need to ask yourself if you want any of the tracing visible or not when you print the design for stenciling purposes, sometimes having landmarks such as elbows or armpit creases makes it easier to lay the stencil on the body. If none of these landmarks are necessary, select the bottom layer, go to Image> Adjust> Hue/Saturation (Apple-H/Ctrrt-H), and set the lightness all the way to the right. This will make the tracing turn completely white, leaving you with only the resized design. If you decide to keep parts of the tracing, use the Paintbrush set to a wide diameter, set to 50% opacity, then white out any parts of the tracing layer that you don’t want. With this completed, I recommend cropping off any excess blank areas with the Crop Tool. After that, save it again.

All that remains after that is to print it and stencil it, either directly on the copy paper or on tracing paper, depending on your stenciling needs. If the design is larger than your printer you will need to break it into separate pieces for printing. In this case, the file needs to be broken into 2 halves. First, click on the Marquee Tool in the Toolbar, then use it to select the left half of the image. You may need the rulers turned on (Apple>R/Ctrrt-R) to ensure the selected area is no larger than the printable area of your printer. You can change the size of your marquee by going to Select> Select From Marquee, which provides the same resizing and rotating options as the Transform Tool. Once the Marquee is the right size, OK the selection transformation by clicking the check box in the Options bar.

Next copy the selected area (Apple-C/Ctrrt-C), then open a new file and paste the copied part onto it (Apply-P/Ctrrt-P). Then, set the image mode to V/Ctrrt-V, Enter, Ctrl-C, V). When you have copied something and then create a new file, the new file will automatically be the right size for pasting in the copied item. When you have pasted that part of the design into the file, go ahead and print it (Apply-P/Ctrrt-P). After that, click back on the full size image, choose the Marquee tool from the toolbar, and use it to drag the existing Marquee over to the right side. Ideally, the two different selected and copied parts of the image will have at least 1/2" (12mm) of overlap. With the Marquee in place on the right side, go to Image> Crop to get rid of the file’s excess parts, then print the remaining section. Don’t save the cropped version of the file, though, in case you need the whole thing again for any reason.

Once you’ve printed both halves of the design, cut off any excess paper where the two pieces meet, reducing the overlap of the two pieces of paper to a bare minimum; a quarter inch (6mm) is good. All that is left at this point is to make the stencil, either on tracing paper or directly on the copy paper, depending on how flat the body part is. With that done, you can proceed knowing that your design will have a precise fit on your client’s body.
5.6) Using Photoshop in the Design Process: Compositing Multiple Images Into One

This project is an example of a design derived from a variety of sources and brought together in Photoshop. It's a subject that's always been a favorite of mine, the Glowing Geometric Orb in an Organic Environment. This is a type of design that uses extreme contrast of value, color, focus, surface type and subject; it's an opportunity to really max out the dynamic range. This particular design was meant for both a tattoo and a painting.

This design began with an image scanned from the back cover of a science magazine. It was much more complex and detailed at first, but Photoshop provided the opportunity to personalize it. The Cloning Stamp and the Paintbrush Tool were used to simplify it, remove some details and smooth it out. It was then carefully selected with the Pen tool, which is ideal for making perfect arcs and straight lines. The rest of the magazine page was then cleared, leaving a clean and simple frame of a geometric shape (Fig. 21.3a). Because the finished orb design was symmetrical, only half the shape needed to be worked on, to be duplicated and flipped later. This strategy saves time and produces more consistent results.

For the core of the glowing shape I used a photo of a paper orb model that I had built and photographed at an angle to make it fit right with the image from the science magazine. The magazine image had been chosen in the first place because it was the right geometry to fit around the orb. About a dozen minor variations on the orb's position were shot to make sure there was at least one perfect fit. After choosing the best one, it was imported into Photoshop, cut carefully in half and its background was erased by selecting it with the Polygonal Lasso and clearing the area around it (Fig. 21.3b). It was then selected and copied (Apple-A, Apple-C / Ctrl-A, Ctrl-C).
The Pen Tool

The uses for this tool may not be immediately obvious to someone just playing around with it, but it has a very handy purpose: to lay down precise work paths. Work paths are vector-based lines that can be used in a number of different ways, such as stroke (which simply draws a line of your chosen color and thickness along the path) or as a precise selection tool, which is how I have mainly been using it. As it turns out, the nature of the Pen Tool makes it ideal for removing unwanted backgrounds from tattoos.

For this purpose, we start by importing a tattoo photo and making sure the image has layers including the image on a foreground layer and a black background (Fig. 214a). This can be accomplished by duplicating the layer in the Layer > Duplicate layer menu, then selecting the background layer and going to Edit > Fill to fill it with the color in the Foreground/Color box in the Toolbar. The next step is to select the foreground layer and then choose the Pen Tool.

To start building a path, click on the image anywhere along the edge of the body part to create a new anchor point (these are points used to define work paths) which will also automatically create a new layer that serves the purpose of containing the work path data. Next, click on a point somewhere along the edge of the body part but before releasing, drag the cursor about an inch or so forward along the intended direction of the path (Fig. 214b). This creates an anchor point with a pair of handles that can be shortened or rotated to adjust the path’s angle and curve. Once an anchor point has been released, it can be altered further by clicking on it while holding the Apple key, which allows its handles to be adjusted. Additional points can be added just by clicking anywhere along the path; unwanted points can be deleted by clicking on them while not holding the Apple key. In addition, points can be changed from curve anchor points into simple angle points by clicking on them while holding the Option key; they can be made back into curved points the same way. I recommend expanding the window so you have some gray easel area around the image, which allows you to add anchor points off-page (Fig. 214c).

In this manner, a very accurate and natural set of curving lines can be traced around even a very complex object. For body parts, the smooth areas produced by the Pen Tool are perfect for tracing around the natural curves of the body. When the body part has been completely enclosed and all points have been adjusted where they need to be, the path is closed by clicking on the initial point where the whole process started (Fig. 215a).

Some Pen Tool features provide a mask while you are laying down the path, which in some cases can be helpful but in my experience is usually an annoyance. This can be disabled by clicking on the Style drop down menu in the Options bar and selecting the empty square in the lower left of the pop up menu. A helpful hint: While working on a path, sometimes a stray click can cause the path to become inactive by joining its anchor points; to vanish the path can be reactivated by clicking on the last action in the History palette.

Once the path has been closed, it needs to be made into a selection. This can be done in the Paths palette, which has an arrow in the upper right corner that opens another menu; one of the options is “Make Selection”. Once this is chosen, another window appears that gives the option of feathering the selections; for most tattoo photos a feather of 2-3 pixels will look the most natural. With the selection in place, the next step is to choose the tattoo layer in the Layers palette, then go to Select > Inverse, Edit > Clear (Fig. 215b). Apple > D / Ctrl > D will get rid of the selection, while turning off the eye in the path layer will make the path invisible.
To combine the images, the next step was to click on the geometric frame to make it active, and to select the layer with the frame in the Layers palette. It was then duplicated (Layer > Duplicate Layer), and the bottom copy of those two layers was selected in the Layers palette. Next, the orb was pasted into place (Apple+V/Control+V), placing it between the two frame layers, and then sized to fit with the Transform Tool (Apple+T/Control+F). A few strategic areas of the top layer were then erased using the Eraser Tool in order to let the different shapes overlap the right way (Fig. 216a), then the Paintbrush Tool was used to smooth out and clarify everything (Fig. 216b).

To make this half into a whole shape, all 3 layers of that half were merged by selecting the top layer and then hitting Apple+ E/Control+E twice. Then it was duplicated by going to Layer > Duplicate Layer. The canvas size was then doubled by going to Image > Canvas size, changing the units to Percent, setting the width to 200% and justifying the existing half shape to the right side in the tic-tac-toe board. For alignment purposes, guides were then pulled out from the rulers to the left side and top of that half (Fig. 216c), making sure Snap was enabled in the View menu.

The duplicate layer was then turned around by going to Edit > Transform > Flip Horizontal, and the Move Tool was chosen from the toolbar and used to move the duplicate half into place. The guides caused it to snap perfectly into alignment (Fig. 217a). To make the two halves into one layer, they were merged (Apple+E/Control+E).

The finished shape ended up being mathematically correct in a way that would be basically out of reach using conventional drawing methods. At the same time, the shape is simple enough that, with a careful enough plan, it can be tattooed and tattooed. It took about 4-5 hours of keyboard to get the image to this point. It is also possible to build these kinds of shapes in 3D modeling programs such as Bryce, by that takes a whole different level of effort then workable results like this.

The next stage in creating this tattoo design was to build the organic environment surrounding the orb, working from a sketch and using wire, foil and clay (Fig. 217b). It was photographed using a low-watt yellow bulb in the center and a pair of blue-wrapped fluorescent lights to either side. After the pictures were imported into Photoshop and narrowed down to a final candidate, a tracing was taken of the client's chest and then scanned at full size. The tracing layer was then duplicated (Layer > Duplicate Layer), the background layer was selected and filled in black, then the top layer was selected again. The eraser was used to clear out all the areas in the tracing where the tattoo would go, leaving a circle for the nipple (Fig. 217c).
The clay model photo was then clicked, selected and copied; then the file with the full-size tracing was clicked on to be made active. After choosing the background layer, the model was pasted in place (Apple> V; Ctrl> V) and sized, angled and stretched, using the Transform Tool, until it fit the tracing optimally (Fig. 218a). Then, with the model sized and all its essential parts contained within the tracing, the tracing layer (which at this stage could be an unwanted distraction) was then turned off by clicking on the Eye next to its layer in the Layers palette.

The geometric orb was then copied and pasted into the file with the model photo, then sized, angled and positioned with the Transform Tool. To make the orb appear to go behind the foreground shapes, the opacity of the model layer was at that point changed to 60% in the Layers palette. The Eraser Tool was then set to a medium width with its hardness at 95% and was used to erase parts of the orb that were meant to be hidden, making it appear to go behind the foreground branches of the organic environment. With the erasing complete, the opacity of the model layer was then turned back up to 100%.

After following through with some airbrushing in the background and a few other finishing touches (Fig. 218b), the finished image was then ready to be translated into both a tattoo and a painting.

Working with models can bring in another level of complexity to a project. Don’t let the model’s possibilities distract you from your prime directive: To make a clear readable image with a distinct and flowing distribution of light and dark. Careful use of lighting on your model is key to accomplishing this.

For the purpose of tattooing, this piece is an obvious candidate for a traced crosshatch stencil (Fig. 219a, 219b). The orb was traced into a conventional line stencil in order to pose the least risk of obscuring its precise structure; but all the organic areas were done with detailed crosshatching, aiming to capture the texture of the clay model as thoroughly as possible.

Getting the basic design committed to the skin was a matter of switching back and forth between a 5 magnum, a 5 round and a medium tight 3 while working slowly upward. First the smoke was sketched in lightly with the 5 mag and some light lavender, then the lower organic areas were roughed in to the point where the blacks, purples and blues were mostly in place. Then, before the stencil for the orb became too faint, it was lined with the 3 and a combination of pinks and oranges. Switching back to the 5 mag, the light rays were edged in warm pink and the remainder of the organic stuff was brushed in to the left and above the orb.

The 5 round was then used to clarify and darken the peripheral lines around the organic shapes to deepen and add detail to the shading and texture. It was also used to strengthen and saturate the background color around the orb (Fig. 219c). The 7 mag was then used to fill in the purples and pinks in the background and saturate the blues and greens in the organic shapes. Care was taken to make the smoke and rays as smooth as possible during this stage. Then, rinsing and switching to warm 7 mag was used to block in the yellows, oranges and whites in the orb along with the yellows and whites in the organic shapes.
After this came a few hours of detail work in and around the orb using the 3 and the 5 round, clarifying and sharpening the edges of all the shapes while trying hard not to lose the delicate balance of contrast from the reference. This tightening stage was the time to really dial in the piece and make sure all its lines, edges and details were clearly defined. Following up with this came a few minutes using the 3 round to add to and sharpen any white highlights as needed.

Primary red and orange were reserved for the orb, with magenta being the warmest color in the background. The lavenders and magentas in the background are darker than the orb, making it pop forward, but lighter than the organic stuff, allowing it to have a clear and readable silhouette and preventing the overall tattoo from becoming too dark. Untattooed skin was left in the rays, balancing out the glowing streams of negative space below the tattoo and helping keep the piece from getting too dense. True white was reserved mostly for the orb, been used only in small stipplings of detail on top of yellow and green in the organic stuff (Fig. 220a).

Throughout this process, the tattoo’s readability was strengthened by giving emphasis to the design’s areas of dark and light. This clarity and strength were balanced with the need for a certain amount of detail.

I ended up doing a painting of this image 8”x10” (20x25cm), right around the actual size of the tattoo (Fig. 220h). Some aspects of this image, especially the orb, are subtler in the painting than they are in the tattoo. In particular, bold lines were used around the organic shapes in the tattoo while none were used in the painting. Black lines in this kind of painting would be unthinkable to me, but in the case of the tattoo it helped offset the realistic detail and contrast the careful color rendering of the orb. They also helped balance out a tattoo on this client’s other chest panel, pictured in Chapter 2.8 (Fig. 96b), which has a similar balance of lines and line-free shapes.

The orb is also more subtle in the painting than in the tattoo. The edges of the tattooed orb were fairly low-contrast in the first session, but after it healed and settled we found that it needed more impact, so we did a follow-up session and pushed the contrast a level or two beyond how it looks in the painting. It seems that we can get away with more delicate relationships on canvas than on skin.

The Yellow Follow-Up
I have found that when I work white highlights that fade into areas of yellow, those yellow zones tend to heal a little dull unless I follow through with a quick final skin over the yellow areas after laying in the whites. Could I instead just try to make sure my initial yellow pass is thorough enough? Sure...but nonetheless, that final yellow skin seems to make a difference in its brightness.

These same methods could be used easily with more conventional subject matter. For example, a clay model of a dragon could be made, coated in a light bulb and photographed; the light bulb could then be replaced in Photoshop with a lotus cut out from a water gardeners’ catalogue. The Hue > Saturation and Brightness > Contrast then could be adjusted to make the lotus look like a light source. A bonsai tree could be photographed while holding a light somewhere inside the tree, somewhere that creates the most dynamic light/shadow interaction, then the light could be replaced in Photoshop with a luminous bird...

I get the idea. Any subject that can benefit from having more convincing lighting, texture, focus and shadow is a good subject for trying these modeling and photography methods. That is not to say that I’d discourage anyone from doing fancy abstract stuff.

The first five parts of this book have been mostly focused on design. I believe that design is the key to a good tattoo, and that a good design can hold up even if the execution isn’t perfect. However, a poor design will never make a good tattoo, regardless of how painstakingly precise its execution might be.

These design guidelines we’ve talked about, including flow, fit and use of the dynamic range, are not meant to be taken as absolutes which must always be followed. Ultimately, it’s up to our own artistic sensibilities to decide what looks good and what doesn’t. These guidelines are just more equipment for your creative toolbox; no artistic advice should ever be followed dogmatically.

Eventually, we all end up with our own set of principles, hopefully a flexible and evolving set, for guiding us as we work and helping to screen out bad designs before we end up getting tattooed. These guidelines are a sum total of our experience and the experience of the rest of the people in our profession, past and present. They are drawn from our hard work as artists and our depth of character acquired as we live our lives. These unique experiences are what make each artist’s work one-of-a-kind.

Our schooling, experience and guidance from others help to make us into skilled craftspeople. But only through hard work can we make ourselves into true artists.
Part V Review Questions

1) What are some reasons for a tattoo artist to use an image manipulation program?

2) What device is used to bring an image on paper into a computer's memory banks? What kind of software runs this device?

3) What is considered a standard photo-quality pixel resolution?

4) Which Photoshop tool is used for trimming an image to its desired size?

5) What tool is used for moving an image around its canvas? Where do we find this tool?

6) What is the purpose of using different layers in Photoshop?

7) How do we navigate between layers?

8) What happens when an image is flattened?

9) What is the difference between image size and canvas size?

10) What does the Cloning Stamp do?

11) What menu contains the tools for adjusting the color and contrast of an image?

12) What are some ways to erase around an image for creating transparent layers? Can you think of any that haven’t been discussed here?

13) If we are going to airbrush an area where two layers overlap and we want the airbrushing to be visible in all layers, which layer should be selected in the Layers palette?

14) If we have a design element that is going to overlap some parts of a second element, while at the same time being overlapped by other parts of that same second element, what are a couple different ways of handling this in Photoshop?

15) What is a good tool for positioning, resizing, and rotating a selected image? Where is this tool found?

16) How can a layer be made invisible without deleting it? How is it made visible again? In what kinds of scenarios might this be a helpful feature?

17) How can a digital image be made into a stencil? How do we make sure it’s the right size?

For answers to these questions, go to: www.hyperspacestudios.com/reinventing/answers

PART VI
Tattooing Technique: Nuts & Bolts

6.1) Technique: An Overview

There's so much that can be said about tattooing technique that it would easily fill a whole book by itself. However, I am convinced that a proper discussion of technique is impossible without having a strong understanding of design. Design and technique are two sides of the same coin; it is not possible to tattoo well without a working understanding of both.

I am uncertain that many readers of this book opened it for the first time, looked at the Table of Contents, then flipped right to this page. After all, the technique chapters are where all the great tips are going to be, right? In reality, tech, this couldn't be further from the truth; even with the best technique, a poor understanding of design will result in unattractive tattoos, no matter how well executed they may be. In this book I chose to enter the discussion of design first because it is a critically important foundation on which to build an understanding of tattooing. With these basic design principles clearly understood, you’ll be able to create strong tattoo designs more easily and will experience far less technical struggle as a result.

Good tattooing technique will not happen simply as a result of finding the right machines or the right pigments; it is a combination of having not only the right equipment but also a good understanding of your relationship with that equipment.

We'll begin the technique discussion with a chapter on stenciling and transferring designs. Some of this material has already been covered in Part 4, where several stenciling methods were used to transfer reference images onto skin. Chapter 6.2 makes up a broader review of stenciling and freemarking options—mainly specific step-by-step instructions that were not discussed in Part 4. After that, in Chapters 6.3 and 6.4 we'll get into detail about needle groups and the different types of tubes, which are responsible for much of the finished look of the tattoo. These days, tattoo suppliers are giving us so many choices of needle configurations and tube types that it could be hard to know where to begin.

Next, in Chapter 6.5 we'll go into detail about tuning machines. Tattoo machines represent a subject that could be discussed endlessly, as simple as they are, the nature of their design allows for an almost infinite variation of physical parameters that can affect the way they run in both major and minor ways. The goal of this chapter will not be to convey a complete understanding of everything about machines, but instead provide you with a practical user's guide to tuning them and making them work smoothly. This will include several troubleshooting checklists that should help frustrated tattooists narrow down the possibilities and zero in on the things that are causing them trouble. Then, in Chapter 6.6 comes a detailed discussion of setting up tattooing equipment in ways to prevent problems and maximize the equipment's performance.
6.2) Design Transfer: Stenciling and Freehanding

There’s not much use in creating the perfect design if it can’t be transferred onto the skin the right way. In Part 4 we briefly discussed various methods of stenciling and freehanding as related to the use of prepared reference material; this chapter provides a more general overview of stenciling and freehanding as they relate to all tattoo projects.

Design transfer is an art form unto itself. A good stencil or freeshand design will fit the body just right, contain all the necessary information in the simplest and most readable form possible, and hold up long enough for the design to be committed to the skin. Making and applying a good stencil isn’t too terribly difficult when doing small flash tattoos, but even these need to be positioned just right. Design transfer is a critical interface between the finished design and a successful tattoo.

Those of us who’ve worked in street shops have no doubt used the standard-issue thermal transfer unit, also known as a stencil machine or hectograph machine. Commonly, it’s used for small and medium designs with simple line drawings prepared for the purpose of running through the machine. Most hectograph paper is 8 1/2” x 11” (21.5 x 27.9cm) but it is possible to get 8 1/2” x 14” (21.5 x35cm) paper. It’s usually a dark purple color, though I’ve seen it red.

Stencils for flash designs are usually made quickly using line drawings that are included with color flash sets for the purpose of making stencils. For simple tattoos, using basic line drawings to represent the design is the most universally understood way of transferring images to skin. However, for custom designs, there are alternatives to these simple line drawings that can simplify the tattooing process and empower the artist to work more efficiently and intuitively.

When making a line drawing of an image, the design is translated “down” to a much simpler language than its original shaded and colored version. Then, while tattooing, the artist must translate that line drawing back “up” into a shaded and colored image, rebuilding all of its depth and complexity from the simple line drawing. This is often accomplished by carefully consulting the finished drawing while working, checking to see what each line in the stencil is meant to represent— from each line, should shading be pulled up or down? Is this small shape meant to be shaded inside, or left blank inside and shaded outside instead? Unless the tattooist is fully and completely familiar with the design, their rendering process will normally be slowed down quite a bit in the course of all this continuous referral to the drawing.

It’s common knowledge that photos and shaded drawings shouldn’t be run through a stencil machine, or the stencil will turn out dark and unreadable. Because the hectograph machine is a fairly blunt instrument with no capability for fine differentiation in tone or value, it’s natural to assume that line drawings are the only option for making a workable stencil. However, by knowing and working with the limitations of the hectograph stenciling medium, all kinds of things are possible. By broadening your range of the kinds of stencil you work with, you can expand your technique into new territories.
In Part 4, I speak high praise for the benefits of using crosshatched stencils. This method of design transfer shows not only the edges and details in a design but also its major gradients and pos/neg relationships. Using this type of stencil, the tattooist is liberated from having to be glued to the reference and can proceed naturally through the tattoo with all the major pertinent information already on the skin (Fig. 226a, 226b).

Stencils that show the shading in a design, as opposed to simple line drawings, are most effective if using a tattooing technique where the stencil is not completely wiped away before beginning the shading. This can involve doing a simple and quick outline (so quick that it doesn’t disrupt the crosshatch areas of the stencil) then the shading, followed by a fine-tuning stage with the outlines. It can also be handled by starting the tattoo using the magnifier first, as we’ll discuss later in chapter 6.9.

With some types of images, such as portraits and other realism projects, it can be helpful to have a method of making an image stencil-ready directly in the computer, since hand-tracing a portrait stencil can cause some minuscule aspects of the facial expression to be lost in the translation. There are a number of tools available in Adobe Photoshop that can be used for this purpose, and with the right kind of handling they can be made to accurately convey all kinds of information not normally possible with hand-traced stencils.

My favorite Photoshop filter for stenciling is the Photocopy filter, which can quickly and effectively translate a shaded drawing or photograph into a simple pos/neg image that will work well in a stencil machine. It’s fairly simple to use. The first step is to import the image into Photoshop, size it for the stencil and crop it as needed (Fig. 226c). Next, it needs to be made into a grayscale image (Image > Mode > Grayscale); often it will help to adjust its levels at this stage (Apple > L / Ctrl > L) to increase its contrast before filtering it (Fig. 226d).

After that, the file is brought into the Photocopy filter (Filter > Sketch > Photocopy), where the image will appear in a preview window in its filtered state. There are two adjustment levers in the upper right of the window for adjusting darkness and detail; a lower detail setting gives the image much finer detail and lines (Fig. 227a), while a higher detail setting gives it thicker lines and darker detail (Fig. 227b). With some projects, it may be helpful to render the image multiple times at two or more levels of detail, then combine parts of the different images together in order to provide crucial detail in some areas along with smooth boldness in other areas. This procedure is quick and easy: Layer the simple rendering over the detailed one, then use the Eraser to expose the detail where it is desired.

Fig. 227c shows a Photocopy stencil of one of my paintings. It is the type of organic image where the style and character of the detail can be most easily conveyed using this kind of stencil, and was made using the procedure just described. Conveying the detail this way was especially essential to me because I was not the one doing this tattoo—instead, this was done on my leg by Pittsburgh tattooist Steve Morris. Using this kind of stencil for the project made it easier for him to mimic the style of a painting that was not his own work to begin with, making possible a more accurate translation of the image into a tattoo.
When using the Photocopy filter for a complex subject matter, you can easily become overwhelmed with detail. To avoid this, render the Photocopy filter as simple and bold as you can, then render it again with enough detail for the design’s most important parts. Place the simple layer on top, then erase through to reveal the detail where needed. By being as selective as possible in revealing detail, you’ll keep the stencil more readable and durable.

Another way to make a shaded image into something that can run through a stencil machine is to convert it into a halftone, which is a small-scale dot pattern meant to mimic a smooth gradation by converting it into tiny black and white dots. This is done by first sizing the image to its desired size at 300dpi; it is then converted to grayscale and its values are adjusted using the Levels controls, as with the Photocopy stencil.

The next step is to go to Image > Mode > Bitmap. A dialog box will ask for the output resolution, which should be 300dpi, and Method should be set to Halftone Screen. After OKing this, another dialog box will come up, where the frequency should be set to 50, the angle to 45 and the shape to Diamond. The finished image will be more or less ideal for running through a stencil machine (Fig. 228a), though the exposure on the machine may need some minor adjustment to make it just right.

Keep in mind that when doing this on a computer, the halftone will look grainy and indistinct due to the limitations of the monitor. By holding down the (Apple / Ctrl) key and hitting the minus sign to make the image smaller on the screen, it’s possible to see more clearly how the halftone will look when printed.

Halftone stencils can be combined effectively with Photocopy stencils as well. This is done the same way as the procedure where two renderings of the Photocopy filter were combined, with the halftone layer placed on top of the Photocopy layer, then erased through to provide the necessary details and edges that the halftone couldn’t adequately capture (Fig. 229b, 229c). This allows for both soft and sharp effects to be conveyed in the same stencil.

Fig. 228a is a closeup of part of the painting that the tattoo was derived from; note the complexity and style of detail. Fig. 228b is a Photocopy print made from this image, with all essential detail reduced to a simple yes/no image that can be fed through a stencil machine. Finally, Fig. 228c is that same area of the finished tattoo; you can clearly see how accurately the detail of the original was conveyed in the tattoo.

Fig. 228d and 228e show the finished piece side-by-side with the painting it was derived from. You can see how the stencil created a bridge for the tattooist, making it easier to work smoothly in unfamiliar territory and still get results that conveyed the character and feel of the original painting.
Hectograph stencils are applied using a sticky, alcohol-soluble film on the skin. There are a number of different products available that will serve the purpose. Many tattooists use Speed Stick or similar deodorant products to apply stencils, I was taught using Speed Stick, and earned funny looks at the drugstore when I purchased a dozen at a time. Its sticky film makes for a durable stencil, but has a few disadvantages that have kept me from using it for most of my career. One is that its not very sanitary to be reusing deodorant sticks on different clients, unless each stick is used only once (excessively and wasteful, in my opinion). Its also questionable as to whether its a good idea to have the additional chemicals and fragrances of these deodorant products drilled into the skin like that. However, my biggest problem with Speed Stick is that it kept ruin my paper stencils.

What happens is that when the stencil is applied, the paper gets covered with deodorant. This isn't a problem if it goes on correctly the first time, but if the stencil needs to be erased from the skin and reapplied a second time, it can't be test-positoned without leaving ghost images in unwanted places on the skin. Since many larger designs need a few attempts to get them right, this can be quite an inconvenience, especially when using a large hand-traced stencil.

Many artists use green soap for applying stencils, which is a safe and effective method. Other liquid soap products can also be used, I use Dr. Bronners peppermint soap, which works pretty much the same as green soap. In both cases, the soap should be diluted by 50-60% with water for stenciling purposes. A stencil applied correctly with liquid soap will make a dark and crisp print on the skin that is free of any questionable ingredients. However, it will be slightly less durable than using deodorant or some of the other products listed in this section.

Another product often used for stenciling is Deutol, which is another cleaning product that is sometimes used in medical settings. Deutol handles in a manner similar to liquid soap, but should first be tried undiluted before adding water to find a good consistency. Some artists find that stencils applied with Deutol are longer lived than stencils put on with soap, but this opinion seems to vary from one artist to the next.

Any kind of soap or other product used for applying stencils will evaporate quickly if it is too dry, sometimes losing most of its stickiness before the stencil is completely in place. Too much water, though will make a light, blurry stencil that can wipe off too quickly.

New products are appearing on the market that are manufactured specifically for applying tattoo stencils. I recently tried out a product called Stencil Stuff and it worked very well. Being a fairly conservative person when it comes to mystery ingredients, I tend to stay with the soap, which is benign enough that you can brush your teeth with it. However, these other products may result in a longer lasting stencil, which can be very helpful when dealing with a complex design.

Before applying a stencil, it first needs to be positioned right. There is the option of smearing a film of the soap onto the general area, holding the stencil above it and dive-bombing it into place, hoping to get the position right by sheer good luck. Often its hard to get the position exactly right using this method even after 4 or 5 tries, so many artists end up compromising and tattooing it even if its placement is not perfect.

I recommend taping the stencil in place with the skin dry, then gluing it down with soap once its proper alignment has been established. Depending on the size and position of the stencil, this can be done either in one or two steps. A one-shot stencil is always ideal, but usually is only allowable for smaller pieces or particularly flat body areas.
First the area needs to be shaved, including surrounding areas, just to make sure no hair gets in the way. The area is then cleaned with isopropyl alcohol and snipped dry, then given a few extra moments to air-dry completely. The alcohol not only sanitizes the skin, but removes body oils from the surface, making it more receptive to the stencil.

Even very fine “peach fuzz” hair can cause a stencil to go on slightly blurry, and to hold up with less permanence.

While the skin is drying, the stencil is prepared by cutting off all extra paper, and then cutting between design elements anywhere it might provide better flexibility (Fig. 232a). Several 4-6" (10-15cm) lengths of masking tape or surgical tape are then torn off the roll and stuck somewhere handy, like the edge of a countertop or the client’s chin.

The stencil is then held in place over the body part. If the piece was designed carefully using an accurate tracing and possibly a photo of the body part, then it should fit pretty much just right. Once the stencil is in the right position it needs to be fixed securely in place with those short lengths of tape.

For a one-shot stencil, it should be taped so that it swings like a hinged door (Fig. 232b). This is done with the client standing in a neutral position, as if they’re waiting for the bus (we’ll refer to this as the Bus Stop position). It’s customary to warn them ahead of time that turning their head in the middle of the process can cause a blurry stencil; anyone who’s ever been on the receiving end of this process can imagine how hard it would be not to look.

When positioning clients for the purpose of applying stencils, make sure they are braced on a wall, pole or other supportive object to help steady them. This is especially helpful when you have to press hard on them to get the stencil to lay flat on their skin.

A paper towel is then folded in quarters and a large corner of it is saturated with soap or some other stenciling product (Fig. 233a). Next, the area of skin where the stencil will go is wiped down with this soap (Fig. 233b), trying to get it as even and sticky as possible without any wet puddles that can blur the stencil. When the sticky film seems just right, the stencil is carefully smoothed down with open palms, moving in a direction away from the tape hinges (Fig. 233c).

Before peeling it back up, it’s important to check the edges of the stencil to make sure they’re stuck down thoroughly. Sometimes with large designs these outer areas may be dry by the time all parts of the stencil have been smoothed down. If this happens, those areas of the stencil need to be carefully peeled back, then stuck back down again after fresh soap or stencil product is re-applied to the necessary spots.

With the stencil glued down to the skin, you’ll most likely notice there are wrinkles in the paper, sometimes a fair amount of wrinkles. This is normal, and you’ll probably find that the stencil makes a clean print even with some wrinkles happening in the process.
For larger designs or stencils involving more curving body parts, sometimes a two-shot stencil is necessary. With the client standing in the Bus Stop position, the stencil is taped down in such a way that one side of it can be swung outward at a time, as if it were a hinge in the middle (Fig. 234a). It needs to be taped in such a way that it swings the most easily. In some cases this will be across the body part, in other cases up and down it.

Recently this type of autoclavable squeeze bottle has come to replace the spray bottle, starting with the idea of keeping bloodborne pathogens from becoming airborne. In addition to being more sanitary than a spray bottle, it doesn’t create a fine aerosol of soap in the air, which is irritating to breathe. Clients also seem to prefer the squirt sensation over the sudden jolt of the spray bottle. In numerous ways, the squirt bottle is a better tool for the job.

After folding back half of the stencil, the next step is to wet down the skin with soap (Fig. 234b). After smoothing this side down (Fig. 235a), the tape is removed and new pieces are placed on the half that’s already been soaped down; this helps to prevent unwanted shifting of the paper (Fig. 235b). The other half of the design is then swung outward to the point where about 1/4" (6mm) of the stenciled part is exposed. The next step is to wet down the skin for the other half of the stencil, taking care not to blur any of the printed first half while gently overlapping a small amount of soap onto it (Fig. 235c). Finally, the second half is smoothed down (Fig. 235d).
The curving geometry of a body part will determine the best points to tape down the stencil. Certain areas may require some trial-and-error to find the most smoothly hinging option. Once the stencil is taped in place, be sure to test swing it to make sure the two halves of the paper will hinge easily without causing a lot of wrinkling or distortion.

After peeling the paper back up, the next step is to check the stencil's position on the body, making sure it's not too high, too low or angled incorrectly; after that, it needs to be looked over closely to make sure it's all there. If it needs to be moved or done again for any reason, it can be cleaned off with alcohol; try applying some and letting it sit for a few moments before wiping. This short pause gives the hectograph ink time to dissolve.

If the finished stencil is mostly satisfactory, it can be cleaned up with Sharpie pens, darkening the parts that are too light and finishing off anything that didn't transfer (Fig. 236a). This is done while checking the drawing to make sure everything important is in place. In some circumstances, more elements or details are added with marker that weren't present in the stencil, which can sometimes be helpful in giving a design a better fit on a body part.

**Freehanding** is a term that has been glorified to a certain extent, and not always with the best results. Inexperienced tattooists see an impressive tattoo in a magazine with the word “freehand” underneath it, and then start scratching recklessly on their clients just so they can put the word “freehand” on their business card. It's a cool word and it sounds impressive, but when approached the right way, freehanding can be as much work, if not more, than making a hectograph stencil.

Almost all freehand designs will benefit from having a drawing of the design prepared first. Sometimes this will need to be a carefully resolved detailed value study (Fig. 237a), although a decent thumbnail sketch can be sufficient if the subject is a familiar one (Fig. 236b). For each project, it is up to the artist to decide how much preparatory work is necessary before drawing on the skin; it's always better to be overprepared than not prepared enough.

It can be helpful to do sketches for large designs inside an image of the client's body part, which can make it easier to achieve the ideal fit and flow. Taking a photo of the blank body part during a consultation (or having the client email a blank photo for the purpose) provides an accurately proportioned canvas to facilitate the initial stages of creating the design. The blank body part can be simply sketched from the photo onto paper and then drawn inside (Fig. 237b). An alternative to this which can be very helpful is to print a few small copies of the body part photo and then sketch inside these prints (Fig. 237c). Doing a series of small drawings before working out a larger and more detailed version is a surefire way to get a more refined design prior to the freehand process; working inside prints like this can make it much easier to explore different options as well.
 marker such as purple or black (Fig. 238b). The darker ink allows the drawing to be refined one level further as well as making the drawing more durable so it will stand up longer during the tattooing process (see Video Clip 27: Freehanding Step 3/ Dark Marker). With this step finished, the frehand drawing should bear a strong resemblance to the original value study sketch, though it is perfectly normal to make minor changes to the design during the freehanding process in order to optimize its fit, flow and relationship with any surrounding tattoo work.

Don’t use red markers on the skin! Some artists have noticed that freehand tattoos done with red marker had troublesome healing, often leaving the client with areas that welled up whenever becoming hot or irritated, sometimes years after the tattoo has healed. Red industrial dyes and pigments tend to be fairly toxic, so avoid using red markers on the skin.

There are plenty of other options available.

Anytime during the freehanding process that erasing is necessary, alcohol and paper towels can be used, as with hachuro stencils. If small parts need to be carefully edited, a paper towel can be folded in quarters, wrapped over a fingernail and then used as an eraser. Cotton swabs can be used for even finer editing.

The light-to-dark drawing process is good for making refined line drawings (as in Fig. 239b), which is a design on my own arm drawn by Aaron Cain and Grime. However, in my own tattoo projects I prefer to draw a more finished value rendering on the skin that shows the design’s major gradients and pos/neg relationships, as with the crosshatch stencils. To accomplish this, sometimes I will use a light marker as a blending tool for softening and painting with ink left over from from darker markers, creating almost a watercolor look that provides a clear template of the major value relationships in the design (Figs. 238b, 239a). This sort of drawing is especially ideal for tattoos started with a magnum rather than a liner.

The combination of hachuro stenciling and freehanding with markers seems to provide the freedom and the precision to transfer just about any kind of design onto the skin. Bringing technology into the picture helps to extend these capabilities, and there are no doubt countless other digital tools available for making better stencil-ready black & white images. The possibilities of design transfer are only starting to be explored. In a very real sense, there’s no reason not to consider the design transfer part of the tattoo process as an art form in its own right.

Designs drawn on with marker generally will not be as durable during tattooing as hachuro stencil. While working on projects that combine both marker and hachuro ink, pay attention to the marker areas to make sure nothing gets wiped off prematurely.

With preparatory sketches ready and the client shaved and washed, the layout is begun using a yellow or lime green Sharpie marker (see Video Clip 25: Freehanding Step 1/ Light Marker). By working with a light color, the design can be scribbled very loosely without causing a lot of mark-up later in the process. It’s preferable to handle this early stage with the client standing in the Bos Position in order to make sure the design is not distorted. Since the freehand process can take a while, possibly hours, it’s best to first mark out the basic flow with the client standing, then to let them sit or lie down somewhere comfortable while the rest of the detail and form is fleshed out. It may be necessary to remind the client that the yellow or lime green marker is only being used because of its light value; the marker color does not necessarily reflect the actual color scheme of the tattoo, just as purple hachuro stencils do not mean that the outline of a tattoo will be done in purple. Clients experiencing this style of freehand drawing for the first time may need some reassurance, things that seem obvious to us might simply be confusing to them.

With the light marker drawing roughed in, the next step is to go in with a medium value marker such as turquoise or orange to refine the design and add detail (Fig. 238a). This step will probably take longer than the rough light marker stage, which is only meant to establish basic flow and fit of the elements. The medium marker stage is meant to refine and narrow down the drawing, bringing it much closer to the look of the original sketch (see Video Clip 26: Freehanding, Step 2/ Medium Marker). Once this stage is complete, the final step is to complete the drawing using a dark
### Needles

<table>
<thead>
<tr>
<th>Size</th>
<th>Type</th>
<th>Used for</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large Magnum</td>
<td>Flat (25, 33, 47 etc.)</td>
<td>oversized prey, long or large targets</td>
</tr>
<tr>
<td>Medium Magnum</td>
<td>Flat (11, 13, 15)</td>
<td>medium-sized prey, medium-sized targets</td>
</tr>
<tr>
<td>Small Magnum</td>
<td>Flat (7)</td>
<td>small prey, small targets</td>
</tr>
<tr>
<td>Large Round</td>
<td>Single (3, 4, 5)</td>
<td>large, round prey, large targets</td>
</tr>
<tr>
<td>Small Round</td>
<td>Single (1, 2, 3)</td>
<td>small, round prey, small targets</td>
</tr>
</tbody>
</table>

#### Benefits

- **Fast lines:** Ideal for quick and efficient tattooing.
- **Strong resistance:** Perfect for holding up against tough conditions.
- **Versatile:** Works well with various techniques and designs.
- **Detailed work:** Great for intricate and fine details.

#### Disadvantages

- **Small targets:** Not suitable for small, delicate work.
- **Strength:** May not be ideal for very strong lines or heavy work.
- **Precision:** Requires more skill and practice to handle effectively.

### 6.3 Needles

Just like the brushes that painters choose, the type of needle used for tattooing will determine the style of tattoo that is done. Various factors, such as the area being tattooed, the size of the tattoo, and the client’s preferences, will all influence the decision. The traditional approach to tattooing involves creating a design on paper or a computer program, and then transferring it to the skin. This is often done by tracing the design with a needle, or by injecting ink directly into the skin. More modern techniques include using a laser or a machine to etch the design into the skin.

The correct needle size and type will vary depending on the area being tattooed and the style of tattoo desired. For larger, more detailed work, a finer needle may be used, while for larger, more solid fills, a larger needle may be used. The size of the needle will also affect the flow of ink, with smaller needles allowing for more precise control and larger needles allowing for more rapid shading.

The choice of needle can also affect the overall appearance of the tattoo. For example, a finer needle will create a more detailed, delicate look, while a larger needle will create a more bold, solid appearance. The correct needle size and type will also depend on the artist’s personal style and the client’s preferences.

Before choosing a needle, it is important to consider the size of the tattoo, the area being tattooed, and the client’s preferences. A consultation with the artist can help determine the best needle size and type for the desired tattoo.
This is just one example of the many potential uses each needle group can have. Groups normally used for shading and coloring also can be used for lining, edging and adding detail to a piece. In fact, some tattooists use only magnums for their entire tattooing process. Similarly, small round groups that are conventionally used for outlining can be very useful for coloring and shading complex areas of a design. They can be used in many different ways during the tattooing process besides simply outlining; they are especially effective for adding tightly focused white highlights toward the end of a session.

Because of this versatility, I encourage tattooists to step back from the traditional "liner" and "shader" definitions of needle groups. I believe that these labels can subconsciously limit artists in how they use their needles. Instead, I recommend that they be referred to simply by their description. A tight 3 is a tight 3, a 7 mag is a 7 mag. Painters do not refer to their brushes as "liners" and "shaders," but as small rounds, medium filberts and such. More versatile terminology can lead to a broader range of how each tool is perceived and utilized.

This chapter presents a brief summary of the most popular needle groups used in tattooing, including their benefits and drawbacks. In some cases, a particular needle group may require a higher level of skill and experience to use than others; this is noted in such instances. However, I encourage all tattooists to try a few types and needles of each type and experiment with them. You may be surprised by your discoveries.

Single needles (Fig. 242a) are one of the most challenging needle groups. If they’re not made just right and used in the right kind of tube with the right amount of rubber band tension, it’s hard to get them to do anything very well at all. Compared to other needle groups, the single is more prone to dropouts and blowouts. It’s a needle group that requires a lot of experience to get good results; as a result, there are very few truly good single-needle artists. If you are curious about singles, I recommend that you try them in a few pieces for some detail and fine rendering, but do the majority of your outlining and edge development with larger rounds. Once comfortable with singles, you may find other uses for them as well, but some of the most impressive work I have seen involving singles are large-scale pieces with bold outlines done with larger groups along with selective accents of fine detail such as hair or scales that were done with singles.

The 3 round (Fig. 242b) will usually do the job of a single if it’s adequately tight and the stretch is good enough. There is a limit to how tight a 3 should be made before going to a single, though; too tight and it can tear the skin as a result of the points not making three separate holes, as intended. Keep tight threes and loose threes available, depending on the scale of the piece I’m doing. A three needle line is far more reliable than one put in with a single, and when done with a graywash can serve the same purpose as a single needle line. Threes also can be used for rendering and coloring small detail work, and for building up medium lines that require a great level of precision.

The 4 round (Fig. 242c) is one of the most versatile needle groups in the small round family. In many pieces where I would have normally set up both a 3 and a 5 round, I’ve found that using only a 4 can achieve almost the same range of fine detail and built-up bold lines. For larger pieces, a 4 round can be ideal for fine detail work. For some reason, fours have never really caught on and most tattoo suppliers do not carry them. One objection I have heard is, "Won’t the four needles make a line that’s kinda square, or something?"

Good question, but think about it: Since a three makes a perfectly good line that doesn’t look triangular, doesn’t it follow that a four should work well also?

The 5 round is an important fundamental needle group (Fig. 243a) and is possibly the single most popular needle group in the tattoo industry. A small round piece can easily be lined, shaded, detailed and colored with this group alone. A tight 5 round will make small details, but puts in way less ink per stroke than a looser 5 round because of its greater skin resistance and reduced capillary action. This group can be used for lines or sharply defined, close-packed shapes, or for long, slow overlapping shading movements. In addition, the 5 round can be used for soft, feathered gradations using its loose oval movements.

I’ve had limited success experimenting with larger rounds (Fig. 243b). Because of its high skin resistance, a larger round needs more tension and power than a 5 round. In general, larger rounds will create lines with soft edges, almost like using spray paint. I noticed this difference even between 5 and 7 rounds, which already start to get too soft at the edges for my tastes. Although large rounds can be used for shading and coloring, their round clustered shape causes the needles in the center of the group to constantly pass over skin already punctured by the needles from the outer edge of the group. Let’s go back up to the spray paint analogy; if you try covering a surface with an even coat of paint from a spraycan you’ll notice how the paint clumps in some areas while leaving faint marks in others. Anywhere that it goes on too thick, it drips (equivalent to chewing a hole in the skin). Now imagine the spray can with a fan nozzle that sprays the paint in a wide fan, this acts more like a magnus needle group, and is less likely to cause the running and blobbing of the regular nozzle. At any rate, I am not trying to discourage experimentation with large rounds, but before trying them out, be aware of their pitfalls and limitations.

Doing good color work with large rounds is obviously possible, as there are some top-notch tattooists using 7, 8 and 14 rounds for both lining and coloring. But I’ve found that compared to a more spread-out needle group, it can be difficult to attain soft gradations and even fields with the big rounds. Somewhere out there is someone who does fantastic work using large rounds, and thinks magnums are difficult to use. I guess it’s all a matter of what we’re used to; however, the majority of excellent tattooists I’m acquainted with use magnums for most of their big shading and coloring work.
A Blasted-In Line Will Look Like A Blasted-In Line!

Some artists like to use large rounds for single-pass bold lines. Especially when using 10 needles or more, these lines will often be light, fuzzy at the edges and slightly scarred after healing and setting. There is no substitute for carefully sculpting a bold line; the amount of effort used in applying thick lines will be visible in their finished quality and their longevity.

I was first taught to tattoo using 6 flats (Fig. 244a) for my shading and coloring. Although not much different from a 7 magnum in terms of how many holes they poke, there’s a world of difference in how they handle. Since the flat is almost like a little blade, it “cuts” the color in, potentially making for a choppier look. It’s common for tattoos done with flats to have all kinds of little square corner marks strewn throughout their gradations. Although some tattooists swear by them, most change their tune after working with magnums for any period of time.

A flat can be spread with a razor blade into an arrangement where the holes are further apart (Fig. 244b), making it less like a knife blade and a far better group for layering color. Unfortunately, when any type of needle group is spread out this way, with some needles bent at an angle, the needles at the corners of the group end up entering the skin turned somewhat sideways, chipping large slits instead of small round holes. This can cause extra trauma to the skin.

Capillary Action is the movement of fluid in the spaces between the needles. Under ideal circumstances, the spacing between the needle units will contribute to the ink flow from the tube tip toward the points. When there is enough space between the points, pigment will flow between them, covering the whole surface of each point before the needles are driven into the skin. Better capillary action equals better pigment saturation in the tattoo.

Any odd number of five or more needles can be made into a magnum. A magnum is a flat group with two rows of needles, a top row with a smaller number of needles and a lower row with a larger number. There are two kinds of magnums: Stacked magnums and spread magnums. A stacked magnum is two flat groups soldered on top of each other, making for a closely spaced group (Fig. 244c). I have no experience with stacked mags, so I can’t say much except that they’d be more work to make than spread mags, and to expect them to require more skill to work with than other needle groups.

A spread magnum starts as one flat group with an odd number of needles tacked together at the blunt end, but with the solder only drawn up a quarter inch (6mm) or so. The needles are then pulled into the staggered magnum pattern by weaving the edge of a razor blade back and forth between the points, making two rows (Fig. 244d). The spread of these rows can be varied by pushing the razor’s edge deeper or pulling it back closer to the points. With the desired spread attained, the solder is then pulled the rest of the way toward the points.

For most needle groups, it’s good to bring the solder to about 1/4” - 3/8” (6-8 mm) short of the points. This will keep the needle group rigid and reliable while still allowing for plenty of capillary ink flow. Some tattooists like to make some of their magnums much more flexible than that, so they only bring the solder up about halfway. This is enough to keep the points in a loose magnum formation, while still allowing for plenty of flexibility.

These folks find that this arrangement is more like a paintbrush. Superstition! Would this decrease the amount of precision? This is difficult to say, I’ve used 5 rounds made this way for coloring and liked them quite a bit. Although I would be hesitant to use them for making precise lines. However, it is definitely true that less solder on the needle shafts will increase ink flow between the needles.

In all my experience, the spread magnum seems to be the best middle ground between sharpness and looseness, dexterity and softness, precision and the ability to really pack in pigment. Some tattooists work only with the magnum and use it for every part of the tattoo process, getting fine definition along with solid coverage and varying levels of focus. It is a truly versatile tool.

A 3 magnum (Fig. 15a) is great for getting a variety of color effects in small shapes. It can also be used for lines with varying thickness, or detailing small areas in a larger piece. It has a different look and feel than the 5 round. I have been using the 5 mag for laying out large pieces and find it to be remarkably versatile. With its small number of needles and wide spacing, its skin reaction is extremely low, making it easy to move fast without having to crank up the power. It can be used for bold lines or sketching in fine detail; anyone who has ever used a calligraphy pen can imagine how this group would handle when brought to the skin from various angles. Rough lining and the basic texturing and shading of a piece can all be handled in one step using this group.

A 7 magnum (Fig. 245b) seems to be among the most versatile of all magnums. It can get into very tight areas, but is still capable of moving through large, even fields in a short time. If you only ever work with one size of magnum, use a 7 mag. This group is popular among many tattooists for pieces of all sizes; some even use it for realistic portrait work without using anything smaller for detail. With all magnums, working off the corner is an important skill to learn, and will allow for a greater range of variation and subtlety during the rendering process (Video Clip 28: Working Off The Corner Of A Magnum).

Larger magnums (Fig. 245c) will cover more area while making it easier to create long smooth gradations and even fields. Especially with bigger tattoos, it is essential to balance out small detail and texture with smooth fields and gradations to give the piece a clean look that will hold up well from a distance. Larger magnums are often the right tool for this job. Soft out-of-focus effects can be easier to achieve using a large magnum as well. However, because of its greater skin resistance, a larger mag will require more spring tension and more power than a smaller magnum, so it may mean having additional machines that are specialized for the purpose.
I won't go into any detail about the more exotic groups, such as hollow-tipped elevens and fifty-needle bullet groups. I can't even imagine how to make any of these groups, so I won't presume to say anything helpful about them except, like the stacked stack, they probably involve more work to put them together. If you're a true equipment nerd and would like to test the limits of what can be done with needles, there is no end to the number of unusual specialized needle groups that can be made. Each type should have its own unique benefits.

The fact is, there are artists doing beautiful work using all kinds of different needles. Many of them arrived at their choices after experimenting with numerous different needle groups and developing a preference. Others, though, found something adequate near the beginning of their career, became comfortable with it, and built upon it (for better or for worse), kind of like marrying their high school sweetheart.

However, no one will divorce us for trying out different needles. It's easy to become comfortable with anything that seems to do the job; it's even easy to become complacent with the pitfalls of tried-and-true habits, since dealing with those pitfalls may seem like less work than learning entirely new ways of doing things.

New needle groups require new rhythms. The hand will flow differently with a larger magnun than it will with a seven. The difference can be noticed while making those tight little oval brushstrokes during shading and coloring. Different needle groups may also require variations in the amount of spring tension, the size of the point gap, the number of order bands and the size of the coils. When auditioning a new needle group, it needs to be tried with a variety of machines under different circumstances, such as gray shading, color fields and sharp white highlights. Only by giving it a chance under a variety of conditions can a needle group's advantages be discovered.

The one thing that will affect it more than any of these factors is the tattooist's working rhythm; this is something that only gets discovered after a certain amount of experience. It's easy to dismiss something if it doesn't initially work very well. It's totally natural to say, "Hey, I know that I can tattoo, and this tattoo isn't going in smoothly—it must be the new needle group!"

This happened to me when I tried out a 13 mag for the first time. It was a large piece with big fields of color, so I thought it would be easy. But it was a struggle in the beginning; not that it wasn't going in, but it just didn't seem to be working things go faster. I kept playing with the power and point gap and trying to compensate with the way I moved. Quite unexpectedly, in around the third hour, it clicked and I began to really experience the benefits of using larger magnuns. Now I use them for most of the larger work that I do.

Whether it be a new needle configuration, machine or lighting setup, new tools and equipment need to be given a chance before deciding if they are appropriate or not. Anything significantly different from the accustomed setup may appear to slow things down or reduce efficiency in other ways, but only after doing a few tattoo projects using a new item of equipment can this really be determined with any accuracy. In other words, don't give up too easily on new things.

When driving a needle into the skin, the point is not just poking a hole; it's also pushing in color. To better understand the relationship between the needles and the skin, try to visualize a needle poking into the skin in slow motion. The skin directly around the point spreads to admit the incoming needle. The skin is elastic, and as the needle slides in deeper the hole pulls inward on itself, trying to close, creating friction against the needle. This
The points of the needles can make a noticeable impact on the way color goes into the skin. These days, a number of different point styles are being sold by tattoo suppliers, each with its own distinct characteristics (Fig. 248a). Types A and B are varieties of long-tapered needles, which are best for tighter needle groupings and doing more precise work. They may not be as good at packing pigment as type C, the short-tapered needle, but may provide an extra degree of precision and control. Type C needles are designed so that the full diameter of the needle will penetrate the skin to the depth needed to make pigment stay permanently in place. It’s also likely that the “shoulder” of the needle (where the straight shaft angles inward toward the point) helps push the ink into the skin slightly better than a smoother taper.

Longer tapered needles cause less skin resistance than shorter tapers. Because of this, there is a noticeable difference in the power required to push a large magnum made of short-tapered needles through the skin than one made of long-tapered needles.

Needle gauge will also make a big difference. “The smaller, the better” could be a simple assumption to make, and there has been a certain amount of romanticism about superfine size 000 entomologist’s pins, or bug pins. Because of their small size, more needles are needed in each group to accomplish the same amount of skin saturation. These superfine points can be helpful and appropriate in some cases, such as extra-soft graywashes or single needle work, but I can’t speak from personal experience here. Some tattooists are using them for color work, and find that their color gradients appear smoother than with standard needles, but others have found them difficult to use.

It seems that the majority of tattooists prefer 00 gauge needles for most general purposes. Some suppliers have several minor variations on this size available. You may find that you like the results from one size more than the others, if you are inclined toward a lot of experimentation. Keep in mind, though, that most tube tips are designed around the specifications of standard 00 needles, so a slightly smaller gauge needle may result in a magnum that fits too loosely in its tube. Odd-sized needles may be the most useful in round groups, where the tube size will not matter as much as with flats or magnums.

A good comparison between 00 and 0000 needles is how they fit in a magnum tube. A standard 7 magnum tube will fit a 7 needle magnum made from 00 pins without much room to spare; the same tube will hold a 9 magnum made from 000 bug pins.

Tattooists today have so many needle choices that an apprentice could easily find the subject confusing and intimidating. The reality is that any well-made needle group in the appropriate tube will drive in pigment. For anyone wanting to start with the basics, I recommend using the combination of a 3 round, 5 round and 7 magnum, as described earlier; they will provide the full range of rendering choices needed to complete most tattoos. Larger and more unusual groups can then be phased in gradually. In time, any artist willing to try a variety of setups will eventually find the combination of needle groups and tubes that works best for their style of tattooing.

What’s The Deal With Carbon-Tipped Needles?

For coloring, I’ve had excellent results from carbon-tipped needles. These needles have more texture in their points than plain stainless needles, making them ideal for driving in larger quantities of pigment than standard points. They work well for shading and coloring, but the conservative part of me is cautious about using carbon needles in lining groups because they may cause blowouts to happen more easily due to how effectively they drive in the pigment.

Carbon needles require an extra step of care. Unlike stainless needles, they can rust, so they need to be handled more carefully. When removing the ungrouped needles from their paper envelopes, tweezers should be used so that fingertip oils don’t oxidize the rest of the contents of the pack. Once the groups are tied on their bars, their points need to be dipped to prevent oxidization. Many different agents can be used for this: Vaseline, glycerine, mineral oil, even cooking oil. Basically, anything that will keep the air off the metal; if oxygen can’t reach it, it can’t rust. This step needs to happen as soon as the needles are soldered, cleaned and dried.

When the autoclave cycle is finished, it’s important to open the door as soon as it is safe and then let the needles cool dry in the residual heat. If the door is left closed while the autoclave cools, the needles will become macking wet and most of them will rust. Keeping them dry at this stage is essential. Once dry, they should be good for at least 6 months. It’s normal for an occasional carbon needle to go bad, despite being dried. For me, it’s about one in twenty-five, even that, but at first it was more. Most carbon needles will leave a tiny brown stain on your paper towel if you clean their points with alcohol, which is normal; you’ll know a bad point when you see it through the eye loupe.

One of the biggest disadvantages to using carbon needles is the fact that most manufacturers won’t sell them pre-made, so this is a needle type best reserved for artists who like to be involved in every stage of the tattoo process. They are a bit of extra work, but their ability to pack color can more than make up for this.
6.4) Tubes

No discussion of tattoo needles is complete without also spending some time talking about tubes. The tube is responsible for two equally important functions: It gives the tattooist something to hold (supporting the machine and keeping the needle bar aligned) and serves the purpose of storing ink and regulating ink flow during the tattooing process. To serve these two functions properly, the tube grip must be comfortable and the right weight, and the tube tip needs to be well designed and in good condition to produce optimal ink flow.

Tattooing tubes come in a variety of styles. They can be outfitted with tube tips that will fit any needle group, and their grips can be set up or modified to work well for almost anyone's comfort needs. Tube types are defined by how many parts they are made from: one-piece, two pieces, or three pieces.

A one-piece tube is considered by some to be the most desirable because of its seamless construction. Machined from a single block of metal, this type of tube has no joints between parts for old ink and fluids to collect. Several manufacturers produce one-piece tubes, which tend to be a bit more expensive than multiple-piece tubes. Their other drawbacks include a narrower variety of tip and grip choices, and no ease of changing the tip when it wears out. Among artists who swear by one-piece tubes, however, these disadvantages are negligible.

Two-piece tubes are made of two main parts: the grip, which can be bought separately in any desired style, and the stem, which comes with the tip attached (Fig. 251a). When the tip is worn out, the stem is discarded and the grip is put on a new one. This type of tube has a couple of advantages: It has no internal seams, where ink and fluid have the most contact, and by occasionally replacing the tube stem, there will be less incident of tubes being gradually flattened and deformed by tube vices. One disadvantage is that these tubes are not nearly as common as three-piece tubes, resulting in fewer choices of tip styles.

Three-piece tubes are the most common and economical tube type. This type of tube allows for an almost limitless variety of tip styles available, including disposable tips. Because tip wear is the main cause of ink flow problems, being able to change tips regularly is of great importance, making this style of tube the most practical. Their main disadvantage is the seam between the tip and shaft (Fig. 251b). This seam allows ink to collect in the tube; by taking apart the tube during scrubbing, you can see that a fair amount of fluid gets trapped between the tube parts, collecting especially inside the grip. Most tattooists scrub all exposed surfaces of the tube and then autoclave them, not worrying about hidden deposits of ink. This is probably quite safe, and is an almost universal practice in the industry. Because of the way three-piece tubes are made, pigment is allowed to collect only in very thin layers, well within the limits of what an autoclave can manage. However, for anyone attempting to implement a perfect cleanliness procedure, multi-piece tubes are a weak link unless disassembled when scrubbing, which can cost extra time and effort.

Because multi-piece tubes are held together by a pair of Allen set screws, they in fact have two additional parts. Some tube makers have referred to them as four-piece and five-piece tubes instead of two-piece and three-piece tubes.
The other major component of a tattooing tube is its grip. The grip is essential to the handle for the entire machine while it is being used, so it needs to be comfortable and secure, and allow for maximum dexterity and maneuverability. Because every person is made differently, no single grip design is appropriate for all artists, so everyone in the industry at one point or another needs to experiment with available grip styles to see what works best for them.

In the old days, the tube grip was extremely simple, often adding little or no extra thickness to the tube shaft. This made for a gripping surface about the thickness of a pencil, which is okay for a pencil but not for something as heavy as a tattooing machine. Thicker grips came onto the market around the middle of the 20th century, mostly simple cylinders with a criss-cross knurling pattern to prevent slippage (Fig. 252a). As more manufacturers began selling grips, more options came along; the first few grips were simply thicker versions of the cylindrical design, which offered relief to some artists but to many were cumbersome.

Tapered grips are another popular modern adaptation (Fig. 252b). I have become very comfortable using grips like these, although they are only part of my arsenal. The thickest part of the tapered grip (3/4" or 17mm) is about 1/8" (3mm) thicker than the normal sized cylindrical grip I used to work with; its diameter then tapers down to being just a little wider than the tube itself. In my own experience, I have come to prefer using tapered grips because they provide a thick chunk of metal near the tube tip, where my fingers are doing the most maneuvering. However, the tapered back end allows my hand to relax more, whereas a grip that is fat from end to end can force the hand to remain open when it really just wants to relax into a more natural semi-closed position.

Other grip styles are available, more than could be fit into these pages. Nonetheless, each adaptation has its own advantages and disadvantages, and each will appeal to artists depending on their particular comfort needs. In some cases, the knurling has been eliminated and replaced with simpler ridges (Fig. 252c). In addition to a more rounded design, grips like these provide the necessary traction yet are less abrasive to the hands, causing less of a callous to build up while working. They are also easier to scrub clean than knurled tube grips. Some suppliers sell a wide range of exotic ergonomic grip styles to choose from (Fig. 252d); if you are experiencing pain in your tattooing hand, you may want to spend some money on a variety of grips to see if any of them give your hand the relief it needs.

Many tattooists, especially in the first 5 years of their careers, will develop a callous on the inner side of their middle finger where the tube grip is stabilized during tattooing. If this callous continues to grow, use a nail file or fine sandpaper to file down the callous a little bit every week until it stabilizes at a reasonable size. Eventually it will stop growing as your hand balances with your equipment; however, by filing or sanding it down during its growth stage it will keep to a smaller size. Left unchecked, it can get big and awkward.

There are additional grip choices as well. Some artists prefer a lighter weight grip but want a large diameter; for this purpose, some manufacturers sell autoclavable plastic grips in various diameters, including sizes that would be quite heavy if made from stainless steel. These grips have a wide diameter but do not provide as much counterbalancing weight as metal grips do. Because of the machine’s heavy weight, a metal grip can be helpful in balancing some of that weight forward and down, toward the tube tip. This makes it less necessary for artists to flex their hands continuously in keeping the needle in contact with the skin. In my experience, the ideal setup is one where the tube and machine balance perfectly when held in a tattooing position; this takes a great deal of strain off the hand. However, if you need an extra fat grip but don’t want the extra weight, try the fat plastic grips; an extra-light machine would complement this setup well. In addition, suppliers are beginning to experiment with novel shapes of ergonomic plastic grips; if comfort is an issue for you, this could be a good direction to explore.

Another comfort option is to use silicone grip covers, which recently have become popular. These covers are sold by a few manufacturers and come in a variety of sizes, styles and colors. Most are designed to fit cylindrical grips, as in Fig. 252a. These covers are slipped over the grip and then autoclaved while on the tube; the heat from the sterilizer helps the grip cover to shrink in place. I have worked with these covers fairly regularly and have found them to be quite comfortable.

Why am I not using them for every tattoo? I’m still trying to decide what I think of them. I’m not presently having any major comfort issues with my machine/tube setup, so the additional comfort these grip covers provide is a small factor in my working setup. Because of this, I have to weigh the small benefit against the numerous drawbacks. The largest issue for me is their diameter, which is a bit wider than I’m used to. Another issue is the need to remove, scrub and put them on again with each tattoo. For an artist doing mostly large custom work, this is only a small problem; and if the covers are allowing for longer sessions this extra step is more than worth it. For someone doing 4-5 small tattoos a day, this might add up into a headache. There is also the option of keeping a few covered grips around for the purpose of the longer sessions, and using the normal grips for shorter projects.

The tip of the tube is its other key component, and regulates the ink flow and precision of the tattooing process. There are three basic types of tip: Round, diamond and square. Each of these tip styles can be made in a variety of ways.

The round tip is used for round needle groups, and can be made in any diameter needed (Fig. 253a). Generally, the inner diameter of the tube tip should be about double the diameter of its intended needle group. Any smaller and there will be limited ink flow, especially when using color; any larger and the ink will pour out of the tube too quickly. I recommend filing down the tip to create a bevel at the end, as described in Chapter 2.6 (Fig. 253b). This will provide better visibility while working, making it easier to see where the needle points are touching the skin.

Most round tube tips are provided with a rinse hole in the front of their ink reservoir (Fig. 253c). This is essential, especially for color artists, to allow quicker rinsing between colors. It also makes these tubes easier to scrub. Some round tubes don’t have this hole (Fig. 253d), especially one-piece tubes. Some artists argue that this design holds more ink and makes it necessary to dip less frequently, but I have found that the lack of this hole simply slows me down.
Because of their simple and economical design, these round tips are prone to wear out quickly, causing spitting or ink flow issues. This can be prevented by checking the tip before setting up—the chief telltale sign is a groove or slot appearing in the part of the tip where the needle rides (Fig. 254a). Their simple construction also makes them vulnerable to other kinds of damage that can happen as a result of dropping or banging them against other objects, look for a dented or mashed tip to see if this is the case (Fig. 254b). Of all the tube tip styles, round tips need to be replaced the most frequently.

Some tattooists prefer diamond-tipped tubes for their round groups (Fig. 254c). This tip style is designed in a way that helps to keep the needle group centered in the back of the tube while working, and can provide an extra degree of precision. However, they are not universally popular; this may be partly because they allow for less ink flow than a round tube. This problem is especially noticeable when the tip is older and starting to get a groove worn into it.

When working with round or diamond tips, it is essential that the needle group is centered with the tip, and flexed in a way that it smoothly rides the back of the tube tip. Often, needles are soldered on the bar in such a way that the tips angle slightly upward, causing them to ride away from the back of the tube (Fig. 254d). This can cause spitting, but its most noticeable problem is that it will make it much harder to work in a precise way. Having the needle group ride firmly in the back of the tube will provide the most tattooing precision and control.

The solution is simple: Bend the needle slightly back, as pictured in Fig. 254e. This should cause the needles to ride the back of the tube tip properly. During this procedure, it is also helpful to check the lateral alignment of the needle, as it will appear when you look straight down at the needle on its bar (Fig. 254f). If the needle is not perfectly straight on the bar, it will ride the tube off to one side or the other, causing precision and ink flow problems. This can also be solved very simply by bending the needle slightly to give it a better centering in the tube (Fig. 254g).

A good habit is to check the vertical and lateral alignment of your needle group on the bar before setting up the machine; this can save a couple steps later in the setup process.

Sometimes round tips will develop holes and trenches in unexpected places. A common spot for this to happen is in the back of the tube, where the tip joins the reservoir (Fig. 255a). This is often a result of working frequently with the needle group angled up slightly, as in Fig. 254d. Any type of wear that produces a hole or trench in the tube means that it's time to change your tip.

Square tips are typically used for shading and coloring groups such as flats and magnums. The simplest variety are formed by pressing a round piece of tube stock into a square cross section, then beveling its tip to about 45 degrees (Fig. 255b). This simple variety is my personal favorite, and seems to allow for good ink flow and plenty of visibility and precision. However, I am less inclined to use this type of tube tip when its corners are completely square (Fig. 255c). Although this should perform in a very similar manner to the slightly rounded version that I prefer, my opinion is that there is a higher likelihood of the tip's corners occasionally coming into contact with the raw tattooed skin; when this happens, the slightly rounded corners would be more comfortable. I also believe that the rounded tip makes the corner needles of a magnus group protrude slightly more, allowing for greater precision.

Other varieties of square tips are made using a computer-controlled mill, where the tip is carved from a block of metal instead of reshaping a length of tubing. Milled tips are usually open along the front, as opposed to the formed tips, which are closed. Milled tips are often designed with a reservoir area for holding ink and a needle support shelf in the tip. In my experience, milled tips work best when there is little or no extra metal (Fig. 255d), making them easier to see. Other milled tip designs are not carved closely to the needle support shelf, leaving a distracting mass of metal (Fig. 255e). Although these two milled tips have the same interior area for the ink and needles, the top example is the easiest to work with because of its increased visibility. Being able to see the tattoo immediately around the tube tip is essential.

Larger magnums are usually made with milled open-front tips (Fig. 255f) which can be made in any width to accommodate any size of magnum. These large open "sloved" style tips are ideal for large magnums, providing solid ink flow and allowing artists to monitor how the needle points are riding the tube tip. For sizes 15 and larger, specialized one-piece tubes become necessary, where the grip is provided with a lengthwise slot through which to insert the needle bar.
Needle alignment is just as important with magnums as it is with rounds of the artist wants to avoid ink spitting or precision problems. Similar to the round group in Fig. 254c, the magnum group may need to be bent to make sure it rides the back of the tube at its points. In addition, it’s important to look straight into the tip of the tube to be sure the magnum is riding flat on the back of the tube (Fig. 256a). If it’s not parallel with the tube tip (Fig. 256b), ink flow and precision problems will likely arise; this can be fixed simply by loosening the tube vise and rotating the tube until it aligns with the needle group.

Square tips can wear out just as easily as round tips. Usually this will take the form of several grooves appearing in the back of the tube tip (Fig. 255c). These grooves will become visible fairly soon after a new tip is brought into use, and they are a normal part of the life cycle of the tube tip. Eventually these grooves may begin to cause ink flow or spitting problems; if the tip is fairly new, this can be solved by using a small flat needle file to remove the grooved metal from the tip. Most tube tips are fairly thin-walled, and there is only so much that can be done to prolong their longevity. When the grooves have worn all the way through the tube tip (Fig. 256d), it’s time to replace it. In some cases, a tube can be so worn out that a groove breaks all the way through the tip during a tattoo session, causing part of the needle group to bend and poke all the way through the groove. At that point there is no denying the need for a new tip.

Tips are cheap and your time is valuable. A good habit is to check and replace worn tips every 3-5 autoclave cycles; this way none of your tubes will ever end up in such bad condition.

Some artists prefer to use disposable plastic tubes. These eliminate the need for scrubbing and sterilizing tubes, and make worn-out tips a thing of the past. At first, this may seem like a great idea—who wants to scrub, anyway? But the ground truth is that disposable tubes have so many disadvantages that I can only recommend them for specific circumstances.

The first and most obvious issue is the lack of variety. Disposable tubes only come in a few styles, with just a few grip types and the most basic tip styles. Anyone who has come to develop specific tube preferences will have to abandon those for the basic choices that disposables offer. If there are ergonomic concerns, these need to be forgotten about as well. Exotic needle groups? Forget about it.

The second issue is their weight—or rather, lack of weight. As with the plastic grips mentioned earlier, the lighter tube options don’t always provide the balance and equilibrium needed for comfortably handling a tattoo machine, causing artists to flex their hands in ways that are unnecessary with a more balanced setup. There’s a few artists who have developed serious hand problems as a result of working like this. I have also seen tattooists marketing weights that slip over the plastic grips, making them heavier and restoring some of that balance. However, in light of all the other disadvantages, this additional step doesn’t seem to be worth the effort.

Another option is to use conventional steel tubes but plastic disposable tips. These are cheap and can be fitted on any standard tube. They do not negate the need for scrubbing, and they will not save any effort during setup and breakdown. I have found them to be useful for one particular thing: Working with white pigment.

No doubt you’ve had this problem: The tattoo is mostly finished, with only the white highlights left to do. You remove the tube thoroughly, dip in the white and start highlighting. However, by the time you dip into the white again, the pigment left in the tube has already started to turn gray. Frustrated, you change to a new tube and start again. Without any pigment traces in the tube, there’s nothing to stain the white pigment—right? However, after trying again, the same thing happens—your white pigment is turning gray.

This is due to the fact that the white pigment is made from a harder substance than the tube tip. Almost all white tattoo ink is made of titanium dioxide, which is harder than steel. In its broken down form, it acts as an abrasive inside the tube, rather than a lubricant (this contributes to the need for more power when working with white). Because of these small amounts of steel nicks with the pigment, and much of the steel will end up permanently in the skin. This isn’t a health issue but will definitely affect the brightness of the white.

The solution is to simply rinse more often. This will not only keep the staining from becoming too obvious but will also prevent the tube from drying out and forcing the machine to work harder (therefore less smoothly). Another solution, though, is to use a disposable tip. Some tattooists are beginning to set up an extra machine specifically for white highlights only, and will use a disposable tip in that setup. None of the familiar staining seems to happen when the problem is approached this way. So, despite their drawbacks, disposable tips can be very helpful for this particular job.

Tubes are largely a matter of personal preference; every artist has their own favorite styles for their own reasons. One thing that is important to remember is that the performance of a tattooing setup will have a lot to do not just with the needle or the tube, but with the relationship between the two. Sometimes a particular magnum group will interact with the wear pattern on the back of a tube to cause spitting; this same tube or needle paired with a different partner might work perfectly. It’s not an exact science, and requires a bit of experimentation to find the right combination. However, to help simplify the troubleshooting process, I’ve provided a few simple step-by-step tech support checklists to help you eliminate any small problems that are slowing you down and affecting your finished results.

**Checklist 1: Ink Flow**

My ink is not flowing smoothly, slowing me down. What can I do?

1) Check vertical alignment of needles. Is the group riding the back of the tube? If not, remove needle bar from armature bar nipple, extend it all the way out the tip, bend it back, reattach to nipple.

2) Check lateral alignment of needles. If it’s a round group, is it centered in the tube? If not, bend accordingly. If it’s a magnum or flat, is it riding parallel to the back of the tube? If not, loosen tube vise and realign.
3) Check condition of tube tip. Is it worn? If so, replace it.
4) Still having ink flow problems? Look at the needle. Is there more solder than necessary on the needle shafts, or irregular blobs of solder? This can cause ink flow limitations; switch to a new needle.
5) If needle and tube are in good condition and the needle is aligned in the tube the right way, check to see if the tube tip is too small. For a round group, the tube tip’s inner diameter should be around twice the diameter of the needle group.
6) Check the needle’s points. Particularly with round groups, sometimes paper towel lint will get stuck between the tips. It can be helpful to keep a sterile but damaged or crooked needle group at your station to use as a “pick” to remove lint. If it happens often, try a different needle group... or a different brand of paper towels.
7) If the ink flow issue is still not resolved, refer to the Machine Checklists in Chapter 6.5.

Checklist 2: Visibility Problems
I’m trying to do precise work but I can’t see very well. What can I do?

1) Is the problem caused by spraying or spitting? This is almost always a needle/tube related problem. First, check alignment of the needles, both vertical and lateral. If the needles are not riding the back of the tube or are not centered, take steps to fix this, as in Checklist 1.
2) Still spraying? Look for wear in the tube tip, or irregularities in the solder on the needle shafts. One of these two procedures will almost always rectify a spraying problem.
3) Still spraying? This might occur because you don’t have enough rubber band tension, allowing the needles to flop around in their tip. This will cause other visibility/precision issues as well. If you look at your points from the side while the machine is running, you should be able to see clearly if they are riding the back of the tube or if they are flopping around. If loose, try adding another rubber band.
4) Is the visibility problem because of ink running too fast from the tube, making a blob on the skin? This will usually be due to a tube tip that is too large for the needle group—the inner diameter should be roughly double the size of the needle group. In some cases this “blobbing” problem will be due to a poorly designed ink reservoir in your tube. In both cases, try a different tube.
5) Are you simply having a hard time seeing your needles? This will be most pronounced with non-beveled round tubes, which block part of your view. Switch to a beveled tube tip and see if it corrects the problem.
6) Still can’t see your needles well enough? Try setting up your machine so that more needle hangs out the tip. It’s alright for the needles to not retract all the way, although the more they retract, the better they will be covered with ink. Extending them further will increase visibility but may decrease ink flow; try various combinations to find your ideal happy medium.
7) Have you done all this but still need better visibility? You probably need a good lamp, placed in such a way that your work area is illuminated in a shadow-free manner (see more information about lighting in Chapter 6.10).

6.5) Machine Tuning

At the core of the whole tattooing process is the machine itself. Tattoo machines are based on a simple design patented over a century ago, and have been in use almost as long as the internal combustion engine. In all those years, the basic principle has not changed, and countless attempts at replacing it with new machines have never caught on. Despite being an example of late Victorian-era technology, the tattoo machine as we know it still seems to be one of the best things around.

One of the things that makes the electromagnetic reciprocating spring-driven machine design so successful is its almost infinite flexibility. Although the basic principles in every machine are essentially the same, the details of how they are made or tuned will determine precisely how they run. Simply changing a single component, like a spring or capacitor, will profoundly affect the way a tattoo machine operates. Even a minor manipulation of one of the machine’s parts can offer a significant range of adjustment, allowing artists to seek a “sweet spot” in the adjustment where the machine runs exactly as they want it. Because of the endless range of options these machines offer, tattooists have deeply explored the many ways that they can be adjusted and refined.

Your principle is simple. When the footswitch is pressed, electricity passes through the machine’s coils, causing an electromagnet to charge to build up in them. Within a short fraction of a second, enough charge has accumulated to make the electromagnet in the coils powerful enough to pull the armature bar down and into contact with the emery stones (Fig. 259a). In doing this, the machine’s main circuit is broken and the charge in the coils is allowed to energize, causing the armature to lose its magnetism. Without the magnetic pull, the spring tension immediately pulls the armature bar back up toward the contact screw, where the cycle can begin again (Fig. 259b). In most machines this will happen several thousand times per minute.
The way the machine runs can be altered in countless ways, from adding rubber O-rings to replacing the capacitor to changing the geometry of the frame. However, this chapter will focus mostly on the simple things that can be done in a busy shop or convention setting in order to keep your machines running smoothly.

All tattoo machines are not created equally. It's a natural enough assumption to start an apprentice tattooist out with a pair of baseline, entry-level catalog tattoo machines, probably for $125-$150 apiece. That's how I started, and that's probably how most tattooists begin (not counting experiments with hand-poking, cursive motor machines, etc.). It seems to make sense to begin this way, especially considering all the other costs involved in getting started.

After the first year and a half or so of working with these cheap catalog iron, I began buying some nicer machines. The difference was like night and day! My machines, which had always healed light or dropped out, began coming out crisp and dark on the first shot. Color flew in and healed richer and brighter. Where I was used to a light, sickly ruffling drone, I was now hearing and feeling a smooth, confident hum.

You're Just An Apprentice... So Let's Start You Out Using Some Junk Machines.

It’s true that many apprentices can't afford good machines and must work with a tight budget, but let this be said: Starting a tattoo education with inferior machines adds up to a handicap that can slow down your learning process and lead to frustration. If you own a shop and are teaching anyone to tattoo, be sure to loan them some decent machines until they can afford something worthwhile of their own.

I've found that better engineered machines made from higher quality parts and materials will stay in tune longer and hold up to wear and tear better than cheap machines do. And, for the most part, these will still be in the $200-$325 range.

It's true that a well-rounded tattooist can fidget with almost any machine to the point where it will work well enough that they can tattoo with it. There's no reason not to find some way to get those cheap machines to hum nicely. But the fact remains that the materials the frame and coils are made of, along with the frame geometry and other engineering factors, will make a big impression on their performance regardless of how well they are tuned.

For the purpose of better understanding how they run, it's good to fidget with old machines, strip them down and put them back together, change the springs and the points and all that. It's nice to have cheap machines just to fiddle with; some manufacturers even have inexpensive kits just for this purpose. If you're apprenticing with someone experienced, chances are they have all sorts of old machine parts lying around that they might hand over to you for the purpose of experimentation. Ultimately, though, when it comes to applying the art to skin, it's important to not have anything that compromises the tattooing process. The backbone of every serious tattooist's operation is to have a good set of solid, reliable workhorse machines.

Don't Tinker Without Backup!

If you only have one set of working machines, treat them carefully. If a friend or coworker suggests changing the way they are tuned, first ask yourself if they need to be altered. It's a common trap to fall into: In the course of attempting to improve your equipment, it ends up being completely out of commission... often with a client sitting patiently in the next room. The best way to avoid this is to collect machines as you can afford them, and always have a set that you are happy with so you can play with your other machines without worrying about the consequences.

The stroke of a machine is its movement from its upward position down to its lower position and back up again. The stroke is measured in terms of both length and speed for example, a shader machine will have a long, moderately fast stroke.

Having a working familiarity with the machine's parts (Fig. 261a) can make it easier to discuss machine tuning with other artists. Part of becoming a tattooist is learning to identify a smoothly running machine by its sound and feel. For many artists, the most basic and convenient field test for a machine's smoothness, power and consistency is to feel the needle's tie armature bar for the rigidity of its hum. Ideally, this is done with a tube and needle in place. The tube tip should be dipped in water before running the machine, since it will run much differently dry. The machine is then held backwards, as shown (Fig. 261b).

With the machine running, the thumb is held lightly but firmly against the needle bar (as to barely slow it at all) while allowing the needle to strike and bounce off of it on each downward stroke (Fig. 261c). If the machine is running right and the appropriate amount of pressure is held in place by the thumb, the machine will slow down the same amount that it would when the needle points strike the client's skin.
The smoothness and strength of the stroke can be felt quite clearly this way. This is a good position to hold a machine while tuning it or adjusting its power. If this test is performed the same way with the same amount of thumb pressure each time, it can be a reliable way to check if a machine is running within the basic parameters preferred for tattooing.

When hanging around tattoo conventions and visiting enterprising machine builders, there won’t always be a needle, tube and cup of water available to perform this test. Instead, the machine can be held by its tube vise and the action gauged with the thumb from your other hand (Fig. 262a). By holding the tube vise only, this minimizes how much the machine’s vibration is damped by your hand.

**The thumb test is a simple and non-specific test. If you are already familiar with your needs, it will tell you from one day to the next if your machines are staying in tune. However, for an unfamiliar machine, the thumb test will only tell you if the machine is running smoothly and will not accurately gauge speed or force.**

With some experience, tattooists should be able to identify that magic perfect hum that signifies a machine is running in a familiar, smooth way that will work for their tattooing habits. It should also be possible to use this hum to help tune the machine, so that the effect of small changes made to the machine’s parts can be gauged in terms of how they directly affect the smoothness and power of the machine. Without having a way to evaluate the way a machine runs, it can be very difficult to improve it.

Machines usually start out their lives tuned for a particular job, such as lining or shading. Every job has its particular requirements; for instance, a machine tuned to drive a 13 magnum will run slower and with more force than a machine tuned for single-pass lining with a 3 round. Although any one machine could be tuned in such a way to handle most of these different jobs satisfactorily, by tuning each one in its own specialized way they can be set up to run optimally for each kind of needle group.

The most basic ways of adjusting a machine involve changing the angle and rotation of the contact screw. This screw comes in contact with the front spring, determining how far upward the spring/armature bar assembly can travel and thus establishing both the length and speed of the stroke. This can be adjusted by loosening its set screw, then turning the end of the contact screw. For fine-tuning purposes, I recommend doing this with the machine running in order to see how the adjustments are affecting the machine’s performance.
While filing a contact screw, you will need to press down on the armature bar’s nipple to hold the front spring out of the way. Be sure to press down on the nipple, as opposed to the spring itself, which can cause unwanted changes to the spring tension and shorten its life.

Naturally, filing the point will change not only its angle but also the width of the gap between it and the spring (also known as the point gap). Sometimes you will need to play with both the position and angle of the screw to find the right combination. The contact screw’s angle can be altered by loosening the mounting screw on the frame side of the machine (Fig. 264a) and then pivoting the contact screw on its binding post (Fig. 264b). It’s important that all set screws and mounting screws are tightened down adequately once the desired combination is found.

When adjusting the contact screw, it’s a good practice to try making changes to its rotation of the screw first, then adjusting its angle as a second resort. Changes to the contact screw’s angle have far-reaching effects and should be kept as minor as possible.

Should I Have A Contact Point On My Front Spring?

Some machines come with silver contact points on their front springs. At first this sounds like a great idea; silver is a strong electrical conductor. However, these points will limit your ability to adjust the screw’s angle, providing only one tiny target. Eventually these points fall out, leaving a hole in the spring that will cause it to quickly weaken and break. Generally I recommend keeping it simple and using point-free springs.

Although making alterations to the contact screw’s rotation and angle will affect a machine’s smoothness, the factor that it influences the most is speed. The reason these alterations also affect the smoothness is because some speeds will naturally resonate smoothly with the machine while others do not. While turning the contact screw, you’ll notice an occasional “sweet spot” in its position that allows the machine to resonate nicely, finding these spots to avoid resonance problems is a crucial part of making machines run smoothly.

When a tattoo machine is assembled, the back spring is usually bent slightly in order to cause the front spring to press against the contact screw. This is referred to as the machine’s spring tension, and is the factor that will provide the upward half of each stroke. In order to run, a machine needs enough spring tension to snap the armature bar into the upward position each time the electromagnetic force briefly pauses; at the same time, too much tension will force the machine to work harder than necessary to pull the armature bar downward.

When the point gap is widened, the machine will usually require additional spring tension in order to run properly. Sometimes widening the gap will cause the front spring to lose connection with the contact screw, so at the very least enough tension needs to be added in order to re-establish contact. Larger needle groups will usually require additional spring tension; this ensures that the upward stroke will carry enough strength to quickly move the heavier group back into the upward position.

Keep some extra springs handy in your spare parts drawer. Springs are cheap and you never know when you might need a new one. In particular, be sure to check your supply of spare springs before making any major adjustments to the spring tension on your machines.

By adjusting the combination of the contact screw’s rotation and angle, you should be able to find a perfect balance where the machine runs smoothly. If you are dealing with a machine that you like the way it normally runs but it has started to run less smoothly, making occasional small adjustments to the contact screw will usually be enough to keep it in tune.

In Chapter 2 we talked in some detail about tuning the machine to run in such a way that it can be worked with like a pencil. This involves a long stroke and soft spring tension, usually running the machine at a relatively low power.

For most shading, coloring and pencil-style lining work, a wide point gap and minimal spring tension are beneficial in a number of ways: You can work an area longer while rendering, spend more time making lines perfect, and layer the color for a more painterly look. This allows for greater control over how the color goes in with the least amount of trauma to the skin, making it especially helpful when building up lines.

Once the point gap has been established, tension can be added to the back spring by first loosening the mounting screw that holds on the binding post (Fig. 265a) and then removing the post, leaving it hanging by its wires.
What Is The Capacitor For?
A tattoo machine can be built to run without a capacitor, but its performance will be degraded. The capacitor increases the efficiency of the machine’s circuit by slowing electromagnetic dissipation, providing a stronger magnetic pull at the moment in the machine’s cycle it is needed the most. Too small a capacitor will lead to it burning out, sometimes with a spectacular firecracker-like blast. Too large a capacitor will cause the armature bar to occasionally stick in the downward position, resulting in snags and other inconveniences. Generally, a burnt capacitor should be replaced with one of similar or slightly higher rating.

The capacitor also provides a buffer to keep sparks from jumping across the contact point gap, preventing these sparks from damaging the coil or damaging the needle. This reduces the stress on the needle and increases its lifespan. Additionally, the capacitor helps to stabilize the voltage and current components of the circuit, resulting in a smoother, more consistent power output.

A small amount of tension is then added to the spring by pulling back gently on it (Fig. 266a). The binding post is then put back into place, its mounting screw is tightened and the machine is run briefly; if the spring needs more tension, the process is repeated. Each time, care is taken to push the spring only a small amount past its natural threshold, gradually turning the metal rather than forcing it into place. By adding tension incrementally like this, the spring is far less likely to end up damaged. Even taking great care, though, expect an occasional broken spring. It’s not an exact science, so if you plan on adjusting your springs, make sure you’ve got a variety of spares.

Tension can be added to a spring, but not subtracted. If the metal is bent one way and then the other, a subtle crease is created which quickly deteriorates the strength of the metal when the machine is running, causing the spring to break. Even the slightest back-and-forth bending will limit a spring’s longevity.

A machine’s speed will also be affected by the weight of its armature bar and springs. A lighter spring and armature bar assembly carries less inertia, making it possible for it to move up and down quicker. This will not only make for a faster cycle, but also will affect the speed that the armature bar moves.

Although the machine speed and needle speed are related to each other, they are not the same thing. The machine speed determines how many times per minute the needles will strike the skin, making it an important factor in terms of how that machine will be used. The needle speed determines how fast the needle points are moving at the moment they strike the skin; since a faster moving needle group will strike with more force, this will determine the number of needles a machine is capable of driving into the skin.

A common misconception of the way a tattoo machine works is that the spring tension is responsible for the needle penetrating the skin. The opposite is actually true; the needles are driven downward by electromagnetic force and then returned upward by the spring tension. As a result of this, the strength of the needle’s strike against the skin can be tuned very precisely by regulating the electromagnetic force in the coils. The tension in the back spring determines how much electromagneticism can build up before the armature bar moves downward, so the precise amount of spring tension will play a key role in determining the strength of the needle strike. So, even though the spring does not directly push the needles through the skin, its tension determines how much electromagnetic force will be in each needle strike.

A tattoo can be worked more (thoroughly) and will heal better if there is little or no surplus force in the needles when they are finished penetrating the skin. Any extra force will be spent pushing the needles deeper than they need to be, causing trauma, blisters and longer healing times. An important goal for tattoo artists is to find the right amount of force for their working habits and refrain from hitting the skin harder than it needs to be hit.

To put all of this theory into practice, it is important to first decide what kind of job a machine will be used for, then to ask yourself how it falls short of doing that job. The main things to look for are the machine speed, the needle speed (which directly determines its force), and its overall smoothness.

If a machine is going to be tuned for shading with a large magnification, the desired result would include a moderately fast cycle speed and a fast, strong needle speed. To alter the speed of a machine, opening or closing the point gap is the first step; usually this will need to be accompanied by either adding tension to the back spring or replacing it with a new one. To add enough force to the machine to accommodate the larger setup, the armature bar may need to be replaced with a lighter one, which would increase the speed and force of the needle. With a lighter armature bar, the springs will need to be changed to proportionately lighter springs in order to maintain the desired cycle speed and avoid resonance problems. While changing the armature bar and springs it will be necessary to start from scratch with the tension on the back spring, or it may snap. Remember, the addition of spring tension is best approached incrementally.

After the point gap has been determined and the armature bar and springs are both installed and adjusted, there is a strong likelihood the machine will need some light fine-tuning to get it running smoothly. This is best approached by making minor adjustments to the position and angle of the contact screw. If these small changes don’t smooth out the machine, there may be too much or too little spring tension.
6.6) Machine Setup

There are a number of considerations related to setting up tattoo machines that can have an impact on their performance, even when the machines themselves are running properly. The setup process includes putting the needle bar through the tube and onto the armature nipple, adjusting and tightening the tube, and adding rubber bands and a few other things. Because all of these items are directly connected to the machine, they must be approached in a way that does not compromise machine performance or the overall handling of the machine while tattooing.

The first steps of the setup process include selecting the right needle group, inspecting its points with an eye loupe, and then choosing an appropriate tube in good condition. The next steps are to insert the needle bar through the tube and to attach the loop at its end to the armature nipple.

Many tattooists have had the frustrating experience of meeting resistance while attempting to guide the delicate needle points through the complexities of the tube tip. This can slow down the setup and potentially cause hooks or blunted ends on the needles. The solution to this problem is surprisingly simple: Instead of guiding the needle all the way through the tube, it is actually much easier to guide it in only about halfway and then let it drop, allowing gravity to do its work. This way, any collision of the needle points on the inside surfaces of the tube will be much gentler than if guided by hand. It seems that gravity has a talent for guiding the needles smoothly to wherever they need to go. I have found this works almost every time.

Grommets are small rubber rings used as a cushion between mechanical moving parts. In the case of tattooing, grommets are sometimes used to attach the needle bar to the armature nipple.

If a needle bar has a rubber grommet in its loop (Fig. 269a), it will not fit easily through the tube vise; in these cases, the needle points first need to be guided through the vise before dropping them through the tube. This can be done in one simple movement, but it does complicate the process slightly. This is part of the reason why some tattooists don’t use a grommet on their needle bars, but instead use one on their armature nipple (Fig. 269b). This allows the needle bar loop to pass through the tube vise, but still provides the convenience of rubber grommets.

In theory, grommets can speed up the setup process, providing a uniform fit on the armature nipple every time. They also offer a clean and visually tidy way of setting up the machine. In practice, though, they can get in the way. Not all needle bar loops are the same diameter; even needle bars bought from one supplier may originate from different manufacturers and have minor variations in their size and shape. In addition, some machines have smaller armature nipples than others. Unless all the equipment in your setup is standardized to work with grommets every time, you’ll often need to be removed or the needle bar loop loosened or tightened with pliers in order to provide a workable fit.
On Which Side Should the Gap in the Needle Bar Loop Be?
To make the setup job easier, tattooists have always made a point of soldering their needles on the bar in a way that the gap in the loop will be on the same side every time. This makes it simpler to know if the needle bar is attached to the armature nipple upside-down or right-side-up. Traditionally, artists have usually soldered them on so the gap is on the left side of the loop. However, many of the imported premade needles are being made with the gap on the right. This fact is important to take into account when setting up.

Fig. 270a
Fig. 270b
Fig. 270c
Fig. 270d

Many artists are able to standardize their equipment and make the grommets work for them. Others use lots of different equipment and are often trying new things, in a dynamic equipment situation like that, grommets often just get in the way. The traditional way of attaching the needle bar is still a good method; this involves using cloth medical tape or paper towel pieces (or possibly a combination of the two) to create a tight fit on the armature nipple (Fig. 270a).

In my own case, I begin with a piece of tape over the nipple, which gives the metal some traction (Fig. 270b). Without the tape, I find this setup step to be more difficult. Next, paper towel is added; usually this will consist of two or three layers of paper towel, but will occasionally require four or possibly just one (in some cases, the tape alone is enough). In order to keep the paper towel piece tidy so its fibers won’t interfere with the contact screw, I try to fold it in a way that the clean edge of the folded faces toward the contact screw (Fig. 270c). The needle bar is then pressed down over the paper towels (Fig. 270d); at this stage, layers of paper towel can be added or subtracted as needed.

How Tight Should the Needle Bar Be on the Armature Nipple?
There’s no doubt that the needle bar needs to fit on the nipple fairly snug; otherwise, the bar can pop off during the tattooing process. However, there’s such a thing as too much of a good thing—too tight, the needle points will want to kick upward in the tube with every stroke of the machine. This can require extra rubber band tension to ensure that the needles ride the back of the tube, which consumes extra power and can add roughness to the machine’s operation. A happy medium in tightness is usually what you want.

With the needle bar affixed to the armature nipple and the tube stem positioned within the vise, the next step is to align the tube so that the needle group is centered and projects the right distance from the end of the tip. This is best done with the rubber bands in place; unless the needles are pressed against the back of the tube during this part of the procedure, it is difficult to get an accurate reading of how much needle is hanging out of the tip. Snapping the rubber bands in place eliminates this problem.

To get the tube aligned the right way, first it needs to be adjusted approximately into position, then the tube vise tightened most of the way to hold it temporarily in place. Next, the machine is turned in such a way to provide a clear view of its back, and of the back of the tube (Fig. 271a). While holding it

Fig. 271a
Fig. 271b
Fig. 271c

...
How Much Needle Should Hang Out Of The Tube?
This is a question with many correct answers depending on your style of tattooing. Generally, though, slightly more that 1/8" (3mm) seems to work well for most jobs. This provides good visibility without seriously compromising ink flow.

It’s natural to be concerned that hanging out this much of the needle point could cause the points to penetrate too deep. This is really only an issue if the machine is running too hard; with the right amount of spring tension and power, the points should penetrate to the correct depth and then stop. By relying on the tube tip as a depth gauge, you will have far less control and visibility; lines done off the tube tip generally will have far more blowouts and dropouts than those done off the tips of the needles.

The rubber bands should be spaced slightly apart from each other on the needle bar. If they’re tangled together (Fig. 273a), this will slow down the machine and possibly cause it to run unevenly. It also seems helpful to have the needles angled slightly towards the contact screw (Fig. 273b), which prevents rubber band tension from inhibiting the downward stroke of the machine. With the machine running, sometimes the rubber bands will gradually re-arrange themselves. It is sometimes necessary to “tweak” them now and then to maintain that slight angle and to make sure they aren’t tangled.

With the needle and tube installed and adjusted and the rubber bands in place, the next step is to bag the machine. Machine bags are not necessary in order to make the machine run, like the rest of the steps described. However, skipping this step introduces a weak link into the cleanliness barrier in your work zone. I came to this conclusion once while attending a group dinner during a tattoo convention. While waiting for our food, we started talking about machines; before I knew it, machines were being passed around the table. Those same machines had been resting in bloody petroleum jelly only hours before, and they were being touched by hands that were then going straight for the Nacho plate.

At this same convention, a few tattooists were starting to bag their machines. Many of the established artists grumbled a bit about this; nobody wants to have to add a time-consuming new procedure into their workflow. But the idea made great sense and began catching on.

The key to incorporating this into an overall tattoo procedure is to keep the installation of the bag simple and quick, and to keep the bag out of the way so it doesn’t interfere with the operation of the machine. First, a bag is selected; some tattoo suppliers are selling custom sized machine bags that work very well (in a pinch, sandwich bags are okay, but are not as tidy to work with). One corner of the bag is cut off, making an opening just large enough to slip over the tube grip (Fig. 273c). The bag is then positioned over the machine so that it is completely covered.

Anytime you are experiencing a precision or ink flow problem while tattooing, inspecting the needles from the side like this is one of the first steps to take.
The tight fit of the bag should be enough to keep it in place. However, for keeping the bag from getting in the way, it can be helpful to tape it to the frame. I normally tape the bag all the way around the rear of the machine (Fig. 274a), folding the tape inward so it can adhere securely to the frame. This needs to be done in such a way that it does not block the clipping/landing bars or impede the movement of the armature bar. Some artists prefer to tape the bag around the stem of the tube (Fig. 274b), which prevents the tube from slipping through the hole during a long session. This can be helpful, but it is difficult to remove the tape later with gloves on, generally it gets slippery and very thoroughly stuck in place. Try both ways to decide your favorite; you may prefer to do both.

Keep in mind that using machine bags is not a replacement for cleaning and inspecting your equipment. However, bags make the cleaning process much quicker and easier, and help keep your machines in better condition.

Occasionally you will need to remove a machine bag to adjust the machine or add a rubber band. To simplify things, make a habit of keeping your bags in a drawer within easy reach. It's easier and cleaner to simply replace a bag than it is to slide it out of the way and then back into place after a machine adjustment.

When technical problems happen, it can sometimes be difficult to narrow down their causes. There are countless factors that can affect the way a machine performs, including everything from the way it is set up to the alignment of its major components. Because of the electric tattoo machine's complexity, it can be helpful to know where to begin looking when particular problems arise. On one hand, the problem could be an obvious machine issue, such as rough running, electrical problems or general inability to put in the ink. On the other hand, it could be a more subtle handling issue, such as poor ink flow, visibility problems or difficulties with precision. The next two pages provide some more troubleshooting checklists to help narrow down the possible causes for these kinds of problems, and hopefully can get you back up and running at times when you're having trouble.

Please keep in mind that these checklists will be helpful only if you are using fairly good equipment. If your power unit is a piece of antique junk that looks like a Soviet-era refrigerator, it may have such profound negative effects on how everything runs that none of the more minor issues with the machine's smoothness can be resolved. If you're persistently having trouble with your machines, there's only so much tuning and evaluating you can do; eventually you'll need to bite the bullet and invest in new equipment. In the meantime, though, here are some places to start:

---

Checklist 3: Machine Runs Rough

I'm set up and ready to work, but my machine sounds wrong and feels rough. What can I do?

1. It's always best to start by checking things that don't involve adjusting the machine itself. First, try pressing the armature bar down, always with your fingers. Does it move freely? If it seems to be encountering friction, it's possible that the needle bar is rubbing against the inside of the tube, or the needle group is too tight in the tube tip (this can be caused by irregular solder on the needle shafts).

2. Next, try tweaking the rubber bands, or pulling all but one of them away from the needle bar with the machine running. Does it run smoother? If so, the rubber bands may need to be adjusted, or one or more should be removed.

3. Also check the machine bag to make sure the tube holding it to the frame is not inhibiting the movement of the armature bar. If so, loosen or lower the tube.

4. If the whole setup appears to be correct, the next thing to check is to see if a blue spark is appearing between the contact point and the front spring (you may need to dim the lights in the room to see it). If so, the capacitor needs to be replaced, and it's possible the points will need to be sanded with emery paper to remove carbon buildup.

5. The next step is to try making adjustments to the rotation of the contact screw. Loosen the set screw and slowly turn the contact screw in and out, seeking the "sweet spot" where it runs smoothly.

6. If the rotation of the contact screw does not completely resolve the issue, then try slightly altering its angle by loosening its mounting screw and adjusting it. This will usually be most helpful if done while trying different rotations of the screw at the same time. Between the position and angle of the screw, you should be able to find a smoother combination.

7. If it still runs rough despite all this, remove the needle and tube. Try running it again; if it runs smoothly, then the setup was the problem. But if it still runs rough, there may be too much spring tension; by pressing down on the armature needle you should be able to see how much spring tension the coils need to overcome in order to pull the needles downward. If the tension is too great, the spring will need to be replaced.

---

Checklist 4: Machine Runs Intermittently

I'm set up and ready to work, but my machine keeps cutting in and out. What's wrong?

1. Intermittent machine power is almost always because of an electrical connection problem. The first thing to check is your clipcord, which is the fastest-wearing item of disposable equipment in your kit. Usually it will need to be changed about twice a year. If the new clipcord solves the problem, throw away the old one immediately to prevent future confusion. It's very important to keep several spare clipcords available, or you could be in trouble!

2. If a new clipcord doesn't solve the problem, the next thing to do is plug in another machine to see if it behaves the same way. If not, the issue is probably with the machine; plug it back in and check the contact point. Is there anything getting in the way, such as lint or part of a machine bag? Clear the way and then test the machine.

3. If the intermittent behavior persists, the problem may be with your clipcord jacks; sometimes the holes will fill with enough grease and dirt to make connectivity weak. Try cleaning them with alcohol on a pipe cleaner.
6.7) The Stretch

Throughout our apprenticeships, we hear the person we’re learning from admonish us for our stretching methods again and again. “Shut up,” we think to ourselves, “I’m trying to tattoo!” The whole stretching thing can seem like a real inconvenience, and we can’t wait for the boss to decide we know what we’re doing and leave us alone so we can crank up our machines and proceed with the business at hand.

For the most part, tattooists develop enough sense for their stretch that they can get by. The difference between trying to work with or without a good stretch is considerable (if not glaringly obvious), so tattooists who are paying attention will incorporate the stretch into their work habits. Eventually, they stop having to think about it and can get on with their work.

If this were really the case, there would be no point in my writing this chapter. However, the stretch is such an important and integral part of the tattooing process that, even after two decades of tattooing, I still need to remain constantly aware of my stretch.

The main reason we are taught to stretch the skin is to make it easier to puncture it with the needles. Loose skin requires less power to penetrate, and allows for way less precision. Tattooing on unstretched skin is likely to result in weak cord lines and blow-out, inaccurate lines. Some body parts require more of a stretch than others, and some areas are already naturally tight, making the stretching process easier. But in no cases is it ever unnecessary.

Stretching involves more than just color saturation. One of its most important aspects is the fact that the stretching-good can feel the vibration of the needle striking the skin, allowing the tattooist to monitor the quality of the strike of the needle: How fast, how hard or soft. It is one of the most critical keys to having control over the medium.

Fact: Stretching the skin is important for three main reasons: Increased precision, better pigment saturation, and crucial tactile feedback on how the needle is striking the skin.

If the stretch is good, the stretching hand will be able to feel the needle’s vibration as it strikes the skin. The tighter the stretch, the more clearly this vibration can be felt. Sometimes it may seem as though the skin is stretched tight but the stretching hand isn’t feeling that vibration; this is a sign to reposition and try a different stretch. Without being able to feel that vibration, it’s difficult to really be sure of what the needle is doing. It may be bouncing off, or it may be getting buried. Having a high level of sensitivity is important in knowing how much power, pressure, etc. to use while tattooing. The feedback that is felt by the tattooing hand is just too far removed from the actual penetration of the needle to rely on its feedback; the stretching hand is far more sensitive to this.

The skin’s tightness will affect how quickly the tattoo can be done, how much it will hurt, how it will heal and how sharp its lines and edges are, along with just about everything else. Regardless of any artist’s level of experience, the stretch is never something that can be taken for granted. In these next few pages we’ll go over some stretching fundamentals that can help make the rest of your tattooing go much smoother, regardless of your level of experience.
So what makes for a good stretch, anyway? Let's begin by first discussing how to recognize and eliminate bad stretches. For starters, it's good to avoid using brute force on our clients whenever possible. One example of a bad stretch is the old school limb-bracer method of reaching behind the limb and pulling back on it (Fig. 278a). This method will not only hurt and create bruises, but will also make for an inconsistent stretch that can distort a stencil or freehand drawing. It might sometimes be necessary to really lean into someone to get a good stretch on the back of the neck or certain parts of the abdomen and thighs, but for the most part these situations can be dealt with by getting the client into a better position. Position is key—pay enough attention to getting your client and yourself positioned the right way, you can work longer and get better results.

An ideal tattooing situation will usually involve a 3-point stretch. This stretch is done by pulling outward from the area that's being worked in 3 directions; this is accomplished by using the thumb and fingers of the stretching hand for two points, and the heel of the tattooing hand as a third point (Fig. 278b). This method will stretch the area the tightest and most uniformly with the least amount of effort and hand strain on the part of the tattooist. A 3-point stretch is done in two steps; first by stretching the area in two directions with the stretching hand, followed by planting the heel of the tattooing hand firmly on the skin, slightly closer to the tattooing area than desired. The heel of this hand is then rocked outward, stretching the skin in a third direction (Fig. 278c).

This will produce a tight spot about the size of a silver dollar, which means there will be a need to constantly adjust and re-stretch as work progresses around the tattoo. Instead of seeking ways to stretch a larger area, which will always compromise the quality of the stretch, it's better to get into a good habit of re-positioning and re-stretching quickly and efficiently from one spot to the next. This process becomes automatic with practice, making it easier to pay attention to the vibration that the stretching hand is feeling.

When a good 3-point stretch is neither possible nor adequate, the stretch can be improved by either positioning the client better or by having them actually help out some with the stretching. The need for a third hand is rare, but with some heavier folks it can be helpful to have them lend a hand. For instance, while doing a chest panel, they can pull at one end of their chest, adding tension to the whole area (Fig. 279a). This can be supplemented with a normal 3-point stretch, providing excellent skin tension without having to feel like you are working up a sweat while you’re tattooing.

The client's position can make a huge difference to the stretch. A good example of this is the lower back. It's easy to assume that it would be best to lay the client face-down on a massage table to work this area; however, this actually causes the skin of the lower back to compress and makes the job harder. No doubt a client can be worked on in this position, and in some rare cases it might be preferable. But if they straddle a chair and bend forward instead, the stencil on their lower back will almost double in size; demonstrating how radically positioning can affect the stretch.

A comfortable way to set the client up for this is to seat them backwards in a tall chair, so their lower back can be accessed by the artist without having to sit on the floor. For added comfort and stability, it's good to provide a stool or crate for their feet. The client's position will be more solid and secure if they have something to lean forward and rest their head on, such as a high massage table or a tall armrest (Fig. 279b). Done right, this position can actually be quite comfortable for relatively long periods.
Working the back of someone’s tricep near the armpit usually makes for a challenging stretch situation. This can be improved significantly by having them reach across their chest and hold onto their opposite shoulder (Fig. 280a). This position tightens the whole area.

A good stretch can be achieved even on the most stubborn parts of the body if the right position is used by both the client and artist. This can be made easier by first making sure there isn't petroleum jelly smeared all over the areas that need to be stretched. Although a dry tattoo may be slightly less comfortable for the client, artists can’t work with their clients sliding around in their hands. Usually it’s good to keep a really light coat of lubrication (almost dry) on the whole thing and then use more generous amounts in the immediate work area, and any light colors near it that need protection.

Sometimes the act of stretching will threaten the integrity of the stencil or freehand drawing. This can be prevented by placing a paper towel over the threatened area of the stencil, then stretching with that paper towel (Fig. 280b). This can protect the stencil while at the same time help to keep a better grip. The paper towel must be clean and dry, or else it may make the situation worse. It also needs to be folded neatly in half or in quarters because a scrunched towel tends to wipe off parts of the stencil more easily than a folded one. Changing this towel regularly will also help prevent it from inadvertently wiping off the stencil.

I could go into such maniacal detail on “The Perfect Stretch” that you’d all fall asleep; it’s not exactly a subject that most tattooists find particularly exciting. Four or five pages should be enough discussion. Bottom line: When artists are conscious of their stretch, they’ll do better tattoos. More importantly, a good stretch provides tattooists with the ability to feel the vibration of the needles with their stretching hand. By paying attention to that vibration, it’s possible to have greater control over how the color goes into the skin. Pretty boring, but super important.

6.8) Tightening and Softening

We’ve gone into some detail already about using the 5 round and other small round needle groups for more than just lining. I’d like to elaborate a little on this subject.

In the most basic kinds of tattooing, the piece is started with a small round group for the outline, then finished off with a larger group for the shading and coloring. Generally, once the liner has been put down, its job is done and it will not be picked up again. This is such an accepted standard that many quite sophisticated designs are still tattooed in this manner. In tattoos done this way, it’s normal to see a narrow fringe of skin between the outlines and the shaded areas (Fig. 281a), since leaving this gap is preferable to accidentally going outside the line with the shading.

By slowing down and spending more time, this gap can be mostly filled using a magnum, working with the machine at tricky angles and being careful not to chop up areas that have already been shaded. However, this can be a challenging, finicky job to do with a magnum, and many tattooists choose to skip it.

It takes very little extra time, though, to switch back to a smaller needle group and use it to fill in those gaps. Not only does a 3, 4 or 5 round fill the gaps easier, but makes it possible to really sharpen and smooth out the edges and lines. It’s simply a better tool for the job than a shading group. Fig. 281b shows a design that has been quickly outlined and graylined using a 5 round, then shaded with a 7 magnum; Fig. 281c shows the same piece after ten minutes of tightening with the 5 round. This same sense of sharp solidity would be almost impossible to achieve if not for the tightening stage.
The tightening stage is, in essence, the process of going through the tattoo with a lining needle group after the shading or coloring has been put in with a larger group. In this sample, you can see how the tightening stage made it possible to create a sharp rendering effect, which contains clean smooth arcs, precise details and carefully shaded shapes in a variety of sizes.

During this stage, not only are these unwanted gaps filled, but the opportunity is there to work on detail, adjust arcs and edges, and address anything that needs refinement. This stage can actually be one of the most fun parts of a tattoo, and doesn’t have to take much time at all. It can also be a defining stage in the tattoo where much of its sharpness, refinement and character are established.

In Fig. 283a, the sense of strength and defined detail comes largely from the work done in the tightening stage, with the detail and lines well established, the coloring stage goes quickly.

When I’m tattooing, I’ll alternate between machines many times in the course of a project to make the most of the strengths of each type of needle setup. For example, I often combine a full-color piece with a 5 round and a 7 mag, I’ll quite often follow a procedure something like this:

1) Using the 5 round, the outline and edges of the design are roughed in. Much of the piece is grayed or blooded.

2) Using the mag, the black shading and some color such as deep and medium purple and blue are put in place. Often, quite a bit of color is already in the skin before black is brushed over parts of it to establish the darkest values. When dealing with deep cool colors, staining is not an issue at all.

3) Switching back to the 5 round, lines are built up where strong line weight is desired, edges and arcs are sharpened and detail is developed using a combination of black, deep and medium cools.

4) Switching to the mag, all medium and light colors are roughed in except for pure yellow and white.

5) Back to the 5 round; medium and light colors are sharpened and developed. Additional detail is added.

6) Back to the magnum. This time, the yellow and large white highlights are established completely.

7) Switching to the 5 round, the yellow is tightened; the round needle group is used to bring the color sharply against edges and into details, saturating areas that are too small to effectively work with a big group. After rinsing really well, the white highlights are tightened and additional white is used for texture and detail, the big white highlights done earlier with the mag are skinned over to ensure saturation and evenness. Done.

This is the most basic machine alteration I normally use; it’s a good all-purpose method for a full-color tattoo. If it’s a larger piece, I may skim over the stencil quickly and then work small areas to completion, each time running through steps 2-7.

This can add up to a lot of switching. Using three or more machines can complicate the process even more; for instance, I enjoy using a 3 round to add focus to my white highlights after doing them with larger round groups. The frequent switching of machines can be made easier by using a power unit with multiple machine settings. This kind of power unit will have a switch with a position for each machine, making it much quicker to adjust the unit to exactly each machine’s operating power. This can save a lot of fiddling and may encourage more freedom when it comes to switching back and forth between machines.

I’ve found that most of my machines run at very similar amounts of power when they are working optimally, making any necessary adjustments very minimal. In any case, it’s likely the power will need to be periodically adjusted throughout the course of working with a single machine, depending on the thickness of the pigment and the toughness of the skin. No matter what kind of power unit is being used, some adjustment may be necessary.

A lot of the tightening process is based on those pencil-like hand movements we discussed earlier. Those movements are used to refine lines and edges, as described in Chapter 2.6: Lines and Edges. Using these same hand movements, virtually any desired effect can be accomplished.

If a clear, sharp edge is wanted on an area that was outlined first and then roughed in with a magnum, first the gap between the shading and the line (Fig. 283a) needs to be eliminated. Using a 5 round, this gap is filled mostly with short overlapping oval brushstrokes (Fig. 283b). The next step is to use bigger overlapping ovals to merge the sharp, dense edge with the area already shaded with a magnum (Fig. 283c). The final step is to skate along the outer edge in short, smooth strokes to make the edge as clean as possible and refine any areas that need it (Fig. 283d). This method is very similar to the line tightening techniques shown in Chapter 2.6.
In Fig. 284a, the basic lining, shading and some coloring have already been completed using a combination of a 4 round, 5 magnum and 7 magnum. The orange chrome in the main curving shape has been brushed in with a 5 magnum; this creates a soft painterly look but still needs some additional reinforcement. In Fig. 284b, the 4 round had been brought back into play and used to add detail and sharper edges to the reflective effects within the chrome, as well as to give the outer edges of the overall shape more contrast and sharpness. This is accomplished by using a combination of red and orange, and a variety of different hand movements including small overlapping ovals, narrow overlapping stiching movements and long gliding skating motions.

Point highlights are small isolated dots or dashes of white, usually applied with a small round needle group. Point highlights are useful for bringing an area of detail into greater focus.

This process is repeated with the highlights in order to maximize the tightly rendered look. In Fig. 284c, the seven magnum has been used to block in the yellow and pack any white highlights that are large enough for the magnum. Then, in Fig. 284d, the 4 round is used to pull these white highlights through the tighter spaces in the tattoo, giving the chrome detailing more shimmer and adding life to the piece in general. Point highlights are used to give the mechanical environment more texture as well.

None of these added steps is necessary to be able to call a tattoo finished. A certain amount of slop or weak edges are considered normal in tattooing, and are usually accepted or overlooked. However, this small amount of extra time can be beneficial to the tattoo because of the opportunity it provides for development and refinement. The resulting look is clean and smooth, and will be more readable across a room and after decades of aging than a tattoo that has been finished with little tightening prior. These results are definitely worth the investment of an extra minute.

Sometimes the opposite of tightening is desired, and soft edges are needed instead. This is especially common with smoke, rays and atmospheric effects.

Following the magnum with a smaller group can allow for a variety of effects. Notice how the coloring in this shape has been given a new level of detail and texture by using a 5 round and dipping between red and purple. These kinds of convincing textures are much harder to accomplish using the magnum alone.

Soft-edged flowing atmospheric effects are helpful not only in giving a design flow and depth, but also for tying in smoothly with neighboring tattoo work. In this example, notice how the flowing streams of atmosphere work with the curvature of the nearby skull tattoo, helping to unify the leg.

Normally when negative space smoke effects are incorporated into a design, the basic flow of the smoke is first bloodlined, then the background color and detail is pulled up to those bloodlines, leaving the interior area of the smoke blank (Fig. 285a). This creates a clear flow of negative space through the design. However, the effect is not always as soft and atmospheric as it could be. This can be improved by making a second pass around the edges of the negative.
space, using a magnum and a soft color, working in loose oval brushstrokes to keep the edge diffused. The finished appearance is softer and more airbrushed looking (Fig. 286a). The negative space effect can also be given more depth and dimension when the soft coloring is used to create layers within the smoke that help separate it from the background better.

Part of the key to successfully doing this is to make sure the negative space areas are open enough to begin with so that the diffuse edge won’t close them up too much, as part of this color will end up inside the edge of the unattacked areas. The looping brushstrokes used for this will end up half inside / half outside the boundary of the negative space. The brushstrokes should be loose and quick enough that they do not simply form a new distinct edge further inside the negative space, but instead conceal any evidence of a hard edge (Fig. 286b). This will be most effective if the color used is just a shade deeper than the natural skin tone. In many cases it will help to dip the machine into the rinse cup to dilute the color, which will make the effect smoother and more transparent.

The next step is to use a richer color, such as medium purple, to make a transition between the soft edge color and the background. More large looping brushstrokes are used, allowing the color to be built carefully and gradually to keep the effect subtle (Fig. 286c). By pulling subtle gradations over the nearby background detail, the negative space will be made to stand out more while still retaining its softness. This is a good opportunity to use color for reinforcing the flow of the negative space and making its fluid movement more clearly readable.

Sometimes the soft gradation effects are delicate or specific enough where it helps to use a 5 round for a quick once-over after most of the work has been done with the magnum. Using low power and loose, light movements, soft gradients can be delicately fine-tuned and adjusted this way.

Tightening and softening techniques are very similar to techniques and hand movements used when painting. These effects can be employed in a minimal way to add more sharpness and definition to a piece, or can be used liberally to give the entire tattoo a highly rendered polish. It’s every artist’s choice how much or how little they want to go beyond the standard amount of work that a tattoo normally requires to look finished. However, collectors can definitely see the difference when extra care is put into their tattoo.
6.9) Starting a Tattoo Magnum First

Modern tattooists have become very comfortable with the idea that all tattoos are started with an outline. This seems largely from the way tattoo designs have always been transferred onto the skin; early acetate stencils needed to be simple and could not contain any information more complex than a basic line. In addition, early 20th Century tattoo designs had to be made simple enough that tattooists with no art background would be able to follow and understand them.

Nowadays, the situation has dramatically changed, but the dogma of starting with an outline still imposes limitations on many artists. The standard outline is indeed a simple way to start a tattoo, and will help make for a tidy appearance in the piece. However, many tattooists are beginning to grow beyond being satisfied with this basic tattoo look and are craving more options in terms of how a design is applied to skin.

Since the early 1990’s, tattooists have experimented by starting tattoos with a magnum or other shading group instead of starting with an outline. This raised a few eyebrows at first, but as it became obvious that any skillfully applied magnum will age well, regardless of how it was applied, more and more artists have become open to this more painterly approach. Working this way has begun to make more sense, especially with so many tattooists coming into the profession already having painting experience.

**Done properly, tattooing with a magnum first can save time, trauma, and effort while possibly preventing healing problems.**

Starting a tattoo with a magnum first requires a different way of thinking than starting it with an outline. On the one hand, the basic single-pass outline is a convenient way to quickly commit a stencil to the skin; however, it allows the tattooist to begin the piece without necessarily having a clear idea of what the tattoo’s color scheme and pos/neg relationships will be. This saves effort in the initial stage of outlining, but afterward the artist must spend time figuring out the shading as they go. On the other hand, starting the piece with the magnum will take longer than a quick outline, but will save a lot of time in the long run. Tattooing this way is only possible, though, if the artist already has a clear sense of the design’s color scheme, pos/neg relationships and gradients, since these features are laid down from the very beginning of the tattooing process when working with the magnum first.

Because of this, it can be very helpful to have a color study of the design (or at bare minimum, a shaded value study) worked out prior to the appointment. With the basic gradients and pos/neg relationships established in the drawing, the stencil can be made using crosshatching, as shown in Chapter 6.1, or frehanded onto the skin with all the value relationships in place. Working with a shaded stencil or frehanded drawing is ideal for tattooing magnum first, and allows the artist to work intuitively rather than having to figure out the important aspects of the design on the fly.

**Having a visible place to keep your color or value study is essential while laying out the tattoo. If it’s not right in front of you, you won’t look at it very often. Taping it to your lamp or some other nearby object can help; some artists even keep a sheet music stand handy for this purpose. It can also be helpful to orient the drawing the same way as the tattoo; for example, if the person is lying on their side, the drawing should also be turned sideways.**
Depending on the type of design, the tattoo process can be started with a variety of different sized magnums. For realism pieces that don't incorporate much in the way of hard lines and instead rely on larger gradients to establish the design's form, a big magnum such as a 13 or larger may be the right tool for the job. Because of their wide surface area, these larger magnums are ideal for blocking in edges while at the same time creating gradations. By holding the magnum at an angle so that only one of its corners penetrates the skin, the needles will naturally create a soft gradation fading away from the edge (Fig. 290a). The magnum is moved in long, narrow overlapping ovals to define a clean edge. Because the color fades smoothly from the edge, more color can be layered into this gradient without leaving rough transitions.

![Fig. 290a](image)

Because each machine is tuned to overcome a certain amount of skin resistance as defined by the number of needles the machine is driving, it's important to be careful when working off the corner of a magnum. There is less skin resistance when only some of the needles are striking the skin, so it's possible to go too deep with the corner needles unless special care is taken. A curved magnum can help to prevent this problem.

Some tattooists specialize in work that consists almost entirely of large gradations and smooth fields, and in some cases the work is done to completion without ever using anything smaller than a large magnum. This makes for a softer overall look and is ideal for renditions of classic oil paintings. The lack of lines and small detail is especially appropriate for large body work of this nature. However, in my experience I have found that when the edge of a shape is defined this way, it will not heal as sharply and fully saturated as if a small round is used to tighten the edge after the magnum. Skipping this step can limit the tattoo's definition and durability.

![Fig. 290b](image)

![Fig. 290c](image)

![Fig. 290d](image)

Fig. 290b is an example of a design that was applied using a magnum first. By avoiding the use of a small round in the beginning, the inner areas of the bird could be given detail and texture without too many sharp lines that might compete with the bird's overall shape. The corner of the mag was used to brush the feathers and other detail in without worrying too much about precision; anticipating the chance to refine the whole thing in a later step. Instead, the overall form and character of the bird were built up gradually, using both color and value.

In Fig. 290c, the tattoo is finished. This was done by first following the initial magnum pass with a 5 round to tighten the edges, refine the edges and strengthen the outlines. After that, additional color was added with the magnum, then highlights and final details were put in using the 5 round. This kind of procedure allows the tattooist to be selective about which shapes and edges get the most emphasis. Outer edges and lines are made clean and strong while inner details are left soft and rendered with less contrast than the design's defining elements.

![Fig. 290e](image)

When blocking in a tattoo with a magnum, be sure not to limit yourself to using just black. Give yourself the freedom to dip between the various shadow colors along with medium and light tones to give the foundation of the piece the range it needs without going too dark. Remember that you can always go darker later in the process.

![Fig. 290f](image)

Many tattoos will incorporate strong lines along with some shapes that have no outline. These kinds of tattoos can be started with a magnum, including their lines. However, care must be taken not to go too fat or sloppy with the linework while starting magnum first. This approach is typical of the kind of work I do, and I find that for most pieces it makes sense to begin with a 5 magnum. The 5 mag is a surprisingly versatile tool that allows for both lines and gradients to be blocked in, all in the same step. Because of its low skin resistance, the 5 mag can be worked with very quickly and can create a very satisfying foundation for a tattoo.

![Fig. 290g](image)

The 5 Mag: Isn’t That Mostly Used Just For Small Flash Tattoos?

Many tattooists exclude the 5 magnum from their toolbox because of the assumption that they are good only for coloring small tattoos. On the contrary, their small size and low skin resistance make them ideal for laying out large body work as well as coloring small items.

![Fig. 290h](image)

![Fig. 290i](image)

Fig. 291a shows a design that was drawn onto the skin in marker, and has in place all the basic gradients and pos/neg relationships of the piece. In Fig. 291b, a small area of the design has been committed to the skin using a 5 mag; note how both the bold lines and the simpler shadows are already in place. Using the 5 magnum allows this to be done quickly and simply enough that the surrounding freehand drawing doesn't melt. Generally, when I am working this way I will work small to medium areas up to this level of rendering before moving to the next section.

![Fig. 291c](image)

![Fig. 291d](image)

![Fig. 291e](image)

![Fig. 291f](image)

After completing the whole forearm to this level with the 5 mag, a 5 round was used to sharpen the lines, smooth out the gradients and add any desired detail (Fig. 291c). This was done using the types of hand movements and techniques discussed in Chapter 6.8. At this stage, the piece is developed enough that the remaining coloring and highlighting make for a fast, easy step.
Starting a piece with a 5 magnum can be an ideal happy medium for large projects like this one, allowing for both boldness and precision in the initial layout phase. You can see in the image on the left that the basic lines and shadows of the tattoo have already been clearly defined, even though the 5 mag was the only needle group used at that stage. In the second image, a 5 round has been used to sharpen and darken the lines, clean up the edges, and add detail as needed. With the foundation of the tattoo established this thoroughly, its final coloring and highlighting stages can go very quickly and easily.

Roughing in bold lines with a magnum requires a certain kind of care to get precise results. I usually avoid lining with a magnum if a shape is demanding in its precision, and I'll switch to a round group at any point that the magnum is too crude of a tool for the job. Mostly, though, I find that the type of designs I draw can be laid out primarily with the magnum. To create a bold and clean line, the magnum is planted into the skin and worked along the path of the line in short overlapping strokes, using the width of the mag to control the line's thickness and the safety of the work (Fig. 293a). For narrower lines, the magnum is angled in such a way to reduce its effective width (Fig. 293b). A mag can also be used for relatively fine lines by working sideways with it, provided the extra care is taken not to cut a trench in the skin (Fig. 293c). This procedure is not necessarily recommended for larger magnums.

If a much finer line is desired, the magnum is used by essentially turning sideways along the line (Fig. 293c), then tilted so that only its corner needles actually touch the skin (Fig. 293d). Then, by pulling (instead of pushing) in the direction of the line, a light, minimal line will be left behind with very few unwanted blots or blowouts. The line around the bird's back in Fig. 290b was done this way, ensuring that even after the tightening process, the line wouldn't be too thick.

A machine tuned for running a 5 magnum should be faster than an ordinary shader but slower than a liner. I try giving it a medium point gap and slightly more than the minimum amount of tension on the backspring.

The magnum first tattooing technique requires a different thinking process than starting with a line, and can involve a few additional stages in the execution. For starters, the stencil or freehand drawing of the design should have the basic gradations and pos/neg relationships clearly spelled out before tattooing begins. Fig. 293a shows a combination of freehand marker drawing and a hectograph stencil, clearly showing where the dark and light areas of the design belong. Because marker tends to wipe off quicker than hectograph ink, the freehand areas are tattooed first before starting on the stenciled area (Fig. 293b). This incudes both black and color shading, some bold black lines, and other lines that fade from black to color at the tips of the ribs to enhance the backlight effect, as described in Chapter 2.8: Lighting and Luminosity.
With this area roughed in, the stenciled part is next tattooed in place, working upward from the bottom (Fig. 294a, 294b). Once the stencil and freehand marker drawing have been completely committed to the skin, a quick cleanup pass over the entire piece with the 5 mag can help to strengthen and smooth out the overall tattoo.

In theory, at this stage in the tattoo’s development the bright colors and highlights could have been added with a larger magnum, and the piece could have been considered finished. However, a tattoo done like that will not heal as strong and saturated (or age as well) one that has been carefully developed and tightened with a smaller round group. In addition, the person wearing the tattoo will most certainly notice the difference between a piece that has been quickly laid down and one that has been carefully developed.

After the piece has all been roughly in place with the magnum, the 5 round is then used to sharpen lines, define edges and add detail as needed (Fig. 294c). This stage can be quick or time-consuming depending on the tattoo. In the case of this piece, the bold lines around the rib shapes took a while to tighten with the 5 round, but the detail in the fleshy central part of the design was a quick and simple part of the job. By comparing this photo to Fig. 294b, you can see how much the piece was improved during the tightening stage.

Next, a larger magnum is used to block in the light oranges and yellows (Fig. 294d), then the 3 magnum is used for laying in the larger white highlights (Fig. 294e). Although the piece looks finished at this point, it is the final pass with the 5 round and some additional sharper white highlights that really bring the tattoo into focus (Fig. 294f). With the 5 round in hand, a few additional red and orange details are also added to give the fleshy area a bit more contrast and definition where needed.

It’s true that this same tattoo could be done in the traditional way, by first outlining the whole piece and then following the normally expected steps of shading, coloring and highlighting. Nonetheless, it is a fact that the kinds of steps taken to finish a tattoo will affect its look when completed. I have found without any doubt that tattoos handled in a more painterly fashion such as this will look more like a painting when they are finished.

Working magnum first is a major departure from the way we are normally taught to tattoo, and it may seem intimidating at first. The entire mindset for executing a tattoo in this manner is worlds apart from what we’re traditionally accustomed to. However, I don’t believe that it necessarily requires more skill than tattooing with an outline first; it just calls for the tattooist to think outside the traditional box. The results are well worth it.

If you have never done a tattoo magnum first, try designing a few small projects for yourself that are ideal for the job, something simple like a skull or a flower. Make a stencil for the piece using cross-hatching, and do the tattoo on someone you know who understands that you are trying something new. By keeping it simple and working on someone familiar, it should take away much of the intimidation involved in trying a radically different technique.

Is this tattoo good enough for my own skin? There is always a question as to when a tattoo is developed enough to be called finished. Especially toward the end of a long day in the chair, it can be easy to skip a few less important steps just to be able to call the piece finished and go have a beer. For my own purposes, I have an easy universal test: Is the piece rendered enough to be in my own tattoo collection? If I were the person on the receiving end of the needle, watching the last steps of the tattooing process, would I feel satisfied with the level of the rendering, or would I wish it were more developed? Asking yourself these questions is a good way to find that elusive point where the tattoo can be called finished.
6.10) Comfort and Ergonomics

The physical comfort of the artist and client are not generally discussed in a standard tattoo apprenticeship. In your basic workshop situation, most of the tattoos are done and out the door before the client's comfort really becomes an issue. In the case of quick tattoo sessions, the pain of the needle is more than enough to take the clients minds off their slightly uncomfortable position.

With larger custom work, though, body position can become a real important factor. If a client is uncomfortable enough, it can actually aggravate the pain of the needle, making them twitchy and restless. It's not uncommon at all for the discomfort of the chair to exceed that of the tattoo; for that reason, any artist who wishes to do longer sessions needs to be conscious of their client's ergonomic situation.

Ergonomics is the science of making tools, equipment and furniture that naturally work well with the human body. The goal is to create workspaces and gear that allow for longer and more comfortable work sessions.

In an ideal situation, the client is adjusted and propped up in a way that is comfortable and will remain so for as long as needed. In a position where the artist can work in an optimal posture. This position should accommodate both the artist and the client; any good ergonomic setup should address both individuals' needs equally. This should mean:

1) The body part being tattooed should be at a good height and angle for the artist to reach
2) The artist should be in a position where they can handle that body part while in a natural posture, preferably with their spine straight and shoulders back
3) The client should be stable, secure and comfortable without needing to work hard at holding their position
4) The lighting should be ideal, with a light immediately above the area being tattooed
5) The artist's equipment and colors should be within easy reach
6) The overall environment, including things like music and temperature, should be to both parties liking

In creating an ideal ergonomic situation, there are many different types of chairs and tables to consider for the purpose of client positioning. Some tattooists use basic office chairs that raise, lower and roll to provide simple flexibility. Others prefer barber chairs that can be quite comfy for some positions but totally inappropriate for others; their heavy weight can be a frustrating limitation. Massage tables are indispensable in most tattoo studios for bodywork when it's more comfortable to lay flat; they can be adjusted to different heights, and sometimes come with a face cradle for when the client needs to lie face-down. In addition to these standard items, there is now a wide variety of seating and comfort items being manufactured specifically for the tattoo industry including a whole array of different armrests, leg rests, footrests, stools and complex multi-adjustable table/chair/body accommodation devices.

I've worked very little with barber chairs. I'll admit that they're great for comfort, but their weight and inflexibility have always kept me from actually purchasing one. Mostly, I've used a combination of office chairs, armrests and massage tables for most projects. They provide for just about every body position and can be set up in countless different ways. However, I wouldn't want to discourage anyone from using something more deluxe than this arrangement; many artists I have competed with are very pleased with their adjustable pneumatic multi-position chairs. It's completely a matter of preference, as long as both artist and client are comfortable.
By the end of most long sessions, clients will often have as much difficulty with their position as they will with the tattoo itself.

I keep several armrests available for different tasks. Some arm positions work best with two armrests, one for the forearm and one for the upper arm, especially in positions where the client is lying down (Fig. 298a). The best armrests have heavy bases and are adjustable not only in height, but in angle as well (Fig. 298b). My favorite has a 12"x6"x1" chunk of plate steel as a base. It's hard to move around but it stays put and barely wobbles at all.

Stay Aware of Your Client’s Circulation!
It’s an accepted fact that the person getting tattooed will endure some discomfort, but some artists are completely insensitive to the other factors that may be affecting their client. I know someone who had his inner bicep tattooed in a hotel room by an unsympathetic artist, and later had to go through physical therapy sessions to get the full feeling back in his hand. Be aware! If clients keep flexing their fingers over and over again, it’s time to give them a short blood circulation break. If this is happening too frequently, try finding a better position.

Once the client is ideally positioned, the lighting needs to be made just right. The best kind of lighting will provide the most even illumination with minimal shadow, while not blinding the client. In many cases, this can be accomplished with a good swing-arm lamp (Fig. 299a). These usually clamp onto the edge of the table or slide into a pre-drilled hole. Some come with heavy bases that can be helpful at conventions where the tables usually aren’t well suited for clamps. One useful alternative to the swing-arm lamp is the flexible-neck lamp (Fig. 299b), providing more flexibility but usually less reach than a swing-arm lamp.

It's important to keep the client's long-term comfort in mind when using office chairs. For short sessions, almost any decent chair will do the job, but for big projects, clients need to be able to sit back and relax. A high-backed office chair that provides neck and head support will serve this purpose. In addition, most come with built-in armrests that can come in handy to give clients greater stability. In other cases, where a high-backed chair is not available, an armrest can be adapted to serve the same purpose.
I have come to prefer a flexible-neck floor lamp (Fig. 300a). This arrangement is ideal for most work situations because it has a number of advantages. For instance, its base can be slid around on the floor with your foot, making it possible to adjust the position of the lamp without touching it. The head of the lamp can be fitted with barrier film, so its angle can be easily fine-tuned with gloves on. The flexible neck provides amazing positioning versatility while its floor mounting makes it a simple matter to get the light exactly where it is needed.

Standard incandescent bulbs affect the appearance of color, making everything more yellow, while compact fluorescent bulbs that screw into standard sockets are often too white, making things look flat. At some stores and through online retailers of health products such as Real Goods, full-spectrum bulbs are available that create a satisfying natural light. The flexible floor lamp I am using utilizes a color-balanced full-spectrum fluorescent bulb that allows me to evaluate my colors very accurately.

The lamp should be positioned right above the work area, so that the tattooist’s hands don’t cast shadows (Fig. 300b). The lamp should be angled in such a way that directs the light away from the client’s eyes so they won’t be blinded by it. This small detail can actually make a big difference in overall comfort; even with everything else perfect, it’s hard for clients to get relaxed when they feel like they’re being interrogated by blinding light.

All these details about light and position may seem very basic. However, they are important enough to deserve careful consideration. With the lighting and position optimal, artists can really concentrate on the tattooing process, sometimes forgetting that they’re even working on a person. That’s a sure sign that they’ve really “gotten into” their work. A good ergonomic setup can make this possible.

Don’t Overestimate Your Ability To See!

Aside from the basics of quality and position, there are many other small things that will affect a client’s comfort. One of the most important is the tattooist’s handling of them. If the manner of holding their body parts is jerky and abrupt, it may cause clients to feel as if their tattooist is in a hurry or impatient with having to work on them. This can make it almost impossible for them to relax. Their body parts, especially after being poked enough to get really raw, need to be handled like fine China. Not only will this make clients feel more physically comfortable, it will give them the sense that more care is going into their tattoo.

In some cases, a client’s behavior may make it difficult to feel sympathetic toward them. However, there are selfish reasons for tattooists to take this kind of gentler approach, as well. It’s simply much easier to work on someone who is relaxed; the less that pain is a factor, the better for everyone involved.

Especially the most potentially painful aspect of handling the clients is the wiping process. It’s perfectly normal to hear them say, “Toward the end, the wiping was worse than the tattooing.” It doesn’t feel good at all to have a dry, scratchy paper towel dragged across raw flesh. Fortunately, there are some simple steps that can be taken to prevent this extra discomfort.

For starters, it helps to use petroleum jelly or A&D ointment for lubrication. Most tattooists are taught this in their apprenticeships, yet some artists are actually taught to work without lubrication. Although lubrication can make the body part slippery and hard to work with, this can be avoided by only applying it where needed. Using lubrication during tattooing has so many benefits that its small inconveniences are insignificant by comparison.

It’s helpful to maintain a thin layer of lubrication in the area that’s being immediately worked. It should be a thin enough layer that it doesn’t accumulate on the tube tip while working; there should be just enough to form a barrier between the skin and the air. This will help keep the pools of ink that flow out of the end of the tube from sinking deeply into the pores (and not wiping off easily). The only pigment that makes it through this thin barrier is that which is delivered directly by the needle.

The act of wiping the client’s arm at frequent intervals helps prevent the ink from getting stuck on the skin, which will help the client absorb the ink more efficiently, and it will also help save the tattooist time. The use of a plastic sheet to protect the client’s arm from the ink being wiped off is another helpful measure. Additionally, it helps to keep the whole setup clean and prevents it from getting crusty and scabbing over prematurely.

Fresh tattoos pass less when they’re coated with lubrication. It’s not unusual for clients to actually request it when their tattoo is still raw and irritated, though most tattoo clients are too nervous and intimidated to speak up on behalf of their own comfort. Although there can’t always be lubrication on the entire tattoo, since this can compromise your stretch, it can certainly be used on parts of it not presently being worked. This will make these areas more comfortable, prevent them from scabbing up, and make it easier to keep them clean.
I have come to prefer a flexible-neck floor lamp (Fig. 300a). This arrangement is ideal for most work situations because it has a number of advantages. For instance, it can be slid around on the floor with your feet, making it possible to adjust the position of the lamp without touching it. The head of the lamp can be fitted with barrier film, so its angle can be easily fine-tuned with gloves on. The flexible neck provides amazing positioning versatility while its floor mounting makes it a simple matter to get the light exactly where it is needed.

Standard incandescent bulbs affect the appearance of color, making everything more yellow, while compact fluorescent bulbs that screw into standard sockets are often too white, making things look flat. At some stores and through online retailers of health products such as Real Goods, full-spectrum bulbs are available that create a satisfying natural light. The flexible floor lamp I am using utilizes a color-balanced full-spectrum fluorescent bulb that allows me to evaluate my colors very accurately.

The lamp should be positioned right above the work area, so that the tattooist’s hands don’t cast shadows (Fig. 300b). The lamp should be angled in such a way that directs the light away from clients’ eyes so they won’t be blinded by it. This small detail can actually make a big difference in overall comfort; even when everything else is perfect, it’s hard for clients to get relaxed when they feel like they’re being interrogated by blinding light.

All these details about light and position may seem very basic. However, they are important enough to deserve careful consideration. With the lighting and position optimal, artists can really concentrate on the tattooing process, sometimes forgetting that they’re even working on a person. That’s a sure sign that they’re really “gotten into” their work. A good ergonomic setup can make this possible.

---

Don’t Overestimate Your Ability To See!

Once upon a time, I had a 10-month delay in opening my shop and ended up tattooing in a temporary studio setup. Because it was temporary, I never made a point of optimizing the lighting. The tattooing I did during this period seemed fine, but much of this work, when seen later in better lighting, turned out to need more development and saturation. Bad lighting will definitely affect the outcome of a tattoo, no matter how good the artist’s vision is.

Aside from their basic position, there are many other small things that will affect a client’s comfort. One of the most important is in the tattooist’s handling of them. If the manner of holding their body parts is jerky and abrupt, it may cause clients to feel as if their tattooist is in a hurry or impatient with having to work on them. This can make it almost impossible for them to relax. Their body parts, especially after being poked enough to get really raw, need to be handled like fine China. Not only will this make clients feel more physically comfortable, it will also give them a sense that more care is going into their tattoo.

In some cases, a client’s behavior may make it difficult to feel sympathetic toward them. However, there are selfish reasons for tattooists to take this kind of gentle approach, as well. It’s simply much easier to work on someone who is relaxed; the less that pain is a factor, the better for everyone involved.

Probably the most potentially painful aspect of handling the clients is the wiping process. It’s perfectly normal to hear them say, “Toward the end, the wiping was worse than the tattooing,” it doesn’t feel good at all to have a dry, scratchy paper towel dragged across raw flesh. Fortunately, there are some simple steps that can be taken to prevent this extra discomfort.

For starters, it helps to use petroleum jelly or A&D ointment for lubrication. Most tattooists are taught this in their apprenticeships, yet some artists are actually taught to work without lubrication. Although lubrication can make the body part slippery and hard to work with, this can be avoided by only applying it where needed. Using lubrication during tattooing has so many benefits that its small inconveniences are insignificant by comparison.

It’s helpful to maintain a thin layer of lubrication in the area that’s being immediately worked. It should be a thin enough layer that it doesn’t accumulate on the tube tip while working; there should be just enough to form a barrier between the skin and the air. This will keep the pools of ink that flow out of the end of the tube from sinking deeply into the pores (and not wiping off easily). The only pigment that makes it through this thin barrier is that which is delivered directly by the needle.

With a thin layer of lubrication in place, the spilled and smeared ink that’s a normal part of the tattooing process will wipe up in one gentle pass of the paper towel instead of repeated painful scrubbing. It also helps to keep the whole tattoo clean and prevents it from getting crusty and scabbing over prematurely.

Fresh tattoos sting less when they’re coated with lubrication. It’s not unusual for clients to actually request it when their tattoo is feeling dry and irritated, though most tattoo clients are too nervous and intimidated to speak up on behalf of their own comfort. Although there can’t always be lubrication on the entire tattoo, since this can compromise your stretch, it can certainly be used on parts if not presently being worked. This will make these areas more comfortable, prevent them from scabbing up, and make it easier to keep them clean.
Wiping is best handled with a clean, folded wet paper towel. It should be folded instead of scrunched, since a scrunched towel has many erasures and corners that can dig into the skin. It’s generally best to fold the towel in quarters, making a square about 5” (12cm) on a side. Then an autoclavable squeeze bottle is used to soak a corner of it, about 1/4 to 1/3 of its surface area (Fig. 302a). By wetting a corner instead of the center, there will be more control over how the wet part glides across the skin than if it were surrounded by dry towel. Prepared this way, the paper towel is dragged lightly across the skin in a smooth and gentle movement. A single wipe should be enough to pick up most stray pigment.

Once the first pass is made, that part of the towel is useless. If it’s used to wipe with again, it will just re-introduce the mess that was recently cleaned. Instead, the towel should be tossed (if it’s mixed out) or re-folded so that a new clean area is exposed; this area is then wet with the squeeze bottle and used to wipe. A single towel is usually good for 3 or 4 of these cycles.

When the tattoo has become covered in enough dried ink and blood that a type of harsh wiping seems necessary, first try squeezing some water onto the area. Then, brush up the pigment with gentle circular wiping motions with your gloved hand. As a result, the residue should come up easily with far less paper towel friction. Pre-wiping with your gloved hand in this manner prior to using any paper towels can prevent a lot of discomfort.

I normally don’t use soap when I wipe. The soap makes the color come up slightly easier, but it can stain and leave a film that dries up and leaves a lingering burning sensation. I’ve found that a clean, wet paper towel is more adequate nearly all of the time. The extra string that the soap provides can end up being one of those many little things that stack up to make a session uncomfortable.

When I first started using those autoclavable squeeze bottles, I found that squeezing them made my hand sore, so I became reluctant to use them. I found that other artists have had this same experience. This problem can be quickly and easily rectified by snipping off the end of the nozzle with a pair of scissors (Fig. 303a). The more that gets snipped off, the easier the water will exit. If too much is cut off, though, water starts squirting out at times it isn’t wanted, such as when the bottle is put down on the table. Removing approximately 1/4” (6mm) seems to be about right.

These bottles recently have become popular, largely as a result of organizations like the A.P.T. declaring that they are cleaner to use. That’s enough of a reason to use them. In addition, using an old-style spray bottle on some clients is not always pleasant for them; often the spray feels cold and sudden, making them cringe and retreat. By using the squeeze bottles instead, they are spared this unpleasantness.

It’s common knowledge that some parts of the body hurt more than others. In a single small piece, a tattooist may pass over some areas that are excreting while others are barely felt at all. The deltoid is a good example of this: The outermost part is well-worn, thick, leathery and padded, while the front is frighteningly close to the sensitive thin skin of the armpit and the top passes over a little bulge of bone that can really electrically things. To make matters worse, in the course of doing the piece, the bad areas are gone over several times.

Normally, in an effort to make things easier for their clients, artists will start out tattooing in the less painful areas to let the client get adjusted before moving onto the more painful spots. This can be taken a step further; after the basic stencil has been committed to the skin, the tattoo can then be developed in small areas, taking each area all the way to completion. Once a client gets used to getting that small area worked on, it becomes easier for them to sit. Sometimes these small areas can even become somewhat numb.

I have definitely noticed that my clients are able to sit much longer with sessions where small areas are worked to completion, instead of the entire tattoo being developed as a single unit. This takes a bit more time and strategy, but for artists aiming to get the maximum amount of work done per session, it’s a critical part of the procedure.

There certainly are advantages to working the whole tattoo at once. The artist can think in a more singular mode, considering the whole design at once instead of concentrating on small areas that will later have to come together into a larger scheme. Working the overall piece also requires less rinsing and changing colors, since the design is worked all the way through with each color before rinsing and switching to the next. Each part of the process needs doing only once, instead multiple times in each different area. The entire procedure ends up being simpler and more straightforward this way.

On a large piece, though, it can hurt quite a bit to have the needle skipping around like that, leaving each area just long enough for it to start healing before going back into it. This can limit a client’s ability to sit and hurt the productivity of a session.

A good way to decide how many small work areas to divide a large piece into is to first estimate how much time the tattoo will take. Then, figure out how many breaks will be taken during that time. If three breaks seem likely, then the project should be divided into four basic parts and each part should be worked most of the way to completion. This way, there is far less need to go back into any raw area after a break, which is one of the things that tattoo clients dread the most.
When clients sit for long sessions, there will be periods when their pain tolerance is at its peak and they seem to be sitting the best. These are the best times to finish the more tender areas. If the tattooist keeps avoiding these spots because the client ditches every time you approach them, then before long it’s the end of the session, the client is worn out with no pain tolerance left, and those tricky spots are still unfinished. It’s definitely best to get them done earlier in the session.

For some pieces, working an area to completion and then moving on to the next area can pose an unacceptable patience test for the yellow and whites. This can be avoided by finishing everything but the yellow and whites in each section, then going over the whole piece one last time and doing the highlights. This makes standing less of a risk. However, that final blast of pigment can be quite painful, especially in places that haven’t felt the needle in several hours. This can cause an artist to have to rush this important step. Seems like a no-win situation.

But a good compromise does exist: each area can be worked to completion except for the yellow and whites. After that, the highlights are done throughout that area, but not in the last inch or so closest to the next area that will be worked. This way, there won’t be any vulnerable light-colored areas immediately next to places where the dark shading hasn’t yet been started. Then, when the darker colors in the new section are done and the yellow and whites are being put in, these pigments can also be added to the unfinished part of the previous area.

Recently, a number of topical products have emerged into the tattoo marketplace for the purpose of numbing tattoos. A variety of different products are available, each with its own uses and its own strengths and weaknesses.

Some of these substances, such as Prepuce and Ela-Max, are meant for pre-numbing the unbroken skin. This is done by spraying a generous thick coating of the cream on the area and then covering it with plastic wrap for 60-90 minutes. The skin will then be almost totally numb for about half an hour, and will regain sensation gradually after that, returning to normal after about an hour. This can be helpful for tattooing a small area, or for skinning quickly over a larger area for the purpose of poking enough holes that other types of numbing agents can be used. However, if a complex stencil needs to be laid over an area that’s just been pre-numbed, most of the effects of the substance may wear off during the entire process. People sometimes remark that the pain comes back with a vengeance.

Don’t pre-numb a larger area than you can tattoo in the short time window that the numbing cream gives you. It should only be used once on each area during a session.

Other substances are useful on areas where the skin has already been broken. One popular product is called Bactine, which can be found at almost any drugstore. It has a watery consistency, and can be used the same way that water is used to clean off the tattoo. I have used generous quantities of it on people with no noticeable side effects.

To use Bactine effectively, enough holes need to be poked in the skin first. I have found that a tattoo starts with magnums will have more than enough holes to be able to use Bactine effectively, while basic outlines will not. In many cases, the Bactine will have the greatest effect near the end of the session when it is needed the most. I have had such good luck with using it that most of my clients have stopped using oral painkillers almost entirely.

For best results, it’s good to keep a bottle handy at your workstation. Bactine comes in two different kinds of bottles. One is a squirt bottle, which can be transferred into an autoclavable Nalgene bottle and kept at the station for use while wearing gloves. The other is a spritz bottle, which is also good to keep around for use during breaks while not wearing gloves. To really numb an area, it’s helpful to take a long enough break that it can be applied to the area that needs it, and allowed to soak in and evaporate for a few minutes before being applied again. After two to three applications, the area can be profoundly numb. This can be done on one part of a tattoo while a different section is being worked with a smooth strategy, there will often be a part of the tattoo soaking in Bactine while other areas are being tattooed. In this manner, much of the tattoo can be done with the pain greatly reduced.

Since the Bactine solution will slowly lose strength if exposed to open air for extended periods, I recommend only transferring a moderate amount into the squirt bottle at a time.

With normal use, Bactine should not cause any side effects. However, when applied more than 5-6 times to sensitive areas, it can cause some mild redness. This will affect the finished photo of the piece but should not affect the healing. In addition, I do not recommend putting plastic wrap over Bactine on the skin; this seems to cause healing problems.

Another popular numbing product on the market is called Sustane. This is a tetracaine-hydrocaine-epinephrine cocktail suspended in glycerine. Tact area is first worked sufficiently and this stuff is then applied, allowed to sit for a few minutes and then wiped off, the area will be almost totally numb. Spots like the armpit or the duff of the elbow get so numb that people start laughing, unable to believe it. It basically feels like someone is holding thick leather over the skin and tattooing the leather. The relief lasts an hour or so and can be reapplied. If the skuff is first broken using a numbing cream and then a product like Sustane is used, in theory a totally painless tattoo could be done.

There’s a catch, of course. The epinephrine causes the capillaries to freeze and constrict, severely reducing blood flow. This can seem like a plus at the time, but it can compromise and adversely affect the healing process. In addition, the glycerine base fills up the pores and softens the skin in a weird way, making it feel cold and jellylike. It’s also possible that the skin can be made too numb, to the extent that its normal healing mechanisms don’t start working properly when they’re needed the most. For these reasons, I am more comfortable with the milder formulation of Bactine, which is less effective for the pain but also less likely to cause healing problems.

When I first started having access to these substances, I was very enthusiastic and used them for every tattoo. Now that the novelty has worn off, I’ve found myself being more conservative about their use. They can be handy for those tough spots or long sessions, and I like to keep a bottle available just in case. However, it’s easy to get into a cycle where the client is constantly requesting it. A good way to deal with this is to set goals; for instance, tell the client that you want to finish a particular area before the next application. Also point out that the effects diminish with each use. By limiting the applications to a few key times, both you and your client will get better numbing results from these products.

Artists can achieve a lot in the comfort department by positioning themselves and their clients the right way, handling them smoothly and wiping gently, and by working the areas of the tattoo strategically. These measures can add up to a very comfortable tattoo experience for both parties involved. That is, unless the atmosphere of the workspace is distracting and unpleasant.
While tattooing, it’s normal for artists to get into what they’re doing so much that they stop noticing the environment around them. For the person working, the tattooing process is the most interesting thing going on in the room. However, for the client, things can get boring pretty fast. Some enjoy watching, but inevitably get some necks. Others can’t watch at all, and crave some type of distraction to help transport them away from the pain.

It’s up to each artist to decide how involved they want to get with this aspect of their clients’ comfort, but remember that the scene they’re stuck looking at will be a large part of their experience while getting tattooed. If the studio walls are decorated with eerie faces or other unpleasant imagery, that will have a lot to do with how the client will feel during the tattoo session. Unless an artist is specializing in that kind of imagery, this can take away from the experience. Completely undecorated walls can be almost as tedious.

Although it’s important to keep the tattooing workspace clean and orderly, it can be nice to have a couple of walls near the work station with some kind of eye candy to serve as entertaining distractions for the client. This can include some of the tattooist’s paintings or drawings, framed things they’ve collected from friends, colorful postcards, hologram stickers, art prints, assemblages of interesting stuff, mirrors… you name it, as long as the overall environment casts a pleasant spell for the client.

Some tattooists like to work with a TV or DVD player running. If the material is something of interest to the client, this can be enough of a distraction to make them almost forget they’re getting tattooed. I’ve been tattooed a few times with good movies and colorful computer graphic videos playing, and the time just flew. Music videos, tattoo videos and nature documentaries can also serve the purpose. However, I’ve found that movies with a lot of long action, fast-flying-gun-shooting-stuff blowing-up-everywhere sort of activity, tend to make clients restless if these scenes go on for too long. I think that the combination of all that booming and the sting of the needle makes for a pretty annoying cocktail… unless the movie happens to be so excellent that the client is completely transported away.

Sometimes clients will like the idea of visual distraction but have trouble staying focused on a plot. Comedies can sometimes be just the right thing. Because they usually consist of many short gags, they can be enjoyed even if parts of the plot are missed. Also potentially helpful are videos of fractals, crazy computer graphics and Japanese animation that can be played without volume and supplemented by whatever music is wanted. Some people seem to really like this combination.

I’m often surprised at how clueless some tattooists are as to their clients’ taste in music. Now I don’t necessarily believe that an artist should have to listen to Yanni if their client is a Yanni fan, but they may want to consider playing something other than Slayer for these folks. There should be some kind of compromise where both parties can feel comfortable. Adventurous tattooists can even invite their clients to bring their own iPods and plug them into the shop stereo. If clients feel like their needs are being taken into consideration, they are more likely to return for more work.

What? I Can’t Hear You!
No matter how much you or your client like the music that’s being played, there is a limit on how loud it should be. Communication between artist and client is always crucial, and much of this happens subliminally. Extremely loud music will cut off any real communication and make the client feel like there is a wall in place. For this reason, headphones on the artist are even less appropriate.

Over the last decade or so, I’ve found myself to be less and less patient about music with lyrics. I suppose this has something to do with already having enough going on in my head; why would I want some dude yelling at me about his love life problems or his issues with society when I’m trying to concentrate? This is about personal taste, of course, but I’ve definitely found that there is a lot of good music out there without any words at all. This can range from intricate guitar work to expansive ambient soundscapes to rhythmic thudding dance music, depending on the desired mood and energy level. Many tattoo clients have been quite open to this sort of instrumental music, and have found that it’s easier to relax and drift off without having the yelling dude in the airwaves.

The atmosphere in a tattooist’s studio is not just about comfort and convenience; it’s also an expression of personal artistic energy. It’s an opportunity not just to get the client to relax, but for them to witness an installation of music and imagery that can be an art form in itself. In the memories of our clients, this part of the experience can last as long as the tattoo.

With all this attention focused on the comfort of the client, it’s also essential for artists to consider their own physical well-being. It’s all too common for tattoo artists of moderate age to have sore backs, stiff necks, cramped legs and tensed arms. Although the tattooing process can be physically demanding, there is no reason that it needs to add up into chronic physical issues. A few daily stretches can make a huge difference.

Various tattooists are going to take the time to do a full range of stretches every day, and many simply don’t have the time. In addition, in the case of someone who already has serious issues, it may be a good idea to visit a doctor or physical therapist to work out the appropriate stretches and exercises to reverse the damage. However, to prevent the most common types of repetitive stress injuries that tattooists encounter, there are several stretches that can be done easily at any free time during the day, such as when a client is taking a short break.

The hands and wrists are especially vulnerable to wear and tear. Cramping and inflexibility are common and can lead to circulation problems and numbness. To counter this, a pair of simple stretches can be done several times a day to open up the spaces between the tendons and muscles. This can even be done while wearing your gloves.

1) Standing with a straight back, lift the arms forward and up until they are straight above your head (Fig. 307a). While doing this, make a pair of tight fists and point them forward and down. Take a deep breath, filling your lungs entirely. Hold the stretch for a moment, but don’t stretch beyond your pain threshold. You should feel the stretch from your knuckles down the backs of your arms.

2) Relax your arms and lower them gradually. Exhale completely, pushing all the air out of your lungs. This helps to expel toxins released by stretching.

3) Extend your arms down and back, swinging them back until they are somewhat behind you (Fig. 307b). While doing this, point your hands forward and up, extending the fingers and opening the spaces between them. Take a deep breath, filling your lungs completely. Hold the stretch for a moment; you should feel the spaces opening between the bones in your hand. Don’t stretch beyond your pain threshold.
The Eyes Have It
Eye strain can be as much of an issue as the strain on any muscle. This is a result of being focused at the same distance for so many hours. The remedy for this is simple: Whenever the opportunity presents itself, look out a window at a far away object, focus on the object, and trace its outline with your eyes. By doing this every couple hours, your eyes will not tire nearly as easily.

4) Relax your arms, shaking out your hands in the process. Exhale, emptying your lungs completely to release toxins. Go back to step 1; repeat 2-3 times.

These simple stretches can make a big difference in preventing hands from cramping up, possibly extending your effective work day. They can also be performed at any time and not just in the workplace. For me, doing these stretches has become a reflex for any time my wrists or hands feel tight or cramped.

! All stretches should be done with caution, and care must be taken to not exceed the body’s limits. Those with medical issues should first consult their doctor about stretches to find out what is best for their individual needs.

It’s also helpful to have a way of releasing tension from the spine. Although there are a wide variety of stretches that can be done to open up the back, the one I have found to be the most useful is to do the following:

1) While standing straight, reach across your chest with both hands, as if to embrace yourself, and grab onto your shoulders as far back as possible.

2) Take a deep breath, filling your lungs completely, then bend forward slowly (Fig 308a). Hold the position for a few seconds, inhaling and exhaling completely a couple times.

3) While breathing, allow the tension out of your lower back and from between your shoulders. Bend slightly more at the waist, allowing gravity to extend the stretch as you relax more. Drop your head forward and allow your shoulders to expand apart, by moving your fingertips further back, you will increase the stretch.

4) Slowly release the pose and straight up again. Hold your hands behind your back and bend back slightly to straighten your spine.

Because of the need to hold onto your shoulders, this stretch requires that you remove your gloves.

Artists who find these stretches to be helpful may want to consult a massage therapist to figure out more specifically what stretches would be the most appropriate for their physical condition. With a little guidance and some simple daily maintenance, a slight pain in the back can be prevented from becoming a major physical issue. After all, tattooing is challenging enough as it is.

Part VI Review Questions

1) What would be a good reason to hand-trace a stencil?

2) What is a disadvantage to using a stencil made on inkjet paper? What are some advantages?

3) Under what circumstances is a one-shot stencil preferable? How about a two-shot stencil?

4) How and why is tape used when applying a stencil?

5) What is an advantage of using soap instead of Speed Stick for applying stencils?

6) What is the difference between a flat and a magnum? What makes a magnum preferable?

7) What is the difference between a stacked magnum and a spread magnum? Why is the spread magnum possibly better?

8) How are spread magnums made?

9) What is the main advantage of using carbon needles? What are some disadvantages?

10) What component of a machine do we feel when judging how it’s running? How is the machine held while doing this?

11) How is tension added to a spring? Why is it a bad idea to subtract tension?

12) What can happen when the rubber bands are tangled instead of being arranged neatly?

13) What do we feel with our stretching hand? Why is this so important?

14) How is a three-point stretch performed?

15) What are some ways of supplementing our stretch?

16) How can we protect our stencil when we have to place our greasy fingers all over it to get a good stretch?

17) How can it be made easier to switch back and forth between machines?

18) What are some advantages to switching back and forth between machines numerous times during the course of a tattoo?
19) Why would an artist want to spend extra time tightening a tattoo when they can get away without doing it?

20) When would it be desirable to soften an edge? How is this done?

21) What are some advantages and disadvantages of using a barber chair? How about an office chair?

22) In what ways can you improve your shop setup for better comfort and lighting?

23) What are some good types of lamps to use? What kind of bulbs? Do you know of any others?

24) What part of a tattoo process is often the most painful? What can be done about it?

25) What are some advantages to using squeeze bottles instead of spray bottles?

26) What are some advantages to working small areas of a design to completion? What are the advantages of working the piece as a whole?

27) What are some ways to make a client more comfortable?

28) What are some advantages and disadvantages of using topical numbing gel? How are they best used?

29) How can the negative side effects of these topical medications be minimized?

For answers to these questions, go to: www.hyperspacestudios.com/ reinventing/answers

---

**PART VII**

**Step-By-Step Processes**

7.1) Bringing It All Together

Meanwhile, back in the tattoo studio, comes the day-to-day challenge of trying to do the best tattooing possible. In reality, there are always time and budget constraints with almost every project, and it's easy to understand why an artist might be naturally inclined to do the most efficient tattooing possible. There is certainly some wisdom to the less-is-more approach, not only in finishing projects quicker but also in the elegant appearance that a minimalized approach can sometimes produce. At the other end of the spectrum, some artists (myself included) like to take their rendering to the highest level of refinement possible.

Somewhere in the middle is a balance between minimalism and labor-intensive rendering. A 4-hour shoulder cap can be just as nice of a tattoo as a 10-hour shoulder cap if the design is strong enough and the rendering is smooth and sufficiently finished looking. However, that same design can generally be made another notch nicer with two to three additional hours of refinement on top of those first 4 hours, making for a 6-7 hour project. In my opinion, those extra hours can make the difference between a good tattoo and a great tattoo.

In the real-world reality of running a tattoo business, artists need to account for that extra time. It's not always easy to find clients with the budget for the extra hours, especially in a situation where an artist is still trying to get established in the competitive world of tattooing. However, the extra time and care put into every piece always pays off, even if it means having to occasionally cut people breaks in charging for the additional hours. Right away, the work looks more impressive and the clients are happier. They notice the additional care put into their tattoo and they feel a stronger sense of loyalty, which of course translates into their friends getting tattooed, and so on; once an artist begins to build up an established reputation, clients simply won't question the amount of time needed to do their work.

---

**Fact**

**Done the right way, additional tightening and development will not only improve a tattoo's appearance, but also increase its longevity.**

There are countless small ways to improve a tattoo, some in the design stage and others while applying the piece. So far in this book we've gone over hundreds of pages of information about design, equipment and execution. Most likely, a lot of this information makes sense to you and confirms things you had already thought. Some of it may feel like new but obviously useful information, while you may feel less sure about other parts. This is all in addition to everything you have already picked up in the course of your experience as an artist and tattoo practitioner. Cultivating all of this into an efficient yet personalized method for designing and applying tattoos can potentially add up to a steep learning curve.
Checklist 6: The “Be Prepared” Checklist

For Getting Ready To Tattoo

A client is due to arrive in 3 days. You have a deposit and a photo of the body part. What needs to be done before the appointment day?

A) The Design
1) Is it the correct size and flow for the body part?
2) Does it have a strong layout with a clearly readable positive/negative relationship?
3) Does it meet the basic requirements requested by the client?
4) If the design is going to be stenciled on the skin, is it stencil-ready?
5) If it will be freestenciled, is the basic design laid out on paper as a clearly readable value study?
6) Are all the major aspects of the design worked out in advance?

You are in the studio on the day of the appointment, and the client is due in an hour. What needs to be taken care of before your client arrives?

B) Space Preparation
1) Is the work area clean and organized?
2) Are the appropriate tables, chairs and armrests wrapped and positioned as needed?
3) Is there a designated lighting, positioned optimally?

C) Station Setup
1) Is the work surface clean and wrapped?
2) Is the trash can clean, with a fresh bag, within easy reach?
3) Is the lamp at your station wrapped so it can be adjusted while wearing gloves?
4) Has the power unit been wrapped and the clipcord sleeved?
5) Are all necessary soap and water solutions available in wrapped autoclavable squirt bottles?
6) Do you have a rinse cup poured? How about two rinse cups (recommended for color work)? Are the rinse cups covered with plastic wrap to protect them from dust while waiting for the client?
7) Do you have plenty of gloves, paper towels, tape and plastic wrap handy? How about a razor?
8) Is the palette of necessary colors poured, and positioned as close as possible to where the client will be?
9) Do you have a paper plate handy to cover the palette with when you are not working?

D) Machine Setup
1) How is the alignment and extension of the needles when the armature needle is pulled down?
2) Is the tube vise tight enough?
3) How is the rubber band tension? Does the band interfere with the machine's movement?
4) Does the needle move freely up and down when you push the armature needle with your finger?
5) Is the machine covered with a bag in a way that allows the spring assembly to move freely?
6) Does it run smoothly when the setup is complete and the tube tip has been dipped in the rinse cup?

E) Design Transfer (Stencils)
1) Is the client shaved, thoroughly cleansed and completely dried?
2) Is the client standing in a stable and neutral “Bus Stop” position?
3) Is the stencil handy, with its excess paper trimmed off?
4) Do you have your stenciling solution (soap, Dettol, etc) handy, along with alcohol, paper towels and tape?
5) Do you have clean markers available for fine-tuning the stencil once it's in place on the skin?

F) Design Transfer (Freestenciling)
1) Is the client shaved, thoroughly cleansed and completely dried?
2) Is the client standing in a stable and neutral “Bus Stop” position?
3) Is the sketch or other reference positioned in plain sight, where it will be handy while drawing?
4) Do you have a light, medium and dark marker available? (Make sure there isn't a red one!)
5) Do you have alcohol and paper towels within arm's reach?

G) Aftercare
1) Do you have a camera handy? Photograph everything, including unfinished work. Apart from being valuable documentation of your art, it's an important learning tool, and can make the client feel good.
2) Do you have a way of wrapping the finished tattoo, and good healing instructions for the client?
3) Do you have a place away from your work station to soak your tubes?
4) Is there a sharps container available for your used needles?
5) Is there a place to dispose of your biohazard waste that isn't in contact with public areas?

Bearing in mind everything we've discussed so far about design and technique, it's time to talk about how all this information applies in practical day-to-day tattooing situations. In this part of the book are a series of projects presented in a step-by-step format to demonstrate how they were done. We'll start with a basic rose tattoo, then a simple skull design before moving on to more complex tattoos, including both abstract and representational imagery. The description of each project will touch on all of the major design points, such as contrast, dynamic range, positive/negative relationships, priority and reserve. These descriptions will also explain how each piece is handled technically, and what kinds of needle setups and stencils are used, while discussing the basic order of events in applying the piece.

The first two projects illustrated in this part, the rose and the skull, are examples of moderate-sized pieces started in the first project. Since many tattooists feel intimidated by the idea of beginning a tattoo without an outline, these projects are intended to take some of the mystery out of the process. The third piece features a sacred heart, which is outlined in a more traditional way and then colored using a number of different needle groups. This is followed by a seahorse design, which uses methods similar to the sacred heart but presents a clear example of the tightening process. After that comes a piece on the side of a neck, which is a tricky area to tattoo with precise results; this chapter shows a few tricks for working on difficult areas of the body. The final project shown in Part 7 is a black and gray project, and demonstrates a number of essential graywash techniques.

Of course, only so much can be learned from looking at photos and reading written descriptions. Nothing compares to actually watching, so the first two of the projects here are accompanied by detailed video footage.
The footage is intended to work with the text in the book, and will be the most useful if watched while reading the descriptions in this chapter. In addition to this, I encourage you to watch other more experienced artists as much as possible. Conventions are a good place for this, but it’s also sometimes possible to develop comfortable relations with other local tattoo artists, and to find time to occasionally drop by their studios and watch. Even if the artists you are watching aren’t talkative about their technique, just quietly observing the process for long enough usually answers many questions.

The best view you will ever get of a tattoo being done will be on your own body. Try to reserve your major arm areas for artists you really look up to, and then watch their every move as you get tattooed by them. They may even allow you to take some video footage.

7.2) A Simple Rose

A rose tattoo is the classic basic tattoo design. It can be applied in the simplest way possible, and still work as a tattoo. In many cases, this application involves a single-pass black outline and some simple black and red shading, with little or nothing else done. However, even a rose can be taken to the next level by using a more painterly approach. The tattoo illustrated in this chapter is medium sized, about 3” (8cm) across not including the foliage. This makes it large enough to comfortably render using a magnum first technique.

The placement of this piece is on a woman’s left hip, with the blossoms resting on the point of the bone. To give the tattoo a nice S-curve follow with that part of the hip, a twisting thorny vine has been incorporated into the drawing, with a few small and medium leaves to help accentuate the flow (Fig. 315a). A soft-edged drop shadow is also used in the design to lift the rose off the skin and make it look less like a sticker.

In many cases, a design like this would simply be stenciled. However, in this case the client had just arrived and needed to choose from several different sketches and body placements, so no final stencil-ready drawing could be done ahead of time. Because of the design’s simplicity and organic flow, a freehand transfer method is adequate. This begins with a light green sketch to establish the basic size, placement and flow (Fig. 315b). To avoid distortion, this is done with the client standing up in a natural position. Then, with her lying on a massage table, the details of the design are roughed in with a medium blue marker (Fig. 315c).
The third step is to draw in the clean lines and the dark shadow of the piece (Fig. 316a). At this stage, the drawing is detailed enough to begin shading. However, sometimes it can be helpful to also draw in the gradients and light and medium values of the piece, using the light and medium values as blending tools (Fig. 316b). When a sketchbook value study has already been made of the design, this step makes all the important shading information immediately available in the marker drawing.

You may have the best luck with markers if you do as much as possible with the light and medium colors first before switching to the dark colors. This will make your finished drawing clearer and more readable, and will prevent the need for a lot of erasing.

Because of the way the client is positioned on the table, it makes the most sense to begin with the leaves and vines on the outermost part of her hip, then continue on to the rose itself before following through to the inner set of leaves and vines. This starts with a 5 magnum, which is used to sketch in the edges and gradients in the leaves and the larger parts of the vine before switching to the 4 round. The four is used to finish the outer outline on the vine, clean up the leaves and refine the edges and details of the whole family of shapes (Fig. 316c, Video Clip 29: Rose 1).

Instead of completing the color and highlighting in the foliage, which might run the risk of dissolving the rest of the marker drawing, the next step is to lay in the rose with the 5 magnum. This is done starting with light and medium colors (Fig. 317a) and getting a simple first pass over the whole thing (Fig. 317b, Video Clip 30: Rose 2) before adding the deeper colors. By the time the first pass is complete, the essential form and pos/ing rhythm of the rose has been established.

The next step is one of my personal favorites, and gives the flower the strength and clarity it needs to make up for its lack of a black outline. This involves using the 4 round to clean up and sharpen the edges of the petals and other shapes, as well as adding additional detail (Fig. 317c, Video Clip 31: Rose 3). The tightening process is done using a variety of hand movements, such as with colored pencils, usually with fairly low power to prevent trauma. Some of the darkest colors in the palette are applied with the 4 round, which is ideal for creating the sharpest edges.

Tightening is a stage where both ink flow and visibility are crucial in this inside process going smoothly. If there's a struggle to get the ink in while making sharp edges, the skin is more likely to be overly traumatized.

When shading first and then adding lines and edges, be sure to keep track of the areas you've saturated the most so you can avoid doing too much additional development in areas of skin that are already close to their trauma limit.

With this complete, the remaining leaves and vines need to be done before the marker drawing is completely gone. This is started with the 5 mag; just like the leaves on the outer part of the hip (Fig. 317d). The magnum is used to lay out details that are not too small; for the tight coil of the vine, the 4 round is used (Fig. 317e). The four is also used to sharpen the details and edges of the leaves.

Once this stage of the layout is finished, there will be no more need for the 5 magnum. The remaining color is done with a larger needle group, in this case a curved 7 magnum. This group is good for the job because of its versatility and its ability to work soft gradients in tight spaces. Its first task is to add the greens to the leaves, followed by the yellow and white (Fig. 317f). This is done in all the foliage, then the four is used for sharpening the white highlights. This completes the foliage, leaving only the rose to be finished.
7.3) A 3-Hour Skull Project

Not all skull tattoos are created equal. The skull is a classic staple of tattoo design for many reasons: there is no mistaking what it is or what it refers to, so the skull makes for a very potent icon regardless of how it is presented or what other elements are combined with it. Skulls can be a lot of fun to tattoo; their organic structure and many options for expressing mood or personality make them a favorite among tattooists. The skull design in this chapter is a medium-sized project meant to fit a particular body part, and designed in a way that a Magnum first technique is the best way to apply it.

Often skulls are rendered in black and gray. The morbid subject matter and general lack of color found in real skulls makes this an obvious choice. However, I sometimes enjoy the challenge of working with a muted color scheme when rendering these types of subjects. By working with subtle warm and cool tones, the depth effects in the piece can be exaggerated beyond what is possible with black and gray, while still not making the piece too bright for its intended result. Much of the muted color scheme is achieved as a result of dipping between bright colors; for instance, dipping from dark purple into mint green will produce a cool gray. So the pigments pored in the palette for this project are not necessarily muted colors, though the way they are used will produce a muted effect.

The piece is designed to fit the back of a calf. The client for this project has short, wide legs, providing a nice canvas for the tattoo. In order to avoid a sticker look, the piece is designed to fade in and out of the skin at the top and bottom of the design. With the skin shaved and cleansed, the sketchbook is placed within easy view and the drawing is started on the skin using a light green marker (Fig. 319a, Video Clip 34: Skull 1). With the basic design roughed in, the client stands up so that the piece can be checked in its natural position; this is the best time to find out if his movement distorts the piece too much.

Tattoos in sensitive areas like this are often easier for the client to sit for if smaller areas are worked for longer periods. The less skipping around in the tattoo, the better.
With the basic sketch approved, the details of the skull are developed further with a medium blue marker (Fig. 320a) and then finished off with a dark purple marker, using the blue and green markers as blending tools (Fig. 320b). The finished marker drawing contains the major dark and light areas of the original sketches, along with many of its gradients and details. This makes it an ideal design to lay out with a small magnifier.

The best way to draw on a freehand design is to start the rough stage with the client standing. Sometimes, though, this is difficult because of the placement on the body. In the case of this skull project, the piece is too high to work efficiently in a piece this size and not by hand that it makes small detail difficult. The beginning of the tightening process consists of moving along the edges of the important shapes, such as the teeth and eye sockets, and making the edges as dark and sharp as possible (Fig. 320c, 320d). This is done using small overlapping oval shapes, much like the kind of hand movements used to build up lines. Other hand movements are also used to create small details and add sharpness to existing elements (Video Clip 37: Skull 4).

For an artist who has never started a tattoo magnification first, a skull is an ideal project for trying this technique because of its organic design. The initial stage of committing the drawing to skin usually involves a relatively quick pass over the entire piece, taking about a third of the total time that the tattoo will take to complete. I usually do this first pass using a variety of light, medium and dark muting tones, with black being only a part of the scheme (Fig. 320c, 320d). Because these colors are all cool muted hues, very little rinsing is necessary and the whole pass is done while dipping between colors like lavender, opaque gray, mint green and black. Dipping between colors in this manner can produce an almost infinite range of muted colors that are ideal for starting this kind of design (Video Clip 56: Skull 3).

Once the tightening is done, the remaining work is fairly quick and easy. The next step is to use the curved 13 magnifier to block in the larger fields of color, including muted blues, yellows, ochre tones and a small amount of true yellow (Fig. 321a, 321b). All of the colors used in this stage are made by dipping between ink caps, which produces a wide range of muted tones. Opaque gray is used in much of the coloring, often dipped into lavender or sea foam to create light, cool muted colors (the undersides of the eyebrows are an example). The large curved shape of the needle group is ideal for pulling long gradients over areas of detail such as the eye sockets or under the cheekbones. A big needle group not only saves time, it also produces a smoother look (Video Clip 38: Skull 5).

The next step is to lay down the large white highlights, which is done with the 5 magnifier. This is a fairly quick process, taking only about 10 minutes (Fig. 321c, 321d). The white is layered partway on top of the
7.4) The Sacred Heart

The sacred heart is a popular tattoo motif for good reasons. The characteristic combination of a heart, a cross, a crown of thorns, a flame and a bleeding knife wound in the heart emits a powerful spiritual resonance, even to those who aren’t educated in the Catholic Church’s archaic visual language. This combination of symbols offers artists a wide range of visual opportunities, and tattooists in particular have done all kinds of creative things with the sacred heart image. The project in this chapter is a variation on the traditional theme, where the crown of thorns is replaced with the detail of cherry blossoms, and the blood running from the cut is replaced with a stream of rain.

When the project as complex as this needs to be completed in a single session, my normal inclination is graylining shapes that in other cases might be colored in and then developed over multiple sessions. Since graylining is quicker than color lining and heals with more contrast, it’s a good option for lining convention pieces and other single-session projects. In this case, the peripheral lines around the heart and flowers are lined in black with a 5 round and then built up; the graystones are then lined and developed with a tight 3 using black and graywash. The remaining details in the heart, flowers, cross and flames are all graylined with the 3 round (Fig. 323a).

For most projects where a grayline will be followed by either shading or coloring, and the grayline is meant to be mostly hidden, try working with a 10-15% wash, using a mix of any good black tattooing pigment and distilled water. If you don’t have a bottle of premixed wash, use a large ink cap, drop 3-4 drops of black into the cap, and then fill it the rest of the way with water.
With the outline complete, the next step is to start coloring. Using a 7 magnum, color is put down in layers, working at low power to prevent saturating the skin too much in a single pass. The volume of the heart is first modeled using purples and lavenders (Fig. 324a). Next, the major surface area of the heart is colored red, blending lightly into the purples and leaving areas of blank skin for lighter colors (Fig. 324b). With the medium values in place and the skin not yet fully saturated, a final shading pass is done with purple concentrate to give the heart maximum depth and volume (Fig. 324c).

With the purple shading strengthened to this extent, the reds appear less vibrant, so more bright red is layered over the existing red and pulled further into the unjured areas, leaving only the final highlights in skin (Fig. 324d). More purple shading is then added to enhance the dimension of the red textures (Fig. 324e). After this, the 7 magnum is put down momentarily and replaced with the 5 round, which is used to add purple and red details and to clarify existing textures, as mentioned earlier on Page 283 (Fig. 324f). As a final touch, subtle yellow and white highlights are brushed into the textures. At this stage, the skin in most of the heart is saturated close to its limit.

By this point, over two hours have elapsed. This design contains many detailed elements, all of which require plenty of rendering time. Although many of the elements in the piece could be rendered more simply, it's always my preference to spend extra time taking the piece to the next level whenever a client is willing.

The next step is to render the gemstones and the flowers. First, bright pink is laid into the cherry blossoms using the magnum, followed by light purple around the blossoms' centers. After this comes a tightening pass using the 5 round, where the pink and purple in the blossoms are sharpened and saturated (Fig. 325a). With the 5 round still plugged in, the gemstones are colored and highlighted. Because the lower part of this tattoo (which is at the bottom of the sternum) is the most painful, the gems are finished at this stage while the client is still sitting well.

Switching back to the 7 magnum, the blossoms are given yellow centers and then white is packed into the petals. The 5 round is then used to further saturate the yellow and white, and to sculpt clean white edges on the petals (Fig. 325b). The 7 mag is then used to pack a dark-to-light green gradient into the flames, followed by a tightening pass with the 5 round (Fig. 325c).

When shading with dark concentrate colors such as blue, purple, green and magenta, the healed and settled result will lose 15-25% of its darkness, noticeably more than black will.
The project is now past its fourth hour. The last thing to finish is the elaborate crystal cross, which is entirely graylined. The intention here is to color the cross in a vibrant but delicate finish. To achieve the precision and clarity needed, the tight 3 will be used for much of the rendering. The crystal element, because of all this, is more time-consuming than most of the piece.

First, the magnum is used to brush in layers of medium and light orange, establishing the pos/neg logic of the gradients in the facets (Fig. 326a). Still using the magnum, yellows and pinks are layered into the oranges (Fig. 326b). The pinks cool down any facets facing away from the cross’ center, while the yellows warm up anything facing inward. No dark colors are used near the flames, helping to keep the elements of the design separate.

The next step is fairly time-consuming, but is essential in making the crystalline qualities of the piece effective. Using the tight 3, medium orange and light red are used to clarify and sharpen all the edges and lines in the cross (Fig. 326c). This is done using small overlapping strokes, kind of like precise mechanical pencil rendering. This is the best opportunity to make all the details clean and symmetrical.

With the skin still not fully saturated, a final shading pass is done, this time using the 5 round and dark purple (Fig. 326d). A renderer is then added along the outer edges of the big facets, fading into the black that is already there and emphasizing the warm/cool contrast of the inner and outer facets. Next, the 5 round is rinsed thoroughly and used to pass-white through all the remaining parts of the cross, giving it a crystalline shine (Fig. 326c). White is also edged in outside the perimeter of the green flames in order to maximize their pos/neg relationship with the faceted details. By using large areas of white on some facets and none on others, the shape is given more of a reflective crystal quality.

The finished piece takes a total of 6 hours, including 30 minutes worth of breaks (Fig. 327a). By methodically working each area to completion, the process never becomes too intolerable for the client. Focusing on individual areas like this also makes it easier to concentrate on the development of each shape, and to keep better track of how much of a beating each part of the skin has gone through, in order to avoid trauma. There are more efficient ways of speeding through a tattoo like this, but a methodical approach is more likely to bring about a finished tattoo with this sort of quality and variety of detail.

Tightening with a 3 round can be incredibly time-consuming on large pieces, and when done too quickly can make for scratchy results. Sometimes it is preferable to handle most rendering with a larger round group, and to use a 3 round only for the most precise details.
7.5) The Seahorse

This project incorporates many of the same methods touched on in the sacred heart tattoo project, but with some exceptions. To make this piece as bright as possible, color lines are used instead of gray lines in order to make it easier to absorb the lines into the coloring as the rendering is completed. The design also involves a background that goes behind the seahorse but also has parts that pass in front of it to give the piece several layers of depth.

Because of the inconvenient placement of an existing tattoo higher up on the shin, this piece had to be squeezed lower on the calf than the normal ideal placement. To make the most of this, the ankle bone is used to lift up the coil of the tail, giving it more dimension and animation. The design’s S-curved background is also laid out to emphasize the ankle upper part of the calf, preventing the tattoo from taking on a bottom-heavy appearance.

The design process is started with a sketchbook study and then a full-sized drawing. For the purpose of making a readable stencil, the dark areas in the drawing’s background have been shaded, clearly spelling out the seahorse’s negative-positive relationship and giving the background part of the stencil the extra durability it needs to hold up during the initial outlining stage.

With this stencil in place, the inner details of the seahorse are colored lined with a tight 3, followed by the color lining of the bubbles and the stream of skin in front of the seahorse. The 5 round is then used to make a quick first pass through the peripheral line (Fig. 329a). Still using the five, the peripheral line is built up to a nice consistent weight, and the facial details are sharpened and developed (Fig. 329b). It is also used to do the black shading in the eyes. At this stage, the stencil has become fairly faint, but is still readable enough to proceed with coloring the background.
When rendering a design with a dark background, try shading and coloring the background first before adding any color or shading to the foreground shapes. This makes it easier to avoid shading the foreground shapes too much or in the wrong places, and keeps things more intuitive when trying to achieve an overall clearer look with the piece.

The next move is to add all the blues in the background with the 7 magnum (Fig. 330a). The whole range of blue is used for this, with the deepest blues concentrated close to the seahorse in order to strengthen its neg-on-pos relationship. The shaded stencil is easy to follow while laying in the first pass of blue, which is handled by dipping back and forth between light blue, medium blue, dark blue and the rinse cup in order to get the whole range of values and the greatest sense of softness. Special care is taken to keep the edges of the blue areas soft and airbrush-like.

Backgrounds of this nature, because of their translucency quality, need to be handled a bit differently than foreground objects. Using a fair amount of water, along with a much looser and layered working style, will produce a more transparent quality and make it easier to give the background an airbrushed look.

Before switching machines, rinse your tube thoroughly. This prevents having to deal with dried pigment later when the machine is needed again (or the tube has to be scrubbed). This is a good habit to get into in general.

Still working with the magnum, the blues are rinsed out of the tube thoroughly and the medium warm colors are added to the seahorse; in this case, pink and lime green are used (Fig. 331a). The versatile shape of the magnum makes it possible to speed through simple processes like this in minutes.

Next, the 5 round is used to tighten the areas colored with the magnum, including both foreground and background (Fig. 331b).

First, pink and magenta are used to sharpen and refine the ridges in the body. Notice how these ridges describe the form of the seahorse; they are a good example of contour lines. The details in the face and fins are also tightened, using dark red, purple, grass green and magenta. The background color is then tightened against the seahorse’s peripheral line, and the bubbles are given sharp edges; finally, the small details in the eyes are colored.

Switching back to the magnum, the bright oranges and yellow greens are packed in (Fig. 331c). Using the magnum, this process takes only about 5 minutes, but deals with some of the most important color in the piece. Since orange is opposite of blue on the color wheel, it is the best candidate for a dominant color in this seahorse. The lime green fins are a different hue from the orange, but still contain enough yellow to read as part of the same family of shapes, especially with the large background field of blue contrasting both the oranges and the greens.
The magnum is then rinsed out thoroughly and used to pack in the bright yellow using small, even, overlapping oval-shaped strokes (Fig. 332a). The yellow is added throughout most of the foreground, blending seamlessly with both the oranges and the greens. Since these medium-value colors were feathered out into the skin, leaving it only lightly traumatized, these areas could still handle a thorough pass with the yellow without risking damage.

Once the magnum has been used to saturate the yellow as much as possible, the 5 round is then used to pull the yellow through all of the tight corners that the magnum couldn’t easily reach. This makes the piece look brighter in general, and offers better saturation than is possible with the magnum alone. Yellow and orange are then added to the edges of the bubbles facing the seahorse; this not only appears as a colorful reflection of the seahorse in the bubbles, but also helps to break the monotone of the large field of blue in the background.

Finally, the 5 round is thoroughly rinsed and white highlights are added (Fig. 333a). Many of these highlights are placed on the raised part of each ridge in the seahorse’s body, giving the body more dimension. These highlights mix with existing yellow already in the skin, and will not heal as true white but as a pale yellow. Highlights are also packed in along the spines of the fins, the ridges of the back, the reflections in the bubbles, and anywhere else in the foreground that looks like it could use it. The highlights in the face are particularly crucial, making the eye shimmer and the mucous in the cheek veins glisten.

There are many white highlights in the piece, but the only clear areas of true white are in the eyes. Since the eyes also have greater concentrations of black than the rest of the tattoo, this gives them the most value contrast, so they easily jump forward. They eyes also have a fairly strong color contrast, with a range from purple to orange. All eye features are as sharp as they can be made; their dynamic range is greater than any other element in the rest of the tattoo, which helps bring them to life. The shiny texture of veins around them draw in additional attention.

The background slightly less range of color and contrast, but a fair amount of sharpening in the eyes, giving it a moderately high dynamic range. This is still a good deal more range than the monochromatic, soft-focus water has. Overall, the piece has a descending order of dynamic range, with the eyes being the most important, and the water commanding the least amount of visual priority. This guarantees that the seahorse will jump forward from the background and make the piece appear as strong and bright as possible.

**Backgrounds can easily overwhelm the main elements in a tattoo if they are made too strong. If a dark background is part of the plan, keep the foreground shapes large, open and relatively light in value. If a colored background is going to be used, be sure the foreground is a contrasting color and a much different value than the background.**
Checklist 7: The Difficult Body Part Checklist
This can include: The neck and collar areas, armpits, lower abdomen and groin, hands and feet

A) Prepare a stencil that will last
1) Make stencil or freehand drawing as high-contrast and readable as possible
2) Prepare the skin just right: Shave, swab with alcohol and thoroughly dry the area
3) Be as careful as possible throughout the earlier parts of the session to make sure the stencil does not sweat or rub off, especially during breaks

B) Get your positioning right
1) Position clients in as comfortable and secure a position as possible while making their body parts maximally available to you
2) Whenever possible, find a position that stretches the skin, especially if the area is elastic like in the back of the upper arm
3) Challenging body parts often mean working in physically awkward positions, so be prepared to stop often to shake out
4) Clients are usually shy about speaking up when their limbs are going numb. Look for obvious signs, like continuous flexing of the fingers, and then find opportunities to let them move their body and get their circulation back

C) Prevent stencil loss during tattooing
1) Be sure the environment is cool enough so the client is not excessively sweating
2) Use a quick first-pass strategy that gets the design quickly committed to the skin before the stencil is gone
3) Use adequate lubrication so that wiping does not accidentally smear or remove the stencil
4) Work carefully so the tattooing hand rests only on areas already committed to the skin
5) Use a clean, dry paper towel to cover any parts of the stencil that must be touched with the stretching hand
6) Wipe with clean, damp paper towels, and blot carefully so that unused pigment is gently lifted away without removing important stencil information

D) Afterward
1) For thin-skinned areas such as the neck and armpits, encourage clients to apply ice after the session to facilitate easier healing
2) For most of these areas, two healed passes is the way to go. Areas that swell up dramatically can’t be saturated as much in a single session as normal skin, so be sure clients understand ahead of time that two passes is most likely what it will take to be able to call the piece finished

7.6) A Difficult Spot: Neck Inferno

Some parts of the body are trickier to work with than others. The skin on some areas is more stretchy, more loose, or has weird elastic qualities. Some spots have thinner skin than usual, heavy concentrations of hair follicles or a tendency to swell up frighteningly at the first touch of the needle. You know the areas I’m talking about. The lower abdomen, inside the bikini line, the armpit areas, and the neck. The neck, especially, can be an issue because it’s a spot where people like to get detailed subjects or things with lettering. It definitely helps to have a few strategies for working in these trouble spots.

The trouble spot tips discussed here are not just for the neck, but apply to any area like those mentioned above. The main issues with these areas involve stencil loss, precision and pigment saturation. So, for the purpose of making life simpler when working in those areas, I’ve provided a checklist for your consideration when working in any difficult areas (Facing Page).

Features of this project:
- Varying line weight, plus no-outline elements
- Black used in organic environment, while flames are color only
- Bold contrasting color scheme
- Simple flowing central flames surrounded by textured surfaces and overlapping objects

Needle groups used:
- 4 round
- 5 magnum
- 7 magnum

Pigments used:
- Black, deep blue, light blue, dark purple, lavender, opaque gray, yellow ochre, sea foam green, dark red, light red, orange, yellow, white

Fig. 335a

The neck is a particularly tricky area for a number of reasons: The terrain is uneven, the area is hard to reach, the position is awkward for the client, the stencil distorts and wipes off easily while the skin swells dramatically. It’s one of my least favorite areas to work on, but a well-done neck tattoo can be a very potent statement and many collectors want artistic neck work.

The piece illustrated in this chapter is an organic flowing design, which can be helpful on places like the neck that are constantly in a state of stretching and distorting. Because the stencil or marker used on a neck is more prone to wiping off than on other parts of the body, a hectograph stencil was selected instead of markers because of its greater longevity. The stencil has been prepared in a manner to make it as strong and high-contrast as possible (Fig. 335a). All excess paper has been trimmed, and cuts have been made into the paper as needed to give the stencil maximum flexibility.
In Fig. 336a, the stencil has been applied with diluted soap, using the one-shot method. On a spot like the neck, even a carefully taped down stencil might land wrong (in this case it required two attempts). This is especially true with stencils that wrap more around the body part, as opposed to a smaller piece. Some touchup is done with purple marker, but overall the darkness and clarity of the stencil are more than satisfactory for a tricky project such as this. With the air conditioning set extra cool to keep the stencil from being sweated off, we got in position and began working.

Once the neck area of the design is safely committed to skin, the front of the stencil needs to be lined into place. Because of the newly vanishing stencil, the flames are simply lined using light red with the 4 round (Fig. 337a). Next, the 5 magnum is used to shade the cavern and lay down the red gradients in the flames (Fig. 337b). After a brief soak in Bactine to calm the irritation, a tightening pass is done with the 4 round (Fig. 337c). This consists of darkening and sculpting the blue lines in the cavern, adding detail to the stone, then cleaning up and developing the red in the flames. This tightening stage is largely responsible for the tattoo’s graphic clarity.

With the red successfully laid down and tightened, the remaining color goes quickly. The 7 magnum is first used to deepen and develop the blues, purples and shadow colors, which are important in the design for contrasting all the warm colors in the flames. Next, the mag is thoroughly rinsed and used to apply yellow ochre to the cavern, develop the oranges in the flames and pack in their fields of yellow (Fig. 337d). After another thorough rinse, the mag is used to apply a few soft white highlights in the cavern and the center of the flame spiral (Fig. 337e). During these stages, this group of light warm colors is added to the entire tattoo, including the areas in the back of the neck which had been started at the very beginning of the session.
Sometimes parts of a stencil will grow dangerously light, and need to be redrawn. This is best done with all the petroleum jelly carefully removed from the area. Any time a pen or marker needs to be used on or near broken skin, it must be discarded at the end of the session for hygienic reasons.

The final step in finishing this tattoo is to add sharp white highlights with the 4 round. This allows for much more precision and definition in the highlights than the magnum can provide. This is done throughout the tattoo, in any areas that seem to need it. White highlights are neither used in the blue shadow areas (which would flatten the overall depth affect) nor in the flames (which would risk dulling the yellows). The one exception is the center of the spiral, where small amounts of white help add to the vortex effect. White lines are also used in the flying sparks, and around the red tips of the flames to strengthen their positivoneg effect (Fig. 338a, 338b).

As a final touch, the 4 round is used for a follow-through pass with yellow. This allows for more precise color saturation than the magnum alone can produce, and gives the finished piece an overall more vibrant appearance. Yellow often appears dull after healing, so the better it is saturated, the more vibrant the piece will appear. Because of their less translucent pigments, richer colors such as red or blue will appear more vibrant after less work than yellow will.

Anytime a project calls for a predominance of a family of colors, such as yellows and oranges, try to find a way of working in a contrasting color, such as blue, somewhere in the design. Even if the contrasting color only accounts for 5 or 10% of the entire piece, it will give a more visual power to the whole color scheme.

On the floor of a tattoo convention, there might not have been room for a massage table, and the client would have had to sit upright instead. Aside from the obvious disadvantages to the comfort of both the client and the artist, this would have involved a different strategy, starting from the bottom instead of the back of the neck. Either way, the goal is to get the tattoo design laid down without losing the stencil, then to get thorough and precise saturation of color, even in the hard-to-reach spots. By being prepared for these difficult areas, you can still do your best work no matter where on your client’s body the tattoo is going.

With thin-skinned areas like the neck, it is more difficult than usual to judge the right amount of power for the job. Too much power can cause dramatic swelling and trenching, while too little seems to just bounce off the skin. Aim to err on the side of caution, starting with low power and adding it as needed. Be sure to remember to check your power each time you switch machines. With thin skin, a good stretch will allow surprisingly low power to push in the color just fine.
The uninked skin that shows through gray washes gives black and gray tattoos a more translucent look than most color work can produce. In these two collaborative tattoo projects I did with Robert Hernandez (left) and Leo Zuniga (right), are a few examples of the many types of graphic effects that black and gray tattooing can produce.

### 7.7) A Black and Gray Design

For some collectors, black and gray tattoos are the style of choice. Many prefer the pure and simple look of black and gray, though not everyone. The diluted washes of black pigment heal to reveal a good quantity of natural skin tone shining through, giving the tattoo a translucent appearance that most color work doesn’t offer. Many collectors also feel more comfortable with the idea that a black and gray tattoo will last longer than a color tattoo, though truth in every tattoo will age as well as it was shaped, regardless of color used. Whatever the motivations may be, though, black and gray tattooing is an important skill for tattooists to have in their bag of tricks.

The project illustrated here combines a variety of elements rendered in different ways. Because some elements demand higher priority than others, they are given strong black outlines. Other parts of the design have thinner black lines, graylines, or no lines at all. The simplest way to handle the variety of rendering styles in this piece is to “divide and conquer” by area, as with the sacred heart project. First, though, the stencils need to be committed to the skin.

**Features of this project:**
- varying line weight, including graylines and bloodlines
- true black used in foreground shapes only
- white used selectively

**Needles used:**
- 3 round
- 5 round
- 7 magnum

**Pigments used:**
- Black, 50% graywash, 15% graywash, white

---

When bloodlining over a strong purple hertograph stencil or a dark marker drawing, the bloodline may appear invisible at first. However, once the stencil has faded completely and the irritation from the bloodlining process has had a chance to surface on the skin, it will become visible enough for the purpose of the day’s session.

Because of its tight illustrative style, this design is best started with a lining group rather than a magnum. To begin with, a 5 round is dipped in water and used to bloodline the negative space smoke coming from the hands and wrapping around the crown, and then used for the rays radiating from the top of the crown. Next, the tube is dried and dipped in black, then used to rough in the outline of the hands and the peripheral line of the crown.

After switching to the 3 round, the starburst underneath the crown is bloodlined; then the sunflower pattern behind the starburst is graylined. The three is also used to grayline some detail in the hands and crown. Finally, some of the smaller details of the crown are outlined in black (Fig. 241a). By working from bloodline to grayline to straight black, it’s easier to ensure that there isn’t any pigment in the tube while bloodlining, which can leave an unwanted ghost line later when the piece is healed.
Graylines and especially bloodlines should be applied with low power, since they are likely to be tattooed over again during the same session and can add up to causing trauma if applied with excessive force.

With the first pass of the line in place, the next step is to switch back to the 5 round and build the peripheral line around the crown. This line is made bold and clear, which is helpful in the case of a complex design like this because of the clear priority it gives the crown (Fig. 342a).

After switching to the 7 magnum, true black and the full range of graywashes are used to shade the hands and the sunflower design (Fig. 343a). True black is used around the hands only; the darkest graywash shading is applied immediately under the edge of the crown. By making the shading darkest just under the crown’s edge and then fading lighter further down, the crown is lifted out, giving the tattoo extra dimension without the need for an unnecessarily large dark area.

Once the magnum work below the crown has been finished, the 3 round is used to tighten the shading in the sunflower pattern, using mostly graywashes of 60% and less. The hands are tightened and detailed with the three and a light stippling is added in the smoke. Small amounts of shading are also applied with the 3 round around the starburst in the middle to make it more distinct. Darker washes are used in the details immediately under the crown, adding to its depth effect (Fig. 343b).

In theory, this whole area could have been tightened with a 5 round. However, the tight 3 makes the detail in the hands sharper and allows for more precision when refining the areas and points in the sunflower pattern. Plus, when dealing with a small area like this, using the 3 round won’t necessarily take more time than doing the same thing with a 5 round. Working with a larger needle group to render detail in a small area can add up to spending extra time trying to maneuver that big thing around in tight spaces, kind of like maneuvering a garbage truck through a narrow alley. Rendering can be handled quickly and confidently using the three, provided the tattoo is small and detailed enough to need such tight refinement.

The Fade Factor: How Much Will Graywash Lighten During Healing?

Although color tattoos change in brightness a little during healing, it’s a known fact that graywash tattoos lose a lot of the value in their shaded areas (much more than color). Common wisdom says to expect a 30–40% loss of darkness when a graywash piece heals and settles.

In practice, it’s not quite that simple. How much a wash will appear to fade is in direct proportion to how diluted that wash is. For example, you can expect only a minor drop in value with darker washes, while the highly diluted ones can lose up to 70% or even more of their value.

The diluted black pigment does not actually fade. With washes, much of the apparent darkness while fresh is due to tiny dots of dried blood forming wherever needles have broken the skin. The lighter the wash, the more this slight trauma will change the apparent value of the shading. With experience, any competent tattoo artist can learn to compensate for the normal fading that happens with graywash work.

Unwanted Dilution Of Black Pigment, And How To Prevent It

Sometimes water remains in the tube tip after rinsing, which can cause pigment to become diluted. This can especially be a problem when switching to straight black, since a small amount of water in the tube can result in the black healing lighter than normal. To avoid unwanted dilution of your black, try this: First, after rinsing, blot the tube tip with a dry part of a paper towel, allowing all the water to absorb into the towel. Next, dip into straight black, run it for a short burst, blot it dry again, then dip into straight black again before working.

Another dilution issue is the possibility of water getting into the black ink cap, reducing its potency. This can be a problem especially in the kinds of graywash work that involve dipping between the black ink cap and the rinse cup. The simplest solution to this is to pour two caps of black, one for dipping during the wash process and the other only for straight black. It’s reassuring to know that the black you are using will heal as a true black.
Once the shading below the crown has been completed, the next step is to move to the upper parts of the tattoo and switch back to the 7 magnum. Light washes of 25-40% strength, applied with light, looping strokes, are used to create the soft edges for the smoke; smaller looping hand movements are then used to fill the areas in between, going as dark as 60% in select places (Fig. 334a). The magnum is then replaced with the 5 round, and these same values of wash are used to strengthen the edges of the starburst in order to bring it forward from the smoke (Fig. 334b). This tightening process with the 5 round takes only moments, but makes a world of difference in separating the various elements and keeping them distinct from one another.

The crown has been saved for last; partly to help optimize the neg-on-pos relationship it has with the background, partly for pain management reasons and partly because it was the most fun part of the tattoo. Sometimes, with complex projects like this one, it can be helpful to leave a fun part for later in the project, so all the hard work doesn’t come at the tail end of the job.

The crown is first shaded with the magnum, using mostly washes lighter than 40% but going a bit darker towards the crown’s outer edges, giving it more curvature (Fig. 345a). Where these bands of reflective shading pass over any of the embossed filigree work on the crown, a short break is left in the shading to make the filigree appear to be raised off the crown’s surface.

With the magnum shading established in the crown, the 5 round is then used to tighten and develop the reflective shading, concentrating on reinforcing the raised look of the filigree by strengthening the short breaks in the shading. This is done with low power, using pencil-like brushstrokes to develop the detailing. For the tightening stage, much of the gray range is used for detailing, but the darkest grays and true blacks are reserved just for the eye and other key details (Fig. 345b).
Graywashes: Using The Whole Value Range

One mistake that inexperienced black and gray artists commonly make is to use only one shade of gray. Often, the artist will pour black for the outline, a premixed gray for the shading, and those are the two values that they work with. However, this will almost always result in a healed piece that doesn’t use the full gray range, giving the work a weak, flat, and low-contrast appearance.

For graywash tattooing, I don’t recommend using premixed opaque grays, which contain white and black with a less translucent look than washes. Instead, try pouring a variety of different washes to work with, including true black, 50%, 25%, and 10% dilutions of black. Some companies are selling bottles of premixed washes that can be very helpful in attaining consistent results from one piece to the next. However, there is also the option of doing it the way it’s been done for decades; in other words, mixing directly in the ink cup.

Since all caps of graywash appear the same to the naked eye, it’s a good idea to arrange them in order of strength on your palette. Normally, I start with the true black (often two caps) on the far right, then the strong wash to the left of those, and so on down to the most dilute wash on the far left. Normally start by pouring two full caps of black, a half cap to the left of them, then a quarter cap and then a final cap with only 1-2 drops of ink. This is followed by filling the partial caps with the rest of the way with water from the squirting bottle.

Using the magnum, large areas of white are blocked into the crown and the starburst at the top of the design. This is followed up with the 5 round, first to refine these large white areas and then to give shimmering details to the reflections and beaded designs in the crown.

Although it’s common for artists to specialize in only color or black and gray, I don’t think that the two styles are incompatible. Many of the skills needed to do good color work are useful in doing graywash work, and vise-versa. Even a specialty artist such as myself finds both skill sets to be helpful. If nothing else, doing an occasional piece in black and gray is a good way for any artist to stay more aware of using the full value range in their tattooing.

7.8) Making Your Technique Work

With all these considerations, it can be hard to even know where to begin. Especially for a relatively new tattooist, the notion of trying to do everything right in every single tattoo must seem overwhelming. The good news is that these considerations, when dealt with the right way during day-to-day tattooing, eventually become second nature. Many of these points are things that make sense naturally, without even needing to be told. However, for the purpose of making things a little simpler, here are two more checklists for you:

Checklist 8: Design

You’re in the process of preparing a tattoo design, and want to make sure that nothing has been overlooked. Before making a final draft of the drawing, ask yourself these questions:

1. Does it fit the body right? Does it flow nicely?
2. Which objects have the most priority, and which have the least? What graphic tools, such as outlines, are being used to establish this order of priority?
3. Is there a good balance between dark and light, warm and cool, focus and out-of-focus?
4. Are the areas of detail balanced out by smooth, open spaces?
5. Are there enough large, open areas of dark and light that the piece will read clearly from a distance?
6. Are all of the pos/neg relationships decisive and clear?
7. How will the design break off into the open skin around it? Will this look attractive from a distance? Are there any sudden cut-offs of the design anywhere? Are any parts of it too dense?
8. How and where will black lines be used, and of what weight? What about grayscales, color lines, and bloodlines?
9. What means will be used to transfer the design to skin? Should this be an all-line stencil, or would a crosshatch pos/neg more appropriate? Should it be done with markers, in part or in full?
10. Most importantly, is there a complete plan, before even touching the skin, to take the piece from start to finish?

Checklist 9: Execution

Once in a while during tattooing, it’s a good idea to mentally back off and look at the whole piece, then ask yourself these questions:

1. How is my stretch? Can I feel the strike of the needle with my stretching hand?
2. How is my visibility situation? Is enough needle visible? Is the machine spraying? What about lighting—is my hand casting a shadow on the piece? Can I see well enough to do my best work?
3) Am I making sure to address the larger forms of the piece, and not getting bogged down in detail that might clutter or hide its larger structure?

4) Am I using a thin coat of lubricant on the areas I am working? Are other areas of the piece where I'm not presently working being lubricated to prevent scabbing? Are nearby light-colored areas lubricated to prevent staining?

5) How's my stretch?

6) Am I using reserve where needed? What have I chosen in advance to reserve for the foreground? How about the background?

7) How is my machine running? If it's bogging down, will a quick dip in the rinse cup help? How about power—is it just right? Have I felt the armature bar lately? If it's rough, could the rubber bands need tweaking?

8) Is the ink flowing smoothly from the tube? If not, is the tube tip trenched? Could there be lint stuck between the needles, or some other blockage?

9) How's my stretch?

10) Am I sticking to the plan? Is the execution living up to the vision? If I'm making any changes to the plan as I go, are they deliberate and for the better?

These are only model questions; you may already have ideas for questions of your own that weren't mentioned in this list. The point here is that with time, you'll develop your own customized mental checklist that will keep you out of trouble, help you find the most efficient way of doing things, and produce the best tattoos you're capable of rendering.

What these lists are really about is a thing the Buddhists call Mindfulness. It's all too easy for artists to fall into their most well-traveled habits, and in the process forget to stop and think. Falling into habits like that can make it difficult to evolve, because the path of the least resistance will never lead to growth. With every tattoo project, no matter how small, there is an opportunity to push your skills to the next level. Being mindful of how every project is being planned and executed provides countless opportunities to find room for improvement.

Habits are easy to fall into, and not all of them are bad. However, the good habits are usually harder to get started with than the bad ones. No one wants to make every day into an uphill climb, but by carefully choosing the places where you can push yourself and get real results, this extra push can add up in the long run to a better career and a vastly improved quality of life. You can seize every day and try to race past the competition, but there's no shortcut through the extra effort that this takes.

Part VII Review Questions

1) What is the advantage of doing a value study before doing a color study? In what kinds of tattooing situations might this be the most helpful?

2) When switching from a graywash to straight black, what precautions can be taken to assure that the black isn't diluted by water in the tube tip?

3) What are some major considerations that can affect your visibility while working?

4) What makes a project a good candidate for a heliograph stencil? In what cases might a frechand design transfer be preferable? How about a combination of both?

5) If a full range of colors is used in a foreground shape, how much range should be used in the background? What is the best way to determine which background colors to use?

6) What are some ways of strengthening the pos/neg relationship between a foreground object and the background? How is this technically done?

7) What are some important considerations when designing a tattoo for a bony or irregular body part?

8) How can line weight be used to make part of a shape appear to pop forward?

9) In a complex design, what are some available tricks for keeping the overall piece readable?

10) What kinds of projects are good candidates for executing magnum opus?

11) When applying a design with a dark background, why is it preferable to shade and color the background before the foreground?

12) What are some advantages of a divide-and-conquer approach, where small parts of a tattoo are worked to completion before moving to the next areas?

13) The 3, 4 and 5 round are fairly similar to each other. In what sorts of situations would a 3 be recommended? What about a 4 or 5 round?

14) What will happen during healing to white highlights that are applied over yellow pigment?

15) Under what circumstances are gray lines ideal? What about color lines?
16) What can be done to prevent stencil loss while working?
17) How much power should be used while applying gray lines or bloodlines?
18) When can a tightening stage using a lining group be advantageous over coloring with only a magnum?
19) What extra steps can be taken while applying bright yellow to achieve maximum saturation?
20) What kinds of colors work well to make a muted color scheme, and how can they be mixed together for results with intentionally limited brightness?

For answers to these questions, go to: www.hyperspacestudios.com/reinventing/answers

PART VIII

Conclusion
8.1) New Horizons

Tattoo artists all have to face some of the same daily realities. Even with a full work schedule, there is still a high overhead in running a shop or just having a life. Tattooing is competitive, and especially when working in a shop with multiple artists all competing for the same walk-in clientele, there is need to keep up with the rat race just to make a decent living. At the end of the day, there’s the sore back and hands. In the late hours, the weird eating schedule and the lack of normal private life that all add up to make a tattoo career somewhat difficult. So the idea of voluntarily taking on additional challenges for the sake of the art might not make sense to everyone.

What I’m encouraging here is not necessarily a hardcore boot camp-style immersion in tattooing. The few oddball individuals who are inclined to dedicate their lives entirely to their art already know who they are, and need no encouragement from me. For the rest of the artists out there, what I am recommending is more like a moderate daily exercise program, where many small efforts are made that in time add up to a substantial improvement. Not every tattooist is in a position to make radical adjustments to how they work; but even in the worst shop situations there are opportunities, sometimes after work at your home drawing board, to make a daily effort to improve yourself.

One of the biggest complaints I hear from tattooists is about the difficulty in finding a good shop where they can work. Especially with artists just getting started or seeking apprenticeships, many parts of the world just don’t have any good shops with job openings available. So, countless young artists begin their tattoo careers struggling in badly run shops, often owned by non-tattooists who don’t have a clue how to run a shop, only how to milk it for all that it’s worth. Sometimes the situation is so bad that the artists there are in no position to learn anything useful at all and simply go into survival mode.

In other cases, the owner is a proficient tattooist who runs the shop well enough, but is fairly hard-headed and closed to learning new things. Often
this means they will also be closed to their apprentices learning anything that is not sanctioned by them. This can be a challenging situation in which to learn, but is preferable to the anarchy that takes place in some tattoo shops. Artists in this kind of environment often feel stifled, but are reluctant to leave for fear of losing a solid job position and entering the unknown.

The reality of a tattoo career often consists of these kinds of challenges, and it’s quite rare to encounter tattooists who did not face these sorts of issues at some point in their careers. If you are not ready for at least a little bit of an uphill climb, then tattooing is not for you. However, the strength and determination needed to make it through the first few years of learning tattooing will be clearly visible in the quality of your work. Like it or not, these kinds of painful career challenges are a sort of screening test that helps weed out those who might not have what it takes to deal with the daily stress of tattooing.

Fact

Most tattooists spend the first decade or more of their careers looking for a work environment that fits their style and personality.

Sometimes I get emails from artists who are at a point of despair and don’t know what to do next. I don’t always know how to reply; some situations are just bad and there’s no easy solution. For example, I know of a very fine tattooist who was under a legally binding contract where he couldn’t work anywhere within 200 miles for the rest of his life, but his ex-wife and child lived near the stuffing shop environment where he worked. In order to be a presence in the life of his child, he worked for 15 years like that until he was able to afford to buy out his contract. I could tell you dozens of stories like this, where a perfectly decent person with artistic potential ends up, by sheer bad luck, stuck in some kind of soul-crushing situation or another. How does anyone keep their optimism under such oppressive circumstances?

The answer is to become as fine of an artist as possible. No matter what your circumstances are, you can always be improving yourself. Ultimately, that’s the only real thing that any artist has to show for themselves: Their abilities. Efforts are made every day, even in the most minimal way, you will see improvement, which can bring positive light into the bleakest of circumstances.

A common situation for young tattooists is this: You’ve begun an apprenticeship at a local shop, possibly after demonstrating to the owner that you have drawing abilities. Several months in, you’ve learned what little the owner has to offer, and the situation is starting to get tense. The owner is either getting deeper into some kind of full-fledged downward spiral or has been arrested, and it looks like they’re going away for a while. All of a sudden, you find yourself on the way toward learning the trade, but at a dead-end. You have the basic equipment and essential beginning skills, but are in no shape to start a shop on your own and have no other local shop options. What can an artist do next at this junction?

If you have a small selection of tattoos you’ve done, choose the best of them and omit the less impressive or badly photographed ones. Get healed photos if you can. Put your tattoo photos near the beginning of the book, and follow them with a clean and consistent collection of drawings or other tattoo-related artwork. Show your skills. If you can, do a set of new drawings that are as up-to-date as possible. Remember that attention spans are short, so less is more—a dozen pages total of your best tattoos and drawings should be more than adequate for anyone looking at your portfolio to get the idea.

I also recommend starting the portfolio with a letter of introduction. Introduce yourself and say a sentence or two about why you think you’ll make a good tattooist and why they should hire you. Mention any past job experience that might be relevant, but talk mostly about yourself as an artist. Keep it short and respectful, and be sure to include contact information. Be prepared to print a few copies of your portfolio and leave them with a few shop owners. Keep in mind that other artists are also asking for those jobs—try to be the one with your act together the most.
A simple solution to making an attractive and durable portfolio is to use a standard 1" (2cm) three-ring binder with plastic looseleaf page protectors for the pages. View binders are especially nice because they allow you to insert your own image into the front cover.

To locate any available job opportunities, you need to make a real effort because there won’t just fall into your lap. Start by looking at the classified ads in tattoo magazines and online tattoo message boards. Join whatever internet forums you can, and get the word out that you’re looking for a job. If you make some positive online connections with other artists and have some good drawings or tattoo photos to show them, word can travel quickly about opportunities. I also recommend going to conventions and talking to as many of the artists you meet as you can. Only by networking will you find out what you are looking for; don’t be shy.

There is no easy solution to starting off your career in a bad environment. However, there is always the option to better your situation, either by improving yourself as an artist or by finding a new and better work environment. No matter how bleak your circumstances might seem, you can always find some part of your artistic life in which to make improvements. Eventually, your art will reach a level of quality where it can be your ticket out of whatever situation you may find yourself.

Not all the readers of this book are struggling to get their careers off the ground; many are seasoned tattooists in secure work situations who are simply looking to improve their tattooing. If you are one of these readers, you probably purchased this book because you were looking to expand your horizons, so there should be no personal barriers holding you back from taking all this new information and putting it to work. In practice, though, it’s not that simple: More experienced artists are likely to be entrenched in their habits, so even with an overall open attitude it can be an uphill climb to work outside your comfort zone and change the way you do things.

To make any visible improvements in the quality of your work, it’s helpful to begin with a list of things you’d like to improve. The more specific, the better: it’s easy to conclude, “I’m not happy with my color work,” but it’s way more helpful to think it through a bit and conclude something more particular, such as “My color work needs more contrast, and looks a little rough.” Ideally, you want to engage in an ongoing dialogue with yourself about the subject. Keeping notes about this stuff in your sketchbook is a good way to keep your thoughts and conclusions current.

One of the most helpful things you can do as an artist is to sit down and have a monthly review of your work. This consists of laying out photos on a coffee table (or computer desktop) and spending time looking at the whole group of material you generated that month. Look at it in light of the previous month’s notes, and ask yourself if you are making progress with your objectives. If your color looked rough, is it looking better? If your use of shapes was too small and cluttered, are you working with larger shapes in the newer work? With every monthly review, you have a chance to guide your progress and evaluate your direction. Typically, you can do this regularly with other artists to share your frustrations, triumphs and observations. Even by yourself, though, you can make strong, steady progress every month by reviewing your work, taking notes and committing yourself to evolving yet another step.

Don’t be frugal with your sketchbook pages. It’s okay to fill most of a sketchbook with scribbles if it allows you to produce a few good drawings. Requiring yourself to make the most of every page will just hold you back.

Evolution happens a step at a time. It’s easy to forget this simple fact, though; many artists make the mistake of comparing their work to that of other artists, and getting discouraged. The conclusion they come to is kind of defeatist: “If I can’t be great, RIGHT NOW, then why bother at all?” It’s exactly this conclusion that keeps most people out of the arts entirely.

Part of being an artist is to embrace who and what you are. You can’t be an effective creative person by trying to be anything besides yourself. On an everyday basis, this translates to an ongoing relationship with your own evolution. You don’t measure your evolution by comparing yourself to others; instead, you measure it by looking at where you are today as compared to yesterday and seeing if you’ve made any movement forward. Unless you’re trying really hard to stay where you are, some evolution is inevitable. With a little daily push, you will feel enough steady growth to make your efforts worthwhile.
With a much bigger than average push, though, there are no limits to where you can go. The more that tattooing evolves, the wider its horizons become and the more room there is for energetic new creative people to enter into the mix. That revolution is happening right now, and by pushing ourselves a little every day we can all be a part of it.

Thanks for your time, and I hope you find this book to be helpful.

Guy Aitchison
October 2008
This book would not have been possible without help and inspiration from many people.

First, a special thanks to the late Bob Oslo, for providing me with a challenging, somewhat frustrating, but still excellent tattoo apprenticeship.

Next, a big thanks to everyone who has tattooed me; that includes: Aaron Cain, Eddy Deutsche, Marcus Pacheco, Greg Kutz, Kari Barba, Alex Herman, Jill Moon, Bob Oslo, Don McDonald, Jon Clee, Steve Morris, Craig Murphy, Dennis Dwyer, Mike Cale, Dan Higgs, Dave Wragg, Jill Jordan, Deano Cook, Ed Tofolla, Bill Salmon, Freddy Corbin, Laura Swift, Igor Morriis, Dave Lunn, Erna Szabady, Jennifer Billig, Deborah Valentin, Theo Jok, Grime, Hannah Aitchison, Michele Wortman, Sluggo and his apprentice Mike.

Next, I must thank everyone I've tattooed; I feel blessed to have such a high quality clientele. For those whose tattoos appear in this book, thanks for the contribution.

I'd like to thank Stephanie Milligan and Jon Clee for their help with the layout, and John Majer, Ph.D., for proofing this monster under pressure; a big thanks also to Jason Marks and Trina Riedling for all help, past, present and future, and Stephen Naparstek, for introducing me to Photoshop all those years ago.

Finally, I want to thank my wife Michele Wortman, ...for all kinds of things.